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Korkma, sönmez bu afaklarda yüzen al sancak;  
Sönmeden yurdumun üstünde tüten en son ocak.  
O benim milletimin y ld z d r, parlayacak;  
O benimdir, o benim milletimindir ancak.  
 

Çatma, kurban olay m, çehreni ey nazl  hilâl! 
Kahraman rk ma bir gül! Ne bu iddet, bu celâl? 
Sana olmaz dökülen kanlar m z sonra helâl. 
Hakk d r Hakk’a tapan milletimin istiklâl. 
 

Ben ezelden beridir hür ya ad m, hür ya ar m. 
Hangi ç lg n bana zincir vuracakm ? a ar m! 
Kükremi  sel gibiyim, bendimi çi ner, a ar m. 
Y rtar m da lar , enginlere s mam, ta ar m. 
 

Garb n âfâk n  sarm sa çelik z rhl  duvar,  
Benim iman dolu gö süm gibi serhaddim var. 
Ulusun, korkma! Nas l böyle bir iman  bo ar, 
Medeniyyet dedi in tek di i kalm  canavar? 
 

Arkada , yurduma alçaklar  u ratma sak n; 
Siper et gövdeni, dursun bu hayâs zca ak n. 
Do acakt r sana va’detti i günler Hakk’ n; 
Kim bilir, belki yar n, belki yar ndan da yak n  

 

 

Bast n yerleri toprak diyerek geçme, tan :  
Dü ün alt ndaki binlerce kefensiz yatan . 
Sen ehit o lusun, incitme, yaz kt r, atan : 
Verme, dünyalar  alsan da bu cennet vatan . 
 

Kim bu cennet vatan n u runa olmaz ki feda? 
üheda f k racak topra  s ksan, üheda! 

Cân , cânân , bütün var m  als n da Huda, 
Etmesin tek vatan mdan beni dünyada cüda. 
 

Ruhumun senden lâhî, udur ancak emeli: 
De mesin mabedimin gö süne nâmahrem eli. 
Bu ezanlar -ki ehadetleri dinin temeli-  
Ebedî yurdumun üstünde benim inlemeli. 
 

O zaman vecd ile bin secde eder -varsa- ta m, 
Her cerîhamdan lâhî, bo an p kanl  ya m, 
F k r r ruh-  mücerret gibi yerden na’ m; 
O zaman yükselerek ar a de er belki ba m. 
 

Dalgalan sen de afaklar gibi ey anl  hilâl! 
Olsun art k dökülen kanlar m n hepsi helâl. 
Ebediyyen sana yok, rk ma yok izmihlâl; 
Hakk d r hür ya am  bayra m n hürriyyet;  
Hakk d r Hakk’a tapan milletimin istiklâl! 

 
         Mehmet Âkif Ersoy 



 

GENÇL E H TABE 

 

Ey Türk gençli i! Birinci vazifen, Türk istiklâlini, Türk Cumhuriyetini, 

ilelebet muhafaza ve müdafaa etmektir. 

Mevcudiyetinin ve istikbalinin yegâne temeli budur. Bu temel, senin en 

k ymetli hazinendir. stikbalde dahi, seni bu hazineden mahrum etmek 

isteyecek dâhilî ve hâricî bedhahlar n olacakt r. Bir gün, istiklâl ve cumhuriyeti 

müdafaa mecburiyetine dü ersen, vazifeye at lmak için, içinde bulunaca n 

vaziyetin imkân ve eraitini dü ünmeyeceksin! Bu imkân ve erait, çok 

namüsait bir mahiyette tezahür edebilir. stiklâl ve cumhuriyetine kastedecek 

dü manlar, bütün dünyada emsali görülmemi  bir galibiyetin mümessili 

olabilirler. Cebren ve hile ile aziz vatan n bütün kaleleri zapt edilmi , bütün 

tersanelerine girilmi , bütün ordular  da t lm  ve memleketin her kö esi bilfiil 

i gal edilmi  olabilir. Bütün bu eraitten daha elîm ve daha vahim olmak üzere, 

memleketin dâhilinde iktidara sahip olanlar gaflet ve dalâlet ve hattâ h yanet 

içinde bulunabilirler. Hattâ bu iktidar sahipleri ahsî menfaatlerini, 

müstevlîlerin siyasî emelleriyle tevhit edebilirler. Millet, fakr u zaruret içinde 

harap ve bîtap dü mü  olabilir. 

Ey Türk istikbalinin evlâd ! te, bu ahval ve erait içinde dahi vazifen, 

Türk istiklâl ve cumhuriyetini kurtarmakt r. Muhtaç oldu un kudret, 

damarlar ndaki asil kanda mevcuttur. 

                       Mustafa Kemal Atatürk 
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Öğrenme biriminin 
numarasını gösterir.Öğrenme biriminde yer 

alan konuları gösterir.

Öğrenme biriminde neler 
öğrenileceği ile ilgili ön 
bilgileri gösterir.

KİTABIN TANITIMI

Öğrenme biriminin
adını gösterir.

Karekod okuyucu ile taratılarak resim, 
video, soru ve çözümleri vb. ilave kaynak-
lara ulaşılabilecek karekod bölümüdür. 
Detaylı bilgi için http://kitap.eba.govtr/
karekod

Öğrenme birimindeki 
önemli kavramları gösterir.

13



Derse başlamadan önce yapı-
lacak hazırlıkları gösterir.

Öğrencilerin edindiği 
bilgiyi kullanmasını
sağlayacak çalışmaları gösterir.

Konu ve uygulamalara ilişkin 
ek bilgi ve ipuçlarını gösterir. 

Konuyu pekiştirmek için 
öğrencilerin yapması gereken 
etkinlikleri gösterir.
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Karekod, görsel kaynakçasını 
gösterir.

   Kazanılan bilgi ve becerilerin   
   her öğrenme birimi sonunda 
   ölçüldüğü çalışmaları gösterir.
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1. Görüntü işleme programları en çok hangi alanlarda kullanılır?

2. Görüntü işleme programları kullanılarak neler yapılabilir?

1.1. GÖRÜNTÜ İŞLEME PROGRAMI
Görüntünün oluşturulması, hatalı görüntünün düzeltilmesi, görüntüde dikkat çekilmek istenen 

yerin belirginleştirilmesi, görüntüye bakıldığında istenen algının oluşturulması gibi amaçları 
gerçekleştirmek için görüntü işlemeye ihtiyaç duyulur. Bu ihtiyaç, görüntü işleme programlarıyla 
karşılanır. Görüntü işleme yazılımları dijital bir görüntünün oluşturulmasına, değiştirilmesine, 
düzenlemesine ve iyileştirilmesine olanak sağlar. Renk düzenleme, netleştirme, rötuşlama, 
kırpma, ekleme işlemleri ile görüntüdeki kusurlar giderilerek istenen görüntü elde edilebilir ve 
görüntü yazdırılabilir. Görüntü işleme programları bunların yanında boyama ve çizim aracı olarak 
da kullanılabilir. Aynı zamanda geometrik şekilleri ve biçimlendirilmiş metinleri görüntülerle 
bütünleştirmek mümkündür. Birçok görüntü kullanılarak kolajlar da oluşturulabilir. Bu işlemler; 
görüntü işleme programındaki ayarlar, özellikler, araçlar, katmanlar, filtreler, efektler ve bunların 
kombinasyonları kullanılarak yapılır. 

1.1.1. Program Kurulumu

Görüntü işleme yazılımı deneme sürümü ya da tam sürüm olarak kullanılabilir. Programı 
kurabilmek için ilgili klasördeki setup dosyası çalıştırılır ve yükleme işlemi başlatılır. Yükleme 
işlemi bittiğinde görüntü işleme programı kullanılmaya hazırdır (Görsel 1.1).

Görsel 1.1: Programın ilk açılış ekranı

HAZIRLIK ÇALIŞMALARI
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İşlem adımlarına göre görüntü işleme programının bilgisayara kurulumunu gerçek- 
leştiriniz. 

1. Adım: Programı lisanslı olarak temin ediniz. 

2. Adım: Bilgisayarınızda kullandığınız işletim sisteminin 32/64 bit olduğundan emin olunuz.

3. Adım: İşletim sisteminize uygun şekilde setup dosyasını çalıştırarak kurulumu başlatınız.
4. Adım: Kurulum sırasında karşınıza gelecek seçenekler içinden programın kurulacağı dizini 

sabit diskinizin durumuna göre belirleyiniz. Programın etkin ve verimli çalışması için varsayılan 
konumu değiştirmemeye dikkat ediniz.

5. Adım: Yükleme tamamlandığında lisans kaydını gerçekleştirmek için internet bağlantınızın 
aktifliğinden emin olunuz.

6. Adım: Lisans kaydınızı gerçekleştiriniz.

7. Adım: Yüklediğiniz programı Başlat menüsünden veya masaüstü kısayolundan çalıştırınız.

1.1.2. Program Arayüzü

Görüntü işleme programında dijital görüntüler Görsel 1.2’deki gibi bir ana pencerede açılır. 
Programda bulunan menü komutları, araçlar ve panel tabanlı özelliklerin çeşitli birleşimleri 
kullanılarak görüntüler düzenlenir. 

1. UYGULAMA

Görsel 1.2: Görüntü işleme programı ana ekranı

A
B

E

F

G

D
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(A) Application Bar (Menu Bar): Görüntü işleme yazılımının komutlarını ve fonksiyonlarını 
gösterir.

(B) Options Bar: Seçili aracın özelleştirilmesini sağlayan kontroller bulunur. Ayrıca çubuğun 
sağ tarafında bulunan düğmeler aracılığıyla kullanıcı davet etme, arama, bir görüntüyü paylaşma 
ve ihtiyaca uygun çalışma alanı seçme işlemleri yapılabilir.

(C)  Title Tab: Açık görüntünün adını, büyütme oranını ve renk modunu gösterir. Açık görüntüler 
arasında geçiş yapmak için sekmelere tıklanır.

(D) Image Window: Açık görüntülerin görüntülediği alandır.

(E) Toolbox: Resim düzenleme araçlarını gösterir. Kullanılacak araç tıklanır ve görüntü üzerine 
işlem yapılır. Ayrıca aktif ön ve arka plan renklerini gösterir.

(F) Status Bar: Görüntüleme oranını ve özelliklerini gösterir.

(G) Panels: Kaynaklara ve komutlara ulaşılır. Panelleri görüntülemek ve gizlemek için sekmelere 
tıklanır.

İşlem adımlarına göre görüntü işleme programının farklı çalışma alanlarını aktifleşti- 
riniz. 

1. Adım: Choose a Workspace düğmesine tıklayınız (Görsel 1.3).

Görsel 1.3: Choose a Workspace düğmesi

2. Adım: Açılan menüden Painting seçeneğine tıklayınız.

3. Adım: Paneller ve toolboxtaki değişiklikleri gözlemleyiniz.

4. Adım: Choose a Workspace düğmesinden 3D seçeneğine tıklayınız.

5. Adım: Bu çalışma alanındaki değişiklikleri gözlemleyiniz.

2. UYGULAMA
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1.2. TEMEL KOMUTLAR
Görüntü işleme programında işlemleri gerçekleştirmek için uygulanacak birçok komut bulunur. 

Bu komutlara ekrandaki araçlar, paneller, açılan menüler veya oluşturulan çeşitli kısayollar 
aracılığıyla ulaşılır.

1.2.1. Temel Menü Komutları

File menüsünde dosyalama işlemlerine ait New... (Yeni), Open... (Aç), Save (Kaydet), Save As... 
(Farklı Kaydet), Export (Dışa Aktar), Import (İçe Aktar), Print... (Yazdır) ve Exit (Çıkış) vb. komutlar 
bulunur. Bu komutları tamamlamak için gelen iletişim pencereleri isteğe uygun şekilde cevaplanır. 

Edit menüsünden Undo (Geri Al), Redo (Yinele), Cut (Kes), Copy (Kopyala), Paste (Yapıştır), 
Transform, Color Settings (Renk Ayarları), Preferences (Tercihler) vb. düzenleme komutlarına 
ulaşılır. Edit menüsündeki bu komutlar genellikle yapılan bir işlemin düzenlenmesi amacıyla 
kullanılır. 

Image menüsü, görüntüleme ile ilgili komutları içerir. Image menüsünden Mode (Görüntüleme 
Modu), Image Size… (Görüntü Boyutu), Canvas Size… (Tuval Boyutu) gibi komutlara erişim 
sağlanır.

Layer menüsü, katmanlar ile ilgili tüm komutları barındırır. Type menüsü altında metin 
işlemlerine ait komutlara erişilir. Select menüsü altında ise seçim işlemlerine ait komutlar 
bulunur. Filter menüsünden filtrelere ulaşılır. Üç boyutlu çalışmalar için tüm ayarlamalar ve 
komutlar 3D menüsü altında bulunur. Görüntüleme özellikleri View menüsü altında bulunan 
komutlar aracılığıyla biçimlendirilir. Program çalışma arayüzü ayarları Window menüsü ile yapılır. 
Görüntü işleme programının eklenti yönetimi için Plugins menüsü kullanılır. Ayrıca yardım ile ilgili 
konulara Help menüsü kılavuzluk eder.

İşlem adımlarına göre yeni belge oluşturup kaydetme işlemini gerçekleştiriniz.

1. Adım: Görüntü işleme programında File>New… seçeneğine tıklayınız veya klavyeden Ctrl+N 
tuşlayınız.

2. Adım: New Document iletişim penceresinde verilen hazır ayarları kullanmak için Saved, 
Photo, Print, Art&Illustrasyon, Web, Mobil, Film&Video sekmelerinden Photo>Portrait>2x3 hazır 
ayarını seçiniz.

3. UYGULAMA
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3. Adım: Hazır ayar kullanarak belgeyi oluşturmadan önce sağ bölümde bulunan PRESET 
DETAILS kısmını aşağıda verilen değerlere göre doldurunuz (Görsel 1.4).

• Width (Genişlik): 24

• Height (Yükseklik): 48

• Birim: Centimeters

• Orientation (Yönlendirme): Dikey (Width ve Height değerlerine göre otomatik olarak 
belirlenir.)

• Resolution (Çözünürlük): 600

• Birim: Pixels/Inch

• Color Mode (Renk Modu): CMYK Color

• Renk Uzayı Boyutu: 16 bit 

• Background Contents: Custom

• Renk: Kırmızı

Görsel 1.4: Yeni belge penceresi

4. Adım: Create düğmesine tıklayınız.

5. Adım: Oluşturulan belgeye Rectangle Tool aracını kullanarak bir dikdörtgen çiziniz.

6. Adım: Foreground colora tıklayınca açılan Color Picker iletişim kutusundan ön plan rengini 
beyaz olarak değiştiniz.

7. Adım: Rectangle Tool aracını seçiniz ve bir dikdörtgen çiziniz.

8. Adım: File>Save seçeneğine tıklayınız veya klavyeden Ctrl+S tuşlayınız.
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9. Adım: Gelen iletişim ekranında kaydetmek istediğiniz klasörü ve dosyanın kayıt türünü 
seçiniz. 

10. Adım: Belgenin adını “1.Çalışma.psd” olarak giriniz ve Save düğmesine tıklayınız.

Renk modu veya görüntü modu, renklerin hangi yöntem kullanılarak oluşturulacağını 
belirler. RGB, CMYK, Index, Gri Tonlama ve Bitmap olmak üzere beş farklı renk modu 
vardır. Boyalarla oluşturulan CMYK modu baskı alınacak görüntülerde, ışıkla oluşturulan 
RGB modu ise dijital görüntülerde kullanılır. 

İşlem adımlarına göre önceden çalıştığınız belgeyi farklı kaydetme, dışa aktarma, 
yazdırma ve kapatma işlemlerini gerçekleştiriniz.

1. Adım: Görüntü işleme programında File>Open…  menüsüne tıklayınız veya klavyeden 
Ctrl+O tuşlayınız.

2. Adım: Aç iletişim penceresinden açılmasını istediğiniz belgenin bulunduğu klasörü seçiniz. 

3. Adım: Üçüncü uygulamada kaydedilen “1.Çalışma.psd”yi seçip Aç düğmesine tıklayınız.

4. Adım: File>Print… menüsüne tıklayınız veya klavyeden Ctrl+P tuşlayınız.

5. Adım: Açılan pencereden Printer alanında yazıcıyı seçerek belgenin kaç adet yazdırılacağını 
Copies alanına yazınız ve Print düğmesine tıklayınız (Görsel 1.5). 

Görsel 1.5: Yazdır penceresi

NOT

4. UYGULAMA
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6. Adım: Belgeyi PNG olarak dışa aktarmak için File>Export>Quick Export as PNG seçeneğine 
tıklayınız.

7. Adım: Gelen Save As iletişim penceresinde PNG türündeki belgeyi kaydedeceğiniz klasörü 
seçiniz ve belge adını giriniz.

8. Adım: Mevcut belgeyi “numara_ad_soyad” ismiyle farklı bir klasöre kaydetmek için 
File>Save As… seçeneğine tıklayınız. 

9. Adım: Belgenin kaydedileceği klasörü seçiniz ve belge adını giriniz. Kaydet düğmesine 
tıklayınız.

10. Adım: Belgeyi kapatmak için File>Close seçeneğine tıklayınız. Birden fazla belge açıksa 
File>Close All seçeneğine tıklayınız. 

Görüntü işleme programını kapatmak için File>Exit veya sağ üst köşedeki X simgesi 
tıklanır.

Görüntü dosyaları, kullanım amacına uygun formatta kaydedilmelidir. Dosya; 
üzerindeki değişiklikler korunacaksa ham dosya (.psd) olarak, webde kullanılacaksa 
.png olarak, webde küçük boyutlu kullanılacaksa .jpg olarak kaydedilmelidir.

1.2.2. Araçlar

Görüntü işleme programlarında istenen düzenleme ve değişikliklerin yapılması için seçim 
araçları, kesme ve dilimleme araçları, boyama araçları, rötuş araçları, filtreler, katmanlar, eylemler 
kullanılır.

Görsel 1.6’da görüntü işleme yazılımında bulunan araçlar verilmiştir. Seçilmek istenen araç 
tıklanır. Gizlenmiş araç varsa aracın sağ alt köşesindeki ok işareti tıklanarak görüntülenir. Ayrıca 
araçlar için varsayılan olarak tanımlanan klavye kısayolları da kullanılabilir. Gizlenmiş araçlar için 
de aynı kısayol geçerlidir. Araç grubu içinde geçiş yapmak için Shift + kısayol tuşlanır.

NOT

NOT
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Move Tool (Taşıma Aracı)

Lasso Tools (Kement Araçları)

Krop Tools (Kırpma Araçları)

Eyedropper Tool (Damlalık Aracı)

Brush Tool (Fırça Aracı)
History Brush Tool (Geçmişe 

Dönme Aracı)
Degrade Tool (Renk Geçişi Aracı)

Dodge Tool (Soldurma Aracı)

Zoom Tool (Büyüteç)

Hand Tool (El Aracı)

Pen Tool (Kalem Araçları)

Blur Tool (Silgi Aracı)

Eraser Tool (Silgi Aracı)

Frame Tool (Yer Tutucu Aracı)

Horizontal Type Tool (Yatay Yazı 
Aracı)
Rectangle Tool (Diktörtgen Çizim 
Aracı)

Set foreground color (Ön plan 
rengini ayarla) Set background color (Arka plan 

rengini ayarla)

Clone Stamp Tool (Klonlama 
Damgası Aracı)

Spot Healing Brush Tool 
(Düzeltme Fırçası Aracı)

Object Selection Tool (Nesne 
Seçim Aracı)

Rectangle Marquee Tool 
(Diktörgen Seçim Aracı)

Edit Toolbar (Araçlar çubuğunu 
düzenle)

Path Selection Tool (Yol Seçim 
Araçları)

Görsel 1.6: Araçlar kutusu

Seçim Araçları: Görüntüde değişiklik veya düzenleme yapılacak bölgeyi belirler ve seçer. Aynı 
veya farklı bir görüntüden alınan bölümü, düzenlenecek görüntünün ilgili bölgesine kopyalar 
veya taşır.

Kesme ve Dilimleme Araçları: Görüntünün istenmeyen bölgelerini keser veya web arayüz 
ihtiyacına uygun olarak görüntüleri dilimler.

Ölçüm ve Gezinti Araçları: Görüntünün renk ve boyut özellikleri ile ilgili işlemler yapar. 
Görüntülenen bölgeyi ve büyüklüğü değiştirir.

Çizim ve Boyama Araçları: Görüntüleri çizim ve fırça uçlarıyla zenginleştirir. Bitmap ve vektör 
tabanlı görüntüler hazırlar.

Rötuş Araçları: Görüntüde olduğu düşünülen renk, ton ve kompozisyon hatalarını giderir.

Filtreler: Temizleme, rötuşlama, sanatsal efektler ekleme, ışık ve aydınlatma efektleri oluştur- 
ma özellikleriyle görüntüleri özgünleştirir.

Katmanlar: Çalışma esnasında karışıklık yaşanmamasına yardımcı olur.

Eylemler: Görüntü işleme programında yapılan işlemleri daha sonra tekrar kullanılmak üzere 
kaydeder.
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1.2.3. Seçim Araçları (Selection Tools)

Görüntünün parçaları, görüntünün geri kalanından bağımsız olarak taşınabilir, renklendirilebilir 
veya dönüştürülebilir. Görüntülerin bazı bölümlerini düzenlemek üzere seçim araçları ile seçim 
yapılmalıdır. Görüntüdeki nesneleri veya benzer renkteki alanları seçmek için farklı yöntemler de 
kullanılabilir.

Move Tool (Taşıma) aracı, katmanları ve kılavuzları taşımak için kullanılır (Görsel 1.7). 

Görsel 1.7: Move araçları

Seçim komutları Görsel 1.8’de görülür. Rectangular Marquee Tool aracı, kare veya dikdörtgen 
şekline sahip seçimleri; Elliptical Marquee Tool aracı, daire veya elips şekline sahip seçimleri; 
Single Row Marquee Tool aracı, tek satır seçimleri; Single Column Marquee Tool aracı ise tek 
sütun seçimleri yapmak için kullanılır. 

Görsel 1.8: Seçim araçları

Görsel 1.9’da Lasso araçları verilmiştir. Lasso Tool aracı, serbest seçimler oluşturur. Polygonal 
Lasso Tool aracı, birçok düz çizgiyle sınırlandırılmış bir seçimi kolayca oluşturur.  Magnetic Lasso 
Tool aracı ise sınırları belli nesneleri seçer. 

Görsel 1.9: Lasso seçim araçları

Görsel 1.10’da özel seçim araçları verilmiştir. Object Selection Tool aracı, belirlenen bölgedeki 
nesneyi otomatik olarak seçer. Quick Selection Tool aracı, ayarlanabilir yuvarlak bir fırça ucunu 
kullanarak boyama yöntemine benzer şekilde seçim yapar. Magic Wand Tool aracı ise benzer 
renkli alanların seçilmesini sağlar.

Görsel 1.10: Özel seçim araçları
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Pen araçları, görüntüdeki bir alanın seçilmesini veya yeni nesne çizilmesini sağlar (Görsel 
1.11).

Görsel 1.11: Pen araçları

1.2.4. Kesme ve Dilimleme Araçları

Görüntüde istenmeyen bölgeleri temizlemek amacıyla kesme araçları kullanılır (Görsel 
1.12). Crop Tool aracı bir görüntünün üst, alt ve yan taraflarındaki gereksiz alanı hızla kaldırır.  
Perspective Crop Tool aracı, perspektiften kaynaklanan bozulmaları düzeltmek için bir görüntüyü 
kırpar. Slice Tool aracı, dilim oluşturur. Slice Select Tool aracı ise dilimleri seçer.

Görsel 1.12: Kesme ve dilimleme araçları

İşlem adımlarına göre internetten bulacağınız veya öğretmeninizin vereceği bir 
görselin bir bölümünü kesiniz.

1. Adım: Görselin bulunduğu dosyayı tıklayıp, görüntü işleme programının üzerine sürükle- 
yerek bırakınız.

2. Adım: Crop Tool aracını seçiniz.

3. Adım: Görselin belirlediğiniz kısmını sol üst köşesinden başlayarak dikdörtgen alan içine 
alınız.

5. UYGULAMA
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4. Adım: Kesme işlemini onaylamak için Enter tuşuna basınız veya Commit current crop 
operation        düğmesine tıklayınız (Görsel 1.13).

Görsel 1.13: Crop aracıyla istenmeyen bölgelerin temizlenmesi

1.2.5. Yazı (Type) Araçları

İhtiyaç duyulduğunda görüntülere yazılar eklenebilir ve seçim alanı olarak yazılar kullanılabilir. 
Type Tool araçları, görüntünün üzerinde yatay veya dikey olarak yazı oluşturur. Horizontal Type 
Tool ile Horizontal Type Mask Tool yatay, Vertical Type Tool ile Vertical Type Mask Tool dikey yazı 
yazmak için kullanılır. Horizontal Type Tool ile Horizontal Type Mask Tool araçları ile yazılan yazılar 
ayrı katmanlarda, diğerlerinde ise hangi katman seçili ise o katmanda yer alır (Görsel 1.14).

Görsel 1.14: Type Tool (T)

1.2.6. Çizim ve Boyama Araçları (Drawing and Painting Tools)

Görüntü işleme programında bir çizim yapmak için çizim ve boyama araçları kullanılabilir.  
İstenen şekiller ve çizgiler; Rectangle Tool, Ellipse Tool, Triangle Tool, Polygon Tool, Line Tool 
araçlarıyla çizilir. Listeden seçilen özel şekiller ise Custom Shape Tool aracıyla çizilir (Görsel 1.15).
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Görsel 1.15: Çizim araçları

Brush Tool aracı, fırça konturlarıyla boyar. Pencil Tool aracı, keskin kenarlı konturlar ile boyar. 
Color Replacement Tool aracı, seçili bir rengi yeni bir renge dönüştürür. Mixer Brush Tool aracı, 
tuval renklerini karıştırarak ve ıslaklığı değiştirerek gerçekçi boyama imkânı sağlar (Görsel1.16). 

Görsel 1.16: Brush araçları

History Brush Tool aracı, anlık görüntü veya seçili durumun kopyasını boyar. Art History Brush 
Tool aracı, anlık görüntü veya seçili durumu kullanarak boyama stillerinin benzetimini yapar 
(Görsel 1.17). 

Görsel 1.17: History Brush araçları

Gradient Tool aracı; çizgisel, açısal, yansımalı renk karışımları oluşturur. Paint Bucket Tool 
aracı, benzer renkli pixelleri arka plan rengi ile boyar (Görsel 1.18).

Görsel 1.18: Degrade ve boyama araçları
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 İşlem adımlarına göre Görsel 1.19’da verilen görüntüyü oluşturunuz.

1. Adım: 1024x1024 piksel boyutlarında Background Contents beyaz olan bir belge oluşturu- 
nuz.

2. Adım: Polygon Tool aracı ile dolgu rengi kırmızı, kenarlık rengi siyah olan bir beşgen çiziniz. 
Beşgen çizmek için Number of Sides özelliğini 5 olarak belirleyiniz.

3. Adım: Move Tool aracını seçiniz. Kırmızı beşgeni tıklayınız ve klavyeden Alt tuşu basılıyken 
sürükle bırak yöntemi ile beşgeni çoğaltınız. 

4. Adım: Kopyaladığınız beşgenin dolgu rengini siyah olarak değiştiriniz.

5. Adım: Move Tool aracını seçiniz. Siyah beşgeni tıklayınız ve ayarlar kısmından Show 
transfrom controls özelliğini işaretli hâle getiriniz. Beşgeni köşesinden orantılı olarak küçültüp 
uygun şekilde konumlandırınız.

6. Adım: Siyah beşgen seçiliyken Edit>Copy seçeneğine tıklayınız. Edit>Paste seçeneğine 
tıklayarak siyah beşgeni çoğaltınız. 

7. Adım: Yeni beşgenin dolgu rengini turuncu olacak şekilde değiştirip turuncu beşgeni uygun 
yere konumlandırınız.

8. Adım: Ellipse Tool aracını seçip, mavi dolgu ve siyah kenarlık ile Shift tuşunu basılı tutarak 
bir daire çiziniz. 

9. Adım: Çizilen daireyi istediğiniz bir yöntemle iki adet çoğaltınız. Verilen örnek tasarıma 
uygun şekilde daireleri konumlandırınız ve renklendiriniz.

10. Adım: Custom Shape Tool aracını seçiniz. Set to shape to create ayarından Görsel 1.19’da 
verilen çiçek ve ağaç şekillerini seçiniz. Çiçek ve ağaç şekillerinin dolgularını belirleyip uygun 
yerlere ekleyiniz.

Görsel 1.19: Çizim, boyama ve yazı araçları uygulaması

6. UYGULAMA
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11. Adım: Type Tool aracını seçiniz. Ayarlar çubuğundan Set to font size özelliğini 72 pt, Set 
the text color özelliğini kırmızı ve Create wraped text özelliğini Arc Upper olarak belirleyiniz. Tuval 
üzerinde uygun yere tıklayıp “Grafik ve Canlandırma” metnini yazınız. 

12. Adım: Grafik ve Canlandırma metnini çoğaltınız. Altta kalan metnin rengini gri olarak 
değiştiriniz ve kırmızı metnin gölgesi olarak konumlandırınız.

13. Adım: Oluşturduğunuz görüntüyü ham dosya formatında ve web kullanımına uygun 
formatta kaydediniz.

1.2.7. Rötuş Araçları

Görüntüler üzerinde düzeltmeler yapmak için rötuş araçları kullanılabilir.
Spot Healing Brush Tool aracı, lekeleri ve nesneleri kaldırır. Healing Brush Tool aracı, 

görüntüdeki kusurları onarmak için boyar. Patch Tool aracı, bir desen veya örneği kullanarak 
seçili alandaki kusurları onarır. Red Eye Tool aracı, flaştan kaynaklanan kırmızı yansımayı kaldırır 
(Görsel 1.20).

Görsel 1.20: Healing Brush araçları

Clone Stamp Tool aracı, görüntüde belirlenen bölgenin örneğiyle boyar. Pattern Stamp Tool 
aracı, görüntünün bir parçasını desen olarak boyar (Görsel 1.21).

Görsel 1.21: Clone Stamp araçları

Blur Tool aracı, keskin kenarları bulanıklaştırır. Shapen Tool aracı, bulanık kenarları keskin- 
leştirir. Smudge Tool aracı, tıklanan alandaki renkleri birbirine bulaştırır (Görsel 1.22).

Görsel 1.22: Blur araçları
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Dodge Tool aracı, görüntünün rengini açık hâle getirir ve soldurur. Burn Tool aracı, görüntünün 
rengini koyulaştırır. Sponge Tool aracı, görüntüdeki bir alanın renk doygunluğunu değiştirir 
(Görsel 1.23).

Görsel 1.23: Dodge araçları

Eraser Tool aracı, pikselleri siler. Background Eraser Tool aracı, sürükleme ile alanları silip 
saydam yapar. Magic Eraser Tool, tıklanan renkteki alanları saydam yapar (Görsel 1.24). 

Görsel 1.24: Eraser araçları

İşlem adımlarına göre Görsel 1.25’te bulunan görselde cilt ve saç üzerinde rötuş- 
lama işlemini gerçekleştiriniz.

Görsel 1.25: Rötuş araçları uygulaması

1. Adım: Görsel üzerinde rötuşlama yapılacak bölgeleri (sivilce, kırışıklık, göz rengi, saç vb.)
belirleyiniz.

7. UYGULAMA
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2. Adım: Rötuşlama işlemini yapmak için Clone Stamp Tool aracını seçiniz.

3. Adım: Düzeltme yapacağınız bölgenin büyüklüğüne uygun olarak fırça ucu ayarını yapmak 
için görüntü üzerindeyken farenin sağ tuşuna tıklayınız. Brush Preset picker penceresi aracılığıyla 
uygun büyüklük ve kenar yumuşaklığı seçimini gerçekleştiriniz.

4. Adım: Alt tuşuna bastığınızda fırça ucunun içinde      belirir. Örnek alınacak bölgeyi 
belirlemek için bu hâldeyken farenin sol tuşuna tıklayınız. Düzeltme yapacağınız bölgede farenin 
sol tuşuna tıklayıp sürüklemeye başladığınızda, imleci bırakıncaya kadar düzeltme işlemine 
devam edilecektir.

5. Adım: Cilt üzerinde silme işlemi yapmak için Patch Tool aracının kullanınız.

6. Adım: Düzeltme yapılacak alanı seçiniz. Seçtiğiniz bölgeyi örnek alınacak bölgeye sürükleyip 
bırakınız. Yapılan işlem düzeltme için yeterli değilse aynı işlemi tekrarlayınız.

7. Adım: Rötuşlama işlemi tamamlanıncaya kadar aynı işlemi tekrarlayınız.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Uygun rötuş araçlarını seçti.

2. Seçtiği rötuş aracına uygun adımları gerçekleştirdi.

3. Rötuşlama işlemini yaptı.

4. Dosyayı kaydetti.

 İnternetten bulduğunuz veya öğretmeninizin size dağıtacağı bir görsel üzerinde 
rötuşlama işlemi uygulayınız.

SIRA SİZDE
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1.2.8. Gezinme ve Ölçme Araçları (Navigation)

Hand Tool aracı, görüntüyü pencerenin içinde taşır. Rotate View Tool aracı, tuvali geçici olarak 
döndürür (Görsel 1.26). 

Görsel 1.26: Navigation araçları

Eyedropper Tool aracı, tıklanan pikseldeki rengi örnekler. Color Sampler Tool aracı ile dört 
piksele kadar renk örneklenebilir. Ruler Tool aracı uzaklıkları, konumları ve açıları ölçer. Note Tool 
aracı, notlar ekler. Count Tool aracı, görüntüdeki nesneleri sayar (Görsel 1.27).

Görsel 1.27: Eyedropper araçları
 

Zoom aracı görüntünün görüntüleme boyutunu büyütür (Görsel 1.28). Zoom aracı, Alt tuşuna 
basılarak kullanılırsa büyütme yerine küçültme yapar.

Görsel 1.28: Zoom Tool

1.3. BOYUT VE ÇÖZÜNÜRLÜK
Görüntünün hangi amaçla kullanılacağı görüntü dosyası oluşturulurken bilinmelidir. Amaca 

uygun boyutlara ve çözünürlüğe sahip olarak dosya oluşturulmalıdır.
Piksel, görüntüleri oluşturan en küçük birimdir. Cep telefonu, bilgisayar gibi tüm elektronik 

cihazların ekranları piksellerden oluşur. Ekranlardaki bu yapı kırmızı, mavi ve yeşil renklerin 
tonlarını gösterir. 

Piksel boyutları, bir görüntünün yükseklik ve genişliğinin toplam piksel sayısını belirler. 
Çözünürlük, bitmap görüntüsündeki en ince ayrıntıdır. İnç başına düşen piksel sayısı (ppi - pixel 
per inch) arttıkça ekranının netliği ve keskinliği artar. Yüksek çözünürlüğe sahip bir görüntü, daha 
iyi görüntü kalitesi sağlar.
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Piksel boyutu, görüntünün kullanılacağı alana göre belirlenmelidir. Görüntü, piksel boyutu 
ne kadar büyükse o kadar büyük bir alanda kullanılabilir veya baskı yapılabilir. Billboardda 
kullanılacak görüntü A4 boyutlarına uyumlu oluşturulduğunda istenen etkiyi sağlamaz. 

Monitör çözünürlüğü, piksel boyutları olarak tanımlanır. Monitörün çözünürlüğü ve fotoğrafın 
piksel boyutları eşit ise fotoğraf %100 görüntülendiğinde ekranı tam olarak doldurur. Görüntünün 
ekranda ne kadar büyük görüntüleneceği; görüntünün piksel boyutları, monitör boyutu, 
monitörün çözünürlük ayarı gibi faktörlerin birleşimine göre değişir. 

Yazıcı çözünürlüğü, dpi (dot per inch) olarak da bilinen inç başına mürekkep noktası cinsinden 
ölçülür. Genel olarak inç başına ne kadar fazla nokta düşerse o kadar iyi çıktı elde edilir. Yazıcı 
çözünürlüğü ile görüntü çözünürlüğü birbiriyle ilişkilidir. İnkjet yazıcıda yüksek kaliteli fotoğraf 
yazdırmak için en az 220 ppi görüntü çözünürlüğü olmalıdır. 

Görüntünün dosya boyutu;  kilobyte, megabyte, gigabyte olarak ölçülen görüntü dosyasının 
dijital boyutudur. Dosya boyutu, görüntünün piksel boyutlarıyla orantılıdır.  Dosya boyutunu 
etkileyen bir diğer faktör de dosya formatıdır. Dosya formatları farklı sıkıştırma yöntemleri 
kullandığı için dosya boyutları aynı pikselde belirgin biçimde değişebilir. 

İşlem adımlarına göre görüntü boyutu ayarlarını düzenleyiniz. 

1. Adım: Görüntü boyutunu hızlıca öğrenmek için belge penceresinin sol alt köşesine bakınız.

2. Adım: Image>Image Size… seçeneğine tıklayınız.

3. Adım: Gelen iletişim penceresinde değişikliğe başlamadan önce baskı boyutunu etkileye- 
cek işlemler yapıp yapmayacağınıza karar veriniz. Değişiklikleriniz baskı boyutunu etkileyecekse 
Resample (yeniden örnekleme) özelliğini etkinleştiriniz. 

4. Adım: Width ve Height yanındaki metin kutularına görüntünüzün genişlik ve yükseklik 
değerini girip birim belirleyiniz. Width ve Height değerlerinin birbirine oranını korumak isterseniz 
Do not constrain aspect ratio simgesinin etkinleştirildiğinden emin olunuz. Bu bağlantıyı 
kaldırmak isterseniz Do not constrain aspect ratio simgesini kaldırınız. Değerler birbirine bağlıysa 
otomatik olarak gelecektir.

Resample etkinleştirildiğinde boyut değişikliğinin en üstte görüntülenen Image Size 
(disk boyutu) değerini değiştirdiği görülür.

NOT

8. UYGULAMA
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5. Adım: Görüntü için istediğiniz çözünürlük değerini Resolation metin kutusuna yazınız ve 
birimi belirleyiniz (Görsel 1.29). 

Görsel 1.29: Image Size iletişim penceresi

1.4. SEÇİLİ ALAN OLUŞTURMAK VE RENK AYARI YAPMAK
Görüntünün parçaları, geri kalanından bağımsız olarak taşınabilir, renklendirilebilir veya 

dönüştürülebilir. Görüntüdeki nesneleri veya benzer renkteki alanları seçmek için farklı araçlar 
kullanılır.

1.4.1. Seçili Alan Oluşturmak

Görüntü dosyaları üzerinde işlem yapabilmek için önce ilgili yerin seçilmesi gerekir. Yer 
seçimi yapıldıktan sonra işlem uygulanır. Böylece sadece istenen alanda değişiklik yapılır. Seçilen 
alan üzerine filtreler ile renk dolguları uygulanabilir ve kesme, kopyalama, yapıştırma gibi basit 
işlemler yapılabilir. Her görüntüde seçilecek alan farklı yapıya sahiptir ve her yapı için farklı seçim 
yöntemi vardır. Kement araçları, geometrik işaretleme araçları, hızlı seçim aracı ve sihirli değnek 
aracı, Select>Color Range… komutu seçme işlemlerini yapmak ve görüntü düzenlemek için 
hazırlanmıştır. 

1.4.1.1. Seçim

Görüntünün bir parçasında değişiklik (silme, çoğaltma, döndürme, renk değiştirme vb.) 
yapmak için tamamen veya kısmen aktif hâle getirilen piksellere seçim denir. Belirli bir bölge 
tamamen seçilmiş ise etrafında yanıp sönen kesikli bir kenarlık görünür. Seçim iptal edilirse 
kenarlık kaybolur.
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1.4.1.2. Seçili Alanı Değiştirmek

Resim dosyasındaki görüntünün tamamını seçmek için Select>All seçeneği tıklanır veya 
klavyeden Ctrl+A tuş kombinasyonuna basılır. Seçme işlemini iptal etmek için Select>Deselect 
seçeneği kullanılır veya klavyeden Ctrl+D tuş kombinasyonuna basılır.  Tekrar aynı alan seçilmek 
istenirse Select>Reselect tıklanır veya klavyeden Shift+Ctrl+D tuş kombinasyonuna basılır. 
Böylece tekrar seçme işlemiyle vakit kaybedilmez. Seçilen alanın dışında kalan yerleri seçmek 
için Select>Inverse tıklanır veya klavyeden Shift+Ctrl+I tuş kombinasyonuna basılır.

Görsel 1.30’da seçim araçlarına ait ayarlar görülür. Soldan itibaren yeni seçim oluşturmak 
için New selection, önceki seçime eklemek için Add to selection, önceki seçimden çıkarmak 
için Subtract from selection ve önceki seçimle kesişim oluşturmak için Intersect with selection 
seçenekleri aktif hâle getirilmelidir. 

Görsel 1.30: Seçim araçları ayarları

İşlem adımlarına göre öğretmeninizin vereceği veya internetten bulacağınız Solo 
Türk akrobasi uçağına ait bir görselin arka planını kaldırınız.

1. Adım: Görüntü dosyasını açınız.

2. Adım: Object Seletion Tool aracı ile uçağı içine alacak şekilde bir dikdörtgen alan belirleyerek 
görüntü işleme programının seçim yapmasını sağlayınız.

3. Adım: Options Bar panelinde beliren ayarları kullanarak varsa seçim hatalarını düzeltiniz.

4. Adım: Select>Inverse komutuna tıklayarak arka planı seçili duruma getiriniz.

5. Adım: Edit>Clear komutuna tıklayarak arka planı temizleyiniz.

6. Adım: Dosyayı uygun formatta kaydediniz.

1.4.2. Renk Ayarı

Görüntüleri istenen şekilde düzenlemek için renk ayarları da kullanılabilir. Görüntünün ışık, 
karşıtlık ayarları değiştirilerek farklı etkiler elde edilebilir.

1.4.2.1. Ton ve Kontrast

Ton, rengin parlaklık derecesini belirler. Herhangi bir renk fazla ışık alırsa açık, az ışık alırsa 
koyu renk olarak adlandırılır.  

9. UYGULAMA
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Kontrast, karşıt demektir. Açık ve koyu, büyük ve küçük gibi zıtlıkları yansıtır. Kontrast, 
görüntü üzerindeki en aydınlık ile en karanlık renkleri ifade eder. Keskin görüntüler elde etmek 
için kontrast doğru ve uygun şekilde kullanılmalıdır. Yüksek kontrast, koyu gölgelerden beyaz 
aydınlıklara kadar geniş farklılığı anlatır. Düşük kontrast, karanlık gölgeler ve parlak aydınlıkların 
aşırı uçlarını içermeyen daha sınırlı farklılığı ifade eder.

1.4.2.2. Ton ve Kontrast Ayarları

Ton ve kontrast ayarları Image>Adjusment>Brightness/Contrast… seçeneği ile gerçekleştiri- 
lebileceği gibi görüntü işleme programının ton ve kontrastı algılayıp, otomatik olarak düzeltmesi 
sağlanabilir. Otomatik ayarlama için Image menüsü altında bulunan Auto Tone veya Auto Contrast 
seçenekleri tıklanır.

İşlem adımlarına göre öğretmeninizin vereceği veya internetten bulacağınız bir 
görüntü üzerinde ton ve kontrast ayarlarını gerçekleştiriniz (Görsel 1.31).

1. Adım: Görüntü dosyasını açınız.

2. Adım: Image>Auto Tone seçeneğine tıklayınız ve görüntü işleme programı tarafından 
otomatik olarak ışık ayarının yapılmasını sağlayınız.

3. Adım: Image>Auto Contrast seçeneğine tıklayınız ve görüntü işleme programı tarafından 
otomatik olarak kontrast ayarının yapılmasını sağlayınız.

4. Adım: Image>Adjustment>Brightness/Contrast… seçeneğini tıklayarak Görsel 1.32’deki 
Brightness/Conrast iletişim penceresini açınız.

5. Adım: Kaydırma çubuğu kullanarak veya metin kutularına değer yazarak görüntünün daha 
aydınlık ve net görünmesini sağlayınız. 

Görsel 1.31: Renk ayarları uygulaması

10. UYGULAMA
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Görsel 1.32: Brightness/Contrast iletişim penceresi

6. Adım: Küçük değişiklikler yaparak görüntüdeki etkiyi gözlemleyiniz.

7. Adım: Dosyayı kaydediniz.

1.5. KATMANLAR (LAYERS)
Katmanlar, görüntü işleme programının en önemli unsurlarından biridir. Katmanlar, yapılan 

çalışmaların kontrollü ve düzenli olmasına, çalışma sırasında karışıklık yaşanmamasına yardımcı 
olan nesnelerdir. Katmanlar hareket ettirilebilir, çoğaltılabilir, silinebilir, birleştirilebilir ve 
gizlenebilir özelliklere sahiptir. 

Katmanlarla ilgili işlemler Layers paneli (Görsel 1.33) ve Layer menüsü kullanılarak yapılır. 
Layers panelinin çalışma ekranında görüntülenip kaldırılması için Window menüsünden Layers 
(F7) komutu kullanılır.

Görüntü işleme programında yeni bir doküman oluşturulduğunda Layers panelinde sadece 
boş küçük bir resim şeklinde kilitli olan Background (arka plan) katmanı belirir. Yeni bir katman 
oluşturulmadığı sürece Background katmanı silinemez.

Görsel 1.33: Layers paneli

A
B

C
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J
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A: Katman efektlerinin yer aldığı listedir.

B: Katman kilitleme seçenekleri ile katmanı kilitler veya katmanın kilidini kaldırır.

C: Katmanı gizler veya gizli katmanı görüntüler (Indicates layer visibility).

Ç: Seçili olan katmanları birbirine bağlar (Link Layer).

D: Seçili katmana stil uygular (Add a layer style).

E: Katmana maske uygular (Add layer mask).

F: Ayar katmanı oluşturur.

G: Yeni grup oluşturur (Create a new group).

Ğ: Yeni katman oluşturur (Create a new layer).

H: Katmanı siler (Delete layer). 

I: Katmanın kilitli olduğunu gösterir.

İ: Katman Fill (Dolgu) değerini ayarlar. Efektler bu işlemden etkilenmez.

J: Katmanın Opacity (Saydamlık) değerini ayarlar. Efektler üzerinde de etkilidir.

K: Katman panelinin sağ üst köşesindeki sembole tıklandığında katman ile ilgili diğer ayarla- 
maların yapıldığı menüyü açar.

1.5.1. Katman Oluşturmak, Silmek, Çoğaltmak

Görüntü işleme programında yeni bir katman oluşturmak, silmek, çoğaltmak veya diğer 
işlemleri yapmak için birden çok yol mevcuttur. Tercihe göre Layer menüsü, Layers paneli, klavye 
kısayolları veya Layers panelinin sağ üst köşesindeki     sembolüne tıklandığında açılan menü 
kullanılabilir. 

1.5.1.1. Katman Oluşturmak
Yeni bir katman oluşturmak için Layers panelinden Create a new layer, Layer menüsünden ü 

veya klavyeden Ctrl+Shift+N tuş kombinasyonları kullanılabilir (Görsel 1.34).

Görsel 1.34: Yeni katman oluşturma
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Görüntü işleme programında oluşturulan katman “Layer 1” ismindedir. Katman ismi üzerine 
çift tıklanarak istenilen katman yeniden adlandırılabilir. Böylelikle yapılan çalışmada karışıklık 
engellenir.

Background katmanı üzerine çift tıklanıp, açılan pencereden katmana isim verilerek veya 
Background katmanı üzerinde sağ tuşa basılıp, Layer from background komutu verilerek katman 
normal Layer katmanına dönüştürülebilir.

Katman isimlerinin sol tarafında yer alan göz sembolüne tıklanarak çalışma sırasında 
görünmesi istenilmeyen katmanları gizlemek mümkündür. Bu işlem, katmanı silmeden gizlemek 
amacıyla kullanılır. 

Bir katman kilitlenebilir veya kilitli bir katmanın kilidi kaldırılabilir. Katmanları kısmi veya 
tamamıyla kilitlemek mümkündür. Dört çeşit katman kilit seçeneği vardır. İlk kilit, saydam 
pixelleri; ikinci kilit, görüntü pixellerini kilitler. Üçüncü kilit, katmanın konumunu kilitleyerek 
katmanın pixellerinin taşınmasını engeller. Dördüncü kilit ise katman üzerinde herhangi bir işlem 
yapılmasını engelleyerek tam anlamıyla bir kilitleme işlemi yapar.

Her işlemin farklı katmanlarda yapılması çalışmalarda kolaylık ve düzen sağlaması 
açısından önemlidir.

1.5.1.2. Katman Çoğaltmak

Mevcut katmanı koruyarak kopyasını almak mümkündür. Bir katmanın kopyasını almak, bir 
başka deyişle katmanı çoğaltmak için şu yollardan herhangi biri kullanılabilir:

• Katmana basılı tutup, panelde yer alan yeni katman sembolü üzerine bırakarak

• Katman üzerinde sağ tuşa basılı tutup, açılan listeden Duplicate Layer seçerek

• Katman seçiliyken Layer menüsünden Duplicate Layer komutunu kullanarak

• Katman seçili ve Alt tuşuna basılıyken fare ile sürükleyip, panel üzerine bırakarak

• Doküman üzerinde çoğaltılmak istenen nesne seçili ve Alt tuşuna basılıyken fare ile sürük- 
         leyip bırakarak

Alt tuşu ile birlikte Shift tuşuna basarak aynı hizada veya düzlemde nesnenin 
çoğaltılmasını sağlamak mümkündür.

NOT

NOT
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1.5.1.3. Katman Silmek

Diğer katman işlemlerinde olduğu gibi katman silme işlemi için de birçok seçenek vardır. 
Katman menüsünü kullanmak, katman üzerinde Delete tuşuna basmak veya silmek istenen 
katmanı katman panelinin sağ alt tarafında yer alan çöp kutusuna taşımak bunlardan bazılarıdır.

1.5.2. Katmanların Sırasını Değiştirmek

Görüntü işleme programında katmanların sırası değiştirilip üstteki katman alta, alttaki katman 
üste alınarak katmanların yeri düzenlenebilir. Yeri değiştirilmek istenen katmana tıklayıp sürükle 
bırak yöntemi ile katmanı istenilen konuma (alta veya üste) getirmek mümkündür (Görsel 1.35).

Görsel 1.35: Katman sıralama

Katmanların sırasını değiştirmek için kullanılan diğer bir yol ise Layer menüsündeki Arrange 
komut seçenekleridir.

Bring to Front: Katmanı en öne getirir.

Bring Forward: Katmanı bir öne getirir.

Send Backward: Katmanı bir arkaya gönderir.

Send to Back: Katmanı en alta gönderir. 

Reverse: Katman sırasını tersine çevirir.

İşlem adımlarına göre dikdörtgen, üçgen, daire şekillerini içeren ve içerdiği şeklin 
adını taşıyan üç katman oluşturup sıralama, çoğaltma ve silme ile ilgili işlemleri 
gerçekleştiriniz (Görsel 1.36).

11. UYGULAMA
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Görsel 1.36: Katman oluşturma ve düzenleme

1. Adım: Katman panelinin alt tarafında yer alan Create a new layer sembolüne tıklayarak yeni 
bir katman oluşturunuz.

2. Adım: Dikdörtgen seçim aracını Shift tuşu ile birlikte kullanarak ekrana kırmızı renkli bir 
kare çiziniz ve katman ismi üzerine çift tıklayarak katmana “Kare” adını veriniz.

3. Adım: Yeni bir katman daha oluşturunuz ve bu katmana yeşil renkli bir üçgen çizerek, 
katmanın adını “Üçgen” olarak belirleyiniz.

4. Adım: Yeni bir katman oluşturarak, bu katmana Shift tuşu ile birlikte elips aracını kullanarak 
mavi renkli bir daire çiziniz. Katmanın ismini “Daire” olarak düzenleyiniz.

5. Adım: Katmanları Görsel 1.36’daki gibi sıralayınız.

6. Adım: Kare isimli katmanı çoğaltınız. Bunun için çoğaltılmak istenen katmanı seçip üzerinde 
farenin sağ tuşuna tıklayınız. Açılan pencereden “Duplicate layer” seçeneğini seçiniz (Görsel 
1.37). 

Görsel 1.37: Katman çoğaltma

7. Adım: “Kare copy” adındaki katmanı siliniz. Silme işlemi için katmanı tutup, çöp kutusu 
sembolü üzerine getirerek bırakınız.

8. Adım: Katmanların yanında bulunan göz simgesine tıklayarak katman gizleme işlemini 
gözlemleyiniz.

9. Adım: Çalışmayı “katman oluşturma” adıyla “.psd” formatında kaydediniz.

1.5.3. Katmanları Bağlamak 

Katmanlar birbirine bağlanarak birlikte hareket ettirilebilir veya katmanların biçim 
değiştirmeleri sağlanabilir. Birbirine bağlanmak istenen katmanlar seçilerek katman panelinin alt 
bölümündeki Link layers (zincir şekli) tıklanır. Bu işlemle katmanlar birbirlerine kilitlenir. 
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1.5.4. Katman Hizalamak (Align) ve Dağıtmak (Distribute)

Görüntü işleme programında Align (Hizalama) komutu kullanılarak nesnelerin hizalanması 
mümkündür.  Layer menüsünden Align veya Window menüsünden Options komutları ile Align 
bölümüne erişilebilir (Görsel 1.38). Align işlemi yapabilmek için en az iki katmanın seçili olması 
gerekir. 

Görsel 1.38: Align komutu seçenekleri

Görsel 1.38’deki üç nokta sembolüne tıklandığında Görsel 1.39 açılır. Burada hizalama 
seçenekleri daha detaylı olarak belirlenir. Açılan görseldeki nesnelerin özellikleri  Tablo 1.1’de 
verilmiştir.

Görsel 1.39: Align ve Distribute

Tablo 1.1: Katman Hizalama ve Dağıtma Seçenekleriyle Görevleri

Align Seçenekleri ve Görevleri
Align left edges (Sol kenarları hizala): Seçili katmanlardaki sol pikseli en solda 

bulunan katmandaki sol piksele veya seçim kenarlığının sol kenarına hizalar.
Align horizontal centers (Yatay merkezleri hizala): Seçili katmanlardaki 

yatay merkez pikselini seçili tüm katmanların yatay merkez pikseline veya seçim 
kenarlığının yatay merkezine hizalar.

Align right edges (Sağ kenarları hizala): Bağlantılı katmanlardaki sağ pikseli 
seçilen tüm katmanlardaki en sağda bulunan piksele veya seçim kenarlığının sağ 
kenarına hizalar.

Align top edges (Üst kenarları hizala): Seçili katmanlardaki üst pikseli seçili 
tüm katmanlardaki en üstte bulunan piksele veya seçim kenarlığının üst kenarına 
hizalar.

Align vertical centers (Dikey merkezleri hizala): Seçili her katmandaki dikey 
merkez pikselini seçili tüm katmanların dikey merkez pikseline veya seçim 
kenarlığının dikey merkezine hizalar.

Align bottom edges (Alt kenarları hizala): Seçili katmanlardaki alt pikseli 
seçili katmanlardaki en altta bulunan piksele veya seçim kenarlığının alt kenarına 
hizalar.
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Distribute Seçenekleri ve Görevleri
Distribute top edges (Üst kenarları dağıt): Her katmanın üst pikselinden 

başlayarak katmanları eşit aralıklarla yerleştirir.
Distribute vertical centers (Dikey merkezleri dağıt): Her katmanın dikey 

merkez pikselinden başlayarak katmanları eşit aralıklarla yerleştirir.
Distribute bottom edges (Alt kenarları dağıt): Her katmanın alt pikselinden 

başlayarak katmanları eşit aralıklarla yerleştirir.
Distribute left edges (Sol kenarları dağıt): Her katmanın sol pikselinden 

başlayarak katmanları eşit aralıklarla yerleştirir.
Distribute horizontal centers (Yatay merkezleri dağıt): Her katmanın yatay 

merkezinden başlayarak katmanları eşit aralıklarla yerleştirir.
Distribute right edges (Sağ kenarları dağıt): Her katmandaki sağ pikselden 

başlayarak katmanları eşit aralıklarla yerleştirir.
Distribute Spacing

Distribute vertically (Dikey olarak dağıt): Katmanlar arasındaki dikey aralığı 
eşit olarak dağıtır.

Distribute horizontally (Yatay olarak dağıt): Katmanlar arasındaki yatay 
aralığı eşit olarak dağıtır.

Align To bölümünde Selection ve Canvas olmak üzere iki seçenek vardır. Selection seçeneği 
nesneleri kendi aralarında hizalarken Canvas (Tuval) seçeneği sayfaya göre hizalama yapar.

İşlem adımlarına göre çalışma alanına üç farklı renkte dikdörtgen ekleyerek hizalama 
işlemini gerçekleştiriniz (Görsel 1.40).

Görsel 1.40: Hizalama uygulaması görselleri

1. Adım: Mavi, Yeşil ve Lacivert adında üç katman oluşturunuz ve bu katmanlara Rectangle 
Tool aracını kullanarak aynı boyutlarda dikdörtgenler ekleyiniz.

2. Adım: Rectangle Tool aracını kullanarak Mavi katmanına mavi, Lacivert katmanına lacivert, 
Yeşil katmanına yeşil renkli dikdörtgenler çiziniz.

12. UYGULAMA



                 Görüntü İşleme46

3. Adım: Canvas ve Align left edges seçeneklerini seçerek nesneleri tuvalin sol kenarına 
hizalayınız.

4. Adım: “Align to: Selection” ve “Align top edges” seçeneklerini seçerek üstte yer alan 
nesnenin üst çizgisine göre hizalayınız.

5. Adım: Align to seçeneğini Canvas olarak değiştirip, Align top edges komutunu uygulayarak 
çalışma alanının üst kısmına hizalayınız.

6. Adım: Align bottom edges hizalama seçeneğini seçerek alt kenarlığa göre hizalayınız.

1.5.5. Katmanları Birleştirmek 

Görüntü işleme programında birden fazla katman birleştirilerek tek bir katmana 
dönüştürülebilir. Bunun için birleştirilmek istenen katmanlar seçilip, sağ tuşa basılarak açılan 
menüden Merge Layers komutu, klavyeden Ctrl+E tuşları veya Layer menüsünden Merge Layers 
seçeneklerinden herhangi biri kullanılabilir.

Katmanlar şekillerden oluşuyorsa bu katmanları birleştirmek için Merge Shapes komutu 
kullanılır. Merge Visible sadece görünür olan katmanları birleştirir. Flatten Image ise Background 
katmanı dâhil tüm katmanları birleştirerek yeni bir Background katmanına dönüştürür.

1.5.6. Katman Grupları

Katman sayısı fazla olduğunda katmanları yönetebilmek için katmanlar bir klasör içine alınarak 
gruplandırılır. Böylelikle daha düzenli çalışma imkânı olur.

1.5.6.1. Katman Grupları Oluşturmak

Birden fazla katmanı seçebilmek için Ctrl tuşu kullanılarak tek tek istenilen katmanlar seçilir 
veya en üstteki katman seçilip Shift tuşuna basıldıktan sonra en alttaki katmanın tıklanmasıyla 
da aradaki katmanlar seçilir. Fare+Shift tuşu ardışık olan katmanlar, Fare+Ctrl tuşu ise ardışık 
olmayan katmanların seçimi için kullanılır.

Bir grup olması istenen katmanlar seçilerek Create a new group nesnesinin içine taşınır veya 
gruplandırılmak istenen katmanlar seçilip farenin sağ tuşuna basıldığında açılan listeden Group 
from Layers komutu seçilir. Grup ismi, istenen şekilde değiştirilebilir.

1.5.6.2. Katman Gruplarını Silmek

Katman gruplarını silmek için birden fazla yol vardır. Birinci seçenek, katman grubunu tutup  
Layers panelin alt tarafında yer alan çöp kutusuna taşımaktır. Katman grubu bu yöntemde 
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içindekilerle  birlikte silinir. Bazen sadece grup silinip içindekilerin tutulması istenebilir. Bu  
durumda       tıklanır. Açılan listeden Delete group seçilir. Grubun içindeki katmanlarla birlikte 
tamamen silinmesi (Group and Contents) veya grup içinde yer alan katmanlar silinmeden 
yalnızca grup isminin silinmesi (Only Group) seçeneklerini sunan iletişim penceresinden uygun 
olan seçenek tıklanarak silme işlemleri gerçekleştirilir.

İşlem adımlarına göre 3 tanesi araba resimleri, 3 tanesi ise uçak resimleri içeren 6 
tane katman oluşturarak katmanlarla ilgili işlemleri gerçekleştiriniz.

1. Adım: Altı tane katman oluşturunuz ve bu katmanları Araba 1, Araba 2, Araba 3, Uçak 1, 
Uçak 2, Uçak 3 olarak adlandırınız.

2. Adım: Araba 3 katmanı en önde, Uçak 1 katmanı ise en altta olacak şekilde katmanları 
sıralayınız. Bu işlem için Bring to Front ve Send to Back komutlarından yararlanınız.

3. Adım: Araba 1, Araba 2 ve Araba 3 katmanlarını birbirine bağlayınız. Bunun için birbirine 
bağlamak istediğiniz üç katmanı seçip Layers panelinin alt tarafındaki Link layers komutuna 
tıklayınız.

4. Adım: Merge Layers komutu ile Araba 1, Araba 2 ve Araba 3 katmanlarını seçerek tek 
katman olacak şekilde birleştiriniz. 

5. Adım: Uçak 1, Uçak 2 ve Uçak 3 katmanlarını seçip, Layers panelinin alt tarafındaki Create 
a new group nesnesi içine sürükleyerek bırakınız.

6. Adım: Group 1 ismiyle oluşan klasör üzerine tıklayarak, klasörün adını “Uçaklar” olarak 
değiştiriniz.

7. Adım: Uçaklar klasörü üzerinde sağ tuşa basıp açılan listeden Duplicate group komutunu 
seçiniz ve adını “Uçaklar 1” olarak belirleyecek şekilde klasörü çoğaltınız.

8. Adım: Uçaklar klasörü üzerinde sağ tuşa tıklayınız. Açılan listeden “Ungroup Layers” 
komutunu seçerek katmanları gruptan çıkarınız.

9. Adım: Delete group komutunu kullanarak “Uçaklar 1” klasörünü siliniz.

1.5.7. Katman Maskelemek (Layer Mask)

Katman maskeleri kullanılarak, katmanın seçili olan herhangi bir bölümü gösterilip gizlenebilir 
ve katmana filtreler uygulanabilir. Maskeler görüntünün orijinalini bozmadan istenmeyen alanları 
saklama, istenen alanları da gösterme özelliğine sahiptir.

13. UYGULAMA
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Layer menüsü altında Layer Mask, Vector Mask ve Create Clipping Mask olmak üzere üç tür 
maskeleme seçeneği vardır. Layer Mask, katmandaki nesneye katman maskeleri uygulamak 
için kullanılır. Katmanlar maskelenerek birden çok görsel tek bir görüntüde birleştirilebilir veya 
fotoğraftaki istenmeyen bir bölüm kaldırılabilir. Katman maskeleri, boyama veya seçim araçları 
kullanılarak düzenlenebilen bitmap görüntülerdir. Vector Mask, vektörel nesnelere maske 
uygulamak için kullanılır. Kalem veya şekil araçları kullanılarak oluşturulur. Create Clipping 
Mask, nesneye kırpma maskesi uygulamaya yarar. Bir katman görüntüsünün diğer bir katman 
görüntüsüne uygun olarak iç içe yerleştirilmesi amacıyla kullanılır.

Background katmanına maske oluşturabilmek için bu katmanı normal katmana 
dönüştürmek gerekir. Layer>New>Layer from Background komutu ile katman arka plan 
olmaktan çıkartılır.

İşlem adımlarına göre arama motoru aracılığıyla bulacağınız veya öğretmeninizin 
dağıtacağı bir görseli maskelemek için gerekli işlemleri gerçekleştiriniz.

1. Adım: 1890x1417 boyutlarında ve arka plan rengi pembe olan yeni bir çalışma sayfası açınız.

2. Adım: File>Place Linked komutunu kullanarak resim ekleyiniz.

3. Adım: Maskelenecek alana uygun seçim araçlarından birini kullanarak maskelemek istediği- 
niz alanı seçiniz (Görsel 1.41).

Görsel 1.41: Maskelenecek alanı seçme

NOT

14. UYGULAMA
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4. Adım: Layers panelinin alt tarafındaki Add layer mask komutunu uygulayınız (Görsel 1.42).

Görsel 1.42: Maskelenmiş katman görseli

İşlem adımlarına göre internetten bulduğunuz herhangi bir çiçek resminin Görsel 
1.43’teki gibi maskelenmesi için gerekli işlemleri gerçekleştiriniz.

1. Adım: Arka planı beyaz olan yeni bir çalışma sayfası açınız.

2. Adım: Custom Shape Tool aracını seçiniz. Set shape to create özelliğini çiçek şekli olarak 
belirleyip çalışma alanına ekleyiniz (Görsel 1.44).

Görsel 1.43: Create Clipping Mask uygulanmış görsel

Görsel 1.44: Çiçek şekli

15. UYGULAMA
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3. Adım: Yeni bir katman oluşturunuz ve bu katmana bir çiçek resmi ekleyiniz (Görsel 1.45).

Görsel 1.45: Oluşturulan yeni katmana eklenecek örnek çiçek resmi

4. Adım: Çiçek resminin bulunduğu katman üzerinde farenin sağ tuşuna basarak Create 
Clipping Mask komutunu veriniz.

5. Adım: Çalışmayı kaydediniz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Vektörü çalışma alanına ekledi.

2. Kalem aracını kullanarak vektörün maskelenecek alanını seçti.

3. Maskeleme işlemini yaptı.

4. Dosyayı kaydetti.

İnternet ortamından bulacağınız vektörel özellikteki bir görseli, vektör maskelerini 
kullanarak maskeleyiniz. 

SIRA SİZDE
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1.5.8. Katman Opaklığı ve Katman Harmanlama Modları 

Opacity, katmanlara saydamlık vermek için kullanılan bir özelliktir. 1 ile 100 arasında değer 
alır ve normalde katmanın opaklık değeri %100’dür. Üstte yer alan katman, alttaki katmanı örter. 
Opaklık değerinin değiştirilmesi ile alttaki katmanın görüntülenmesi sağlanabilir.  Opaklık değeri 
küçüldükçe görünürlük azalır (Görsel 1.46).

%100 %80 %60 %40 %20
Görsel 1.46: Katman opaklık örneği 

Blendings Modes ile resimlerin birbirleriyle ne tür ilişki içine girecekleri belirlenir. Layers 
panelinin sol üst kısmında yer alır. Normal, Dissolve, Darken, Hue vb. harmanlama modları vardır. 
Harmanlama modlarını kullanmak için en az iki katmanın açık olması gerekir.

İşlem adımlarına göre Görsel 1.47 ve Görsel 1.48’de yer alan Türk bayrağı ve Atatürk 
resimlerinin harmanlanması işlemini gerçekleştiriniz.

Görsel 1.47: Türk bayrağı                                         Görsel 1.48: Atatürk’ün silüeti ve imzası

1. Adım: Yeni bir çalışma sayfası açınız ve Bayrak isminde bir katman oluşturunuz.

2. Adım: Bayrak katmanına Türk bayrağı resmi ekleyiniz.

3. Adım: Atatürk isminde yeni bir katman oluşturarak Atatürk resminin ve imzasının bulunduğu 
bir görsel ekleyiniz.

4. Adım: Katmanları Türk bayrağı üste gelecek şekilde sıralayınız.

5. Adım: Bayrak katmanı seçiliyken harmanlama modlarından “Lighten” modunu seçiniz.

16. UYGULAMA
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6. Adım: İki görselin pozisyonunu Görsel 1.49’da görüldüğü gibi ayarlayınız.

Görsel 1.49: İki görselin harmanlanması

7. Adım: Her iki katmanı da kilitleyiniz.

8. Adım: Katmanları birleştirerek tek bir arka plan katmanı hâline getiriniz. Bu işlem için her 
iki katman seçiliyken Layer>Flatten image komutunu uygulayınız.

9. Adım: Çalışmayı “harmanlama” olarak kaydediniz.

1.5.9. Katman Stilleri

Katmanların stil özelliklerini kullanarak seçili katmandaki içeriklere çeşitli efektler 
uygulanabilir.  Bunun için katman panelinin alt tarafında bulunan Add a layer style sembolü veya 
Layer menüsünde yer alan Layer Steels>Blending Options komutu kullanılır (Görsel 1.50).

Görsel 1.50: Blending Options
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Bevel and Emboss (Kabartma): Bevel nesnenin kabarık görünmesini, Emboss ise nesnenin 
çukur görünmesini sağlar.

Stroke (Kontur): Seçili nesneye kenarlık ekler.

Inner Shadow: Nesnenin iç kısmına gölge efekti uygular. 

Inner Glow: Nesneye ışık efekti uygular. 

Satin: Nesneye saten efekti uygular.

Color Overlay: Nesneyi belirlenen renkle kaplar. 

Gradient Overlay: Nesneyi degrade renk geçişiyle kaplar. 

Pattern Overlay: Nesneye desen uygular.

Outer Glow: Nesnenin dış tarafına ışıma efekti uygular.

Drop Shadow (Gölge): Nesnenin dış kısmına gölge efekti uygular.

İşlem adımlarına göre internetten bulduğunuz veya öğretmeninizin dağıtacağı 
bir çiçek görselini kullanarak Görsel 1.51’deki gibi yazı ve fotoğrafa stilleri uygulama 
işlemini gerçekleştiriniz.

Görsel 1.51: Stil örnekleri

1. Adım: Seçtiğiniz resmi boyutlandırıp Alt tuşu yardımı ile görseldeki gibi yan yana gelecek 
şekilde çoğaltınız.

2. Adım: Add a layer style komutunu kullanarak görsel ve yazılara sırasıyla görselin altında 
yazan efektleri uygulayınız. 

3. Adım: Çalışmayı “katmanefektleri.psd” olarak kaydediniz.

17. UYGULAMA
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DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Çokgen aracını kullanarak bir beşgen oluşturdu.

2. Çokgen aracı yardımıyla sekizgen oluşturdu.

3. Çokgenlerin rengini görseldeki gibi ayarladı.

4. Beşgene Inner Glow stilini görseldeki gibi uyguladı.

5. Sekizgene Bevel & Embos stilini tanımlayarak görseldeki gibi görünecek 
şekilde ayarladı.

6. Katman isimlerini beşgen ve sekizgen olarak ayarladı.

7. Dosyayı kaydetti.

8. Zamanı verimli kullandı.

Görsel 1.52’deki gibi iki çokgen oluşturarak beşgene Inner Glow, sekizgene ise Bevel 
& Embos efektlerini veriniz.  

Görsel 1.52: Stil verilmiş çokgenler

1.5.9.1. Katman Stillerini Çoğaltmak

Bir katmandaki nesneye uygulanan stillerin aynısı farklı bir katmanda yer alan diğer nesnelere 
de uygulanmak istenebilir. Bu tür durumlarda her stili tek tek uygulamak yerine stili kopyalayıp 
diğer katmana uygulamak mümkündür.

SIRA SİZDE
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İşlem adımlarına göre Dikdörtgen ve Elips adında iki katman oluşturunuz. Kırmızı 
renkteki Dikdörtgen katmanına Satin, Outer Glow ve Stroke efektlerini belirtilen 
özelliklerde (Tablo 1.2) uygulayıp aynı efektleri tek seferde Elips katmanına aktarmak 
için gereken işlemleri gerçekleştiriniz (Görsel 1.53).

Görsel 1.53: Katman stillerini kopyalamak

1. Adım: Yeni bir çalışma sayfası açarak “Dikdörtgen” adında bir katman oluşturunuz ve 
Rectangle Tool aracını kullanarak kırmızı renkte bir dikdörtgen çiziniz. 

2. Adım: Çizdiğiniz dikdörtgeni seçip Tablo 1.2’de belirtilen stilleri uygulayınız.

3. Adım: Elips adında bir katman oluşturunuz ve Elipse Tool aracını kullanarak bir elips çiziniz.

4. Adım: Dikdörtgen katmanındaki stilleri bu katmana uygulamak için dikdörtgen katmanı 
üzerinde sağ tuşa basıp “Copy Layer Style” komutunu uygulayınız.

5. Adım: Elips katmanı üzerinde farenin sağ tuşuna basıp “Paste Layer Style” komutunu 
uygulayınız.

1.6. FİLTRELER (FILTERS)
Filtreler, seçili resmin bir bölümüne veya tümüne çeşitli efektler (rötuşlama, ışık, bulanıklaş- 

tırma, deformasyon vb.) uygulamak için kullanılır. Görüntü işleme programında kullanılabilecek 
efektler Filter menüsü altında yer alır. Bazı filtreler RGB, bazıları ise CMYK modunda çalışır.  
Bu nedenle bazı filtreler uygun mod seçilmediğinde pasif olarak görünür.

18. UYGULAMA

Tablo 1.2: Satin, Outer Glow, Stroke Efektlerine Uygulanacak Özellikler

Satin 

Distance: 50

Size: 50

Outer Glow  

Blend Mode: Overley

Opacity: 50

Stroke 

Fill Type: Pattern

Size: 18
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1.6.1. Neural Filters

Neural Filters, orijinal görüntü üzerinde gerçekte bulunmayan yeni pixeller oluşturarak 
görüntüleri düzenlemeyi sağlayan sinir filtreleridir.

1.6.2. Filter Gallery

Filter menüsü altındaki Filter Gallery sayesinde birçok filtreyi ön izlemesi ile birlikte görüp 
uygulamak mümkündür. Filtre galerisinde Artistic, Brush Strokes, Distort, Sketch, Stylize, 
Texture gibi filtre seçenekleri yer alır. Artistic filtreleri, sanatsal efektler uygulamak için kullanılır. 
Brush Strokes filtreleri ile görsele fırça veya mürekkep darbeleri uygulanır. Distort filtreleri ile 
görüntüyü çarpıtarak deforme eden filtreler oluşturulur.  Sketch filtre grubu, resme el ile çizilmiş 
gibi karalama efekti uygular. Stylize, görüntünün piksellerini değiştirerek görüntü üzerinde etkiler 
oluşturur. Texture filtreler ise resme derinlik veren dokular uygulamaya yarar.

İşlem adımlarına göre seçeceğiniz bir görsele Filtre galerisini kullanarak Görsel 
1.54’teki gibi filtreleri uygulama işlemini gerçekleştiriniz.

Artistic-Neon Glow

Sketc-Photocopy

Artistic-Underpainting Brush Strokes-Ink Outlines Disort-Diffuse Glow

Stylize-Glowing Edges Texture-Patchwork Texture-Mosaic Tiles 

Görsel 1.54: Filtre galerisi filtre örnekleri

19. UYGULAMA
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1. Adım: Filtre uygulamak istediğiniz görseli çalışma alanına ekleyiniz ve Properties paneli 
yardımıyla görselin boyutlarını W:300, H:400 olarak ayarlayınız.

2. Adım: Görseli seçip Alt tuşu yardımıyla çoğaltınız.

3. Adım: Çoğalttığınız görsellere alt taraflarında adı yazan filtreleri uygulayınız.

4. Adım: Çalışmayı kaydediniz.

Filtreler bir görselin tamamına uygulanabileceği gibi sadece bir bölümüne de uygulanabilir. 
Görsel 1.55.a da seçim aracı kullanılarak resmin bir bölümü seçilmiş ve seçilen bölüme görsel 
1.55.b de Filtre galerisinden Texture-Craqulure filtresi uygulanmıştır. 

Görsel 1.55.a: Filtre uygulanmamış görsel Görsel 1.55.b: Bir bölümüne filtre uygulanmış görsel

1.6.3. Adaptive Wide Angle

Adaptive Wide Angle, panorama görüntülerde veya geniş açılı merceklerle çekilen fotoğraflarda 
eğri görünen çizgileri düzleştirmek ve deformasyonu gidermek için kullanılan filtredir.

1.6.4. Camera Raw Filter

Camera Raw Filter, görüntü işleme programında fotoğrafla ilgili tüm ayarları tek bir ekrandan 
yapabilmeye yarayan kısmı açarak görüntü üzerinde detaylı rötuşlar yapılmasını sağlar.

1.6.5. Lens Correction

Lens Correction, lens düzeltme aracıdır. Bozulma ve perspektif gibi lens sorunlarını gidermek 
için kullanılır.
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1.6.6. Liqufy
Liqufy, resmi deforme etmek için kullanılan filtredir. Görüntünün herhangi bir alanını itip 

çekmeye, döndürmeye, büzüp şişirmeye veya yansıtmaya yarar.

1.6.7. Vanishing Point
Vanishing Point filtresi duvarlar, zeminler veya herhangi bir dikdörtgen nesne gibi perspektif 

düzlemleri içeren görüntülerde perspektif düzeltmeyi kolaylıkla yapmayı sağlar. Bu filtre sayesinde 
bir bina veya eğimli yüzey üzerine yazı yazılarak görsel eklenebilir.

1.6.8. 3D Filters
3D Filters, herhangi bir görüntüye derinlik veya kontrast eklemek için kullanılır. Görüntü işleme 

programı birçok 3D formatı desteklediği için bu dosyalar programa aktarılabilir, yeni görüntüler 
oluşturulabilir veya görüntüler üzerinde düzenlemeler yapılabilir. Generate Bump (Height) Map 
ve Generate Normal Map olmak üzere iki harita filtresi vardır.

1.6.9. Blur
Blur, fotoğraflarda bulanıklaştırma efekti oluşturmaya yarayan filtredir. Seçili olan kısmı veya 

görüntünün tamamını yumuşatır. Rötuş işlemlerinde çokça kullanılır.

Average: Görüntünün renk ortalamasını alarak görseli bu renkle kaplar.

Blur: Görüntü üzerinde belli belirsiz bir bulanıklaştırma efekti oluşturur.

Blur More: “Blur” filtresinden daha etkili bir bulanıklaştırma sağlar.

Box Blur: Daha yoğun bir bulanıklaştırma oluşturur. Radius (yarıçap) özelliği ile görüntünün 
bulanıklaştırma değeri ayarlanabilir.

Gaussian Blur: “Box blur”a benzer. Bulanıklaştırma, yumuşatma etkisini ayarlar ve istenen 
seviyeye getirir.

Lens Blur: Bir ögeyi daha çok ortaya çıkarır. 

Motion Blur: Hareketli bir kameranın yakaladığı görüntüyü simüle ederek cismin hareketini 
görebilmeye yarar.

Radial Blur: Resmi dairesel olarak döndürmek veya derinlik katmak için kullanılan bir kamera 
efektidir.

Shape Blur: Görüntü üzerinde seçilen şekle göre bulanıklaştırma yapar.

Smart Blur: Görüntüdeki pürüzleri azaltmaya yarar.

Surface Blur: Görüntü yüzeyinde bulanıklık oluşturarak görüntüyü güzelleştirir.
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1.6.10. Blur Gallery

Blur Gallery, belirli alanlarda bulanıklık oluşturup ayarlar yapmaya yarar. 

Field Blur: Görüntü üzerinde bulanıklaştırma yapılacak alanlar oluşturarak bulanıklaştırma 
sağlar. Netleştirme veya bulanıklaştırma istenen yerlere raptiyeler eklenerek ayarlama yapılır. 

Irish Blur: Seçili alan dışında tuval üzerindeki her şeyi bulanıklaştırır.

Tilt-Shift Blur: Bu efekt uygulandığında görüntü üzerinde iki düz paralel çizgi oluşur. Bu çizgilerin 
iç tarafında kalan alan net alandır. Onun dışında kalan alanlara isteğe göre bulanıklaştırma uygular.

Path Blur: Seçilen bir yol boyunca hareketi simüle eden bulanık bir alan ve hareket yolu 
oluşturur.

Spin Blur: Radial bulanıklığa benzer ancak bulanıklık açısı 0 ile 360 derece arasında ölçülür.

1.6.11. Distort

Distort, bir görüntüyü geometrik olarak deforme ederek 3D veya farklı şekillerde efektler 
oluşturur.

Displace: Bir seçimin nasıl deforme edileceğini belirlemek için başka bir görüntü haritasını 
kullanarak görüntünün pixelini değiştirir.

Pinch: Görüntüye içe veya dışa doğru bükme efekti uygular.

Polar Coordinates: Görseli kutupsal koordinatlardan dörtgene veya dörtgenden kutupsal 
koordinatlara dönüştürür. Bu filtre art arda uygulandığında farklı görüntüler ortaya çıkar.

Ripple: Su dalgası efekti oluşturur.

Shear: Görüntüyü bir eğri boyunca deforme eder. 

Spherize: Küresel veya doğrusal deformasyon efektidir.

Twirl: Dönme efekti oluşturur.

Wave: Dalga efekti verir. 

ZigZag: Suya atılan bir taşın oluşturduğu dalgalara benzeyen bir efekt oluşturur.

1.6.12. Noice

Noice, fotoğrafların herhangi bir yerine gürültü (parazit) eklemeye yarar. Bu efekt, 
bulanıklaştırma galerisi efektleriyle birlikte kullanılır. Böylelikle bulanık bir bölüme biraz ayrıntı 
veya doku ekleyebilmeyi sağlar.

Add Noise: Parazit filtresi ekler. Görüntüye rastgele pixeller uygular. Ağır rötuşlanmış alanlara 
daha gerçekçi bir görünüm kazandırmak veya dokulu bir katman oluşturmak için de kullanılır.
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Despeckle: Görüntüdeki düşük tonlu pikselleri yok eder. Dergi veya diğer basılı materyallerin 
tarama sırasında görünen görsel parazitlerini de ortadan kaldırır.

Dusk & Scratches: Görsel üzerindeki renkleri birbirine yaklaştırarak kontrastı azaltır.

Median: Görüntüdeki hareket görünümünü veya taranmış görüntüde oluşabilecek istenme- 
yen desenleri ortadan kaldırarak veya azaltarak pürüzsüz yüzeylerin oluşmasını sağlar.

Reduce Noise: Yetersiz ışıkla çekilen fotoğrafın oluşturduğu parlak gürültüyü ve renk 
gürültüsünü azaltır.

1.6.13. Pixelate

Pixelate, görüntünün pixellerini değiştirerek efektler oluşturmaya yarar.

Color Haftone: Görüntüdeki pixelleri yarı tonları ile doldurur.

Crystallize: Görüntü üzerinde çokgen biçimli renk kümeleri şeklinde bir doku yaratır.

Facet: Renkli pixel boyutları oluşturmak için bir araya gelen düz veya benzer renk pixellerini 
barındırır. Genellikle taranan görüntüye el ile boyanmış bir görünüm verir.

Fragment: Görüntü üzerinde uzak ve bulanık bir etki yaratır.

Mezzotint: Doymuş renkleri renkli bir görüntüye veya normal bir görüntüyü rastgele bir siyah 
beyaz desene dönüştürmeye yarar.

Mosaic: Görüntüye mozaik etkisi verir.

Pointtillize: Görseli noktasal bir resimdeki gibi rastgele yerleştirilmiş noktalar olarak yeniden 
çizer.

1.6.14. Render

Render, görüntü üzerinde ışık efektleri oluşturmaya yarar. 

Flame: Alev efekti oluşturur.

Tree: Ağaç filtresi oluşturur.

Clouds: Foreground ve Background (ön ve arka plan) renklerini kullanarak bulut etkisi vermeye 
yarayan filtredir.

Differance Clouds: Ön plan ve arka plan rengi arasında değişen rastgele değerleri kullanarak 
bulut desenleri oluşturmaya yarar. Filtre ilk seçildiğinde görüntünün bölümleri bulut deseninde 
ters çevrilir. Filtre birkaç kez uygulandığında ise mermer dokusuna benzeyen desenler oluşur.

Fibers: Ön ve arka plan renklerini kullanarak dokuma lifleri oluşturur.

Lens Flare: Kamera objektifine parlak bir ışığın vurmasıyla oluşan ışık kırılmasının simüle 
edilmesini sağlar.
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Lighting Effects: Işık efekti oluşturur.

1.6.15. Sharpen
Keskinleştirme filtreleri, görüntü üzerinde keskinliği ve bulanıklığı ayarlar. 

Shake Reduction: Fotoğraf çekimi sırasında fotoğraf makinesinin sallantısından kaynaklanan 
bulanıklaşmayı olabildiğince düzeltir.

Sharpen: Görüntü üzerinde keskinleştirme sağlar.

Sharpen Edges: Kenarların daha net görünmesini sağlar.

Sharpen More: Görüntü üzerinde daha şiddetli bir keskinleştirme sağlar.

Smart Sharpen: Akıllı keskinleştirme filtresidir. Bir görüntünün gölge ve vurgu alanlarında ayrı 
ayrı keskinleştirme yapabilmeyi sağlar.

Unsharp Mask: Keskinliği azaltma maske filtresidir. Görüntü kenarlarındaki kontrastı artırarak 
keskinleştirme sağlar.

1.6.16. Stylize 
Stylize, görüntüdeki pixellerin yerini değiştirerek ve kontrastı bulup yükselterek görüntü 

üzerinde değişik etkiler oluşturmayı sağlar.

Diffuse: Seçimin daha az odaklanmış görünmesini sağlamak için seçimdeki pikselleri karıştırır.

Emboss: Kabartma şeklinde bir efekt oluşturur.

Extrude: Görseli üç boyutlu blok veya piramide dönüştürür.

Find Edges: Kenarları vurgulayarak görseli el veya kurşun kalemle çizilmiş bir şekle dönüştürür.

Oil Paint: Görseli yağlı boya ile yapılmış bir tabloya dönüştürür.

Solarize: Görselin negatif ve pozitifini karıştırarak efekt oluşturur.

Tiles: Görsel üzerinde fayansla kaplanmış bir etki oluşturur.

Trace Contour: Görüntü üzerindeki kontur çizgilerini bularak geri kalanları yok eder.

Wind: Rüzgâr efekti oluşturur.

1.6.17. Video
Video, video yakalama kartıyla elde edilen görüntüleri düzenlemek için kullanılan filtreleri 

içerir.

De-Interlace: Videodan aktarılan görüntü üzerinde temizlik yapar.

NTSC Colors: Aşırı doygun renklerin televizyon tarama çizgileri arasında taşmasını önlemek 
için renk gamını televizyon üretimi için kabul edilebilir olanlarla sınırlar.
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1.6.18. Other

Custom, High Pass, HSB/HSL, Maximum, Minimum, Offset gibi diğer filtrelerin yer aldığı 
kısımdır. Kişisel filtre oluşturmak, görüntü seçimini dengelemek, renkleri ayarlamak ve görüntü 
maskelerini değiştirmek için kullanılır.

Costom: -999 ile +999 arasında numerik değerler girip, pixelleri düzenleyerek görsel üzerinde 
farklı filtreler oluşturulmasını sağlar.

High Pass: Bir görüntüdeki düşük frekanslı ayrıntıları kaldırır. Taranan görüntülerden çizgi 
resimleri ve büyük siyah beyaz alanları çıkarmak için de kullanılır.

HSB/HSL: Bir görüntünün renk tonunu veya doygunluğunu ayarlar.

Maksimum: Görüntü üzerindeki açık pikselleri vurgular.

Minimum: Görüntü üzerindeki koyu pikselleri vurgular.

Offset: Seçili alanın orijinal konumunda boş bir alan bırakıp, seçimi yatay veya dikey olarak 
belirtilen miktarda kaydırır.

İşlem adımlarına göre Görsel 1.56’daki gibi bir ateş çemberi hazırlama işlemini 
gerçekleştiriniz.

Görsel 1.56: Ateş çemberi örneği

1. Adım: Arka plan rengi siyah olan yeni bir çalışma sayfası açınız.

2. Adım: Yeni bir layer oluşturunuz.

3. Adım: Ellipse Tool aracını seçiniz ve bu araca ekranın üst kısmında aktif olan özellikler 
bölümünden path özelliğini veriniz.

20. UYGULAMA
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4. Adım: Ekrana path özelliği olan bir daire çiziniz (Görsel 1.57).

Görsel 1.57: Path özelliği verilen daire

5. Adım: Filter>Render>Flame komutunu seçiniz (Görsel 1.58).

Görsel 1.58: Flame özellik penceresi

6. Adım: Flame Type bölümünden “4. Multiple Flames Path Directed” seçeneğini seçiniz.

7. Adım: Length özelliğini 200 olarak ayarlayınız.

8. Adım: Çalışmayı “atescemberi.jpg” olarak kaydediniz.
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İşlem adımlarına göre öğretmeniniz tarafından sizlere dağıtılacak bir görsele (Görsel 
1.59.a) Render filtresi altında yer alan Tree filtresini uygulayınız (Görsel 1.59.b)

Görsel 1.59.a: Filtresiz görsel                                   Görsel 1.59.b: Render>Tree filtresi uygulanmış görsel 

1. Adım: Görsel 1.59.a’daki gibi bir görsel ekleyiniz.

2. Adım: Yeni bir katman oluşturunuz.

3. Adım: Filter>Render>Tree komutunu kullanarak Tree filtresi özellikler penceresini açınız 
(Görsel 1.60).

Görsel 1.60: Render>Tree filtresi özellikler penceresi

4. Adım: İstediğiniz ağaç tipini seçerek görsel üzerinde uygun konuma yerleştiriniz.

5. Adım: Çalışmayı kaydediniz.

21. UYGULAMA
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Görüntü işleme programı filtrelerinden yararlanarak Görsel 1.61’deki çalışmayı 
yapınız.

Görsel 1.61: Ağaçlar görseli

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Arka plan rengi beyaz olan yeni bir çalışma sayfası açtı.

2. Eklenecek her nesne için ayrı katmanlar oluşturdu.

3. Render>Tree komutunu kullanarak ağaçlar ekledi.

4. Ağaçların boyutunu ayarladı.

5. Render>Picture Frame komutunu kullanarak çerçeve ekledi.

6. Dosyayı kaydetti.

1.7. BİÇİMLİ YAZILAR TASARLAMAK
Görüntü işleme programını kullanarak yazıları düzenlemek, yazılara efekt vermek veya resimli 

yazılar hazırlamak mümkündür. 

SIRA SİZDE
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1.7.1. Yazı Araçları Özellikleri

Type Tool seçildiği zaman programın üst tarafında araçla ilgili özellikler görülür (Görsel 1.62). 
Metinle ilgili yazı tipi, renk, boyut, yön, hizalama vb. işlemler bu bölüm kullanılarak yapılır. 

A B HĞGFEDÇC
Görsel 1.62: Type Tool aracı özellikler penceresi 

A: Metin araç çubuğunun seçili olduğunu gösterir.

B: Metnin yönünü (yatay veya dikey) belirler.

C: Yazı tipini (font) belirler.

Ç: Seçilen yazı tipi ile ilgili farklı biçimlerin (Bold, Regular, Bold, Black vb.) yer aldığı kısımdır. 
Farklı biçimler özelliği her fontta mevcut değildir.

D: Yazı tipi boyutunu (font size) ayarlar.

E: Fontun genel görünümü (Anti-aliasing method) ile ilgili keskinlik, parlaklık, yumuşaklık gibi 
ayarların yapıldığı bölümdür. 

F: Metni sola, ortaya, sağa hizalar. 

G: Yazıya renk verir.

Ğ: Warp Text oluşturma penceresini açar.

H: Karakter ve paragraf paneline geçişi sağlar.

1.7.1.1. Karakter Ayarları

Character paneli kullanılarak fontlar, yazı tipleri, diğer font özellikleri, yazı boyutu, satır arası 
mesafeler, harfler arası mesafeler, yazı rengi, harfe alt simge, üst simge vb. metin karakter 
ayarlamaları yapılır (Görsel 1.63).

Görsel 1.63: Character paneli
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1.7.1.2. Paragraf Ayarları
Bir paragraftaki yazıların hizalama, girinti ve paragraf arası boşluk ayarlarını yapmak için 

Paragraph paneli kullanılır. Window menüsünden Paragraph seçilerek panel açılır (Görsel 1.64).

Görsel 1.64: Paragraph paneli

1.7.1.3. Transform ve Free Transform 

Yazı seçiliyken Window menüsünden Properties komutunu kullanarak Transform panelini 
açmak mümkündür (Görsel 1.65). Transform ve Free Transform işlemi ile ilgili diğer seçeneklere 
Edit menüsünden erişilir. 

Görsel 1.65: Transform paneli

İşlem adımlarına göre görüntü işleme programı kullanarak yazdığınız “Ankara” 
metnine Free Transform seçenekleri ve Transform altındaki Scale, Rotate, Skew, Distort, 
Perspective, Warp komutlarını uygulayan çalışmayı gerçekleştiriniz.

1. Adım: Çalışma sayfasına “#120689” renk kodunda ve 72 pt büyüklüğünde yatay olarak 
“ANKARA” yazınız.

2. Adım: Yazıyı seçip, klavyeden Ctrl+T tuşlarına basarak Free Transform komutunu aktif ediniz 
(Görsel 1.66).

Görsel 1.66: Free Transform

22. UYGULAMA
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3. Adım: Free Transform komutu seçildiğinde ekranın üst tarafındaki araç kutusundan Rotate 
değerini “-45” olarak belirleyiniz (Görsel 1.67).

Görsel 1.67: Rotate değeri -45 olarak ayarlanmış metin

4. Adım: X ve Y değerlerini değiştirerek metnin konumunda meydana gelen farklılıkları 
gözlemleyiniz.

5. Adım: W ve H değerlerinde değişiklikler yapıp, metnin genişlik ve yüksekliğinde küçültme 
veya büyütme sağlayarak oluşan farklılıkları gözlemleyiniz.

6. Adım: H ve V (Horizontal ve Vertical skew) değerlerine farklı değerler girerek değişiklikleri 
gözlemleyiniz.

7. Adım: Edit>Transform>Distort komutunu aktif duruma getirerek metni deforme ediniz 
(Görsel 1.68).

Bu komutun aktif olabilmesi için yazının metin özelliğinden çıkartılıp vektöre 
dönüştürülmesi gerekir. Bunun için Type>Rasterize Type Layer komutu kullanılır.

Görsel 1.68: Deforme edilmiş metin

8. Adım: Distort komutunu Shift komutu veya Alt komutu ile birlikte kullanarak farklı şekiller 
elde ediniz.

9. Adım: Metne Edit>Transform>Perspective komutunu uygulayınız.

10. Adım: Edit>Transform>Warp komutunu uygulayarak metni farklı şekillere dönüştürünüz 
(Görsel 1.69).

NOT
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Görsel 1.69: Warp komut seçeneği uygulanmış metin

11. Adım: Metne Edit>Transform>Rotate komutunu uygulayarak metni sırasıyla 180 derece, 
saat yönünde ve saatin tersi yönünde döndürünüz.

12. Adım: Flip Horizontal ve Flip Vertical komutları ile yazıya yatay ve dikey eksende aynalama 
yapınız (Görsel 1.70).

Flip VerticalFlip Horizontal

Görsel 1.70: Flip Horizontal ve Flip Vertical uygulanışı

Görüntü işleme programında açacağınız beyaz renkli çalışma sayfasına adınız ve 
soyadınızı kırmızı renkte ve 48 pt boyutunda yatay olarak yazınız. Metne Transform 
komutu altında yer alan tüm komutları uygulayınız. 

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Adını ve soyadını kırmızı renkli, 48 pt olarak yazdı.

2. Metne Scale komutunu uyguladı.

3. Metne Rotate komutunu uyguladı.

4. Metne Skew komutunu uyguladı.

5. Metne Distort komutunu uyguladı.

6. Metne Perspective komutunu uyguladı.

7. Metne Warp komutunu uyguladı.

8. Metne Rotate 180�, Rotate 90o Clockwise ve Rotate 90o Counter Clockwise 
komutlarını uyguladı.

9. Metne Flip Horizontal ve Flip Vertical komutlarını uyguladı.

SIRA SİZDE
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1.7.2. Yazılara Efekt Vermek

Warp Text aracı ile metinleri şekillendirmek mümkündür. Warp Text özelliğine yazı aracı 
seçiliyken Type menüsünden, Warp Text veya yazı aracı ile ilgili özellikler bölümünden erişilebilir 
(Görsel 1.71).

Görsel 1.71: Warp Text

İşlem adımlarına göre “Bilişim Teknolojileri” yazısına Görsel 1.72’deki Warp Text 
efekti özelliğini verme işlemini gerçekleştiriniz.

Görsel 1.72: Warp Text uygulanan metin 

1. Adım: Bilişim Teknolojileri yazısını mavi renkli ve 48 pt olarak yazınız.

2. Adım: Metni seçerek Type menüsünden Warp Text komutunu uygulayınız.

3. Adım: Açılan pencereden Style olarak Bulge özelliğini seçiniz.

4. Adım: Dosyayı kaydediniz.

1.7.3. Yol Boyunca Metin Eklemek 

Görüntü işleme programı araçlarını kullanarak, bir yol çizip metni bu yola eklemek 
mümkündür. Kalem aracı kullanılarak çizilen bir çizgi boyunca veya geometrik şekillerin etrafına 
metin eklenebilir.

23. UYGULAMA
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İşlem adımlarına göre Görsel 1.73’teki gibi bir şeklin etrafına metin ekleme işlemini 
gerçekleştiriniz.

Görsel 1.73: Yola metin ekleme

1. Adım: Shift tuşu ile birlikte Elipse aracını kullanarak çalışma alanına bir daire ekleyiniz.

2. Adım: Metin aracını seçerek, dairenin dış çizgisi üzerine gelip metni yazınız (Görsel 1.74).

Görsel 1.74: Daire dış kenarına yazı yazma

3. Adım: Chraracter panelinde yer alan         değerini metin dairenin etrafını saracak şekilde 
ayarlayınız.

İşlem adımlarına göre Görsel 1.75’teki yol boyunca yazılan Bilişim Teknolojileri 
metnini oluşturma işlemini gerçekleştiriniz.

Görsel 1.75: Yola metin ekleme

24. UYGULAMA

25. UYGULAMA
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1. Adım: Curvature Pen Tool aracını kullanarak Görsel 1.76’daki gibi bir çizgi şekli oluşturunuz.

Görsel 1.76: Curvature Pen Tool aracıyla çizim

2. Adım: Type Tool aracını kullanarak metni çizgi üzerinde yazınız (Görsel 1.77).

Görsel 1.77: Type Tool aracını kullanarak yola yazı ekleme

3. Adım: Chraracter panelinde yer alan           değerini 25 olarak ayarlayınız.

4. Adım: Çalışmayı kaydediniz.

1.7.4. Metni Yola Dönüştürmek 

Görüntü işleme programı kullanılıp, metin yazı özelliğinden çıkarılarak bir yola (path) 
dönüştürülebilir. Type menüsünden Create Work Path komutu ile işlem gerçekleştirilir. Paths 
panelinin ekranda görüntülenmesi için Window>Paths seçilir. 

İşlem adımlarına göre görüntü işleme programını kullanarak 48 punto, Calibri 
Regular ve mavi renk özelliklerinde “Bilişim Teknolojileri” yazısını yazınız. Yazdığınız 
metni yola dönüştürme işlemini gerçekleştiriniz. 

26. UYGULAMA
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1. Adım: Yeni bir çalışma sayfası açınız ve Type Tool aracını kullanarak “Bilişim Teknolojileri” 
yazısını istenen özelliklerde yazınız.

2. Adım: Yazı seçiliyken Type menüsünden Create Work Path komutunu veriniz. Bu işlem ile 
metin, yazı özelliğinden çıkacak ve Paths panelinde Work Path adında bir path oluşacaktır (Görsel 
1.78).

Görsel 1.78: Metne path özelliği verme

3. Adım: Layers panelinde oluşan Bilişim Teknolojileri katmanı önündeki göz simgesine 
tıklayınız. Bu işlem ile hazırlanan Work Path daha net görünecektir (Görsel 1.79).

Görsel 1.79: Work Path uygulanmış metin 

4. Adım: Work Path ismini “Path örneği” adı ile kaydediniz. Bu işlem için Paths panelindeki 
Work Path yazısının üzerine çift tıklayıp, açılan pencereden Name bölümüne istenen ismi yazarak 
OK düğmesine basmak yeterlidir (Görsel 1.80). 

Görsel 1.80: Save Path
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5. Adım: Yazı özelliğinden path özelliğine geçen “Bilişim Teknolojileri” görselinde Path 
Selection Tool (A) aracını kullanarak seçtiğiniz nesnelerin yerini değiştiriniz (Görsel 1.81). Direct 
Selection Tool aracını kullanarak görsele istediğiniz şekli veriniz (Görsel 1.82).

Görsel 1.81: Selection Tool 

Görsel 1.82: Path Selection ve Direct Selection uygulanan görsel

6. Adım: Çalışmayı “path uygulaması” ismi ile kaydediniz.

Kırmızı renkte ve 48 pt özelliklerinde yazdığınız “MUSTAFA KEMAL ATATÜRK” yazısını 
yola dönüştürerek şekillendiriniz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. “MUSTAFA KEMAL ATATÜRK” yazısını kırmızı renkli ve 48 pt olarak yazdı.

2. Metni yazı özelliğinden çıkartıp yola dönüştürdü.

3. Direct Selection Tool aracını kullanarak şekillendirme işlemini gerçekleştirdi.

4. Çalışmayı kaydetti.

1.7.5. Metni Şekle Dönüştürmek

Metni yola dönüştürme işlemi gibi metin bir şekle de dönüştürülebilir. Bu işlemler için Type 
menüsünden Convert to Shape komutu veya Paths paneli kullanılır. 

SIRA SİZDE
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İşlem adımlarına göre görüntü işleme programını kullanarak yazdığınız 36 punto,  
Bahnschrift yazı tipi ve kırmızı renk özelliklerindeki “Bilişim Teknolojileri” metnini şekle 
dönüştürme işlemini gerçekleştiriniz.

1. Adım: Yeni bir çalışma sayfası açıp istenen özelliklerde “Bilişim Teknolojileri” yazısını yazınız.

2. Adım: Yazı seçiliyken Type menüsünden Convert to Shape komutunu seçerek metnin şekil 
özelliği almasını sağlayınız.

3. Adım: Görsel 1.83’te yer alan işaretli bölüm üzerine çift tıklayınız ve açılan pencereden 
rengi mavi olarak seçiniz.

Görsel 1.83: Convert to Shape özelliği verilen yazı katmanı

4. Adım: Katmanın Opacity özelliğini %50 olarak ayarlayınız.

5. Adım: Çalışma dosyasını “metinden şekle” adıyla kaydediniz.

1.7.6. Metni Maskelemek

Horizontal Type Mask Tool ve Vertical Type Mask Tool araçlarını kullanarak yazılan yazıları 
yatay veya dikey yönde maskelemek mümkündür.

İşlem adımlarına göre “Bilişim Teknolojileri Dersi” yazısını Görsel 1.84’teki gibi yatay 
yazarak maskeleme işlemini gerçekleştiriniz.

Görsel 1.84: Maskeleme örnek görseli

27. UYGULAMA

28. UYGULAMA
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1. Adım: Görüntü işleme programını açınız ve File>Place Linked komutunu kullanarak bir 
resim ekleyiniz.

2. Adım: Horizontal Type Mask Tool aracını kullanarak 36 punto büyüklüğünde yazıyı yazınız.

3. Adım: Maskelemenin yapıldığı (yazının yer aldığı) katman üzerine tıklayınız.

4. Adım: Layers panelindeki Add Layer Mask sembolüne tıklayarak işlemi tamamlayınız 
(Görsel 1.85). 

Görsel 1.85: Maskeleme işlemi

İstediğiniz herhangi bir görseli seçerek “Grafik ve Canlandırma” yazısına dikey 
maskeleme işlemi uygulayınız.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Görseli çalışma alanına ekledi.

2. Vertical Type Mask Tool aracını kullanarak metni dikey yazdı.

3. Add Layer Mask komutunu uygulayarak metni maskeleme işlemini 
tamamladı.

4. Çalışmayı kaydetti.

1.7.7. 3D Yazı Oluşturmak

Görüntü işleme programı ile 3D yazılar oluşturulabilir. Bunun için 3D menü seçeneklerinden 
ve 3D panelinden yararlanılır.

SIRA SİZDE
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İşlem adımlarına göre 3D özelliği kullanılarak hazırlanan Görsel 1.86’daki metni 
yazma işlemini gerçekleştiriniz.

Görsel 1.86: 3D yazı örneği

1. Adım: Yazı aracını kullanarak çalışma alanına 72 pt büyüklüğünde “3D TEXT” yazınız.

2. Adım: Yazıyı seçip 3D menüsünden New 3D Extrusion from Selected Layer komutunu 
seçiniz. 3D çalışma alanı açılacaktır.

3. Adım: 3D Properties bölümünden Extrusion Depth özelliğini 46,65 olarak ayarlayınız (Görsel 
1.87).

Görsel 1.87: Extrusion Depth ayarlaması

4. Adım: Shape Preset kısmından “Inflate” seçeneğini seçiniz.

5. Adım: Üst çubuktaki araçların 3D Mode seçeneklerinden “Rotate the 3D Object” seçerek 
nesneyi döndürünüz (Görsel 1.88).

Görsel 1.88: 3D Mode seçenekleri

1.7.8. Metinlere Stil Uygulamak

Görüntü işleme programında metinlere stil eklenirken katmanlara stil eklemede olduğu gibi 
Layer Style özelliği kullanılır.  

29. UYGULAMA
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İşlem adımlarına göre “Merhaba” kelimesini Görsel 1.89’daki gibi yazmak için gerekli 
işlemleri gerçekleştiriniz.

Görsel 1.89: Stil uygulanan metin 

1. Adım: Çalışma sayfasına 36 punto, siyah ve Calibri yazı tipinde “Merhaba” yazınız.

2. Adım: Metnin kabarık ve çukur görüntü oluşturması için Bevel & Embos efektini uygulayınız. 
Bevel & Embos efektine Outer Bevel stilini uygulayınız. Direction özelliğini “Up” ve  Size özelliğini 
13 px olarak ayarlayınız. Shadow Mode rengini pembe olarak belirleyiniz. 

3. Adım: Metne Stroke efektini uygulayınız. Fill Type özelliğini Gradient olarak seçiniz.

4. Adım: Çalışma dosyasını “Uygulama 30” olarak kaydediniz.

1.7.9. Metne Filtre Uygulamak

Görüntü işleme programı kullanılarak yazılan bir yazıya filtre uygulamak mümkündür. Bir 
metne filtre uygulayabilmek için metnin yer aldığı katmanı rasterize yapmak (katmanı resme 
dönüştürmek) gerekir. Bunun için yazının bulunduğu katman üzerinde farenin sağ tuşu ile 
tıklanarak Rasterize Layer seçilir.

İşlem adımlarına göre bir çiçek resmi görseli üzerine yazdığınız yazıya ZigZag filtresini 
uygulama işlemini gerçekleştiriniz (Görsel 1.90).

Görsel 1.90: ZigZag filtresi uygulama

30. UYGULAMA

31. UYGULAMA
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1. Adım: Görüntü işleme programını açarak çiçek resmi ekleyiniz.

2. Adım: Eklediğiniz görsel üzerine “HOŞGELDİN BAHAR” yazınız.

3. Adım: Yazının bulunduğu katman üzerinde sağ tuşa basarak açılan listeden Rasterize Layer 
seçiniz.

4. Adım: Filter>Distort>ZigZag filtresini metne uygulayınız.

5. Adım: Çalışmayı “zigzag.jpg” olarak kaydediniz.

1.8. EYLEMLER (ACTIONS)
Actions, görüntü işleme programında yapılan işlemlerin daha sonra tekrar kullanılmak 

üzere kaydedilip saklanmasını sağlayan nesnelerdir. Örneğin birden fazla fotoğrafa aynı boyut 
veya efektin uygulanması gerekebilir. Bir logo çok sayıda resimde kullanılmak istenebilir. Böyle 
durumlarda görüntü işleme programının actions özelliğinden yararlanılır. Actions kullanılarak 
yapılan her işlem kaydedilir. Aynı işlemler istendiği zaman tek tuş ile farklı dosyalarda ve 
fotoğraflarda kullanılabilir.

Actions paneline Window menüsünden Action komutu veya klavyeden Alt+F9 tuşları 
kullanılarak erişilir (Görsel 1.91).

FA B C D E

Görsel 1.91: Actions paneli 

A: Stop playing/recording

B: Begin recording

C: Play selection

D: Create new set

E: Create new action

F: Delete
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İşlem adımlarına göre internetten bulduğunuz veya öğretmeniniz tarafından verilen 
bir manzara resmine Mosaic ve Gaussion Blur filtrelerini uygulamayı sağlayacak eylemi 
oluşturarak kaydeden çalışmayı gerçekleştiriniz (Görsel 1.92 ve Görsel 1.93).

Görsel 1.92: Filtresiz görsel Görsel 1.93: Gaussian Blur ve Mosaic 
                       filtre uygulanan görsel

1. Adım: Yeni bir çalışma sayfası açınız ve manzara resmini ekleyiniz.

2. Adım: Create new set düğmesini kullanarak “Örnek Çalışmam” adında bir action klasörü 
oluşturunuz.

3. Adım: New action düğmesine tıklayınız. Açılan pencereden eyleminize bir isim (name) 
vererek Kaydet (Record) düğmesine basınız (Görsel 1.94). Bu aşamadan sonra yapılan her işlem 
“Stop playing” düğmesine tıklanıncaya kadar kaydedilecektir.

Görsel 1.94: New action penceresi

4. Adım: Layers panelinde Background kilidini kaldırınız ve bu katmanın adını “filtrelerim” 
olarak değiştiriniz.

32. UYGULAMA
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5. Adım: Filter>Blur>Gaussian Blur filtresini seçip, Radius özelliğini 6 pixel olarak ayarlayınız.

6. Adım:  Filter>Pixelate>Mosaic filtresini seçip Cell Size özelliğini 10 square yapınız.

7. Adım: Stop playing düğmesine tıklayarak kaydetme işlemini durdurunuz.

8. Adım: Bu eylemi daha sonra farklı çalışmalarda kullanmak veya arkadaşlarınızla paylaşmak 
amacıyla kaydediniz. Bunun için klasör seçiliyken Actions panelinin sağ üst köşesindeki                
     sembolüne tıklayınız.  Açılan menüden “Save Actions” komutunu seçerek eyleminizi 
bilgisayarınızda oluşturacağınız bir klasörün içine kaydediniz.

Kaydedilen eylemi yeni bir çalışmada kullanmak için ilgili eylem dosyasını Actions 
paneli üzerine sürükleyerek bırakmak yeterlidir. 

İşlem adımlarına göre otuz ikinci uygulamada kaydettiğiniz eylemi, herhangi bir 
görüntü dosyası üzerinde uygulayacak işlemi gerçekleştiriniz.

1. Adım: İşlem yapılacak görseli açınız.

2. Adım: Action dosyasını bilgisayarda kayıtlı olduğu yerden sürükle bırak yöntemi ile Actions 
paneli üzerine taşıyınız.

3. Adım: Taşıdığınız actionu seçip Actions panelinden Play selection düğmesine tıklayınız. 

İşlem adımlarına göre internetten indireceğiniz veya öğretmeninizin sizlerle 
paylaşacağı en az 5 adet çiçek resminden oluşan bir klasör oluşturunuz ve Görsel 
1.95’teki eylemin klasördeki tüm resimlere aynı anda uygulanmasını sağlayacak 
işlemleri gerçekleştiriniz. 

Görsel 1.95: Action uygulanan çiçek resmi 

NOT

33. UYGULAMA

34. UYGULAMA



                 Görüntü İşleme82

1. Adım: Görüntü işleme programını açınız ve File>Open komutunu kullanarak bir çiçek resmi 
ekleyiniz.

2. Adım: Çiçek resminin yer aldığı Background kilidini açınız.

3. Adım: Edit>Stroke komutunu kullanarak 50 px boyutunda, yeşil renkte ve Inside özellik- 
lerinde bir çerçeve oluşturunuz. 

4. Adım: Kaydetme işlemini durdurunuz ve dosyayı kapatınız.

5. Adım: File>Automate>Batch (Toplu işlem) komutunu seçerek Görsel 1.96’daki ayarları 
yapınız.

Görsel 1.96: Batch komut penceresinden bir kısım

Source (Kaynak) Folder ile görsellerin olduğu klasörü, Destination (Hedef) kısmındaki Folder 
seçeneğiyle de çerçeveli resimlerin kaydedileceği klasörü seçiniz. 

6. Adım: Karşınıza çıkan pencereleri onaylayarak eylemin tüm görsellere uygulanmasını ve 
hedef klasöre kaydedilmesini sağlayınız.

İnternetten bulacağınız veya öğretmeninizin dağıtacağı 10 adet tarihi yer görselini 
“tarihi yerler” isminde bir klasöre kaydediniz. Bu görsellere 8x10 300 Dpi CMYK 
özelliklerini topluca vermeyi sağlayarak eylemi hazırlayınız. Hedef dosyanın adını “tarihi 
yerler cmyk” olarak oluşturunuz.

DEĞERLENDİRME

Çalışmalarınız diğer sayfada yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

SIRA SİZDE



                                                         Görüntü İşleme 83

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR
1. Tarihi yer görsellerinin bulunduğu “tarihi yerler” adlı kaynak klasörü 
oluşturdu.

2. Görselleri klasöre ekledi.

3. Hedef dosyalarının tutulacağı “tarihi yerler cmyk” adında klasör oluşturdu.

4. “Baskıya hazırlık” görseller isminde bir action seti oluşturdu.

5. “eylemim” isminde bir action oluşturdu.

6. İstenen özellikleri action olarak kaydetti.

7. Kaydetme işlemini durdurdu.

8. File>Automate>Batch komutunu kullanıp, “tarihi yerler” klasöründeki 
görselleri yeni özellikleri ile toplu olarak “tarihi yerler cmyk” klasörüne aktardı.

1.9. WEB ARAYÜZÜ VE BÖLÜMLERİ HAZIRLAMAK
Görüntü işleme yazılımı kullanılarak birden fazla ekran biçimi ve cihaz için gelişmiş tasarım 

oluşturulur. İstenirse bu tasarımlar tek ve sonsuz tuvalde yapılır. Resimler üzerinde işlemler 
yapılırken aynı zamanda web sayfa tasarımına yönelik temel işlemler de bu programda 
gerçekleştirilir. Özellikle dilimleme aracı kullanılarak etkileşimli web sayfaları hazırlanır.

1.9.1. Web Arayüzü İçin Yeni Belge Oluşturmak

Çalışma alanında yeni bir belge açmak için farklı yollar kullanılabilir. Bu yolların biri, görüntü 
işleme programı açıldıktan sonra Create new seçilmesidir (Görsel 1.97). 

Görsel 1.97: Create new seçeneği

KONTROL LİSTESİ
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Create new seçildikten sonra hazır şablonların bulunduğu New Document (Yeni Belge) 
penceresiyle karşılaşılır (Görsel 1.98). Bu penceredeki ön ayarlı boş belgeler (BLANK DOCUMENT 
PRESETS) kullanılarak tasarıma uygun ekran biçimi ve cihaz seçilir. İhtiyaca göre ön ayarlı boş 
belge düzenleri oluşturularak kaydedilir.

A

C

D

G

Ğ

H

Ç
E

F

İ

B

Görsel 1.98: New Document penceresi

A) Web Seçeneği: Tasarıma uygun genişlik, yükseklik ve çözünürlükte ön ayarlı boş belgelere 
ulaşmak için kullanılır.

B) Untitled-1: Ön ayarlı boş belgenin ayarları yapıldıktan sonra dokümanı kaydetmek için bu 
kutudan uygun bir isim belirlenir.

C) Width (Genişlik): Çalışılacak belgenin genişliği bu kutuya girilerek belirlenir.

Ç) Pixels (Pikseller): Bu açılır kutu kullanılarak çalışılacak belgenin boyutları Pixels (piksel), 
Inches (inç), Centimeters (santimetre), Millimeters (milimetre), Points (nokta) ve Picas (pika) 
birimlerinde belirlenir.

D) Height (Yükseklik): Çalışılacak belgenin yüksekliği bu kutuya girilerek belirlenir.

E) Orientation (Yönlendirme): Belgenin yatay mı, dikey mi olacağı belirlenir.

F) Artboards (Çalışma Yüzeyi): Tasarım belgesinde artboards kullanılıp kullanılmayacağı bu 
onay kutusundan seçilir.

G) Resolution (Çözünürlük): Birim alan başına kaç piksel olacağı bu kutudan belirlenir. 72 
Pixels/Inch genellikle kullanılan çözünürlüktür.
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Ğ) Color Mode (Renk Modu): Belgede kullanılacak renk modu belirlenir. Web arayüzler için 
sadece RGB Color (kırmızı, yeşil, mavi renkler) seçilebilir.

H) Background Contents (Arka Plan İçeriği):  Arka plan rengi bu açılır kutudan belirlenir. Arka 
plan için şeffaf, beyaz, siyah veya ayarlanacak özel bir renk belirlenebilir.

İ) Create (Oluştur): Ayarları yapılan çalışılacak belge Create düğmesine tıklanarak oluşturulur.

İşlem adımlarına göre görüntü işleme yazılımında web arayüzü tasarlamak için 
1600 piksel genişliğinde, 1000 piksel yüksekliğinde, arka plan rengi siyah olacak şekilde 
tasarım belgesi oluşturunuz.

1. Adım: Görüntü işleme yazılımını çalıştırınız.

2. Adım: Açılan ekranda Create New düğmesine tıklayınız.

3. Adım: Yeni gelen New Document penceresinde Web seçeneğini tıklayınız.

4. Adım: Pencerenin sağ tarafındaki Width kutusuna 1600 değerini giriniz.

5. Adım: Width kutusunun sağ tarafındaki açılır listeden Pixels seçeneğini seçiniz.

6. Adım: Pencerenin sağ tarafındaki Height kutusuna 1000 değerini giriniz.

7. Adım: Pencerenin sağ alt tarafındaki Background Contents açılır listesinden Black değerini 
seçiniz.

8. Adım: Pencerenin sağ altındaki Create düğmesini tıklayınız.

Web arayüzü tasarlamak için 1400 piksel genişliğinde, 800 piksel yüksekliğinde ve 
arka plan rengi Transparent (şeffaf) olan belgeyi oluşturunuz.

DEĞERLENDİRME

Çalışmalarınız diğer sayfada yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

SIRA SİZDE

35. UYGULAMA
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DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR
1. Görüntü işleme yazılımını çalıştırdı. 
2. Create New düğmesine tıkladı.
3. Web seçeneğine tıkladı.
4. Width kutusuna 1400 değerini girdi. 
5. Width kutusunun sağındaki açılır listeden Pixels değerini seçti.
6. Height kutusuna 800 değerini girdi.
7. Background Contents açılır listesinden Transparent seçti.
8. Create düğmesine tıkladı.

1.9.2. Artboards (Çalışma Yüzeyleri) 

Bir arayüz tasarımı veya web arayüz tasarımı yapılırken karşılaşılacak en büyük problemlerden 
biri, farklı ekran boyutları ve cihazlar için tasarımı ayarlamaktır. Artboards ile farklı cihazlar ve 
ekran boyutları için tasarımlar hazırlanabilecek tuvale ulaşılarak tasarım süreci kolaylaştırılır. 
Artboards oluştururken önceden ayarlanmış farklı boyutlar arasından seçim yapılabilir veya özel 
boyutlar tanımlanarak kullanılabilir.

Artboards sadece bir ekran boyutu ile tasarım yapılsa bile kullanışlıdır. Örneğin bir web sitesi 
tasarlanırken, farklı sayfaların tasarımları yan yana ve tek bir içerik olarak görüntülenebilir. 

1.9.2.1. Artboard Oluşturmak

Artboard özel bir tür katman grubu olarak ifade edilebilir. Bir artboard, içerdiği ögelerin 
boyutlarını kendi sınırlarına göre kırpar (Görsel 1.99).

Görsel 1.99: Aynı tasarımın iki farklı artboard görünümü

Artboards kullanılarak otuz beşin üzerinde farklı cihaz veya ekran boyutu ile çalışılabilir. 
Görsel 1.99’da Web Most Common (En Çok Ortak Kullanılan Web) ekran boyutuna sahip soldaki 
Artboard 1 ile Mobile Design (Mobil Tasarım) ekran boyutuna sahip sağdaki Artboard 2 arasındaki 
fark görülür. Bu fark, farklı boyuttaki artboardların içeriğini kendi sınırlarına göre kırpmasından 
oluşur.

KONTROL LİSTESİ
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Artboard oluşturmak için görüntü işleme yazılımı açıldıktan sonra Create New seçeneği seçilir. 
Açılan New Document penceresinden Web veya Mobile seçildiğinde ekranın sağ tarafında, 
PRESET DETAILS bölümünde artboards onay kutusu seçili olarak gelir (Görsel 1.100). Photo, Print, 
Art & Illustration veya Film & Video seçildiğinde ise artboards onay kutusu seçili olarak gelmez. 
Şablonlar artboards ile birlikte kullanılmak istendiğinde bu onay kutusu seçili hâle getirilmelidir.

Görsel 1.100: Artboards onay kutusu

1.9.2.2. Artboards Boyutlandırmak

Artboards, belirli ekran boyutlarında veya belirli cihazlar için uygun şekilde oluşturulabilir. 
Bununla birlikte Layers panelinde boyutu değiştirilecek olan Artboard 1 seçilerek (Görsel 1.101) 
etrafında oluşan içi beyaz kutucuklardan sürükle bırak yöntemiyle istenen boyutta artboards 
oluşturulur.

Görsel 1.101: Layers panelinden Artboard 1 seçimi

Görsel 1.102’deki kutular kullanılarak sürükle bırak yöntemiyle Artboard istenen yönde 
büyütülür veya küçültülür. Görsel 1.103’te sağdan küçültülmüş bir Artboard görülür.

Görsel 1.102: Artboard boyutlandırma kutuları        Görsel 1.103: Sağdan küçültülmüş Artboard
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1.9.2.3. Artboard Çoğaltmak

Aynı anda birden fazla artboard ile aynı ekranda çalışmak mümkündür. Bu özellik sayesinde 
farklı web sayfaları tek ekranda tasarlanabilir. Bunun için artboardları çoğaltmak gerekir (Görsel 
1.104).

Görsel 1.104: Artboard Tool seçimi

Görüntü işleme yazılımının sol tarafındaki Tools bölümünde bulunan Move Tool üzerinde fare 
sol tuşuna bir süre basılırsa alt araçlar ortaya çıkacaktır. Bu araçlardan Artboard Tool, ardından 
Layers panelinden Artboard 1 seçilir. Görsel 1.105’te oluşan artı simgelerine tıklanarak Artboard 
1’in boş bir kopyası oluşturulur.

Görsel 1.105: Artboard 1 seçilince oluşan artı simgeleri

Artboard 1’deki layerlar yeni oluşan Artboard 2’de yer almaz (Görsel 1.106).

Görsel 1.106: Artboard 1’in boş kopyası Artboard 2
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Artboard 1’deki layerlar yeni oluşan Artboard’da yer alacaksa klavyeden Alt tuşuna basılı 
tutarken artı simgesi tıklanır (Görsel 1.107). Bu sayede her iki artboard içeriği farklı düzenlenebilir. 

Görsel 1.107: Artboard 1’in kopyası Artboard 1 copy

1.9.2.4. Artboards Silmek

Silinecek Artboards, Layers panelinden seçilir ve klavyeden Delete tuşuna basılır veya silinecek 
Artboards, Layers panelinden sürükle bırak yöntemiyle Görsel 1.108’deki çöp kutusu simgesine 
bırakılır. 

Görsel 1.108: Artboard 2 silme

İşlem adımlarına göre görüntü işleme yazılımında web arayüzü tasarlamak için 
Artboard 1 oluşturunuz. Artboard 1’in Artboard 2 isminde kopyasını oluşturup Artboard 
1’i siliniz.

1. Adım: Görüntü işleme yazılımını çalıştırınız.

36. UYGULAMA
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2. Adım: Açılan ekranda Create New düğmesine tıklayınız.

3. Adım: Yeni gelen New Document penceresinde Web seçeneğini tıklayınız.

4. Adım: Seçeneklerden Web Most Common seçiniz.

5. Adım: Pencerenin sağ tarafındaki Artboards onay kutusunu seçili hâle getiriniz.

6. Adım: Pencerenin sağ altındaki Create düğmesini tıklayınız.

7. Adım: Artboard Tool seçiniz.

8. Adım: Layers panelinde Artboard 1 seçiniz.

9. Adım: Artboard 1 etrafında yer alan artı simgesine tıklayınız.

10. Adım: Layers panelindeki Artboard 1’i seçiniz ve klavyeden Delete tuşuna basınız.

Web arayüzü tasarlamak için üç tane boş artboard oluşturup ilk artboardu siliniz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Create New düğmesine tıkladı.

2. Web seçeneğine tıkladı.

3. Web Most Common seçeneğini seçti.

4. New Document penceresinin sağındaki Artboards onay kutusunu seçili hâle 
getirdi.

5. Create düğmesine tıkladı.

6. Artboard Tool seçti.

7. Layers panelinde Artboard 1’i seçti.

8. Çalışma alanında Artboard 1’in sağındaki artı simgesine tıkladı.

9. Çalışma alanında oluşan Artboard 2’nin sağındaki artı simgesine tıkladı.

10. Layers panelinde Artboard 1’i seçti.

11. Klavyeden Delete tuşuna bastı.

SIRA SİZDE
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1.9.3. Düğmeler

Web sayfalarındaki düğmeler tıklandığında genellikle farklı web sayfalarına geçişi sağlar. 
Görüntü işleme yazılımı kullanılarak çeşitli ve özgün web sayfa bağlantı düğmeleri tasarlanabilir.

1.9.3.1. Düğme Oluşturmak

Görüntü işleme yazılımı çalıştırıldıktan sonra Create new seçeneği tıklanır. Açılan New 
Document penceresinin PRESET DETAILS kısmındaki isim kutusuna Düğme, Width kutusuna 500 
ve Height kutusuna 350 piksel değerleri girilir (Görsel 1.109).

Görsel 1.109: Düğme boyutları

Create seçeneğine tıkladıktan sonra çalışma alanında beyaz bir arka plan oluşur. Araçlar 
bölümünden Polygon Tool aracı seçilir (Görsel 1.110). 

Görsel 1.110: Polygon Tool seçimi 
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Polygon Tool aracı seçildikten sonra beyaz çalışma alanında herhangi bir yere tıklanır. Polygon 
seçeneklerinin düzenlenebileceği yeni bir pencere ile karşılaşılır. Width kutusuna 60, Height 
kutusuna 60 ve Number of Sides (Kenar sayısı) kutusuna 8 değeri girilir (Görsel 1.111).

Görsel 1.111: Polygon oluşturma

OK seçeneği tıklandıktan sonra çalışma alanında şekil belirir. Dikey ve yatay hizalama 
seçenekleri kullanılarak şeklin ekranın ortasına gelmesi sağlanır (Görsel 1.112).

Görsel 1.112: Yatay ve dikey hizalama

Properties panelindeki Transform bölümünde Set Rotation açısına 45 derece girilir (Görsel 
1.113).

Görsel 1.113: Set Rotation kutusu
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Daha sonra araçlar bölümünden Direct Selection Tool seçilir (Görsel 1.114). 

Görsel 1.114: Direct Selection Tool seçimi

Direct Selection Tool aracı kullanılarak polygonun sağ tarafı ortadan itibaren seçilir (Görsel 
1.115). Seçim sonrası polygonun sağ tarafında içi dolu dört kutu oluşur (Görsel 1.116).

Görsel 1.115: Polygon seçimi  Görsel 1.116: Seçim sonrası Polygon

Shift tuşuyla beraber sağ ok tuşuna basıldığında şekil sağa doğru genişlemeye başlar. Polygon 
istenen boyuta ulaşınca tuşlar bırakılır (Görsel 1.117).

Görsel 1.117: Polygonun uzatılmış hâli

Polygon uzatıldıktan sonra pencerenin sağ alt tarafındaki Layers bölümünden Add a layer 
sytle simgesi tıklanır (Görsel 1.118). Açılan seçeneklerden en üst sıradaki Bevel & Emboss seçilir 
(Görsel 1.119). 

Görsel 1.118: Add a layer style simgesi Görsel 1.119: Bevel & Emboss seçeneği
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Yeni açılan Layer Style penceresinde Bevel & Emboss onay kutusu ile Gradient Overlay onay 
kutusu seçilir (Görsel 1.120). Pencerede bulunan OK düğmesine tıklanır.

Görsel 1.120: Layer Style penceresi

Araçlar bölümündeki “T” simgesi kullanılarak düğmenin ismi yazılır. Bu düğmeyi ihtiyaca göre 
çoğaltıp, düğmenin üzerindeki ismi değiştirerek yeni düğmeler elde etmek mümkündür. Görsel 
1.121’de düğmenin ismi “ANA SAYFA” olarak yazılır.

Görsel 1.121: ANA SAYFA düğmesi

Düğme kaydedilmeden önce Layers bölümünden Background silinir. Silinecek Background 
katmanı seçildikten sonra Delete layer simgesi tıklanır (Görsel 1.122).

Görsel 1.122: Background katmanı seçimi ve Delete layer simgesi



                                                         Görüntü İşleme 95

Beyaz arka plan silindikten sonra düğmenin arka planı gri ve beyaz karelerden oluşur. Bu, arka 
planın şeffaf olduğunu ifade eder (Görsel 1.123).

Görsel 1.123: Şeffaf arka planlı düğme

File (Dosya) menüsünden Save As… (Farklı Kaydet) seçilir ve uygun bir dosya ismi verilerek 
çalışma kaydedilir. 

İşlem adımlarına göre görüntü işleme yazılımında, web arayüzünde kullanmak için 
“RESİMLER” isminde düğme tasarlayınız.

1. Adım: Görüntü işleme yazılımını çalıştırınız.

2. Adım: Açılan ekranda Create New düğmesine tıklayınız.

3. Adım: Yeni gelen New Document penceresinde PRESET DETAILS isim kutusuna “Düğme” 
yazınız.

4. Adım: Width kutusuna 500 piksel değerini giriniz.

5. Adım: Height kutusuna 350 piksel değerini giriniz.

6. Adım: Pencerenin sağ altındaki Create düğmesini tıklayınız.

7. Adım: Araçlar bölümünden Polygon Tool seçiniz.

8. Adım: Çalışma alanına tıklayınız.

9. Adım: Create Polygon penceresinde Width 60, Height 60 ve Number of Sides kutusuna da 
8 değerini giriniz. OK düğmesine tıklayınız.

10. Adım: Dikey ve yatay hizalama seçeneklerini kullanarak şeklin ekranın ortasına gelmesini 
sağlayınız.

11. Adım: Properties panelindeki Transform bölümünde Set Rotation açısına 45 derece giriniz.

12. Adım: Araçlar kısmından Direct Selection Tool seçiniz.

13. Adım: Direct Selection Tool ile polygonun sağ tarafını ortadan itibaren seçiniz.

37. UYGULAMA



                 Görüntü İşleme96

14. Adım: Shift tuşuyla beraber sağ ok tuşuna basınız. Şekil istenen boyuta gelince tuşları 
bırakınız.

15. Adım: Pencerenin sağ alt tarafındaki Layers bölümünden Add a layer sytle simgesini 
tıklayınız. Açılan seçeneklerden en üst sırada yer alan Bevel & Emboss seçiniz.  

16. Adım: Yeni açılan Layer Style penceresinde Bevel & Emboss onay kutusu ile Gradient 
Overlay onay kutusunu seçiniz.

17. Adım: Layer Style penceresinde bulunan OK düğmesine tıklayınız.

18. Adım: Araçlar bölümündeki “T” simgesini kullanarak “RESİMLER” ismini düğmenin üzerine 
yazınız.

19. Adım: Layers bölümünden Background katmanını seçiniz. Daha sonra Delete layer 
(Katmanı sil) simgesini tıklayınız.

Web arayüzünde kullanmak için “TARİHÇE” isminde düğme tasarlayınız.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Create New düğmesine tıkladı.

2. New Document penceresinde PRESET DETAILS isim kutusuna “Düğme” 
yazdı.

3. Width kutusuna 500 piksel değerini girdi.

4. Height kutusuna 350 piksel değerini girdi.

5. Create düğmesine tıkladı.

6. Araçlar bölümünden Polygon Tool seçti.

7. Çalışma alanına tıkladı.

8. Create Polygon penceresinde Width 60, Height 60 ve Number of Sides 
kutusuna 8 değerini girerek OK düğmesine tıkladı.
9. Dikey ve yatay hizalama seçeneklerini kullanarak şeklin ekranın ortasına 
gelmesini sağladı.

SIRA SİZDE
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DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR
10. Properties panelindeki Transform bölümünde Set Rotation açısına 45 
derece girdi.

11. Araçlar kısmından Direct Selection Tool seçti.

12. Direct Selection Tool aracı ile polygonun sağ tarafını ortadan itibaren seçti.

13. Pencerenin sağ alt kısmındaki Layers bölümünden Add a layer sytle simgesi 
tıklandığında açılan seçeneklerden en üst sırada yer alan Bevel & Emboss seçti.
14. Yeni açılan Layer Style penceresinde Bevel & Emboss onay kutusu ile 
Gradient Overlay onay kutusunu seçti.

15. Layer Style penceresinde bulunan OK düğmesine tıkladı.

16. Araçlar bölümündeki “T” simgesini kullanarak “TARİHÇE” ismini düğmenin 
üzerine yazdı.
17. Layers bölümünden Background katmanını seçti. Daha sonra Delete layer 
simgesini tıkladı.

1.9.4. Web Arayüzü Bölümleri

Bir web sayfası tasarlanırken sayfa çeşitli bölümlere ayrılır. Bu bölümler Görsel 1.124’te 
verilmiştir.

Header (Başlık): Web sayfasının üst bölümünü ifade eder. Genellikle logo ve web sayfa 
bağlantı düğmeleri bu kısımda bulunur.

Content (İçerik): İçerikle ilgili bölümleri ifade eder. Genelde sayfanın orta kısmındadır.

Footer (Altbilgi): Web sayfasının alt bölümünü ifade eder. Genelde sosyal medya hesapları, 
çeşitli bağlantılar ve telif ile ilgili bilgiler bulunur.

Görsel 1.124: Temel bir web sayfasının bölümleri

Başlık 
(Header)

İçerik
(Content)

Altbilgi
(Footer)
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1.10. WEB ARAYÜZÜNE DİLİM EKLEMEK
Görüntü işleme yazılımında tasarlanan resimler, düzenlenen fotoğraflar ve çalışılan sayfalar 

internet ortamında web sayfası şeklinde etkileşimli olarak yayınlanabilir. Dilimleme, web 
ortamında dosyaların hızlı bir şekilde yüklenmesini sağlar ve güncellenmesini kolaylaştırır. Dilimler 
kullanılarak belirtilen web sayfasına bağlantı sağlanır. Oluşturulan ve kaydedilen düğmeler 
File>Place Embedded… menüleri ile çalışma alanına uygun bir şekilde yerleştirilir. Ardından Slice 
Tool seçilir (Görsel 1.125).

Görsel 1.125: Slice Tool 

Slice Tool ile tıklandığında web sayfalarına yönlendirilecek tüm düğme, resim ve yazılar 
dilimlenir (Görsel 1.126).

Görsel 1.126: Dilimlenmiş ANA SAYFA düğmesi

Bu işlemden sonra her bir düğmeye tıklandığında farklı bir web sayfasına yönlendirme 
işlemi yapılabilir. ANA SAYFA düğmesine Slice Tool ile gelinip, fare sağ tuşuna tıklanınca açılan 
seçeneklerden Edit Slice Options seçilir (Görsel 1.127).

Görsel 1.127: Edit Slice Options seçeneği
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Yeni açılan Slice Options penceresinden dilimle ilgili Görsel 1.128’deki ayarlamalar yapılır.

Görsel 1.128: Slice Options penceresi

Slice Type (Dilimleme Tipi): No Image, Image veya Table seçeneklerinden biri seçilir.

Name (İsim): Dilime isim verilir.

URL (Web Sayfası): Dilim tıklandığında yönlendirilecek sayfanın adresi yazılır.

Target (Hedef): Dilim tıklandığında web sayfasının nerde açılacağı belirlenir. _self, _blank, _
parent, _top gibi seçenekler yazılır.

Message Text (Mesaj Metni): Web sayfası açıldığında tarayıcının durum çubuğunda 
görüntülenecek metin yazılır.

Alt Tag (Alternatif Etiket): Ekran okuyucu programlar için dilimin görevi belirtilir. 

Dimensions (Boyutlar): Dilimin konumu ve boyutları kutulara yazılarak belirlenir.

Slice Options penceresinde URL kutusuna “index.html” yazılarak, bu dilime tıklandığı zaman 
hangi web sayfasına bağlanılacağı belirtilir. Çalışma, web sayfası olarak kaydedilip tarayıcıda 
çalıştırıldığında ANA SAYFA düğmesine tıklanırsa “index.html” sayfası açılacaktır. Aynı işlemler 
TARİHÇE düğmesi için de yapılabilir. Slice Options penceresinin URL kutusuna “tarih.html” yazılır. 
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Daha sonra klavyeden Alt tuşu basılı tutulurken Artboard 1’in sağ tarafındaki + simgesi tıklanır. 
Böylelikle aynı sayfadan iki tane oluşturulur (Görsel 1.130).

Görsel 1.130: Artboard 1 ve Artboard 1 copy

Yeni oluşturulan sayfa “tarih.html” web sayfası olacak şekilde düzenlenir (Görsel 1.131). 

Görsel 1.131: “tarih.html” sayfası

1.10.1. Web Sayfası Olarak Kaydetmek

Oluşturulan “index.html” ve “tarih.html” sayfalarını web sayfası olarak kaydetmek için 
File>Export>Save for Web (legacy) seçeneği seçilir. Yeni açılan Save for Web penceresinde Görsel 
1.132’deki Save... seçeneği seçilir.

Bu sayede işlevsel iki tane düğme elde edilir. ANA SAYFA düğmesine basılınca “index.html” 
sayfasına, TARİHÇE düğmesine basılınca “tarih.html” sayfasına gidilir. Bu durumda iki farklı web 
sayfası tasarlanmalıdır. Bunun için araçlardan Artboard Tool seçilir (Görsel 1.129). 

Görsel 1.129: Artboard Tool
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Görsel 1.132: Save seçeneği

Save seçeneği seçildikten sonra gelen pencerede Dosya adı kutusuna “index.html” yazılır. 
Format kutusundan HTML and Images (Html ve görüntüler) seçilir. Settings ve Slices kutularının 
değeri değiştirilmez. Kaydet düğmesi tıklanır (Görsel 1.133). Böylelikle web sayfasının ana sayfası 
oluşturulur. 

Görsel 1.133: Save Optimized As penceresi

TARİHÇE web sayfasını oluşturmak için Layers panelindeki Artboard 1 copy seçilir. Menüler- 
den Edit>Copy seçeneği seçildikten sonra File>New seçeneği tıklanır. Create seçeneği ile 
Artboard 1 copy boyutlarında bir belge oluşturulur. Daha sonra Edit>Paste seçeneği ile boş 
belgeye Artboard 1 copy yapıştırılır. TARİHÇE sayfasında olması gereken içerik yerleştirildikten 
sonra sayfada yer alan düğmeler Slice Tool ile dilimlenir ve Edit Slice Options ile düğmelerin hangi 
web sayfalarına bağlanacağı düzenlenir. Son olarak File>Export>Save for Web seçeneği seçilir. 
Açılan pencereden Save seçeneği ile gelen pencerede Dosya adı kutusuna “tarih.html” yazılır. 
Format kutusunda HTML and Images seçiliyken Kaydet düğmesine tıklanır. Böylelikle iki farklı 
web sayfası oluşturulur.
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İşlem adımlarına göre “resimler.html” web sayfasını oluşturunuz.

1. Adım: Görüntü işleme yazılımını çalıştırınız.

2. Adım: Açılan ekranda Create New düğmesine tıklayınız.

3. Adım: Yeni gelen New Document penceresinde PRESET DETAILS isim kutusuna “resimler” 
yazınız.

4. Adım: Width kutusuna 2390 piksel değerini giriniz.

5. Adım: Height kutusuna 1400 piksel değerini giriniz.

6. Adım: Pencerenin sağ altındaki Create düğmesini tıklayınız.

7. Adım: Araçlar bölümünden Rectangle Tool seçiniz.

8. Adım: Çalışma alanına tıklayınız. Gelen pencerede Width kutusuna 2390 ve Height kutusuna 
da 1400 değerini giriniz. OK düğmesine tıklayınız.

9. Adım: Rectangle nesnesini Move Tool kullanarak ekranın tam ortasına yerleştiriniz.

10. Adım: Gradients bölümünden Blues seçeneklerinden mavi renk geçişi seçiniz.

11. Adım: Text Tool kullanarak ekranın sol üst köşesine 48 punto büyüklüğünde, kırmızı renkte 
“RESİMLER” yazınız.

12. Adım: File>Place Embedded menüsü ile çalışma alanına kaydedilen “ANA SAYFA” düğme- 
sini yerleştiriniz.

13. Adım: Slice Tool ile düğmeye dilim ekleyiniz.

14. Adım: ANA SAYFA düğmesine Slice Tool ile gelip, mouse sağ tuşuna tıklayınca açılan Edit 
Slice Options seçeneğini seçiniz.

15. Adım: URL kutusuna “index.html” yazınız. OK düğmesine tıklayınız.

16. Adım: File>Export>Save for Web seçeneğini seçiniz. Gelen pencereden Save seçeneğini 
seçiniz ve açılan pencerede Dosya adı kutusuna “resimler.html” yazınız. Format kutusunda  HTML 
and Images seçiliyken Kaydet düğmesine tıklayınız.

“iletisim.html” isminde web sayfası tasarlayınız.

SIRA SİZDE

38. UYGULAMA
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DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Görüntü işleme yazılımını çalıştırdı.

2. Create New düğmesine tıkladı.

3. New Document penceresinde PRESET DETAILS isim kutusuna “iletişim” 
yazdı.

4. Width kutusuna 2390 piksel değerini girdi.

5. Height kutusuna 1400 piksel değerini girdi.

6. Create düğmesine tıkladı.

7. Araçlar bölümünden Rectangel Tool seçti.

8. Çalışma alanına tıkladı.

9. Create Rectangele penceresinde Width 2390, Height kutusuna da 1400 
değerini  girerek OK düğmesine tıkladı.

10. Move Tool kullanarak şeklin ekranın ortasına gelmesini sağladı.

11. Text Tool kullanarak 48 punto büyüklüğünde, kırmızı renkte, ekranın sol 
üst köşesine “İLETİŞİM” yazdı.
12. File>Place Embedded menüleri ile çalışma alanına ANA SAYFA düğmesini 
yerleştirdi.

13. Slice Tool ile düğme üzerine dilim ekledi.

14. Slice Tool ile düğme üzerine mouse sağ tuş ile tıkladı.

15. Edit Slice Options seçeneğini seçip URL kutusuna “index.html” yazdı.

16. File>Export>Save for Web seçeneğini seçti.

17. Save seçeneğini seçti.

18. Açılan pencerede Dosya adı kutusuna “iletisim.html” yazdı.

19. Format kutusunda HTML and Images seçiliyken Kaydet düğmesine tıkladı.
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A) Aşağıdaki soruları dikkatlice okuyarak doğru seçeneği işaretleyiniz.

1. Aşağıdaki dosya uzantılarından hangisi görüntü dosyasına aittir?

    A) .doc		  B) .pptx		 C) .psd		  D) .rar		  E) .xls

2. Seçimi tersine çevirmek için aşağıdakilerden hangisi kullanılır?

    A) Ctrl + A

    B) Edit>Inverse

    C) Shift + Ctrl + I

    D) Select>Reselect 

    E) Select>Deselect

3. Magic Wand aracının görevi aşağıdakilerden hangisidir?

    A) Hızlı seçim yapar.

    B) Toleransa göre seçim yapar.

    C) Renge göre şekil çizer.

    D) Şekle göre seçim yapar.

    E) Sihirli seçim yapar.

4. Aşağıdakilerden hangisi kontrast terimini ifade eder?

    A) Resimdeki açık renkleri

    B) Resimdeki koyu renkleri

    C) Resimdeki bulanıklığı

    D) Beyaz ışık oranını

    E) Açık ve koyu renk farkını

5. Aşağıdaki komutlardan hangisi görüntü dosyasının boyutunu değiştirmek için kullanılır?

    A) Edit>Image Size

    B) Image>Image Size

    C) Image>Canvas Size

    D) View>Print Size

    E) Window>Options

ÖLÇME VE DEĞERLENDİRME
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6. Katmanlar, Layer panelinde yer alan aşağıdaki simgelerden hangisinin üzerine götürüle- 
rek silinir?

   A) 			  B) 		  C) 		  D) 		  E) 

7. Aşağıdaki filtrelerden hangisi fotoğraflarda bulanıklaştırma efekti oluşturmak için kulla- 
          nılır?

    A) 3D Filters				      	 B) Vanishing Point

    C) Adaptive Wide Angle				    D) Blur

   				     E) Distort

8. Aşağıdaki seçeneklerden hangisi Actions panelinde yer almaz?

    A) Create new set					     B) Create new action

    C) Create new folder				     D) Play selection

    				    E) Delete

9. 

Görüntü işleme yazılımında  görsele göre aşağıdakilerden hangisi doğrudur?

    A) Çalışılacak belgenin genişliği 768 pikseldir.

    B) Çalışılacak belgenin yüksekliği 1366 pikseldir.

    C) Çalışılacak belgenin ismi “Untitled-1” olarak belirlenmiştir.

    D) Artboards otomatik olarak oluşturulmayacaktır.

    E) Çözünürlük 768 inch başına piksel olarak belirlenmiştir.

10. 

Slice Options (Dilimleme seçenekleri) penceresinde yer alan görseldeki URL: kutusuna 
aşağıdaki hangi bilgi girilir?

    A) Dilimin ismi

    B) Dilime tıklandığında hangi web sayfasının açılacağı

    C) Dilime tıklandığında web sayfasının hangi pencerede açılacağı

    D) Web sayfası açıldığında durum çubuğunda görüntülenecek metin

    E) Ekran okuyucu programlar için dilimin görevi



KONULAR

2.1. GÖRSEL EFEKT PROGRAM KURULUMU

2.2. ÇALIŞMA SAHNESİ AYARLARI

2.3. MATERYAL EKLEMEK

2.4. DÖNÜŞTÜRME (TRANSFORM) İŞLEMLERİ

2.5. ÇIKTI (RENDER)

 NELER ÖĞRENECEKSİNİZ?

• Görsel efekt programlarından herhangi birini bilgisayara kurma

• Görsel efekt yazılımı açılış ayarlarını yapma

• Görsel efekt yazılım programını kullanarak materyal ekleme

• Görsel efekt programında dönüştürme işlemlerini yapma

• Görsel efekt yazılımını kullanarak çıktı (render) alma

ANAHTAR KELİMELER

Grafik animasyon, render, çalışma alanı, panel, kısayol atama, dosya çağırma (import 
file), footage, kompozisyon (composition), araç kutusu (toolbox), dönüştürme 
(transform), konum (position), ölçek (scale), döndürme (rotation), şeffaflık (opacity)



GÖRSEL EFEKT YAZILIMINDA 
TEMEL DÜZENLEMELER

2. ÖĞRENME BİRİMİ



                 Görsel Efekt Yazılımında Temel Düzenlemeler108

2.1. GÖRSEL EFEKT PROGRAM KURULUMU
Görsel efekt programları; animasyon oluşturmak, videolar üzerinde görsel efektler uygulamak, 

yazılar üzerinde farklı efektleri uygulayarak onları hareketli hâle getirmek için kullanılabilir. Bu 
işlemler iki veya üç boyutlu olarak yapılabilir. 

Render, iki boyutlu veya üç boyutlu resim, video, animasyon gibi modellemeleri ilgili görsel 
efekt yazılımından çıktı olarak üreten bir işlemdir. Render işlemi yapılırken bilgisayarın işlemci, 
bellek ve ekran kartı özelliklerinin de yüksek olması, yapılacak işlemlerin daha hızlı gerçekleşmesini 
sağlayacaktır.

Kullanılacak görsel efekt yazılımı, deneme sürümü veya tam sürüm olarak tercih edilebilir. 
Programı kurabilmek için ilgili klasördeki setup dosyası çalıştırılır ve yükleme işlemi başlatılır. 
Yükleme işlemi bittiğinde artık görsel efekt programı kullanıma hazırdır (Görsel 2.1).

Görsel efekt programıyla oluşturulan animasyonları veya videoları, farklı dosya formatlarında 
ve çeşitli özelliklerde (düşük boyut, yüksek kalite) render edebilmek için kullanılan programlar da 
mevcuttur. Bu programlar deneme veya tam sürüm olarak temin edilip kullanılabilir.

Görsel 2.1: Programın ilk açılış ekranı

İşlem adımlarına göre telif haklarını göz önünde bulundurarak temin ettiğiniz görsel 
efekt programının bilgisayara kurulumunu gerçekleştiriniz. 

1. Görsel efekt yazılımı için kullanacağınız programı telif haklarını göz önünde 
bulundurarak nasıl temin edebilirsiniz?

2. Görsel efekt programının deneme sürümünü internetten indirerek nasıl 
kullanabilirsiniz?

1. Adım: Temin ettiğiniz program sıkıştırılmış bir formatta ise kurulum dosyalarını bilgi- 
sayarınızın sabit diskinde uygun bir bölüme çıkarınız.

2. Adım: Kurulum dosyası içindeki setup dosyasını çalıştırarak ilgili programı deneme veya 
tam sürüm olarak kurunuz.

3. Adım: Yükleme işlemi bittiğinde Başlat menüsünden veya masaüstünden yüklenen  
programı çalıştırınız.

HAZIRLIK ÇALIŞMALARI

1. UYGULAMA
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Telif haklarını göz önünde bulundurarak temin ettiğiniz görsel efekt programını 
bilgisayarınıza kurunuz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Görsel efekt programını sabit diskte uygun bir bölüme çıkardı.

2. Setup dosyasını çalıştırarak programın deneme veya tam sürümünü kurdu.

3. Başlat menüsünden veya masaüstünden programı bularak çalıştırdı.

2.2. ÇALIŞMA SAHNESİ AYARLARI

Çalışma sahnesinde varsayılan olarak gelen bir dizi panel bulunur. Bu panellerin yerleri 
değiştirilebilir. Bazı paneller kapatılabilir, kapalı olanlar ise daha sonra açılabilir. Kullanıcıların 
daha rahat bir düzende çalışabilmesi için çalışma alanındaki paneller kişiye göre ayarlanıp 
kaydedilebilir.

2.2.1. Görsel Efekt Programında Açılış Ayarları 

Görsel efekt programındaki açılış ayarları, kullanıcının programı daha hızlı ve verimli 
kullanmasını sağlar.

2.2.2. Çalışma Alanı

Program ilk açıldığında varsayılan çalışma alanı ile karşılaşılır. Bu çalışma alanında menüler, 
paneller ve araçlar yer alır (Görsel 2.1).

Çalışma Sahnesi’nin üst menü bileşenleri; File (dosya), Edit (düzenleme), Composition  
(kompozisyon), Layer (katman), Effect, Animation, View (görünüm), Window, Help olarak sıralanır.

SIRA SİZDE
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Varsayılan çalışma alanının üst tarafında seçme, sahneyi ekranda kaydırma, yakınlaştırma gibi 
çeşitli araçların olduğu Toolbox (araç kutusu) bölümü bulunur. Sol tarafta, projede kullanılacak 
resimlerin, videoların veya farklı türde dosyaların projeye dâhil edilebileceği Project paneli 
bulunur (Ctrl+0 ile bu panel gösterilebilir veya gizlenebilir.). Orta bölümde, projede yeni bir 
kompozisyon oluşturabilmeye imkân veren Composition paneli bulunur. Çalışma alanının sağ 
tarafında,  özellikle yazılarda kullanılabilecek farklı animasyon seçeneklerinin olduğu Effects & 
Presets paneli bulunur. Bir nesneyi, video boyunca hareket eden başka bir nesneye sabitlemeyi 
sağlayan track motion özelliği Tracker panelinde bulunur. Bunların dışında farklı işlevleri yerine 
getirebilecek başka paneller de vardır. Gösterilmek veya gizlenmek istenen paneller Window 
menüsünden yönetilebilir. Çalışma alanının en altında yer alan panel ise Timeline (zaman 
çizelgesi) panelidir.

2.2.3. Paneller

Program açıldığında karşılaşılan varsayılan çalışma alanında Project (proje), Composition 
(kompozisyon), Timeline (zaman çizelgesi), Info (bilgi), Audio (ses), Preview (ön izleme), Effects 
& Presets (efektler ve ön ayarlar), Align (hizalama), Libraries (kütüphane), Character (yazı), 
Paragraph (paragraf), Tracker (takip) ve Content-Aware (içerik bazlı dolgu) panelleri yer alır 
(Görsel 2.2).

Composition Paneli

Timeline Paneli

Project Paneli
İnfo Paneli

Audio  Paneli
Preview  Paneli

Libraries Paneli
Align Paneli

Character Paneli
Paragraph Paneli
Tracker Paneli

Effect & Present
Paneli

Content - Aware Paneli

Görsel 2.2: Varsayılan çalışma alanındaki paneller

Panellerin çalışma alanındaki yeri değiştirilebilir. Bunun için panel isimlerinin olduğu 
yere imleç yaklaştırılır ve sürükle bırak yöntemiyle ilgili panelin çalışma alanındaki yeri 
değiştirilebilir. Çalışma alanındaki panelleri tekrar varsayılan hâle getirebilmek için menüden 
“Window>Workspace>Default>Reset "Default" to Saved Layout” seçenekleri seçilebilir. Window 
menüsünden hangi panelin açılıp kapanacağı ayarlanabilir.



    Görsel Efekt Yazılımında Temel Düzenlemeler 111

Project Paneli: Projede kullanılacak materyallerin olduğu bölümdür. Resim, video dosyaları 
yanında photoshop ve illustrator gibi program türleri de istenirse katmanlarıyla birlikte projede 
kullanılabilir (Görsel 2.3).

 Görsel 2.3: Project paneli

Composition Paneli: Projeye istenilen genişlik, yükseklik, fps (saniyedeki çerçeve sayısı) gibi 
değerler doğrultusunda yeni kompozisyonların eklenebileceği paneldir. Ayrıca var olan bir video 
dosyasının (footage) projeye dâhil edilip, ilgili dosyanın genişlik, yükseklik veya video uzunluğu 
değerleri kullanılarak yeni bir kompozisyonun eklenebileceği paneldir (Görsel 2.4).

 Görsel 2.4: Composition paneli

Info Paneli: Kompozisyon üzerinde imlecin bulunduğu noktanın x, y koordinatları ve RGB renk 
kodları hakkında bilgi verir.
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Preview Paneli: Hazırlanan kompozisyonun render işleminden önce ön izlemesinin yapılabil- 
diği bölümdür. Klavyeden space (boşluk) tuşu kullanılarak ilgili kompozisyonun ön izlemesi 
yapılabilir. Projenin hızlı bir şekilde ön izlemesi yapılmak istenirse Resolution (Çözünürlük) 
seçeneklerinden Half, Third veya Quarter gibi düşük çözünürlük seçilebilir. Full Screen seçeneği 
işaretlenip, ön izleme seçeneklerinden Play simgesine tıklanarak tam ekran olacak şekilde ön 
izleme yapılabilir (Görsel 2.5).

 Görsel 2.5: Preview paneli

Görsel 2.6: Effect & Presets paneli

Effects & Presets: Resim, video veya yazılara sürükle bırak yöntemiyle çeşitli efektlerin 
kolaylıkla uygulanabildiği paneldir. Uygulanan efektler daha sonra Effect Control panelinden 
ayarlanabilir (Görsel 2.6).

Align Paneli: Çalışmada kullanılan elemanların kompozisyonda hizalanması ile ilgili işlemlerin 
yapıldığı paneldir.
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Character Paneli: Yazı büyüklüğü, fontu, rengi vb. yazı ile ilgili ayarlamaların yapıldığı paneldir 
(Görsel 2.7).

Görsel 2.7: Character paneli 

Tracker Paneli: Bir nesneyi, video boyunca hareket eden başka bir nesneye sabitlemeyi sağlayan 
Track Motion komutu bu panelde bulunur. Çalışmanın üç boyutlu yapısını çıkarıp videodaki bir 
noktaya herhangi bir yazıyı sabitlemeyi sağlayan Track Camera komutu da bu paneldedir.

2.2.4. Çalışma Alanını Kişiselleştirmek
Projede çalışılırken ihtiyaca göre farklı paneller açılmış veya panellerin yerleri değiştirilmiş 

olabilir. Çalışma alanının kişiye özgü ayarlanmış hâli kaydedilip, daha sonra isteğe bağlı olarak geri 
yüklenebilir (Görsel 2.8).

Görsel 2.8: Yeni Çalışma Alanı olarak kaydetme
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2.2.5. Klavye Kısayolları

Bir proje üzerinde çalışılırken yapılacak işlemler araç kutusu, panel veya menüler üzerinden 
gerçekleştirilebilir. Örneğin kompozisyon üzerinde bir nesneyi seçebilmek için araç kutusu 
üzerindeki Selection Tool (Seçim aracı) kullanılabilir. Bu aracın kısayol tuşu, V harfidir. Bunun 
gibi farklı işlemlerin daha hızlı yapılabilmesi için klavyede tanımlanan kısayol karşılıkları vardır. 
Bu kısayol tuşlarının düzenlenmesi veya görüntülenmesi istenirse Edit menüsünden Keyboard 
Shortcuts seçeneği kullanılabilir (Görsel 2.9).

Görsel 2.9: Klavye kısayollarını ayarlama

İşlem adımlarına göre görsel efekt programı arayüzündeki panellerin yerini 
değiştirme ve varsayılan hâle geri getirme uygulamasını gerçekleştiriniz.

1. Adım: Program arayüzündeki panellerin üzerine tıklayarak seçilmesini sağlayınız.

2. Adım: Seçili panelin yerini, seçili panelin üst taraftaki isminin yanındaki boş alana imleci 
götürüp, sürükle bırak yöntemiyle hareket ettirerek değiştiriniz.

3. Adım: Çalışma alanında görünmeyen bir panel varsa ilgili paneli Window menüsünden 
seçerek görünür hâle getiriniz.

4. Adım: Window>Workspace>eset “Default” to  Saved Layout seçenekleriyle birlikte çalışma 
alanını varsayılan hâline geri getiriniz.

2. UYGULAMA
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Çalışma alanındaki panellerin yerini değiştirip, bazılarını gizleyerek daha sonra 
varsayılan hâle geri getirilmesini sağlayınız.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Program arayüzündeki herhangi bir panelin üzerine tıklayarak paneli seçti.

2. Seçili panelin yerini sürükle bırak yöntemiyle hareket ettirerek değiştirdi.

3. Essential Graphics adlı paneli Window menüsünden açtı.

4. Çalışma alanını varsayılan hâle geri getirdi.

İşlem adımlarına göre araç çubuğu üzerindeki hand (el) komutunun kısayol tuşunun 
değiştirilmesi uygulamasını gerçekleştiriniz.

1. Adım: Hand Tool aracının kısayol tuşunu öğrenerek bu kısayol tuşuyla birlikte çalışma 
sahnesinde açtığınız bir kompozisyon üzerinde komutu deneyiniz (El aracı, kompozisyon üzerindeki 
projeyi çalışma sahnesinde farklı yönlere kaydırmak veya hareket ettirmek için kullanılır.).

2. Adım: Edit>Keyboard Shortcuts seçeneğiyle kısayolların görüntülendiği klavyeye ulaşınız. 
3. Adım: Klavyenin altındaki sol kısımda yer alan komutlar bölümünden hand kelimesini aratıp 

ilgili komutun kısayol karşılığına fare ile tıklayınız.

4. Adım: Hand Tool aracında atamak istediğiniz yeni kısayol tuşuna klavyeden basıp OK ile 
klavye kısayolları penceresini kapatınız.

SIRA SİZDE

3. UYGULAMA
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Programın klavyesi üzerinde istediğiniz bir kısayolu üçüncü uygulamaya benzer 
şekilde değiştiriniz. 

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Hand Tool kısayol tuşunu kullanarak bu aracı çalışma sahnesinde açılan bir 
kompozisyon üzerinde denedi.

2. Edit>Keyboard Shortcuts seçeneğiyle kısayolları görüntüledi.

3. Klavyenin altındaki sol kısımda yer alan komutlar bölümünden hand 
kelimesini arayarak ilgili komutun kısayol karşılığına fare ile tıkladı.

4. Hand Tool aracına atamak istediği yeni kısayol tuşuna klavyeden basıp Ok ile 
klavye kısayolları penceresini kapattı.

2.3. MATERYAL EKLEMEK
Görsel efekt programında ihtiyaca bağlı olarak resim veya video gibi materyaller kullanılabilir. 

Photoshop ve Illustrator gibi programlarda oluşturulan dosyalar, istenirse katmanlarıyla birlikte 
kullanılan programa aktarılabilir.

2.3.1. Dosya Aktarmak (Import)

Görsel efekt programında kullanılmak istenen resim veya videoların öncelikle Project paneline 
aktarılması gerekir. Bunun için Project panelinin altındaki boşluk üzerindeyken sağ tuş yapılıp 
import>file seçeneğiyle beraber proje alanına resim veya video dosyası eklenebilir (Görsel 2.10).

SIRA SİZDE
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Görsel 2.10: Project  paneline dosya ekleme

Proje alanında aktarılmak istenen bir photoshop dosyasıysa Import>file menüsünden sonra 
ilgili dosya seçileceğinde Import As açılır listesinden Composition seçilir (Görsel 2.11).

Görsel 2.11: Photoshop dosyası ekleme

Dosya import edilirken Footage seçeneği seçilirse, alınmak istenen dosya photoshop ve 
illustrator gibi katmanlı dosyalar bile olsa sadece bir katmandaki içerik programa aktarılabilir.

Resim veya videolar Project paneline aktarıldığında ilgili dosyanın adı (Name), tipi (Type), 
dosya büyüklüğü (Size), çerçeve oranı (Frame Rate), başlangıç noktası (In Point), bitiş noktası 
(Out Point) ve dosya konumu (File Path) gibi bir dizi özellik bulunur (Görsel 2.12).

Görsel 2.12: Project  panelindeki dosyanın özellikleri
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2.3.2.  Paneldeki Dosyaları Düzenlemek

Project paneline aktarılan dosyaların düzenli olmasını sağlamak için ilgili resim veya videolar, 
oluşturulacak farklı klasörlerin içine alınabilir.

Panel üzerinde yeni bir klasör oluşturmak için File menüsünden New>New Folder seçenekleri 
seçilebilir. Project paneli üzerindeyken farenin sağ tuşuna basılıp açılan seçenekler içinden New 
Folder seçeneğiyle de yeni klasör oluşturulabilir (Görsel 2.13).

Görsel 2.13: Yeni klasör oluşturma

İşlem adımlarına göre biri photoshop, diğeri video dosyası olmak üzere iki farklı 
dosyanın görsel efekt programına aktarılması ve ön izlemesinin yapılmasına dair örnek 
uygulamayı gerçekleştiriniz. 

1. Adım: Import>Multiple Files seçenekleriyle birlikte photoshop ile hazırlanmış bir dosyayı 
seçiniz.

2. Adım: Import As açılır listesinden Composition seçeneğini seçiniz.

3. Adım: İkinci açılan diyalog penceresiyle bilgisayarınızdaki bir video dosyasını seçiniz.

4. Adım: Project paneline eklediğiniz dosyalardan photoshop olan dosyaya çift tıklayarak 
Footage panelinde dosyanın açılmasını sağlayınız.

5. Adım: Video dosyasına çift tıklayıp Footage panelinde videonun açılmasını sağlayınız.

6. Adım: Klavyeden boşluk tuşuna basarak veya Preview panelinden Play simgesine tıklayarak 
videonun ön izlemesini yapınız.

4. UYGULAMA
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DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Import>Multiple Files seçenekleriyle birlikte photoshop ile hazırlanmış bir 
dosyayı seçti.

2. Import As açılır listesinden Composition seçeneğini seçti.

3. İkinci açılan diyalog penceresiyle bilgisayardaki bir video dosyasını seçti.

4. Project paneline eklenen dosyalardan photoshop türünde olanına çift tıkla- 
yarak Footage panelinde dosyanın açılmasını sağladı.

5. Video dosyasına çift tıklayarak Footage panelinde videonun açılmasını 
sağladı.

6. Klavyeden boşluk tuşuna basarak veya Preview panelinden Play simgesine 
tıklayarak videonun ön izlemesini yaptı.

2.3.3. Kompozisyon Oluşturmak

Görsel efekt programında bir proje üzerinde çalışmaya başlayabilmek için öncelikle yeni 
bir kompozisyon oluşturulmalı veya mevcut bir video kullanılarak o videonun özelliklerinde 
(videonun çözünürlük, fps gibi değerleriyle aynı özelliklerde) bir kompozisyon oluşturulmalıdır 
(Görsel 2.14).

Görsel 2.14: Kompozisyon oluşturma

Çalışma alanında biri photoshop, diğeri video dosyası olmak üzere iki farklı dosyayı 
Import>Multiple Files seçenekleriyle birlikte Project paneline aktarınız.

SIRA SİZDE
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Composition menüsünden New Composition seçeneğiyle (kısayol karşılığı Ctrl+N), belirli 
özelliklere sahip (fps, genişlik-yükseklik vb.) yeni bir kompozisyon oluşturulabilir (Görsel 2.15).

Görsel 2.15: Kompozisyon özellikleri

Yeni bir kompozisyon seçeneği seçildiğinde açılan pencerede birtakım özelliklerin girilmesi 
gerekir. Composition Name kısmından kompozisyona bir isim verilir. Preset kısmından 
kompozisyon için hazır ayarlardan biri seçilip kullanılabilir. HDTV (High Definition TV) 1080 29.97 
seçeneği seçildiğinde kompozisyonun Width değeri 1920 px, Height değeri 1080 px, Frame 
Rate değeri 29.97 otomatik olarak gelir. Preset kısmından farklı çözünürlük ve fps değerlerinde 
kompozisyonlar oluşturulabilir. Lock Aspect Ratio özelliği seçiliyse genişlik veya yükseklik 
değerlerinden birine bir değer girildiğinde diğeri de program tarafından otomatik olarak belirlenir.

Frame Rate seçeneği, animasyon veya videolarda saniyede gösterilecek kare sayısını belirler 
(fps-frame per second). Fps oranı 24’ün altında olan videolar izlenirken görüntüde takılmalar 
veya donmalar olacaktır. Bu sebeple kompozisyonla çalışırken fps oranı en az 24 ve üzerinde 
seçilmelidir.

Resolution kısmı, oluşturulacak kompozisyonun çözünürlüğünün ayarlandığı bölümdür. 
Full, Half, Third ve Quarter olmak üzere farklı seçenekler bulunur. Kompozisyon için 
1920x1024 olarak belirlenen genişlik ve yükseklik değeri için çözünürlük kısmı Half seçilirse 
çalışmanın ön izlemesi yapılırken 990x512 ölçülerinde görüntülenerek daha hızlı sonuç alınır.  
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Kullanılan bilgisayarın sistem özelliklerine bağlı olarak çözünürlük; 1:1, 1:2, 1:3, 1:4 veya özel 
olarak ayarlanabilir. Background Color kısmından kompozisyon için istenilen bir arka plan rengi 
ayarlanabilir. Composition>Composition Settings seçenekleriyle daha sonradan da kompozisyon 
ayarları yapılabilir.

Resim, video veya başka bir materyalin eklenebilmesi için Project panelindeki ilgili dosya türü 
sürükle bırak yöntemiyle kompozisyon üzerine taşınır.

İşlem adımlarına göre belirli özelliklere sahip bir kompozisyonu oluşturma 
uygulamasını gerçekleştiriniz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Project  panelindeyken sağ tuş yaparak New Composition seçeneğini seçti.

2. Preset kısmından Custom seçeneğini seçerek Width değerini 1980, Height 
değerini 1024 olacak şekilde ayarladı.

3. Frame Rate değerini 25 olarak girdi.

4. Çalışma süresini 10 saniye olarak belirledi.

5. Arka plan rengi olarak maviyi seçti.

Farklı çözünürlük, çerçeve oranı ve arka plan değerlerine sahip bir kompozisyon 
oluşturunuz.

1. Adım: Project panelindeyken sağ tuş yaparak New Composition seçeneğini seçiniz.

2. Adım: Preset kısmından Custom seçeneğini seçerek Width değerini 1980, Height değerini  
1024 olarak ayarlayınız.

3. Adım: Frame Rate değerini 25 olarak giriniz.

4. Adım: Çalışmanızın süresini 10 saniye olarak belirleyiniz.

5. Adım: Arka plan rengi olarak maviyi seçiniz.

SIRA SİZDE

5. UYGULAMA
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2.3.4. Araç Çubuğu (Toolbar)

Üst menünün altında yer alan araç kutusu üzerinde farklı görevlere sahip komutlar 
bulunur (Görsel 2.16). Araç kutusu seçenekleri, kompozisyon üzerine aktarılan materyallerin 
yönetilmesinde kullanıcıya büyük kolaylık sağlar.

Görsel 2.16: Araç kutusu

Home: Görsel efekt programının ana ekranına dönülmesini sağlar. Bu ana ekran üzerinde yeni 
bir proje oluşturulabileceği gibi Create New seçenekleri ile birlikte seçilecek bir resim veya video 
dosyasının genişlik, yükseklik ve fps değerlerinde yeni bir kompozisyon da oluşturulabilir. 

Selection Tool (V): Kompozisyon üzerindeki istenilen materyali (resim, video, yazı vb.) seçmeyi 
sağlar. Klavyedeki kısayolu V harfidir. Kompozisyon üzerindeki materyallerden bazıları seçilmek 
istenirse Shift tuşuna basılarak ilgili resme veya yazıya tıklanabilir.

Hand Tool (H): Kompozisyonda yer alan çalışmayı ilgili panelde farklı yönlere kaydırabilmek 
amacıyla kullanılır. Klavyedeki kısayolu H harfidir. Çalışılan kompozisyona %100’ün üzerinde 
yakınlaştırma yapıldığında çalışma,  görülebilen ekranın dışına taşacağı için hand aracı kullanılarak 
ekranda kaydırılabilir ve görünmeyen kısımların ekranda görünmesi sağlanabilir.

Zoom Tool (Z): Kompozisyonu ekranda yakınlaştırmaya veya uzaklaştırmaya yarar. Klavyedeki 
kısayolu Z harfidir. Zoom aracı seçildiğinde büyüteç üzerinde + işareti gözüküyorsa bu araç, 
çalışmayı yakınlaştırır. Büyüteç üzerinde - işareti gözüküyorsa zoom aracı çalışmayı uzaklaştırır.

Rotation Aracı (W): Ekranda yer alan bir resmi, videoyu veya yazıyı istenen yöne döndürmeyi 
sağlar. Klavyedeki kısayolu W harfidir. Shift tuşu ile beraber seçilen içeriği farenin sol tuşuna 
basarak saat yönünde veya saat yönüne zıt olacak şekilde 45 derecelik açılarla döndürmek 
mümkündür. Alt tuşu ile birlikte farenin sol tuşuna basılı tutularak ilgili resmin kendisi ekranda 
sabit olacak şekilde sadece dönüşüm noktaları istenen açıya göre döndürülür ve döndürme 
açısına karar verildiğinde farenin sol tuşu bırakılır. Böylece döndürme işlemi gerçekleşir.
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Pan Behind (Anchor Point) Aracı: Kompozisyon üzerindeki herhangi bir şeklin, resmin, 
videonun veya yazının merkez noktasını görmek için kullanılır. İlgili materyal döndürülmek 
istendiğinde Pan Behind aracıyla görünür hâle getirilen bu nokta, istenen yere kaydırılıp, dönme 
hareketi bu nokta esas alınarak gerçekleştirilir (Görsel 2.17).

Görsel 2.17: Pan Behind aracı

Rectangle Aracı (Q): Kompozisyon üzerine dikdörtgen, köşeleri yuvarlatılmış dikdörtgen, 
elips, poligon ve yıldız araçlarının eklenebileceği komuttur (Görsel 2.18). Her bir seçenekte dolgu 
rengi, kontur ve kontur kalınlığı gibi ilave seçenekler bulunur.

Görsel 2.18: Şekil araçları

Katmanlar panelinde resim veya videonun olduğu bir katman seçiliyken şekil araçlarından 
herhangi biri seçilir ve kompozisyon üzerine çizilmeye çalışılırsa o an seçili olan resim veya video 
maskelenir (Görsel 2.19).  Şekil araçlarıyla çizim yapılacaksa katmanlar bölümünden sağ tuş 
ile New>Shape Layer seçilerek şekil katmanı oluşturulduktan sonra şekil çizmek daha yerinde 
olacaktır.

Görsel 2.19: Şekil araçlarıyla maskeleme



                 Görsel Efekt Yazılımında Temel Düzenlemeler124

İşlem adımlarına göre şekil araçlarını kullanarak kompozisyon üzerine belirli bir 
konturu ve dolgu rengi olan bir şekli çizme uygulamasını gerçekleştiriniz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Menü üzerindeki yıldız şekil aracını (Star Tool) seçti.

2. Dolgu (Fill) özelliğinin yanındaki renk simgesine tıklayarak kırmızı rengi seçti.

3. Kontur (Stroke) özelliğinin yanındaki kenarlık simgesine tıklayarak mavi 
rengi seçti.

4. Kontur büyüklüğünü 5 piksel olarak ayarladı.

5. Kompozisyona sığacak bir yıldız şekli çizdi.

Farklı dolgu ve kenarlık renkleri için oluşturacağınız kompozisyona farklı büyüklük- 
lerde şekiller çiziniz.

Pen Aracı (G): Seçilen dolgu, kontur rengi ve büyüklüğü 
doğrultusunda herhangi bir şekil oluşturmaya yarar (Görsel 
2.20). Klavyedeki kısayolu G harfidir. Bu araç, herhangi bir 
resmin veya videonun olduğu katman seçiliyken kullanılırsa 
maskeleme yapılır. 

Görsel 2.20: Pen Tool seçenekleri

1. Adım: Menü üzerindeki yıldız şekil aracını (Star Tool) seçiniz.

2. Adım: Dolgu (Fill) özelliğinin yanındaki renk simgesine tıklayarak kırmızı rengi seçiniz.

3. Adım: Kontur (Stroke) özelliğinin yanındaki kenarlık simgesine tıklayarak mavi rengi seçiniz 
ve kontur büyüklüğünü 5 piksel olarak ayarlayınız.

4. Adım: Kompozisyona sığacak bir yıldız şekli çiziniz.

SIRA SİZDE

6. UYGULAMA
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Pen Tool aracının alt seçeneklerinden Add Vertex aracı, çizilen şeklin herhangi bir kenarı 
üzerine dönüşüm noktası (vertex) ekler. Bu sayede daha hassas çizimler yapılabilir. Delete Vertex 
aracıysa şekil üzerinde gereksiz olduğu düşünülen dönüşüm noktalarını silmeyi sağlar. Şekil 
üzerindeki dönüşüm noktaları seçilip, ilgili noktacığın iki yanında beliren tutamaçlara farenin sol 
tuşuyla basılı tutularak tutamaçlar sağa sola veya yukarı aşağı yönde hareket ettirilir ve şekil 
üzerinde daha hassas ayarlamalar yapılır.

Mask Feather aracıysa herhangi bir şekil üzerinde maskeleme yapılacağı zaman ilgili noktaya, 
bir dönüşüm noktasından dışarıya doğru bir yumuşatma efekti vermek için kullanılır (Görsel 
2.21).

Görsel 2.21: Mask Feather aracıyla maskeleme

Type Aracı ( Ctrl+T):  Kompozisyon alanına yatayda veya dikeyde yazı eklemek için kullanılan 
bir araçtır (Görsel 2.22). Klavyedeki kısayolu Ctrl+T tuşlarıdır.

Görsel 2.22: Type araçları

Brush Aracı (Ctrl+B): Resim veya videonun herhangi bir karesine fırça ile boyama işlemi 
yapılmasını sağlar.

Clone Stamp Aracı (Ctrl+B): Resim veya videonun herhangi bir yerindeki bölgenin 
kopyalanarak başka bir bölgeye aktarılmasını sağlar. Bu işlem için klavyeden Alt tuşuna  
basılı tutularak farenin sol tuşuyla beraber kopyalanacak bölge hafızaya alınır. 
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Daha sonra resim veya videonun başka bir bölümüne, hafızaya alınan bölge farenin sol tuşuna 
basılarak boyama yöntemiyle aktarılır (Görsel 2.23).

 Görsel 2.23: Clone Stamp aracı

Eraser Tool (Ctrl+B): Kompozisyon üzerindeki herhangi bölümü silmeyi sağlar. Silinen kısımlar, 
kompozisyon için belirlenen arka plan rengiyle görünür.

Roto Brush Tool (Alt+W): Roto Brush aracı, resim veya video üzerindeki herhangi bir nesneyi 
maskeleyerek ilgili katmanın altından bir yazı veya arka plan görseli göstermek için kullanılır 
(Görsel 2.24). Klavyedeki kısayolu, Alt ile beraber W tuşudur. Refine Edge aracıysa saç, tüy gibi 
seçilmesi zor olan bölgelerin daha hassas ayarlamalar yapılarak seçilebilmesine olanak veren 
komuttur.

Görsel 2.24: Roto Brush araçları

İşlem adımlarına göre Roto Brush aracıyla bir videodaki belli bir alanın seçilerek 
videonun diğer kısımlarının nasıl maskeleneceği ve seçili kısımların arka planına nasıl 
yazı ekleneceği uygulamasını gerçekleştiriniz.

1. Adım: Görsel 2.23’te görüldüğü gibi örnek bir video dosyasını internetten temin ediniz 
(Videoda seçilebilecek bir nesnenin olmasına dikkat ediniz.).

2. Adım: İndirdiğiniz video dosyasını proje dosyalarına import ederek bu videodan bir katman 
oluşturunuz (Project panelindeki video dosyasını sürükle bırak yöntemiyle katmanlar bölümüne 
taşıyınız.).

7. UYGULAMA
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3. Adım: Video dosyasını Ctrl+D tuşlarıyla çoğaltınız.

4. Adım: Katmanlar panelinde sağ tuş yaparak New>Text seçenekleriyle yeni bir yazı katmanı 
ekleyiniz. Okulunuzun ismini yazı katmanına yazdıktan sonra yazı katmanını iki video katmanının 
ortasına gelecek şekilde yerleştiriniz (Görsel 2.25). 

5. Adım: En üstteki video katmanını seçip, kompozisyon üzerine çift tıklayarak ilgili 
kompozisyonu Layer (katman) olarak açınız.

6. Adım: Roto Brush aracını seçerek video üzerindeki aile üyelerini fırçayla boyayınız. Fırça ile 
boyanan alanın çizim işlemi sonunda etrafı mor olacak şekilde seçili görünmesi gerekir (Görsel 
2.26). İstenmeyen bölümler seçilmişse Alt tuşuna basarak Roto Brush aracıyla bu kısmı seçimden 
çıkarabilirsiniz.

Görsel 2.25: Katmanlar paneli

Görsel 2.26. Roto Brush ile seçim yapılması 

7. Adım: Videoda görünmesi istenen bölümleri Roto Brush aracıyla seçtikten sonra orta 
bölümde yer alan Composition panelini tıklayarak seçiniz. Ardından Preview panelinden  
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Resolution özelliğini Half seçip, Full Screen özelliğini işaretleyerek projenin tam ekran olacak 
şekilde ön izlemesini yapınız (Görsel 2.27.).

Görsel 2.27: Roto Brush ile ön izleme

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Temin ettiği video dosyasını proje dosyalarına import edip, bu videoyu 
sürükle bırak yöntemiyle katman paneline taşıyarak yeni bir katman oluşmasını 
sağladı.

2. Video dosyasını Ctrl+D tuşlarıyla çoğalttı.

3. Katmanlar panelinde sağ tuş yaparak New>Text seçenekleriyle yeni bir yazı 
katmanı ekledi. 
4. Okul ismini yazı katmanına yazdıktan sonra yazı katmanını iki video 
katmanının ortasına gelecek şekilde yerleştirdi.
5. En üstteki video katmanını seçip, kompozisyon üzerine çift tıklayarak Layer 
panelini açtı.
6. Roto Brush aracını seçerek video üzerindeki aile üyelerini fırçayla boyadı ve 
diğer kısımların maskelenmesini sağladı.
7. Videoda görünmesi istediği bölümleri Roto Brush aracıyla seçtikten sonra 
orta bölümde yer alan Composition paneline tıklayarak seçti. Ardından Preview 
panelinden Resolution özelliğini Half seçip, Full Screen özelliğini işaretleyerek 
projenin tam ekran olacak şekilde ön izlemesini yaptı.

Roto Brush aracını deneyebileceğiniz seçim yapılabilecek nesnelere sahip bir video 
temin ediniz.

SIRA SİZDE
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Puppet Position Pin Tool:  Kompozisyona eklenen herhangi bir nesneyi hareketlendirmek için 
kullanılabilen çeşitli kukla araçlarından oluşur. Puppet Position Tool aracı hareketin başlanması 
istenen noktayı işaretlemek için kullanılır. İlgili nokta işaretlendikten sonra resim veya videodaki 
hareket ettirilmesi istenen nesnenin ağ yapısı çıkarılır. Bunun için Puppet aracı seçildikten sonra 
üst menüdeki Mesh özelliği Show olacak şekilde seçilir (Görsel 2.28).

Görsel 2.28. Ağ yapısı görünümü

Position aracıyla hareketin başlayacağı pin belirlendikten sonra Puppet Starch Pin aracıyla 
bir veya birden fazla pin daha eklenir. Starch Pin aracıyla eklenen pinler, birden fazla eklem yeri 
eklenerek hareketin daha gerçekçi olmasını sağlar. Puppet Advanced Pin Tool aracı, Starch Pin 
aracıyla eklenen pinlerin arasına gelişmiş bir pin ekler. Gelişmiş Pin aracıyla birlikte ilgili bölgede 
yer alan kısım; konum (Position), ölçek (Scale), dönme (Rotation) özellikleri kullanılıp, farklı 
değerler girilerek hareket ettirilebilir. Puppet Bend Pin Tool aracıyla birlikte boyun, kuyruk gibi 
kısımlara bükme veya eğme hareketi verilebilir. Bend aracında ölçek ve dönme özelliklerine göre 
hareket verilir (Görsel 2.29).

Görsel 2.29. Puppet Tool (Kukla araçları)

İşlem adımlarına göre Puppet Tool kullanarak resim veya videodaki bir nesneyi 
hareket ettirme uygulamasını gerçekleştiriniz.

1. Adım: Proje alanına hareket ettirilmesi planlanan bir görsel ekleyiniz (Bu uygulamada 
zürafa kullanılacaktır.).

2. Adım: 1980x1024 ölçülerinde, 29 fps değerine sahip ve 10 saniyelik bir kompozisyon 
oluşturunuz. Bu görseli kompozisyon alanına taşıyarak hareket ettirilecek nesneden bir katman 
oluşturunuz.

8. UYGULAMA
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3. Adım: Puppet Position Pin Tool aracını seçerek zürafanın ayaklarının başladığı dört  
farklı noktaya pin ekleyiniz (Görsel 2.30). Pin eklerken zaman çizelgesindeki zaman işaretçisini 0. 
saniyeye taşımayı unutmayınız (Görsel 2.31).

4. Adım: Puppet Starch Pin Tool kullanarak her bir bacak üzerine ikişer tane pin ekleyiniz 
(Görsel 2.32).

Görsel 2.30: Puppet Position Pin Tool eklenmesi

Görsel 2.31: Zaman işaretçisi

Görsel 2.32: Puppet Position Pin Tool eklenmesi
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5. Adım: Puppet Advanced Pin Tool aracını kullanarak görseldeki yeşil ile gösterilen bölgelere 
pin ekleyiniz (Görsel 2.33).

6. Adım: Zaman çizelgesindeki zaman işaretçisini 3. saniyeye taşıyınız. Seçim aracıyla birlikte 
zürafanın bacaklarının orta kısmındaki gelişmiş pin simgesini kullanarak zürafanın bacaklarını 
Görsel 2.34’teki 2. konuma getiriniz.

Görsel 2.34: Birinci konum hareketi 

Görsel 2.33: Puppet Advanced Pin Tool eklenmesi
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Bacak pozisyonları değiştiğinde Position ve Rotation özelliklerinin karşısında, ilgili 
zaman işaretçisi altında keyframeler oluşur. 

Görsel 2.35: İkinci konum hareketi

7. Adım: Zaman çizelgesindeki zaman işaretçisini 6. saniyeye taşıyınız. Seçim aracıyla birlikte 
zürafanın bacaklarının orta kısmındaki gelişmiş pin simgesini kullanarak zürafanın bacaklarını 
Görsel 2.36’daki 3. konuma getiriniz.

Görsel 2.36: Üçüncü konum hareketi

NOT
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8. Adım: Zaman işaretçisini 0. saniyeye taşıyınız. Farenin sol tuşuna basarak, ilgili karedeki 
tüm keyframeleri seçerek kopyalayınız (Görsel 2.37).

9. Adım: Zaman işaretçisini 9. saniyeye taşıyıp kopyalanmış keyframeleri Ctrl+V tuşlarıyla 
yapıştırınız (Görsel 2.38).

10. Adım: Klavyeden space tuşuna basarak veya Preview panelinden Play simgesine tıklayarak 
çalışmanızı ön izleme yapınız.

Görsel 2.37: Kopyalanacak keyframeler

Görsel 2.38: Keyframelerin yapıştırılması

2.4. DÖNÜŞTÜRME (TRANSFORM) İŞLEMLERİ
Kompozisyon üzerinde yer alan resim veya video dosyalarının boyutlarının ve ekranda 

bulunduğu açının değiştirebileceği bölümdür. Bu menüden şeffaflık seviyesi, ilgili içeriğin çalışılan 
sahnedeki ekranda hangi yöne bağlı olarak sığdırılacağı da belirlenebilir.
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Project paneline eklenen bir içerik, sürükle bırak yöntemiyle sahneye taşındığında resmin veya 
videonun büyüklüğüne bağlı olarak ekranda kendi ölçüsünde görüntülenir. İçerik, kenarlarındaki 
dönüştürme noktalarından farenin sol tuşuyla birlikte daha büyük veya daha küçük hâle 
getirilebilir.

Composition paneli üzerinde sağ tuş yapılarak Transform (Dönüştürme) seçenekleri 
altındaki komutlarla birlikte ilgili içeriğin boyutları, açısı veya şeffaflık değerleri değiştirilebilir. 
İçeriği kompozisyona sığdırmak için Fit to Comp, Fit to Comp Width veya Fit to Comp Height 
seçeneklerinden yararlanılabilir (Görsel 2.39).

Görsel 2.39:  Transform seçenekleri

Fit to Comp: Görselin boyutlarının kompozisyon boyutlarına göre ayarlanmasını sağlar.

Fit to Comp Height: Görselin yüksekliğini kompozisyonun yüksekliğine sığdırır.

Fit to Comp Width: Görselin genişliğini kompozisyon genişliğine göre ayarlar.

Flip Horizontal: Seçili görselin sağa veya sola dönme işlemini gerçekleştirir.

Flip Vertical: Görselin ters dönmesini sağlar.

Center Anchor Point In Layer Content: Çıpa noktasının merkeze alınmasını sağlar.
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Görsel 2.40: Anchor Point

Görsel 2.41: Rotation işlemi

Rotation: Belirlenen merkez noktasına göre görselin döndürülmesi işleminin gerçekleştiril- 
mesini sağlar (Görsel 2.41).

Anchor Point: Açılan pencerede girilen x ve y değerlerine bağlı olarak görselin hareket mer- 
kezi değiştirilir (Görsel 2.40). Özellikle dönme hareketlerinde resim veya video döndürüleceği 
zaman Anchor Point esas alınarak döndürme işlemi yapılır.
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Görsel 2.42: Scale (Ölçekli büyütme ve küçültme)

Scale: Materyalin boyutunun ölçekli bir şekilde büyütülüp küçültülmesi işlemlerinin 
gerçekleşmesini sağlar (Görsel 2.42).

Reset: Kompozisyon üzerindeki görselleri başlangıçta sahne üzerine aktarıldıkları şekle 
dönüştürür.

Position: Görsellerin sahne üzerindeki konumunun belirlenmesini sağlar.

Opacity: Görsellerin şeffaflığını değiştirmeyi sağlar. 

2.5. ÇIKTI (RENDER)
Görsel efekt programında çalışılan proje, File>Save (Dosya>Kaydet) seçenekleriyle birlikte 

aep uzantılı olarak kaydedilebilir. Proje daha sonra düzenlenmek istenirse aep uzantılı olarak 
kaydedilmelidir. 

2.5.1. Görsel Efekt Programıyla Render İşlemi

Çalışılan projeyi avi uzantılı kaydetmek, herhangi bir programa ihtiyaç duymadan projenin 
başka bilgisayarlarda da oynatılabilmesine olanak verir. Bunun için File>Export>Add to Render 
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Queue seçenekleriyle ilgili panel açılır (Görsel 2.43).

Görsel 2.43: Render kuyruğuna ekleme ve render paneli

Render Settings>Custom: Best Settings özelliği seçildiğinde açılan pencereden render almak
için gerekli olan aşağıdaki bazı ayarlara ulaşılır.

• Quality: Görüntü kalitesini ayarlama seçeneğidir. Best, Draft ve Wireframe seçenekleri 
vardır. Best seçeneği tercih edilmelidir.

• Resolution: Çözünürlüğün ayarlandığı kısımdır. Görüntü kalitesi yüksek tutulmak istendiğin- 
de Full seçilir. Çalışma sırasında işlemleri hızlandırmak için daha düşük çözünürlükler tercih 
edilebilir fakat çıktı alınmadan önce Full seçeneği tercih edilmelidir.

• Frame Rate: Animasyon ve videolarda saniye başına düşen kare sayısı bilgisini girmeye 
yarayan seçenektir. Kompozisyonda verilen kare sayısı değeri tercih edilebilir veya render 
işleminden önce bu seçenekle yeni kare sayısı değeri girilebilir. Dikkat edilmesi gereken önemli 
nokta, kompozisyondakinden çok daha fazla kare sayısı girilmemesidir çünkü program, aradaki 
kareleri çok fazla tekrarla doldurur.

• Start ve End: Render süresi için düzenlemelerin yapıldığı seçeneklerdir.

• Custom Time Span: Bu seçenekle yeni değerler girilebilir.

• Output Module>Lossless: Bu seçenekle açılan pencerede “dışarıya aktarım ayarları” yapılır.

• Format: Render alınabilecek dosya formatları bulunur. Video, görsel ve ses formatlarından 
çalışmaya uygun olan ve kullanılmak istenen format seçilir. JPEG Sequence formatı, animasyon- 
larda 25 karenin ayrı ayrı fotoğraf olarak kaydedilmesini sağlar. PNG Sequence ise işlem yapılan 
video karelerinde Alpha bilgisi bulunuyorsa bu bilgiyi koruyarak kaydetme işlemini gerçekleştirir.

• Video Output>Channels: Renk kanallarıyla ilgili seçim yapmayı sağlar. RGB, Alpha, 
RGB+Alpha seçenekleri bulunur. Alpha seçilirse karelerde yalnızca Alpha bölgeleri kaydedilir.  
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Animasyonlarda RGB+Alpha’yı aktif duruma getirebilmek için Format Options>Video Codec 
kısmından Animation seçeneği seçilmelidir. Bu seçenekte hem RGB hem de Alpha kısımlar 
kaydedilebilir.

• Resize: Bu seçenekle projenin çözünürlüğü değiştirilebilir.

Audio Output Auto: Bu seçenekle projenin ses kaydını açıp kapatma ve sesle ilgili özelliklerini 
düzenleme işlemleri yapılabilir.

Output To: Bu seçenekle projenin kaydedileceği yer seçilir ve kayıt ismi girilir.

Render Queue: Bu pencerede düzenleme işlemleri yapıldıktan sonra Render düğmesine tıklanır.

Loading Bar: Proje kaydedilirken, ilgili panelde mavi bir şerit olarak görülür. Bu çizgi 
tamamlandığında render işlemi de biter (Görsel 2.44).

Görsel 2.44: Çalışmanın render edilmesi

2.5.2. Media Encoder Programıyla Render İşlemi

Görsel efekt programında çalışılan doküman, media encoder ile mp3, mp4, avi, mpeg gibi 
farklı formatlarda kaydedilebilir. Bu işlemi gerçekleştirmek için File>Export>Add to Adobe Media 
Encoder Queue seçenekleriyle birlikte Media Encoder uygulaması açılır (Görsel 2.45).

Görsel 2.45 Media Encoder Kuyruğuna ekleme
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Açılan pencerede çalışma hangi dosya türünde kaydedilmek isteniyorsa format alanındaki 
seçeneklerden uygun olanı seçilir. Çıktı dosyası bölümünden ilgili projenin hangi konuma 
kaydedileceği seçilir ve Kaydet simgesine (sağ üstteki kırmızı çerçeveyle gösterilmiş küçük yeşil 
simge) basılarak render işlemi başlatılır (Görsel 2.46).

Görsel 2.46: Media Encoder ile mp4 formatında dosya kaydetme

İşlem adımlarına göre görsel efekt programında çalışılan projenin Media Encoder ile 
mp4 formatında render alınmasına dair örnek uygulamayı gerçekleştiriniz.

1. Adım: File>Export>Add to Adobe Media Encoder Queue seçenekleriyle birlikte Media 
Encoder uygulamasını açınız (Görsel 2.46).

2. Adım: Media Encoder uygulamasında format alanındaki seçeneklerden H.264 seçiniz.

3. Adım: Çıktı dosyası bölümünden projeyi bilgisayarda nereye kaydedeceğinizi seçiniz.

4. Adım: Projeyi kaydedeceğiniz konumu belirledikten sonra klavyeden Enter tuşuna basınız 
veya kuyruğu başlat simgesine tıklayarak render işlemini başlatınız.

9. UYGULAMA
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DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. File>Export>Add to Adobe Media Encoder Queue seçenekleriyle birlikte 
Media Encoder uygulamasını açtı.

2. Media Encoder uygulamasında format alanındaki seçeneklerden avi seçti.

3. Çıktı dosyası bölümünden projeyi bilgisayarda nereye kaydedeceğini seçti.

4. Projeyi kaydedeceği konumu belirledikten sonra klavyeden Enter tuşuna 
bastı.

Çalışma alanında çalışılan bir projeyi Media Encoder kullanarak .avi formatında 
kaydediniz.

SIRA SİZDE
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A) Aşağıdaki soruları dikkatlice okuyarak doğru seçeneği işaretleyiniz.

1. Görsel efekt programında çalışılan projeyi tam ekran olarak görüntüleyebilmek için 
           aşağıdakilerden hangisi seçilmelidir?

    A) İnfo paneli>Screen					     B) İnfo paneli>Preview	
    C) Preview>Full Screen					     D) Preview>Play	
				    E) Preview>Cache Before Playback

2. 

   Verilen bu menü konumundan seçilecek Reset “Default” to Saved Layout seçeneği ile 
           aşağıdaki işlemlerden hangisi gerçekleştirilir?

    A) Panellerin yeni konumu kaydedilir.

    B) Paneller varsayılan hâle geri yüklenir.

    C) Yeni çalışma alanı olarak kaydedilir.

    D) Kaydedilmiş çalışmaya kısayol tuşu atanır.

    E) Paneller en son kaydedilmiş hâle geri yüklenir.

3. Aşağıdakilerden hangisi kompozisyonda yer alan çalışmayı ilgili panelde farklı yönlere 
          kaydırabilmek amacıyla kullanılır?

    A) Selection Tool    					     B) Hand Tool	

    C) Zoom Tool						      D) Rotation Tool   	
				    E) Clone Stamp Tool

ÖLÇME VE DEĞERLENDİRME
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4.

 Dosya import edilirken Composition seçeneği seçilirse aşağıdakilerden hangisi gerçekleşir?

    A) Katmanlı dosyalarda sadece bir katmandaki içerik programa aktarılır.

    B) Katmanlı dosyalarda, katmanlardaki tüm içerikler programa aktarılır.
     C) Katmanlı dosyalardaki  içerikler,  katman büyüklükleriyle birlikte programa aktarılır. 

    D) Çalışma alanına başka bir Composition aktarılır.	

    E) Çalışma alanına Footage ile birlikte başka bir Composition aktarılır.

5. Aşağıdakilerden hangisi Pan Behind (Anchor Point) aracının yaptığı işi açıklar?

    A) Ekranda yer alan bir resmi, videoyu veya yazıyı istenen yöne döndürmeyi sağlar.

    B) Dikdörtgen, elips, poligon ve yıldız araçlarının eklenebileceği komuttur. 

    C) Herhangi bir şeklin, resmin veya videonun merkez noktasını görmek için kullanılır.

    D) Projeyi ilgili panelde farklı yönlere kaydırabilmek amacıyla kullanılır.	

    E) Kompozisyonda yer alan çalışmanın arkasına gölge ekler.

6. 

Aşağıdakilerden hangisi verilen bu görseldeki işlemi açıklar?
        A) Dolgu rengi yeşil ve kontur rengi olmayacak şekilde yıldız aracıyla şekil çizilmiştir.
    B) Dolgu rengi yeşil ve kontur rengi siyah olacak şekilde yıldız aracıyla şekil çizilmiştir.
    C) Kalem aracıyla yıldız çizilmeye çalışılmıştır.
    D) Katmanlar bölümüne aktarılan bir resim, fırça aracıyla siyah renge boyanmıştır.
       E) Katmanlar bölümüne aktarılan bir resim, yıldız aracıyla maskelenmeye çalışılmıştır.

7. Aşağıdakilerden hangisi resim veya videonun herhangi bir yerindeki bölgenin kopyala- 
           narak başka bir bölgeye aktarılmasını sağlar?

    A) Pan Behind Tool					    B) Clone Stamp Tool

    C) Puppet Pin Tool					    D) Rectangular Tool				    E) Roto Brush Tool
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8. 

      Aşağıdakilerden hangisinde verilen ilgili komutun görevi yanlış yazılmıştır?

    A) Kalem aracıyla istenen şekil çizilir.

    B) İlgili çizime dönüşüm noktası eklenir.
   	     C) İlgili çizimden dönüşüm noktası silinir. 
    D) İlgili çizimin kenar hatlarındaki keskinlik azaltılır.

    E) İlgili çizim vektörel hâle çevirilir.

9. Aşağıdakilerden hangisi Roto Brush Tool aracının ne işe yaradığını açıklar?

    A) Fırçayla seçili katmanı boyamayı sağlar.

    B) Dönüşüm noktasından dışarıya doğru bir yumuşatma efekti vermek için kullanılır. 

    C) Resmin herhangi bir yerindeki bölgenin başka bir bölgeye aktarılmasını sağlar. 

    D) Resim veya video üzerindeki herhangi bir bölgeyi maskelemek için kullanılır.

    E) Katman üzerine daha sonra düzenlenebilecek vektörel bir çizgi ekler.

10. Kukla araçlarıyla ilgili aşağıdaki bilgilerden hangisi yanlıştır?

    A) Puppet Position Pin Tool aracı, hareketin başlanması istenen noktayı işaretlemek için kul- 
              lanılır.

    B) Puppet Starch Pin aracıyla çakışma olması muhtemel durumlar ortadan kaldırılır.

    C) Puppet Advanced Pin Tool aracı, Starch Pin aracıyla eklenen pinlerin arasına gelişmiş bir 
              pin ekler.

    D) Puppet Bend Pin Tool aracıyla birlikte boyun, kuyruk gibi kısımlara bükme veya eğme ha- 
              reketi verilir.

    E) Puppet Overlap Pin aracıyla çakışma olması muhtemel durumlar ortadan kaldırılır.



KONULAR

3.1. KOMPOZİSYON OLUŞTURMAK

3.2. KOMPOZİSYON AYARLARI

3.3. KATMANLAR

3.4. ZAMAN CETVELİ (TIMELINE)

3.5. YAZI OLUŞTURMAK

3.6. ŞEKİL OLUŞTURMAK

3.7. HAREKET TAKİBİ

 NELER ÖĞRENECEKSİNİZ?

• Kompozisyon oluşturma, nesne ekleme, şekil ekleme

• Transform işlemlerini yapma 

• Kompozisyona anahtar kare ekleme, silme, taşıma

• Kompozisyonda grafik editör kullanma

• Kompozisyona katman ekleme

• Pre-composition oluşturma

• Zaman cetveli kullanma

• Kompozisyona yazı ekleme

• Kukla aracı kullanma

• Hareket takip etme

ANAHTAR KELİMELER

Kompozisyon, dönüşüm, anahtar, kare, katman, zaman cetveli, kukla, hare-
ket, takip



HAREKETLİ GÖRÜNTÜLER

3. ÖĞRENME BİRİMİ
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1. Görsel efekt yazılımı size ne ifade ediyor?

2. Görsel efekt yazılımının kullanım yerleri ile ilgili neler biliyorsunuz?

3.1. KOMPOZİSYON OLUŞTURMAK
Resim, video ve ses dosyalarını kullanarak hareketli kompozisyonlar oluşturmak, görsel efekt 

yazılımının en güçlü olduğu noktalardan biridir. Kompozisyonların içinde farklı kompozisyonlar 
olabilir. Hareketli görüntüler için kompozisyon oluşturma, transform işlemleri ve katmanları iyi 
anlamak gerekir.

Görsel efekt yazılımına video, resim ve ses dosyaları eklendikten sonra bunlara katmanlarda 
canlandırma ve efekt uygulamak için kompozisyon oluşturulur. Her kompozisyonun içinde 
birden fazla katman ve bu katmanların kendine has bir zaman çizelgesi bulunur. Kompozisyon 
oluşturulurken iki yöntem sıklıkla kullanılır. Bu yöntemlerden biri, Project paneline eklenen 
dosyaların sürükle bırak yöntemiyle Create a new Composition simgesinin üzerine bırakılmasıdır 
(Görsel 3.1).

Görsel 3.1: Sürükle bırak yöntemiyle yeni kompozisyon oluşturma

HAZIRLIK ÇALIŞMALARI
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Kompozisyon oluşturma yöntemlerden bir diğeri ise menü çubuğundan Composition>New 
Composition (Ctrl + N) seçilmesidir (Görsel 3.2).

Görsel 3.2: Menü çubuğundan yeni kompozisyon oluşturma

3.2. KOMPOZİSYON AYARLARI
Kompozisyon oluşturma işlemi Project panelindeki dosyayı sürükle bırak yöntemiyle yapılırsa 

herhangi bir ayar sorulmadan dosyanın özellikleriyle aynı ayarlarda kompozisyon oluşturulur. 
Bu kompozisyonun ayarlarını değiştirmek için menü çubuğundan Composition>Composition 
Settings (Ctrl + K) seçilir (Görsel 3.3).

Görsel 3.3: Menü çubuğundan kompozisyon ayarlarını açma

Menü çubuğundan yeni kompozisyon oluşturulursa otomatik olarak kompozisyon ayarları 
penceresiyle karşılaşılır (Görsel 3.4).

Görsel 3.4: Kompozisyon ayarları
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Composition Name: Kompozisyonun isminin yazıldığı bölümdür.

Preset: Kompozisyonun formatını belirler. Hazır formatlardan projeye uygun olanı seçer ve 
videoyu dışa aktarırken bu formatı kullanır. 

Frame Rate: Saniyede kaç çerçeve (fps) gösterileceğini belirler.

Width and Height: Kompozisyonun genişlik ve yüksekliğini belirler ve projenin boyutlarını 
ayarlar.

Duration: Kompozisyonun süresini belirler.

Background: Kompozisyonun arka plan rengi belirler.

Kompozisyon ayarları yapıldıktan sonra OK düğmesine tıklanarak yeni kompozisyon oluştu- 
rulur.

3.2.1. Kompozisyona Nesne Eklemek

Kompozisyona görsel efekt yazılımının araçları kullanılarak çeşitli şekiller (dikdörtgen, elips, 
çokgen ve yıldız gibi) eklenebildiği gibi projeye dâhil edilmiş resim, video ve ses dosyaları da 
yerleştirilebilir.

3.2.2. Kompozisyona Şekil Eklemek

Görsel efekt yazılımında kompozisyon oluşturulduktan sonra farklı formatta birçok nesne 
eklenebilir. Bu nesneler şekil, video, ses ve resimlerden oluşabilir. Görsel efekt yazılımı yaygın 
olarak kullanılan tüm dosya formatlarını tanır. Kompozisyona bir nesne eklendiğinde ona ait olan 
katman otomatik olarak oluşur.

İşlem adımlarına göre görsel efekt yazılımında kompozisyona dikdörtgen şekli 
ekleyiniz.

1. Adım: Araçlar (Tools) çubuğundan dikdörtgen (Rectangle Tool) aracını seçiniz (Görsel 3.5).

Görsel 3.5: Dikdörtgen aracı seçimi

1. UYGULAMA
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2. Adım: Çalışma alanında mouse sol tuşu basılıyken sol üstten sağ alt tarafa doğru ok işaretini 
hareket ettiriniz (Görsel 3.6).

Görsel 3.6: Dikdörtgen çizimi

İşlem adımlarına göre görsel  efekt yazılımında kompozisyona elips şekli ekleyiniz.

1. Adım: Araçlar çubuğunda yer alan dikdörtgen aracının üstüne mouse ok işaretini getirip sol 
tuşa basılı tutunuz (Görsel 3.7).

Görsel 3.7: Elips aracı seçimi

2. Adım: Açılan seçeneklerden Ellipse Tool aracını seçiniz.

3. Adım: Çalışma alanında mouse sol tuşu basılıyken sol üstten sağ alt tarafa doğru ok işaretini 
hareket ettiriniz (Görsel 3.8).

Görsel 3.8: Elips çizimi

2. UYGULAMA
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Görsel efekt yazılımında kompozisyona yıldız şekli ekleyiniz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Araçlar çubuğundan yıldız şeklini seçti.

2. Çalışma alanına yıldız şeklini çizdi.

3. Zamanı verimli kullandı.

3.2.3. Kompozisyona Dışarıdan Dosya Eklemek

Kompozisyona görsel efekt yazılımındaki şekiller eklenebildiği gibi dışarıdan resim, video ve 
ses dosyaları da eklenebilir.

İşlem adımlarına göre kompozisyona dışarıdan resim ekleyiniz.

1. Adım: 1024 piksel genişliğinde, 768 piksel yüksekliğinde yeni bir kompozisyon oluşturunuz.

2. Adım: File>Import>File menüsünden bilgisayardaki “resim1.png” dosyasını seçerek Project 
paneline ekleyiniz (Görsel 3.9).

Görsel 3.9: Project panele resim dosyası ekleme

SIRA SİZDE

3. UYGULAMA
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3. Adım: Project panelindeki “resim1.png” dosyasını sürükle bırak yöntemiyle kompozisyona 
bırakınız (Görsel 3.10).

Görsel 3.10: Kompozisyona “resim1.png” dosyasını ekleme

4. Adım: Çalışma alanına “resim1.png” dosyasının yerleştiğini görünüz (Görsel 3.11).

Görsel 3.11: Çalışma alanında “resim1.png” 

Görsel efekt yazılımında kompozisyona dışarıdan dosya ekleyiniz.

SIRA SİZDE
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DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Dosyayı File>Import>File menüsünden Project panele ekledi.

2. Sürükle bırak yöntemiyle dosyayı kompozisyona bıraktı.

3. Zamanı verimli kullandı.

3.2.4. Kompozisyonda Nesneyi Uygun Konumlandırmak

Kompozisyona bir nesne eklendiğinde çalışma alanının ortasında görüntülenir. Bu nesne, 
etrafındaki kutucuklardan tutularak boyutlandırılabilir ve sürükle bırak yöntemiyle çalışma 
alanında istenen yere konumlandırılabilir.

İşlem adımlarına göre kompozisyona eklenen nesnenin boyutunu küçültüp çalışma 
alanında sol üst köşeye yerleştiriniz.

1. Adım: 1024 piksel genişliğinde, 768 piksel yüksekliğinde yeni bir kompozisyon oluşturunuz.

2. Adım: File>Import>File menüsünden bilgisayardaki “resim1.png” dosyasını seçerek Project 
paneline ekleyiniz.

3. Adım: Project panelindeki  “resim1.png” dosyasını sürükle bırak yöntemiyle kompozisyona 
bırakınız.

4. Adım: Çalışma alanında yer alan nesneyi etrafındaki kutucuklardan tutarak küçültünüz 
(Görsel 3.12).

5. Adım: Çalışma alanındaki nesneyi sürükle bırak yöntemiyle sol üst köşeye yerleştiriniz 
(Görsel 3.13).

Görsel 3.12: “resim1.png” çalışma ekranında          Görsel 3.13: Nesnenin küçültülmesi ve taşınması

4. UYGULAMA
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Kompozisyona eklenen nesnenin boyutunu küçültüp nesneyi sağ üst köşeye 
yerleştiriniz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Yeni kompozisyon oluşturdu.

2. Dışarıdan bir dosyayı Project paneline ekledi.

3. Project panelindeki dosyayı sürükle bırak yöntemiyle kompozisyona yerleş- 
tirdi.

4. Çalışma alanındaki nesneyi küçülttü.

5. Çalışma alanındaki nesneyi sürükle bırak yöntemiyle sağ üst köşeye yerleş- 
tirdi.

3.2.5. Kompozisyonda Nesnelerin Görünüm Sırası

Kompozisyona birden fazla nesne eklendiğinde zaman çizelgesinde en üstte yer alan nesne 
(Görsel 3.14) çalışma alanında da diğer nesnelerin üstünde görünür (Görsel 3.15).

Görsel 3.14: Zaman çizelgesinde nesneler             Görsel 3.15: Nesnelerin görünüm sırası        

SIRA SİZDE
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Zaman çizelgesindeki katman sıraları değiştirilerek çalışma ekranında nesnelerin görünüm 
sırası da ayarlanabilir. “resim2.png” katmanı en üste alındığında (Görsel 3.16) çalışma ekranında 
da en üstte görünür (Görsel 3.17).

Görsel 3.16: “resim2.png” katmanı en üstte                         Görsel 3.17: “resim2.png” en üstte

Çalışma alanında nesnelerin görünüm sırasını değiştirmek için katmanların sırası sürükle 
bırak yöntemiyle değiştirilebilir. Bu sayede zaman çizelgesinde en üst katmandaki nesne, çalışma 
alanında da en üstte görünür. 

3.2.6. Kompozisyondaki Nesnenin Transform İşlemleri

Görsel efekt yazılımında kompozisyondaki nesnelerin çapa noktası, konumu, ölçeklendirmesi, 
dönüşü ve şeffaflığı ayarlanabilir. Kompozisyonda yer alan nesnelerden ayarı değiştirilecek 
nesnenin sol tarafındaki “>” işareti tıklanır ve nesnenin aşağısında Transform seçeneği görülür 
(Görsel 3.18).

Görsel 3.18: “resim2.png” nesnesine ait dönüşüm seçeneği

Dönüşüm seçeneğinin sol tarafındaki “>” işareti tıklandığında açılan seçeneklerden Görsel 
3.19’daki ayarlar yapılır.

Görsel 3.19: Transform seçenekleri

Anchor Point (Çapa Noktası): Çapa noktası tüm ölçekleme, döndürme ve konumsal 
hareketlerin temel alındığı noktadır. Nesne, çapa noktasına göre döner. Nesnenin tam orta noktası, 
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varsayılan olarak çapa noktası şeklinde ayarlanır. Çapa noktası nesnenin köşesine taşınmışsa 
ölçekleme veya döndürme işlemi bu köşeden yapılır. Nesne seçiliyken klavyeden “A” harfine 
basılırsa bu dönüşüm seçeneği açılır. 

Position (Konum): En çok kullanılan dönüşüm seçeneğidir. Çalışma alanında nesnenin X ve Y 
konumunu belirler. Üç boyutta çalışılırken Z derinlik ayarı da yapılır. Nesne seçiliyken klavyeden 
“P” harfine basılırsa bu dönüşüm seçeneği açılır.

Scale (Ölçeklendirme): Genişlik ve yükseklik olmak üzere iki değerle ayarlanır. Burada yer 
alan zincir simgesi (Görsel 3.20) tıklanarak, genişlik ve yükseklik ayarlarına bağımsız olarak değer 
verilir (Görsel 3.21). Nesnenin boyutu büyütülüp küçültülebilir. Nesne seçiliyken klavyeden “S” 
harfine basılırsa bu dönüşüm seçeneği açılır.

Görsel 3.20: Zincir simgesi aktif         Görsel 3.21: Zincir simgesi pasif

Rotation (Döndürme): Nesnelere dönüş hareketi eklemek için bu dönüşüm kullanılır. İki 
değerle ayarlanır. İlk değer, dönüş adedini; ikinci değer ise dönüş açısını belirler. Örneğin burada 
3x+180 değeri varsa nesne 3 tam tur döner ve 180 derece açı yapar. Bir başka deyişle 3,5 tur 
döner. Nesne seçiliyken klavyeden “R” harfine basılırsa bu dönüşüm seçeneği açılır.

Opacity (Şeffaflık): Nesnenin sahip olduğu şeffaflık miktarıdır. Buradaki değer %100 ise nesne 
tam görünür (opak) ve %0 ise nesne tamamen görünmez olur.  Nesne seçiliyken klavyeden “O” 
harfine basılırsa bu dönüşüm seçeneği açılır. 

İşlem adımlarına göre kompozisyona yerleştirilen nesneyi ters döndürünüz.

1. Adım: Kompozisyona yerleştirilmiş nesnelerden birini seçiniz.

2. Adım: Klavyeden “R” tuşuna basınız. Rotation dönüşümünü açınız.

3. Adım: Mouse sürükle bırak yöntemiyle veya klavyeden sayı girerek derece değerini 180 
yapınız (Görsel 3.22).

Görsel 3.23: “resim2.png” nesnesiGörsel 3.22: Rotation değerini değiştirme                                         

4. Adım: Çalışma alanında “resim2.png” nesnesini inceleyiniz (Görsel 3.23).

5. UYGULAMA
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Görsel efekt yazılımında kompozisyona eklenen nesneyi 270 derece döndürünüz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Kompozisyona yerleştirilen nesneyi seçti.

2. Klavyeden “R” tuşuna basıp Rotation dönüşümünü açtı.

3. Derece bölümüne 270 girdi.

4. Zamanı verimli kullandı.

3.2.7. Kompozisyonun Ön İzlemesi  

Yapılan animasyonun gerçek zamanlı olarak ön izlemesi (preview) yapılabilir. Ön izlemenin 
hızı ve kalitesi bilgisayarın sahip olduğu RAM miktarına bağlı olarak değişebilir. Görsel efekt 
yazılımında bir kompozisyonun ön izlemesini başlatmak için kullanılacak kısayollar şunlardır:

• Boşluk tuşu (Spacebar)

• Shift + boşluk tuşu

• Numerik klavyeden (Numpad)  0 tuşu

• Shift + Numerik klavyeden 0 tuşu 

• Alt + Numerik klavyeden 0 tuşu  

Her kısayol farklı bir ön izleme davranışı gerçekleştirir. Bu ön izleme davranışı tuşlara ön izleme 
ayarlarından atanır. Ön izleme kısayolları kullanılmadan menülerden yararlanılarak da ön izleme 
başlatılabilir.

• Window > Preview menüsü veya Ctrl + 3 kısayol tuşu ile açılan Preview panelinden Play 
simgesine basılarak ön izleme başlatılabilir (Görsel 3.24).

Görsel 3.24: Preview paneli ve Play simgesi

SIRA SİZDE
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• Composition>Preview>Play menüsünü kullanılarak da ön izleme başlatılabilir.

3.2.8. Kompozisyona Anahtar Kare Eklemek 

Keyframe (anahtar kare) kullanmak, görsel efekt yazılımında resim ve video gibi nesnelere 
çalışma alanında hareket vermek için en kolay ve en temel yöntemlerden biridir. Zaman 
çizelgesinde bir özelliğin değeriyle değişiklik oluşturmak için en az iki anahtar kare kullanılır. 
İlk anahtar kare değişimin başına, diğer anahtar kare ise belirli bir sürede değişecek değişimin 
sonuna yerleştirilir (Görsel 3.25).

Görsel 3.25: Anahtar karelerin yerleşimi

İşlem adımlarına göre nesneye soldan sağa doğru ikinci saniyeden başlayıp dör- 
düncü saniyede biten bir hareket ekleyiniz.

1. Adım: Soldan sağa hareket eklenecek nesneyi seçiniz.

2. Adım: Transform seçeneklerini açınız.

3. Adım: Current Time Indicator (bulunulan zaman göstergesi) mouse sürükle bırak yöntemiyle 
zaman çizelgesinde ikinci saniye üzerine getiriniz (Görsel 3.26).

Görsel 3.26: Current Time Indicator (CTI) ikinci saniye üzerinde

6. UYGULAMA
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4. Adım: Position yazısının sol tarafındaki kronometre simgesine tıklayınız ve ilk anahtar kareyi 
ikinci saniyeye yerleştiriniz (Görsel 3.27).

Görsel 3.27: Position dönüşümünün ikinci saniyesinde anahtar kare

5. Adım: CTI simgesini zaman çizelgesinde dördüncü saniyeye yerleştiriniz (Görsel 3.28).

Görsel 3.28: CTI simgesi dördüncü saniyede

6. Adım: Add or remove keyframe simgesine tıklayınız (Görsel 3.29).

Görsel 3.29: Anahtar kare ekle / kaldır simgesi

7. Adım: Dördüncü saniyeye anahtar kare eklendikten sonra Position dönüşümünün X 
değerine 805 giriniz (Görsel 3.30).

Görsel 3.30: Nesneyi soldan sağa doğru hareket ettirme
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Görsel efekt yazılımında kompozisyona eklenen nesneyi 5. saniyeden 10. saniyeye 
soldan sağa hareket ettiriniz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Kompozisyona yerleştirilen nesneyi seçti.

2. Transform seçeneklerini açtı.

3. CTI simgesini 5. saniyeye getirdi.

4. Position dönüşümünün sol tarafındaki kronometre simgesini tıkladı.

5. CTI simgesini 10. saniyeye getirdi.

6. Position dönüşümünün sol tarafındaki anahtar kare ekle / kaldır simgesine 
tıkladı.
7. Position dönüşümünün X koordinatına ilk değerden daha büyük bir değer 
girdi.

3.2.9. Kompozisyondan Anahtar Kareleri Silmek

Kompozisyonda bulunan katmanlardaki anahtar kareleri silmek için şu yöntemlerden biri 
kullanılabilir:

• Tek bir anahtar kare silinecekse o anahtar kare mouse ile seçilir ve klavyeden Delete tuşuna 
basılır. Birden fazla anahtar kare silinecekse tüm anahtar kareler Shift tuşuna basılı tutulurken 
mouse ile seçilir ve Delete tuşuna basılır.

SIRA SİZDE
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• CTI üzerindeki anahtar kare silinecekse anahtar kare ekle / kaldır simgesi tıklanır. Görsel 
3.31’de CTI, dördüncü saniyede yer alan anahtar karenin üzerinde bulunur. Anahtar kare ekle / 
kaldır simgesine tıklandığında dördüncü saniyedeki anahtar kare silinir. 

Görsel 3.31: Anahtar kare ekle / kaldır simgesi 

• Bir dönüşüme ait anahtar karelerin tamamı silinmek isteniyorsa dönüşümün sol tarafındaki 
kronometre simgesine tıklanır. Görsel 3.32’deki kronometre simgesi tıklanırsa Position 
dönüşümündeki tüm anahtar kareler silinir.

Görsel 3.32: Kronometre simgesi

3.2.10. Kompozisyonda Anahtar Kareleri Taşımak

Anahtar kareler birbirine yaklaştırmak veya uzaklaştırmak için taşınabilir. Taşınarak birbirine 
yaklaştırılan anahtar karelerde dönüşüm daha hızlı, taşınarak birbirinden uzaklaştırılan anahtar 
karelerde dönüşüm daha yavaş gerçekleşir. Anahtar kareleri taşımak için kullanılan yöntemler 
şunlardır:

• Yeri değiştirilmek istenen anahtar kare mouse sürükle bırak yöntemiyle istenen zamana 
bırakılır.

• Yeri değiştirilmek istenen anahtar kare seçilir. Ctrl + X tuşlarına basılır. CTI, istenen zaman 
üzerine getirilir ve klavyeden Ctrl + V tuşlarına basılır.

• Yeri değiştirilmek istenen anahtar kareler Shift tuşuna basılı tutularak seçilir. Ctrl + X tuşlarına 
basılır. CTI, istenen zaman üzerine getirilir ve klavyeden Ctrl + V tuşlarına basılır. 
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3.2.11. Kompozisyonda Grafik Editör Kullanmak

Görsel efekt yazılımında nesnelere dönüşüm verilirken anahtar karelerin yanı sıra grafik editör 
de kullanılabilir. Grafik editör kullanabilmek için en az iki anahtar karenin zaman çizelgesinde 
olması işleri kolaylaştırır. Görsel 3.33’te soldan sağa dördüncü saniye başlayan hareket, on altıncı 
saniyede biter. CTI, onuncu saniyede animasyonun tam ortasındadır.

 Görsel 3.33: Soldan sağa hareket ve grafik editör simgesi

Grafik editör simgesi tıklandığında zaman çizelgesi yerini temel bir grafik düzenleme 
tablosuna bırakır (Görsel 3.34). Bu tabloda Position dönüşümünün X koordinatını kırmızı çizgi, Y 
koordinatını ise yeşil renkli çizgi ifade eder. Kırmızı renkli çizgi mouse ile tıklanarak aşağı doğru 
hareket ettirildiğinde X konumu azalır, kırmızı renkli çizgi mouse ile tıklanarak yukarı doğru hareket 
ettirildiğinde X konumu artar. Kırmızı renkli çizgi mouse ile sağa hareket ettirildiğinde hareketin 
süresi artar, kırmızı renkli çizgi sola hareket ettirildiğinde hareketin süresi azalır. Grafikteki yeşil 
renkli çizgi de benzer şekilde mouse ile  aşağı ve yukarı hareket ettirilebilir.

Görsel 3.34: Grafik editör paneli

3.3. KATMANLAR
Project paneline dışarıdan aktarılan video, resim, yazı, ses vb. dosyalar, hazırlanan 

kompozisyona dâhil edilerek zaman cetveline eklendiğinde katmanlar oluşturulur. Her katman, 
zaman cetveli panelinde belirli bir hiyerarşik düzende sıralanır. Standart olarak en üstte bulunan 
katman, Composition panelinde en önde görüntülenir.
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Her katman kendi içinde düzenlenebilir. Katmanlara efekt, yazı, maskeleme, hareketlendirme 
gibi eklemeler yapılabilir. Ayrıca katmanlar birbiriyle ilişkilendirilerek farklı görsel etkiler 
oluşturulabilir.

3.3.1. Kompozisyona Layer Menüsünden Katman Eklemek

Kompozisyon oluşturulduktan sonra katman eklemek için Menü çubuğundan Layer>New 
seçilir. Açılan listede istenen katman türüne tıklanır (Görsel 3.35). Katman panelinde boş bir 
noktaya farenin sağ tuşuyla tıklanarak da aynı menüye ulaşılır.

Görsel 3.35: Kompozisyona yeni katman ekleme menüsü

Seçilen katmanın türüne göre bir ayarlama penceresi açılır. Açılan pencerede istenen özellikler 
belirlendikten sonra OK düğmesine tıklanır. Seçilen katman, kompozisyona ve zaman çizelgesinin 
katman bölümüne eklenir.

Solid Layer (Katı katman) ile istenen renkte, isimde, çözünürlükte ve süresi kompozisyon 
ile aynı uzunlukta bir katman oluşturulur. Solid Layer genellikle arka plan katmanı olarak veya 
üzerine efekt panelinden eklenen efektlerle birlikte kullanılır.
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1. Adım: Katman panelinde bir Solid katmanı oluşturmak için Layer>New>Solid düğme- 
lerini sırayla tıklayınız. Oluşturulacak Solid katmanının ayarlarının yapıldığı Solid Settings (Solid 
Ayarları) menüsü açılacaktır (Görsel 3.36).

Görsel 3.36: Solid katmanı ayarlama menüsü

2. Adım: Açılan Solid Settings menüsünde aşağıdaki işlemleri gerçekleştiriniz (Görsel 3.36).

• Name alanında kompozisyona eklenecek katmanın ismini belirleyiniz (A).

• Width ve Height alanında genişlik ve yükseklik piksel değerlerini girerek katmanın çözünürlük 
değerini belirleyiniz (B).

• Units (üniteler) alanında  birim değerini piksel olarak belirleyiniz (C). Projenin türüne göre 
birimler piksel değerinin yanı sıra inç veya milimetre cinsinden de hesaplanabilir.

• Pixel Aspect Ratio (piksel en ve boy oranı) alanında pikselin en ve boy oranını belirleyiniz (D). 
Bu alanı Square Pixels (kare pikseller) değerine ayarlamak, katmanı döndürme gibi animasyonlar 
uygulandığında katmanın şeklinin bozulmasını önleyecektir.

• Make Comp Size butonuna tıklayınız (E).  Bu butona tıkladığınızda eklenecek Solid katmanının 
çözünürlük değeri, oluşturulan kompozisyonun çözünürlük değerini alacaktır.

• Renk alanında katmanın sahip olacağı rengi belirleyiniz (F). Damlalık aracı kullanılarak da 
istenen renk seçilebilir.

7. UYGULAMA

İşlem adımlarına göre kompozisyona Solid katmanı ekleyiniz.
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3. Adım: Ayarlamaları tamamladıktan sonra OK düğmesine tıklayınız. Oluşturduğunuz katmanı 
zaman çizelgesi panelinde görüntüleyiniz (Görsel 3.37).

Görsel 3.37: Solid katmanı eklendiğinde sahnenin görünümü

Solid katmanda herhangi bir değişiklik istenirse zaman çizelgesi panelinde Solid katmanı 
seçildikten sonra Menü çubuğundan Layer>Solid Settings seçilerek Solid Settings menüsü açılır 
ve istenen değişiklikler yapılır.

4. Adım: Kompozisyona Text (yazı) katmanı eklemek için Layer>New>Text düğmelerini sırayla 
tıklayınız (Görsel 3.38).

Görsel 3.38: Kompozisyona Text katmanı ekleme

Zaman çizelgesi panelinde Solid katmanının üstüne Text katmanı Empty Text Layer (Boş yazı 
katmanı) ismiyle eklenir (Görsel 3.39).



                                                Hareketli Görüntüler 165

Görsel 3.39: Zaman çizelgesi panelinde Text katmanı

5. Adım: Text katmanını kullanarak sahneye yazı eklemek için kompozisyon panelinde Solid 
katmanı üzerindeki herhangi bir boş noktaya farenizin sol düğmesi ile tıklayınız. Klavyeden 
istediğiniz yazıyı yazınız (Görsel 3.40).

Görsel 3.40: Text katmanı ile yazı oluşturma

Katman bölümündeki Transform menüsünde bulunan Scale değerleri, katmanın X ve Y 
eksenlerindeki büyüklüklerini değiştirmek için kullanılır (Görsel 3.41).

6. Adım: Yazı katmanının yanındaki ok simgesine basıp, açılan Transform menüsününde Scale 
değerini artırarak eklenen yazının boyutunu büyütünüz.

Transform menüsünde bulunan Position değerleri katmanın X ve Y eksenlerindeki konumlarını 
değiştirmek için kullanılır (Görsel 3.41).

7. Adım: Position değerlerini değiştirerek yazıyı ekranın ortasına taşıyınız.

Görsel 3.41: Transform menüsü



                 Hareketli Görüntüler166

Bir katmanı diğerinden ayırmak için her katmanın renk etiketi bulunur. Bu renkler isteğe göre 
değiştirilebilir.

8. Adım: Katman rengini değiştirmek için Solid katmanın solundaki renkli kutucuğa tıklayınız 
ve açılan menüden dilediğiniz bir rengi seçiniz (Görsel 3.42).

Görsel 3.42: Katman rengini belirleme

Katmanın solunda soldan sağa doğru sırasıyla göz, hoparlör, nokta ve kilit simgeleri bulunur 
(Görsel 3.43).

Görsel 3.43: Katman özellikleri

Katmana ait satırda bulunan bu simgelerden Göz (Hides Video-Videoyu gizle) tıklanarak 
kapatıldığında o katman kompozisyon panelinde gizlenir. Göz simgesine tekrar tıklandığında 
ise katman kompozisyon panelinde görünür hâle gelir. Hoparlör (Mutes Audio-Sesi kapat) 
düğmesine tıklandığında o katmanın sesi kapanır. Hoparlör simgesine tekrar tıklandığında 
katmanın sesi açılır. Nokta (Solo-hides all non solo video-İşaretli olmayan tüm katmanları gizle) 
simgesine tıklandığında o katman dışındaki tüm katmanlar kompozisyon panelinde gizlenir. Nokta 
simgesine tekrar tıklandığında gizlenen katmanlar gösterilir. Kilit (Lock) simgesine tıklandığında 
katman, zaman çizelgesi panelinde seçilemez hâle gelir. Kilit simgesine tekrar tıklandığında 
katman seçilebilir.

9. Adım: Katmanları gösterme, gizleme, kilitleme özelliklerini kullanarak sonuçları 
gözlemleyiniz.
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Kompozisyona eklenebilecek diğer katmanlar şunlardır:

Light Layer (Işık Katmanı): Üç boyutlu çalışmalarda sanal ışık kaynağı oluşturmak için kullanılır.

Camera Layer (Kamera Katmanı): Üç boyutlu çalışmalarda sanal kamera oluşturmak için 
kullanılır.

Null Object (Boş Obje Katmanı): Null Object katmanı, diğer katmanları kendine bağlamaya 
yarayan gizli bir katmandır.

Shape Layer (Şekil Katmanı): Kompozisyona şekil eklemek için kullanılır.

Adjustment Layer (Ayarlama Katmanı): Katmanla ilgili efektler, Adjustment Layer oluşturularak 
katmana eklenir. Adjustment Layer sadece altındaki katmanları etkiler. 

Yeni eklenen katman, zaman çizelgesinde varsayılan olarak üstte konumlanır. Böylece bu 
katman kompozisyon penceresinde de üstte görünür.  

Her katmanın standart olarak Transform özelliği vardır. Katmanlar türlerine göre Transform 
menüsü dışında farklı işlemler için kullanılan menülere sahiptir (Görsel 3.44).

Görsel 3.44: Katman özellikleri

3.3.2. Layer Menüsünden Katman Özelliklerini Değiştirmek

Layer menüsünde bulunan seçenekler, katmanlarla çalışılırken ihtiyaç duyulan komutları 
içerir. Layer menüsünde bulunan seçeneklerin birçoğu Katman panelindeki katman seçilerek 
farenin sağ tuşuna tıklandığında da açılır. Bu seçenekler panellere, araçlara, simgelere,  
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açılır menülere de eklenerek kullanım kolaylığı sağlanır (Görsel 3.45).

Görsel 3.45: Layer menüsü

Layer menüsü katmanlara maske, katman stili, karıştırma modları, işaret, efekt, tracker 
eklemek; katmanları düzenlemek, dönüştürmek ve gruplamak; videonun hızını artırmak, 
azaltmak veya ters çevirmek gibi birçok komut içerir.

3.3.2.1. Karışım Modları (Blending Modes)

Karışım Modları, eklendiği katman ile altındaki katmanı farklı ölçütler kullanarak birleştirir. 
Bunun sonucunda farklı dinamik renk etkilerine sahip görseller ve videolar ortaya çıkar.  
Karıştırma etkisi sadece modun eklendiği katmanla altındaki katman arasında olur. 

İşlem adımlarına göre görsellere karışım modu uygulayınız.

1. Adım: Kompozisyona iki adet görsel ekleyiniz (Görsel 3.46.a, Görsel 3.46.b).

8. UYGULAMA
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Görsel 3.46.a: Kompozisyona eklenen 1. görsel Görsel 3.46.b: Kompozisyona eklenen 2. görsel

2. Adım: Zaman çizelgesinde üstte bulunan katmana farenin sağ tuşuyla tıklayınız. Açılan 
listeden Blending Mode düğmesini seçerek Karışım Modları menüsünü açınız. Listeden Screen 
karışım modunu seçiniz (Görsel 3.47).

Görsel 3.47: Karışım modları
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Karışım Modu alanı, Katman panelinin altındaki Toggle Switches / Modes düğmesine 
tıklanarak panelde görünür hâle getirilir (Görsel 3.48).

Görsel 3.48: Toggle Switches / Modes düğmesi

3. Adım: Screen karışım modu kullanılarak birleştirilmiş iki görseli inceleyiniz (Görsel 3.49).

Görsel 3.49: Screen karışım modu etkisi

İşlem adımlarına göre görsellere karışım modu uygulayınız.

1. Adım: Yeni bir proje dosyası oluşturmak için sırasıyla sol üst köşede bulunan  
File>New>New Project düğmelerini seçiniz (Görsel 3.50).          

Görsel 3.50: Yeni proje oluşturma

9. UYGULAMA
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2. Adım: Yeni projede yeni kompozisyon oluşturmak için ekranın üst tarafındaki menüde 
sırasıyla Composition>New Composition seçeneklerini seçiniz (Görsel 3.51).         

Görsel 3.51: Yeni kompozisyon oluşturma

3. Adım: Açılan Composition seçenekleri penceresinde kompozisyon ayarlarını Görsel 
3.52’deki gibi yaparak OK düğmesine basınız.

Görsel 3.52: Kompozisyon ayarları



                 Hareketli Görüntüler172

4. Adım: Karışım modları uygulanacak görselleri (Görsel 3.53)  önce proje penceresine daha 
sonra zaman çizelgesine ekleyiniz (Görsel 3.54).  

Görsel 3.53: Karışım modları uygulanacak görseller

Görsel 3.54: Görselleri projeye dâhil etme

5. Adım: Zaman çizelgesinde “Bulutlar” görselini seçiniz. Composition panelinde “Bulutlar” 
görselinin kenarlarındaki noktaları farenizin sol tuşuyla tutarak “Sahil” görselindeki gökyüzünün 
kapladığı alanı hizalayacak şekilde küçültünüz (Görsel 3.55).

Görsel 3.55: Görselleri kompozisyon penceresine yerleştirme
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6. Adım: Karışım modu eklemek için zaman çizelgesi penceresinde Bulutlar katmanının 
sağında bulunan Mode değerini Screen olarak değiştiriniz. Oluşan etkiyi gözlemleyiniz (Görsel 
3.56).

Görsel 3.56: Karışım modu ekleme

3.3.3. Katman Stilleri (Layer Styles)

Katmanlara ışık, gölge, kenarlık ve kabartma efektleri eklemek için Layer Styles kullanılır.
Katman panelinde katmana farenin sağ tuşuyla tıklanır. Açılan menüden Layer Styles seçilerek 

Katman Stilleri menüsü açılır. Hepsini Göster (Show All) seçeneği, bütün stilleri katmana ekler. 
Hepsini Kaldır (Remove All) seçeneği ise katmandaki bütün stilleri kaldırır (Görsel 3.57).

Görsel 3.57: Katman stilleri
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İnternetten bulacağınız veya öğretmeninizin dağıtacağı 2 adet görseli katman 
bölümüne ekleyerek üst katmanda bulunan görsele sırasıyla Hue (ton), Saturation 
(doygunluk), Color (renk) karışım modlarını ekleyiniz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Yeni proje oluşturdu.

2. Yeni kompozisyon oluşturdu.

3. Görselleri Project paneline ekledi. 

4. Görselleri Katman bölümüne ekledi.

5. Üst katmanda bulunan görsele Hue karışım modunu ekledi.

6. Üst katmanda bulunan görsele Saturation karışım modunu ekledi.

7. Üst katmanda bulunan görsele Color karışım modunu ekledi.

İşlem adımlarına göre katmanlara katman stilleri ekleyiniz.

1. Adım: Zaman çizelgesine bir Text katmanı ekleyiniz. Text katmanını Transform menüsünde 
bulunan Scale değerini değiştirerek büyütünüz. Text katmanını Transform menüsünde bulunan 
Position değerini değiştirerek ekranın ortasına taşıyınız (Görsel 3.58).

SIRA SİZDE

10. UYGULAMA
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Görsel 3.58: Yeni Text katmanı ekleme

2. Adım: Yazının etrafına bir çerçeve eklemek için Text katmanına farenin sağ tuşuyla tıklayınız 
ve Layer Styles>Stroke seçerek ekleyiniz (Görsel 3.59).

Görsel 3.59: Stroke katman stili
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Composition panelinde görüntülenen Text katmanının etrafında çerçeve oluşur. Ayrıca zaman 
çizelgesi panelinde katmana ait Layer Styles başlığı altında Stroke komutuna özel ayarların geldiği 
görülür (Görsel 3.60).

Görsel 3.60: Text üzerinde Stroke katman stili etkisi

Text katmanı içine eklenen Stroke menüsü altındaki ayarlar şunlardır:

Blend Mode: Text katmanının altındaki katman ile yazı çerçevesi arasındaki karışım modunu 
belirler.

Color: Çerçeve rengini belirler.

Size: Çerçeve kalınlığını ayarlar.

Opacity: Çerçeve görünürlüğünü ayarlar.

Position: Yazı etrafındaki çerçevenin yazının neresinde hizalanacağını ayarlar.

3. Adım: Text katmanının etrafına eklediğiniz çerçevenin renk, boyut, opaklık, konum gibi 
özelliklerini değiştirerek oluşturduğunuz etkileri Composition panelinde gözlemleyiniz.

4. Adım: Katman stillerini kullanarak, Text katmanına eklenen çerçevenin belli aralıklarla yanıp 
sönmesi animasyonunu oluşturmak için öncelikle zaman çizelgesinde imleci 0. kare konumuna 
alınız. 

5. Adım: Stroke katman stilinin altında bulunan Opacity ayar düğmesinin solundaki kronometre 
düğmesine tıklayarak 0. kareye anahtar kare eklenmesini sağlayınız.

6. Adım: Zaman çizelgesinde imleci 1. kare konumuna alınız.  Opacity değerini 0 olarak 
ayarlayınız. 1. kare konumuna otomatik olarak anahtar kare eklenecektir.
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7. Adım:  Zaman çizelgesinde imleci 10. kare konumuna alınız. Opacity değerinin en solunda 
bulunan anahtar kare simgesine tıklayarak 10. kare konumuna anahtar kare ekleyiniz (Görsel 
3.61).

Görsel 3.61: Anahtar kare ekleme

8. Adım: Zaman çizelgesinde imleci 11. kare konumuna alınız. Opacity değerini 100 olarak 
ayarlayınız. 11. kare konumuna otomatik olarak anahtar kare eklenecektir.

9. Adım: Zaman çizelgesine eklenen anahtar kareleri farenizin sol düğmesiyle sürükleyerek 
seçiniz (Görsel 3.62).

Görsel 3.62: Anahtar kareleri seçme

10. Adım: Klavyenizden Ctrl+C tuşlarına basarak seçilen anahtar kareleri kopyalayınız. Zaman 
çizelgesinde imleci 20. kare konumuna alınız. Kopyalanan anahtar kareleri yapıştırmak için 
klavyenizden Ctrl+V tuşlarına basınız.

11. Adım: Klavyenizden boşluk tuşuna basarak oluşturduğunuz animasyonu oynatınız.
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12. Adım: Projeyi kaydetmek için sol üst köşedeki File>Save As düğmelerine sırasıyla basınız 
(Görsel 3.63).

Görsel 3.63: Projeyi kaydetme

13. Adım: Açılan pencerede Dosya adı kısmına bir dosya ismi  girdikten ve dosyanın 
bilgisayarınızda nereye kaydedileceğini belirledikten sonra Kaydet düğmesine basınız (Görsel 
3.64).

Görsel 3.64: Proje dosyasına isim verme
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İşlem adımlarına göre katmanları kullanarak Pre-composition oluşturunuz.

1. Adım: Yazılımı çalıştırdıktan sonra daha önce kaydedilen proje dosyasını açmak için sol 
üst köşede bulunan File>Open düğmelerine sırasıyla basınız (Görsel 3.65). Açılan pencerede 
dosyanın kayıtlı olduğu yerde proje dosyasını seçtikten sonra Tamam butonuna basınız.

Görsel 3.65: Kaydedilen proje dosyasını açma

2. Adım: Açılan projede zaman çizelgesi panelinde bulunan iki katmanı farenizin sol tuşuna 
basılı tutup sürükleyerek seçiniz (Görsel 3.66).

Görsel 3.66: Katmanları seçme

3.3.4. Pre-composition Oluşturmak

Büyük projelerde, çalışılan Katman panelinde çok fazla sayıda katman bulunabilir. İki veya 
daha fazla katmanın bir araya getirilerek tek bir katmanmış gibi işlem yapılabildiği durumlarda 
Pre-composition (Ön kompozisyon) oluşturulur. Oluşturulan Pre-composition, yeni bir isim 
verilip ana kompozisyona katman olarak eklenebilir. Böylece Katman panelindeki yığılma ve 
karmaşa önlenir.

11. UYGULAMA
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3. Adım: Farenizin sağ tuşuna tıklayarak, açılan pencerede Pre-compose...  seçeneğini seçerek 
ön kompozisyon ayarlarının yapıldığı pencereyi açınız (Görsel 3.67). 

Görsel 3.67: Pre-compose... seçeneği ile ön kompozisyon oluşturma

4. Adım: Açılan pencerede New composition name alanında yeni oluşturulacak ön 
kompozisyona bir isim veriniz. Önceki kompozisyonda yapılan tüm animasyon ve efektlerin 
ön kompozisyona taşınmasını sağlamak için Move all attributes in to the new composition 
seçeneğini işaretleyiniz. Ardından OK düğmesine basarak işlemi tamamlayınız (Görsel 3.68).

Görsel 3.68: Pre-compose ayarları
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Oluşturulan ön kompozisyon, ana kompozisyon içine katman olarak eklenir (Görsel 3.69). 
Ön kompozisyon içindeki katmanlara müdahale etmek gerekirse oluşturulan ön kompozisyona 
farenin sol düğmesiyle çift tıklanarak katmanlara erişilebilir.

Görsel 3.69: Ön kompozisyonun ana kompozisyonda katman olarak bulunması

3.4. ZAMAN CETVELİ (TIMELINE)
Timeline, kompozisyonun ve katmanların sürelerini gösteren bir paneldir. Katmanların sahip 

olduğu konum, boyut, görünürlük gibi birçok özelliği ile animasyonlar oluşturmak için zaman 
cetveli panelinde süre çubuklarına anahtar kareler eklenir. 

3.4.1. Zaman Cetvelinin İşlevleri

Zaman cetveli, içinde katman bölümünü de bulunduran bir paneldir. Katman bölümünde 
bulunan materyaller belli bir hiyerarşik düzene göre alt alta sıralanır. Materyallerin karşısında ise 
katmanların süresinin gösterildiği zaman çubuğu bulunur (Görsel 3.70).

Görsel 3.70: Zaman cetveli
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A. Zaman Gezgini Çubuğu
B. Zaman Cetveli
C. Çalışma Alanı (Kompozisyon) Süre Çubuğu
D. Kompozisyon Ön-render Göstergesi
E. Katman Süre Çubuğu
F. Zaman İmleci
G. Zaman Cetveli Zoom Kaydırıcı
H. Kompozisyon İşaretleyici (Marker) Bölmesi
 I. Kompozisyona Dönme Simgesi

Zaman Gezgini Çubuğu (A): Çalışma alanını yakınlaştırarak zaman imlecinin,  zaman cetvelinde 
her bir kareye daha kolay erişmesini sağlar. Zaman gezgini çubuğu, başından veya sonundan 
tutulup sürüklenerek istenen zaman aralığında yakınlaştırma yapılır (Görsel 3.71).

Görsel 3.71: Zaman gezgini çubuğu

Zaman Cetveli (B): Kompozisyonun süresini gösterir. Her kompozisyon için ayrı zaman 
cetveli oluşur. Bu süre kompozisyon ayarlarından değiştirilebilir. Katman süreleri kompozisyon 
süresinden uzun olamaz. 

Çalışma Alanı Süre Çubuğu (C): Kompozisyonun çıktıda kullanılacak bölümünü gösterir. Bu 
çubuğun gösterdiği alanın dışında kalan süreler render edilmez. Kompozisyon üzerinde çalışılırken 
kompozisyonun sadece bir kısmı çıktı olarak kullanılmak istenirse zaman cetvelinin bir bölümü 
Çalışma Alanı olarak belirlenir. Çalışma alanı iki farklı yolla ayarlanabilir.

1. Yol: Süre Çubuğu, başından veya sonundan tutularak sürüklenir (Görsel 3.72).

Görsel 3.72: Çalışma alanı süre çubuğu

2. Yol: Çalışma alanının başlangıç zamanını belirlemek için zaman imleci istenen süreye 
getirilerek klavyeden B düğmesine basılır. Çalışma alanının bitiş zamanını belirlemek için zaman 
imleci istenen süreye getirilerek klavyeden N düğmesine basılır. 

5 ve 20. kareler arasında 
yakınlaştırma yapılması

5 ve 10. kareler ara- 
sında yakınlaştırma  
yapılması

Çalışma alanı 1 ve 2.  
saniye olarak belirlendi.
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Zaman cetvelini yeni oluşan çalışma alanı süre çubuğuna göre ayarlamak için çalışma alanı 
süre çubuğu üzerinde farenin sağ tuşuna tıklanır. Açılan listede Trim Comp to Work Area seçilir 
(Görsel 3.73).

Görsel 3.73: Çalışma alanı ayar menüsü

Kompozisyon Ön Render Göstergesi (D): Oluşturulan kompozisyonun çıktı alınmadan önce 
ön izleme yapılması istendiğinde ön render edilip edilmediğinin görüldüğü alandır. Ön render 
edilmemiş alanlar ön izleme sırasında gerçek zamanlı olarak izlenemez. Bu durum, videolarda 
donmalara veya yavaşlamalara yol açar. Ön render edilmiş alanlar, ön render göstergesinde yeşil 
renkte gösterilir. Bu işlem, klavyeden boşluk tuşuna basılıp, video oynatıldığında otomatik olarak 
başlar (Görsel 3.74).

Görsel 3.74: Ön render göstergesi

Katman Süre Çubuğu (E): Katman süresini gösterir. Her katmanın kendine ait bir süre çubuğu 
vardır. Projeye aktarılan (import) fotoğrafların ve çalışma alanında oluşturulan katmanların (Text, 
Shape, Null, Camera vb.) süresi, kompozisyon süresi kadardır. 

Projeye aktarılan video ve ses dosyalarının süresi kompozisyon süresinden kısa ise katman 
süre çubuğu video ve ses dosyalarının süresine denk uzunlukta oluşur (Görsel 3.75).

Görsel 3.75: Katman süre çubuğu
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Kompozisyona eklenen materyalin süresi kompozisyonun süresinden uzun ise zaman 
cetvelinde oluşan süre çubuğu, kompozisyon süresi kadardır. Video katmanına ait süre çubuğu 
farenin sol düğmesine basılı tutularak sağdan sola doğru çekildiğinde görüntü, süre çubuğunun 
çekildiği süre kadar başından kırpılır ve devamındaki görüntü süresi süre çubuğunun sonuna 
eklenir (Görsel 3.76).

Görsel 3.76: Video süresinin kompozisyon süresinden uzun olması durumu

3.4.1.1. Katman Süresini Uzatmak veya Kısaltmak

Projeye aktarılan fotoğrafların ve çalışma alanında oluşturulan katmanların  süresini uzatmak 
veya kısaltmak için fare imleci, katman süre çubuğunun uç noktalarına götürüldüğünde imleç 
sağı ve solu gösteren oklara dönüşür. Farenin sol düğmesine basılı tutulup, fare sürüklenerek 
katman süresi uzatılabilir veya kısaltılabilir (Görsel 3.76). Video ve ses dosyalarının süreleri kendi 
sürelerinden daha fazla uzatılamaz fakat bu süreler başından veya sonundan kırpılabilir (Görsel 
3.77).

Görsel 3.77: Süre çubuğunun başından ve sonundan kırpılması

Farenin imleci katman süre çubuğunun orta bölgelerindeyken farenin sol tuşuna basılı tutulup, 
fare sağa veya sola sürüklenerek katman süre çubuğunun yeri değiştirilebilir (Görsel 3.78).

Görsel 3.78: Katman süre çubuğunun yerinin değiştirilmesi

3.4.1.2. Katman Süresini Kesmek

Katmanın belirli bir bölümünün görünmesi istendiğinde katman süresi kesilerek sadece 
görünmesi istenen alan bırakılır. Geçerli Zaman Göstergesi, katman süre çubuğunun üzerinde 
istenen zamana getirilir. Klavyeden Ctrl+Shift+D tuşlarına birlikte basıldığında katman o süreden 
itibaren iki katmana ayrılır (Görsel 3.79). 

Katman süre çubuğu 1 ve 10. saniyeler arasında

Katman süre çubuğu 10 ve 20. saniyeler arasında
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Görsel 3.79: Katman süre çubuğunun istenen zamandan kesilmesi

Silinmek istenen katman seçilerek klavyeden Delete tuşuna basılır.

3.5. YAZI OLUŞTURMAK
Görsel efekt programında kompozisyona istenen özelliklerde yazılar eklenerek bu yazılarla 

animasyonlar oluşturulabilir. Yazı özelliklerinin belirlenebilmesi için Character (Karakter) ve 
Paragraph (Paragraf) panellerinin çalışma alanına eklenmesi gerekir.

Character ve Paragraph panellerini çalışma alanına eklemek için Menü çubuğundan  
Windows>Character ve Paragraph panelleri seçilir (Görsel 3.80).

Görsel 3.80: Character ve Paragraph panellerinin çalışma alanına eklenmesi

Video katmanı

Video katmanı 2 katmana bölündü.

Video katmanı 3 katmana bölündü.

Ctrl + Shift + D

Ctrl + Shift + D



                 Hareketli Görüntüler186

Oluşturulmak istenen yazının karakter özelliklerini belirlemek için ekranın sağında bulunan 
Character paneli kullanılır (Görsel 3.81).

Görsel 3.81: Character paneli

Oluşturulmak istenen yazının paragraf özelliklerini belirlemek için ekranın sağında bulunan 
Paragraph paneli kullanılır (Görsel 3.82).

Görsel 3.82: Paragraph paneli

Fare imleci Character panelinin üzerindeyken farenin sol düğmesine basılarak panel genişletilir 
ve yazı karakteri özellikleri açılır (Görsel 3.83).

Görsel 3.83: Character paneli simgelerinin açıklamaları

Fare imleci Pharagraph panelinin üzerindeyken farenin sol düğmesine basılarak panel geniş- 
letilir ve paragraf özellikleri açılır (Görsel 3.84).

Görsel 3.84: Paragraph paneli simgelerinin açıklamaları

Font özelliği (kalın, italik) ayarlanır.
Yazı tipi (font) ayarlanır. Karakter çerçeve rengi belirlenir.

Satırlar arasındaki boşluk miktarı ayarlanır.
Harfler arasındaki boşluk miktarı ayarlanır.

Kenarlık yönü belirlenir.
Harflerin genişliği ayarlanır.
Karakterler arasındaki boşlukların 

sıkıştırılması oranı (tsume) ayarlanır.

Kalın, italik, büyük harf, alt simge, üst 
simge gibi yazı özellikleri belirlenir.

Yazı rengi belirlenir.

Yazı boyutu ayarlanır.

Kenarlık kalınlığı ayarlanır.
Harflerin uzunluğu ayarlanır.

sağa yaslı sola yaslıortaya yaslı

Karakter aralığı (Kerning) 
referans sistemi belirlenir.

Harflerin çapa noktasına (anchor 
point) göre yüksekliği ayarlanır.

Paragrafı çapa noktasından 
(anchor point) sağa ya da 

sola ötelemek için kullanılır.

Paragraftan önce ya da sonra  boşluk 
bırakmak için kullanılır.

Paragrafın satır başı miktarını ve yazıyı 
oluştururken imlecin sağa doğru mu 

yoksa yazının sola doğru mu ilerlemesi 
gerektiği belirlenir.

Yazı olarak ayarlanır.
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3.5.1. Kompozisyona Yazı Katmanı Eklemek

Oluşturulan kompozisyona yazı katmanı eklemek için farklı yollar kullanılabilir. Birinci yol, araç 
çubuğunda bulunan ve T şeklinde gösterilen Horizontal Type Tool (Yatay harf aracı) düğmesinin 
seçilerek aktifleştirilmesidir (Görsel 3.85).

Görsel 3.85: Horizontal Type Tool düğmesi

Composition panelindeki sahnede yazı oluşturulmak istenen alana farenin sol düğmesiyle 
tıklanarak klavyeden istenen yazı girilir. Bu sırada zaman çizelgesinin katman bölümünde adını, 
yazılan yazının ilk kelimelerinden alan bir yazı katmanı oluşur. Yazı katmanı kendi içinde birçok 
özelliği barındırır. Horizontal Type Tool düğmesini aktif hâle getirmek için kullanılan kısayolu  
Ctrl+T’dir.

Oluşturulan kompozisyona yazı katmanı eklemenin başka bir yolu ise zaman çizelgesi 
panelinde katmanların bulunduğu bölgedeki boş bir yere farenin sağ düğmesine basılarak  
New>Text düğmelerinin sırasıyla seçilmesidir (Görsel 3.86). Zaman çizelgesinin katmanlar 
bölümünde <empty text Layer> isminde bir yazı katmanı oluşur. Yazı katmanı zaman çizelgesi 
panelinde oluştuktan sonra klavyeden istenen yazı girilebilir. Yazı katmanının ismi, girilen yazının 
ilk birkaç kelimesi olarak değişir. Bu isim, katman üzerinde farenin sağ düğmesine basılıp, daha 
sonra Rename düğmesi seçilerek değiştirilebilir.

Görsel 3.86: Zaman çizelgesi panelinden yazı katmanı ekleme
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Menü çubuğundan Layer>New ve Text düğmeleri sırasıyla seçilerek de kompozisyona yazı 
katmanı eklenebilir (Görsel 3.87).

Görsel 3.87: Kompozisyona Layer menüsünden yazı katmanı ekleme

3.5.2. Yazı Katmanı ve Özellikleri

Katman panelinde yazı katmanının yanındaki ok simgesine tıklanarak katman parametreleri 
açılır. Yazı katmanları, Transform menüsüne ek olarak Text menüsüne de sahiptir (Görsel 3.88).

Görsel 3.88: Yazı katmanı özellikleri

3.5.3. Text Açılır Menüsü

Text açılır menüsünün solundaki ok simgesine tıklanarak Text parametreleri açılır.

Source Text: Source Text parametresi, kaynak yazının karakterlerini kapsar. Kaynak yazıdaki 
harfler, animasyonun belli zaman aralığında Source Text parametresinden değiştirilebilir.
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Path Options: Yazıya üzerinde hareket edebileceği bir yol atama seçeneğidir. Kompozisyon 
alanında Pen Tool (kalem aracı) veya Rectangle Tool (kare şekli aracı) gibi şekil oluşturma 
araçlarıyla çizilen şekiller kullanılarak yazının bu şekil üzerinde hareket etmesi sağlanır. Path 
düğmesinin altında “yazının yolu nasıl takip edeceğiyle ilgili seçenekler” bulunur.

More Options: Path Options alanında yapılan seçimlerden daha farklı seçenekler bulunur. 
Örneğin Anchor Point Grouping seçeneğinin yanındaki seçim listesi açıldığında yazı harflerinin 
teker teker veya tamamının seçilmesi yöntemiyle “aynı yol üzerindeki oturma şekilleri” 
değiştirilebilir.

3.5.4. Transform Açılır Menüsü

Transform özelliği, tüm katmanlarda standart olarak bulunur.  Bu menüde bulunan paramet- 
reler şunlardır:

• Anchor Point: Yazının çapa (merkez) noktasının yerini ayarlar.

• Position: Yazının X ve Y eksenlerindeki konumunu ayarlar.

• Scale: Yazının oransal olarak büyüklüğünü ayarlar.

• Rotation: Yazının çapa noktası etrafında döndürülmesini sağlar.

• Opacity: Yazının görünürlük (saydamlık-opaklık) miktarını ayarlar.

3.5.5. Yazı Katmanının Composition Ekranında Hizalanması

Oluşturulan yazı katmanlarını sahnede hizalamak için ekranın sağında bulunan Allign paneli 
kullanılır (Görsel 3.89).

Görsel 3.89: Allign paneli
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Allign panelini açmak için ekranın üstünde bulunan menü çubuğunda sırasıyla  
Windows>Allign düğmeleri seçilir (Görsel 3.90).

Görsel 3.90: Allign panelinin açılması

Allign paneli, yazı katmanı seçiliyken aktif olan hizalama düğmelerine sahiptir (Görsel 3.91).

Görsel 3.91: Allign paneli düğmeleri

İşlem adımlarına göre 5’ten geriye sayan sayaç animasyonu yapınız.

1. Adım: Yeni bir proje oluşturmak için menü çubuğundan sırasıyla File>New>New Project 
seçeneklerini seçiniz.

12. UYGULAMA

Yazıyı sola yaslandır. Yazıyı alta yaslandır.

Yazıyı sağa yaslandır. Yazıyı üste yaslandır.

Yazıyı dikey eksende ortala. Yazıyı yatay eksende ortala.
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2. Adım: Açılan projede yeni bir kompozisyon oluşturmak için menü çubuğundan sırasıyla 
Composition>New Composition seçeneklerini seçiniz.

3. Adım: Ekrana gelen kompozisyon seçenekleri menüsünde kompozisyon ayarlarını Görsel 
3.92’deki gibi yapınız.

Görsel 3.92: Yeni kompozisyon ayarları

4. Adım: Oluşturulan kompozisyona yeni bir Text katmanı eklemek için menü çubuğundan 
sırasıyla Layer>New>Text düğmelerini seçiniz (Görsel 3.93).

Görsel 3.93: Kompozisyona Text katmanı ekleme
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Bu işlemden sonra zaman çizelgesinin katmanlar bölümünde <empty text layer> isminde bir 
Text katmanı oluşur (Görsel 3.94).

Görsel 3.94: <empty text layer> isimli yazı katmanı

5. Adım: Oluşturulan yazı katmanına ait özellikleri belirlemek için ekranın sağında bulunan 
Character panelinde gerekli ayarları Görsel 3.95’teki gibi yapınız.

Görsel 3.95: Character panelinden yazı katmanı ayarlarını yapma

6. Adım: Composition panelini seçtikten sonra kompozisyon ekranına 5 sayısını klavyeden 
giriniz. Yazdığınız yazıyı  Allign panelini kullanarak ekranın ortasına taşıyınız (Görsel 3.96).

Görsel 3.96: Klavyeden yazı girilmesi

7. Adım: Zaman imlecini 0. saniye konumuna alınız. Text açılır menüsüne ait Source Text 
düğmesinin solundaki kronometre simgesine farenizin sol tuşuyla basarak 0. saniye konumuna 
anahtar kare eklenmesini sağlayınız (Görsel 3.97).  

Görsel 3.97: Source Text ayar düğmesine anahtar kare eklenmesi
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8. Adım: Zaman imlecini 1. saniye konumuna alınız ve Composition ekranında bulunan 5 
rakamının üzerine çift tıklayarak klavyeden 4 rakamını giriniz (Görsel 3.98).

1. saniye konumunda yazı değiştirildiğinde 1. saniyeye otomatik olarak bir anahtar kare 
eklenecektir. Bunun anlamı; zaman 0 ve 1. saniyeler aralığındayken ekranda 5 rakamı görünecek, 
zaman imleci 1. saniyeye ulaştığında ekranda 4 rakamı görünecektir (Görsel 3.98).

Görsel 3.98: 1. saniye konumunda yazıyı değiştirme

9. Adım: Zaman imlecini 2. saniyeye alıp Composition ekranındaki rakamı 3 olarak değiştiriniz. 
Daha sonra zaman imlecini 3. saniyeye alıp Composition ekranındaki rakamı 2 olarak değiştiriniz. 
Bu işlem adımlarını zaman imleci 5. saniye konumundayken Composition ekranındaki rakamı 0 
olacak şekilde değiştirinceye kadar sürdürünüz (Görsel 3.99).

Görsel 3.99: Source Text ile yazıyı değiştirme
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10. Adım: Zaman imlecini 0. saniye konumuna aldıktan sonra klavyeden boşluk düğmesine 
basarak oluşturduğunuz animasyonu inceleyiniz.

11. Adım: Projeyi bilgisayarınıza kaydediniz.

1’den başlayarak 5’e kadar birer saniye aralıklarla sayan bir uygulama yapınız.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Yeni proje oluşturdu.

2. Yeni kompozisyon oluşturdu.

3. Yeni text katmanı ekledi.

4. Source Text özelliğinin değerlerini değiştirerek anahtar kareler ekledi.

5. Projeyi bilgisayara kaydetti.

İşlem adımlarına göre Animate özelliğini kullanarak Text animasyonu oluşturunuz.

1. Adım: Yeni bir proje oluşturunuz ve açılan projeye Görsel 3.100’deki ayarlara sahip bir 
kompozisyon ekleyiniz.

SIRA SİZDE

13. UYGULAMA
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Görsel 3.100: Kompozisyon ayarları

2. Adım: Yeni bir yazı katmanı oluşturmak için zaman çizelgesi panelinin katmanlar kısmında 
boş bir alana farenizle sağ tıklayarak açılan menüden sırasıyla New>Text düğmelerini seçiniz 
(Görsel 3.101).

Görsel 3.101: Yeni bir Text katmanı oluşturma

3. Adım: Character panelinde yazı ayarlarını Görsel 3.102’de görüldüğü gibi yapınız. 

Görsel 3.102: Character paneli ayarları
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6. Adım: Composition panelini seçtikten sonra yazmak istediğiniz yazıyı klavyeden giriniz. 
Yazdığınız yazıyı araç çubuğundaki Allign panelini kullanarak ekranın ortasına taşıyınız (Görsel 
3.103).

Görsel 3.103: Klavyeden yazı yazma

7. Adım: Zaman çizelgesindeki katman alanında bulunan yazı katmanına ait menüyü açabilmek 
için katmanın isminin solunda bulunan ok simgesine basınız. Açılan menüde Animate düğmesine 
tıklayınız. Bu menüde doğrudan katmana uygulanabilecek bazı animasyonlar bulunur (Görsel 
3.104).

Görsel 3.104: Animate menüsü

8. Adım: Yazı katmanında karakterlerin konumlarını değiştirerek animasyon oluşturmak için 
Animate menüsünde bulunan Position düğmesini seçiniz. Animator 1 menüsü yazı katmanına 
eklenecektir (Görsel 3.105).

Görsel 3.105: Animator 1 menüsü
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Animator 1 menüsü altında Range Selector 1 alt menüsü ve katmana eklenen Position 
animasyonu bulunur.

Range Selector 1 alt menüsünde animasyonun hangi uzunlukta olacağı ayarlanır. Start,  0 ile 
100 arasında bir değer alır. 0 değeri yazılan yazının ilk karakterine, 100 değeri ise yazılan yazının 
son karakterine denk gelir (Görsel 3.106).

Görsel 3.106: Range Selector 1 alt menüsü

9. Adım: Range Selector 1 alt menüsü altında bulunan Start değerine anahtar kare eklemek için 
zaman imleci 0. saniye konumundayken düğmenin solunda bulunan Stop watch (Kronometre) 
düğmesine basınız. Zaman imlecini 5. saniye konumuna alıp, Start değerini 100 olarak ayarlayınız 
(Görsel 3.107).

Görsel 3.107: Start değerine anahtar kare eklemek

Böylece Start değerinin 5 saniyelik sürede 0’dan 100’e doğru hareket etmesi sağlanır. Yazılan 
yazı üzerinde Start değerinin gösterdiği karakter, o anda Position değerinin gösterdiği konumdan 
başlayarak ilk bulunduğu konuma doğru hareket eder. Yazılan yazı üzerinde Stop değerinin 
gösterdiği karakter ise o anda yazının bulunduğu ilk konumdan başlayarak Position değerinin 
gösterdiği konuma doğru hareket eder.

10. Adım: Position ayarının Y ekseninde hareketi sağlayan ikinci değeri, yazılan yazının ekranın 
dışına çıkmasını sağlayacak şekilde değiştiriniz (Görsel 3.108).

Görsel 3.108: Position değerinin değiştirilmesi

11. Adım: Klavyenizden boşluk tuşuna basarak oluşturduğunuz animasyonu inceleyiniz.
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Yazılan yazı karakterlerinin 5 saniyede sırasıyla ekranın dışından başlayarak ilk konumlarına 
doğru hareket ettiği görülür (Görsel 3.109).

Görsel 3.109: Yazı animasyonu

Add özelliği kullanılarak Animator 1 menüsüne yeni animasyonlar eklenebilir. 

12. Adım: Harflerin aşağıdan yukarı doğru gelirken küçülmesi işlemi için Animator 1 
menüsünün solunda bulunan Add menüsüne farenizin sol düğmesiyle basınız. Ardından sırasıyla 
Property>Scale düğmelerini seçiniz (Görsel 3.110).

Görsel 3.110: Katmana yeni animasyon ekleme

Scale değerinin Animator 1 menüsüne eklendiği görülür (Görsel 3.111).

Görsel 3.111: Animator 1 menüsünde Scale değerinin görülmesi

13. Adım: Scale değerini 200 olarak değiştiriniz (Görsel 3.112).

Görsel 3.112: Scale değeriyle animasyon oluşturma
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14. Adım: Klavyenizden boşluk tuşuna basarak oluşturduğunuz animasyonu inceleyiniz.

15. Adım: Projeyi bilgisayarınıza kaydediniz.

İşlem adımlarına göre Text katmanına hazır animasyonlar ekleyiniz.

1. Adım: Yeni bir proje oluşturmak için menü çubuğundan sırasıyla File>New>New Project 
seçeneklerini seçiniz.

2. Adım: Açılan projede yeni bir kompozisyon oluşturmak için menü çubuğundan sırasıyla 
Composition>New Composition seçeneklerini seçiniz. 

3. Adım: Ekrana gelen kompozisyon seçenekleri menüsünde kompozisyon ayarlarını Görsel 
3.113’te görüldüğü gibi yapınız.

Görsel 3.113: Yeni kompozisyon ayarları

4. Adım: Oluşturulan kompozisyona yeni bir Text katmanı eklemek için menü çubuğundan 
sırasıyla Layer>New>Text düğmelerini seçiniz.

Bu işlemden sonra zaman çizelgesinin katmanlar bölümünde <empty text layer> isminde bir 
Text katmanı oluşur (Görsel 3.114).

Görsel 3.114:<empty text layer> isimli Text katmanı

14. UYGULAMA
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5. Adım: Oluşturulan yazı katmanına ait özellikleri belirlemek için ekranın sağında bulunan 
Character panelinde gerekli ayarları Görsel 3.115’te görüldüğü gibi yapınız.

Görsel 3.115: Character panelinde Text katmanı ayarlarını yapma

6. Adım: Composition panelini seçtikten sonra kompozisyon ekranında klavyeden istediğiniz 
yazıyı giriniz. Yazdığınız yazıyı Allign panelini kullanarak ekranın ortasına taşıyınız (Görsel 3.116).

Görsel 3.116: Klavyeden yazı girilmesi

Oluşturulan yazı katmanına hazır animasyonlar eklemek için ekranın sağında Effect & 
Presets panelinde bulunan Animation Presets efektleri kullanılır. Animation Presets, içinde 
sınıflandırılarak klasörlere ayrılmış birçok efekt barındırır. Effect & Presets paneli ekranın sağında 
görünmüyorsa Window menüsünden Effect & Presets seçilerek panel aktifleştirilir (Görsel 3.117).
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Görsel 3.117: Effect & Presets paneli

7. Adım: Yazı katmanına hazır animasyon eklemek için yazı katmanı seçiliyken Effect & Presets 
panelinde sırasıyla Animation Presets>Text>Blurs düğmelerini seçiniz. Daha sonra Foggy efektine 
çift tıklayarak animasyonun yazı katmanına uygulanmasını sağlayınız (Görsel 3.118).

Görsel 3.118: Effect & Presets panelinde Foggy efekti
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Foggy efekti, yazı karakterlerinin soldan sağa doğru bulanıklığının giderilerek netleşmesi 
animasyonudur (Görsel 3.119).

Görsel 3.119: Foggy efekti

Animasyonun yazı katmanına uygulanmasıyla beraber yazı katmanına Foggy efekti menüsü 
eklenir. Hazır animasyonlar kendi içinde daha önceden oluşturulmuş bazı ön ayarlar ve anahtar 
karelerle gelir. Burada animasyonun süresinin uzatılması için Offset ayarına ait 2. anahtar kare 
ileri bir süreye çekilir. Ayrıca Scale, Opacity ve Blur ayarları değiştirilerek animasyondaki boyut, 
görünürlük ve bulanıklık değerleri değiştirilebilir (Görsel 3.120).

Görsel 3.120: Yazı katmanı içinde Foggy efekti menüsü

8. Adım: Offset değerine atanan ikinci anahtar kareyi farenizin sol tuşuyla tutup sürükleyerek 
ileriki bir zamana taşıyınız.

9. Adım: Scale, Opacity ve Blur değerlerini değiştirdikten sonra animasyonu oynatarak oluşan 
etkileri gözlemleyiniz.

10. Adım: Yazı katmanında bulunan Foggy Animator efektini seçip, klavyenizden Delete 
düğmesine basarak siliniz.

11. Adım: Yazı katmanı seçiliyken Effect & Presets panelinde sırasıyla Animation  
Presets>Backgrounds düğmelerini seçiniz. Daha sonra Deep Tissue efektine çift tıklayarak 
animasyonun yazı katmanına uygulanmasını sağlayınız (Görsel 3.121).
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Görsel 3.121: Effect & Presets panelinde Deep Tissue efekti

Deep Tissue, yazı katmanına hareketli bir arka plan efekti uygulanmasını sağlar (Görsel 3.122).

 Görsel 3.122: Deep Tissue efekti

12. Adım: Yazı katmanına Effect & Presets panelinden Animation Presets>Text klasörleri 
altındaki diğer hazır animasyonları ekleyerek sonuçları gözlemleyiniz.

3.6. ŞEKİL OLUŞTURMAK
Geometrik şekillerin oluşturulması için şekil araçları kullanılır. Ekranın üst kısmında 

bulunan araç çubuğu panelinde Rectangle Tool varsayılan bulunur. Bunun 
dışında görsel efekt programında dört temel şekil aracı daha vardır. Bunlar;  
Rounded Rectangle Tool, Ellipse Tool, Polygon Tool ve Star Tool araçlarıdır. Diğer  
dört şekil aracını aktif etmek için Rectangle Tool aracına farenin sol düğmesiyle bir müddet 
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basılı tutulur. Böylece diğer şekil araçlarının bulunduğu menü açılır ve çizilmek istenen şekil aracı 
seçilir (Görsel 3.123).

Görsel 3.123: Şekil oluşturma araçları

Temel şekil araçlarının dışında araç çubuğundaki Pen Tool ile özel şekiller çizilir (Görsel 3.124).

Görsel 3.124: Pen Tool 

3.6.1. Temel Şekil Araçlarıyla Şekil Oluşturmak

Araç çubuğundan Şekil aracı seçilir. Farenin imleci kompozisyon ekranına götürüldüğünde 
imlecin şeklinin değiştiği görülür. Bundan sonra kompozisyon ekranında farenin sol düğmesine 
basılı tutulup, fare sürüklenerek şekil çizilir. İstenen şekil çizildiğinde zaman çizelgesinin katmanlar 
bölümüne Shape Layer 1 isminde şekil katmanı eklenir. Shape Layer 1 katmanının Contents 
kısmında ise çizilen şeklin ismi görülür (Görsel 3.125).

Görsel 3.125: Sahneye şekil çizme

Katman panelinde herhangi bir şekil katmanı seçiliyken sahneye şekil çizildiğinde oluşan yeni 
şekil, kompozisyona yeni katman olarak eklenmez. Çizilen yeni şekil, seçili katmanın içine eklenir. 
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Böyle bir durumda katmanda yapılan bütün değişiklikler, oluşan yeni şekle de uygulanır.
Shape Layer 1 seçiliyken sahneye çizilen yeni şekil, Shape Layer 1’in Contents özelliğine eklenir 

(Görsel 3.126).

Görsel 3.126: Aynı katmana şekil çizme

Şeklin ayrı bir katmanda çizilmesi için katman bölümünde herhangi bir şekil katmanının seçili 
olmaması gerekir. Katmana ait Transform özellikleri aynı katmanın Contents bölümünde bulunan 
bütün şekiller için ortaktır (Görsel 3.127).

Görsel 3.127: Şekil katmanının özellikleri
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Composition panelinde bulunan iki farklı şeklin ayrı Transform özelliklerine sahip olması 
istenirse bu iki şekil, farklı şekil katmanlarında bulunmalıdır. Bu nedenle yeni bir katman 
oluşturulacağı zaman katman bölümünde seçili bir katman olmamalıdır (Görsel 3.128).

Görsel 3.128: Şekillerin farklı katmanlarda bulunması

Katman panelinde şekil katmanı dışında bir katman (görsel veya video katmanı) seçiliyken 
sahneye şekil çizildiğinde seçili katman üzerinde Maske oluşturulur (Görsel 3.129, Görsel 3.130).

Görsel 3.129: Katman maskesi eklenecek görsel

Görsel 3.130: Şeklin katman maskesi olarak kullanılması
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3.6.2. Kalem Aracıyla Özel Şekiller Oluşturmak

Serbest çizimler oluşturmak için araç çubuğundan Pen Tool seçilir (Görsel 3.131).

Görsel 3.131: Pen Tool 

Kalem aracı kullanılarak serbest çizimler oluşturmak için araç çubuğundan kalem aracı 
seçildikten sonra Composition panelinde sahnede bir noktaya farenin sol düğmesiyle basılır. 
Farenin imleci farklı bir noktaya götürülüp tıklanarak ikinci bir nokta belirlenir. Birinci nokta ile 
ikinci nokta arasında düz bir çizgi oluştuğu görülür. Bundan sonra fare ile belirlenen başka bir 
noktada çizim devam ettirilebilir (Görsel 3.132).

Görsel 3.132: Sahneye Pen Tool ile serbest çizim oluşturma

Çizilen şeklin çizgi kalınlığı ve içinin herhangi bir renkle dolu olup olmayacağı belirlenebilir.
Çizgi kalınlığının kaç piksel olacağı (şekil katmanı seçiliyken) ekranın üst kısmındaki px değeri ile 
belirlenir. Çizgi rengi ise ekranın üst kısmında bulunan Stroke alanından seçilir (Görsel 3.133).

Görsel 3.133: Çizilen şeklin kalınlığı ve dolgu rengi ayarları
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Şeklin içinin herhangi bir renk ile dolu olup olmayacağı veya şeklin içi doluysa hangi renk 
olacağı ekranın üst kısmındaki Fill düğmesi ile belirlenir. Fill düğmesine basıldığında açılan 
menüde birinci sıradaki üzeri kırmızı çizgili beyaz düğme None (Hiçbiri) seçildiğinde çizilen şeklin 
dolgu rengi kaldırılarak şeklin içi boş hâle gelecektir (Görsel 3.134).

Görsel 3.134: Çizilen şeklin dolgu renginin silinmesi

Dolgu rengini değiştirmek için Fill düğmesinin yanındaki renk düğmesine basılır. Açılan renk 
paletinden istenen renk seçilir (Görsel 3.135).

Görsel 3.135: Çizilen şeklin dolgu renginin belirlenmesi

3.6.3. Çizilen Şeklin Köşelerini Eğimli Yüzeyler Hâline Dönüştürmek

Pen Tool aracı ile serbest çizim yapıldıktan sonra çizimin bazı köşeleri eğimli hâle getirilmek 
istenebilir. Bunu yapmak için ekranın üst kısmında Pen Tool aracına farenin sol düğmesiyle basılı 
tutulur. Açılan menüde Convert Vertex Tool (Köşe dönüştürme aracı) seçilir (Görsel 3.136).
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Composition ekranında çizilen şeklin köşelerindeki bağlantı noktalarından sürüklenerek, bu 
köşeler sürükleme miktarına bağlı olarak istenen seviyede eğimli hâle getirilir (Görsel 3.137).

Görsel 3.137: Çizilen şeklin köşelerinin eğimli hâle getirilmesi

3.6.4. Çizilen Şekle Yeni Köşeler Eklemek ve Köşeleri Silmek

Pen Tool aracı ile serbest çizim yapıldıktan sonra çizime bazı yeni köşelerin eklenmesi veya var 
olan köşelerin silinmesi istenebilir. Çizime yeni köşelerin eklenmesi için ekranın üst kısmında Pen 
Tool aracına farenin sol düğmesiyle basılı tutulur. Açılan menüde Add Vertex Tool aracı seçilir. Var 
olan köşelerin silinmesi için Delete Vertex Tool (Köşe silme aracı) seçilir (Görsel 3.138).

Görsel 3.138: Add Vertex Tool ve Delete Vertex Tool

Görsel 3.136: Convert Vertex Tool 

Eğimli hâle getirilmek
istenen nokta

Farenin sol düğmesiyle
tutulup sürüklenir.
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 Eklenen köşeler araç çubuğundaki Selection Tool  ile istenen yere taşınabilir (Görsel 3.139).

Görsel 3.139: Çizilen şekle yeni köşeler eklenmesi

3.6.5. Şekil Katmanına Eklenebilen Düzenleyiciler

Contents alt menüsünün karşısındaki Add düğmesi ile açılır menüden çizilen şekle, şekil 
üzerinde değişiklikler yapılabilmesini sağlayan düzenleyiciler eklenebilir (Görsel 3.140).

Görsel 3.140: Add menüsü

Yeni köşe eklemek istenen yerler

Köşeler Selection Tool
aracı ile istenen yere 
taşınabilir.
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İşlem adımlarına göre Repeater, Twist, Wiggle Paths değiştiricilerini katmanlara 
ekleyerek animasyonlar oluşturunuz.

1. Adım: Yeni bir proje oluşturmak için menü çubuğundan sırasıyla File>New>New Project 
seçeneklerini seçiniz.

2. Adım: Açılan projede yeni bir kompozisyon oluşturmak için menü çubuğundan sırasıyla 
Composition>New Composition seçeneklerini seçiniz. 

3. Adım: Ekrana gelen kompozisyon seçenekleri menüsünde kompozisyon ayarlarını Görsel 
3.141’de görüldüğü gibi yapınız.

Görsel 3.141: Yeni kompozisyon ayarları

4. Adım: Kompozisyon ekranına Fill, Stroke ve px özellikleri Görsel 3.142’de görüldüğü gibi 
bir çember şekli çiziniz. Çizdiğiniz çember şeklini Move Tool aracı ile ekranın sol üst köşesine 
taşıyınız.

Görsel 3.142: Çember şekli çizilmesi

15. UYGULAMA
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5. Adım: Repeater değiştiricisini çember şekil katmanına ekleyiniz (Görsel 3.143).

Görsel 3.143: Şekil katmanına Repeater değiştiricisi ekleme

Repeater değiştiricisi, çizilen şeklin kopyalanarak yan yana sıralanmasını sağlar.

6. Adım: Contents menüsüne eklenen Repeater menüsündeki Copies değeri, kopya sayısının 
belirlenmesini sağlar. Bu değeri 6 olarak ayarlayınız (Görsel 3.144).

Görsel 3.144: Repeater değiştiricisi menüsü

6 adet çember oluşturulur.
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7. Adım: Çemberlerin birbirlerine olan uzaklığını belirlemek için Transform: Repeater 1 
menüsü içindeki Position değerini değiştiriniz (Görsel 3.145).

Görsel 3.145: Position değerinin değiştirilmesi

8. Adım: Transform: Repeater 1 menüsü içindeki Scale düğmesi ile animasyon oluşturmak için 
zaman çizelgesinde Scale değerini %0 olarak ayarladıktan sonra zaman çizelgesinin 0. saniyesine 
anahtar kare ekleyiniz. Zaman imlecini 5. saniyeye alarak, Scale değerini %100 olarak ayarlayınız. 
Zaman çizelgesinin 5. saniye konumuna otomatik olarak anahtar kare eklenir (Görsel 3.146).

Görsel 3.146: Scale değerine anahtar kare eklenmesi

9. Adım: Zaman imlecini 0. saniye konumuna alarak boşluk düğmesiyle animasyonu oynatınız. 
Ekrandaki çember şekillerinin zamanla büyüyerek belirdiği görülür (Görsel 3.147).

Görsel 3.147: Oluşturulan animasyonun ön izlemesi
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10. Adım: Çember şeklinin bulunduğu şekil katmanını seçerek Delete düğmesi ile siliniz. 
Kalem aracını seçerek ekranın ortasına Fill, Stroke ve px özellikleri Görsel 3.148’de görüldüğü gibi 
düz bir çizgi çiziniz. 

Görsel 3.148: Kalem aracı ile sahnede çizim yapılması

11. Adım: Twist değiştiricisini çember şekil katmanına ekleyiniz (Görsel 3.149).

Görsel 3.149: Twist değiştiricisinin şekil katmanına eklenmesi

Twist değiştiricisi, istenen tur sayısınca, belirlenen bir referans noktasından itibaren çizilen 
şeklin kıvrılmasını sağlar. 

7. Adım: Contents menüsüne eklenen Twist menüsünde bulunan Angles (Açı) değeri şeklin 
kaç derece kıvrılacağının belirlenmesini sağlar. Bu değeri 1000 olarak ayarlayınız. Center (Merkez) 
değeri ise şeklin kıvrılırken hangi noktanın referans alınacağını belirler (Görsel 3.150).
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Görsel 3.150: Twist değiştiricisi

8. Adım: Contents menüsüne eklenen Twist menüsünü seçip, klavyeden Delete düğmesine 
basarak siliniz (Görsel 3.151).

Görsel 3.151: Değiştiricinin katmandan silinmesi

9. Adım: Wiggle Paths değiştiricisini çember şekil katmanına ekleyiniz (Görsel 3.152).

Görsel 3.152: Wiggle Paths değiştiricisinin şekil katmanına eklenmesi
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Wiggle Paths değiştiricisi, çizilen şeklin rastgele noktalardan rastgele miktarlarda sallanmasını 
sağlar. Wiggle Paths değiştiricisi katmana uygulandığında anahtar kare eklenmesine gerek 
kalmadan animasyon oluşur. 

Contents menüsüne eklenen Wiggle Paths menüsündeki değerler şunlardır:

Size değeri, hareketin dikey eksende büyüklüğünü belirler.

Detail değeri, hareketin yatay eksende sıklığını belirler.

Points değeri, köşelerin sivri uçlardan mı yoksa yumuşak hatlardan mı oluşacağını belirler.

Wiggles/Seconds değeri, saniyede oluşacak hareket sayısının belirlenmesini sağlar. Bu değer 
0 girildiğinde sallanma hareketi oluşmaz.

10. Adım: Wiggle Paths menüsündeki değişkenlere farklı değerler vererek oluşan animasyonu 
oynatınız. Değişkenlere atanan değerlerin etkilerini gözlemleyiniz.

İşlem adımlarına göre Trim Path komutunu kullanarak şekil katmanıyla animasyon 
oluşturunuz.

1. Adım: Daha önce kaydedilen 5’ten Geriye Sayma uygulamasında kaydettiğiniz animasyonu 
açmak için menü çubuğundan sırasıyla File>Open Project düğmelerini seçiniz. Kaydettiğiniz 
dosyayı seçerek açınız (Görsel 3.153). 

Görsel 3.153: Kaydedilen bir dosyanın açılması

2. Adım: Araç çubuğunda bulunan Ellipse Tool aracını seçiniz. Composition ekranında 
bulunan sahneye çizilen şeklin tam bir daire olmasını sağlamak için çizim yaparken klavyeden 
Shift düğmesine basılı tutunuz.

16. UYGULAMA
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3. Adım: Sahnedeki dairenin çizgi kalınlığını 40 px olacak şekilde ayarlayınız. Allign panelindeki 
düğmeleri kullanarak daire şeklini sahnede ortalayınız (Görsel 3.154).

Görsel 3.152: Şekil katmanı özelliklerinin belirlenmesi

4. Adım: Daire şeklini kesikli çizgiler hâline getirmek için şekil katmanında, Contents>Ellipse 
alt menülerinin içinde, çizgi ayarlarının yapıldığı Stroke bölümünde bulunan Dashes düğmesinin 
yanındaki + düğmesini seçiniz. Kesikli çizgi kalınlığı değerini Dash düğmesini kullanarak ayarlayınız 
(Görsel 3.155).

Görsel 3.155: Dash düğmesiyle kesikli çizgi oluşturma

Görsel 3.154: Şekil katmanı özelliklerinin belirlenmesi
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Animasyon oynatıldığında daire şekline ait çizgilerin saat yönünden başlayarak kaybolmasını 
sağlamak için şekil katmanına Trim Path animasyonu eklenir. 

5. Adım: Şekil katmanına Trim Path animasyonu eklemek için önce Contents menüsünün 
yanındaki Add düğmesini sonra açılan menüden Trim Path düğmesini seçiniz (Görsel 3.156).

Görsel 3.156: Şekil katmanına Trim Path animasyonu ekleme

Böylece Trim Paths 1 menüsü Contents menüsünün içine eklenir. Start ve End değerleri, 
çizilen şeklin baştan veya sondan belli bir yüzdelik kısmının kırpılması işlemini gerçekleştirir 
(Görsel 3.157).

Görsel 3.157: Thrim Paths menüsü

6. Adım: Çizilen şekil sondan başa doğru kaybolacağı için Start değerini %100’e, End değerini 
%0’a ayarlayınız (Görsel 3.158).

Görsel 3.158: Start ve End parametrelerinin belirlenmesi
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7. Adım: Zaman çizelgesinde zaman imlecini 0. saniye konumuna alınız ve End değerine bir 
anahtar kare koyunuz.

8. Adım: Zaman çizelgesinde zaman imlecini 5. saniye konumuna alınız ve End değerini %100 
olarak ayarlayınız. 5. saniye konumuna otomatik olarak anahtar kare konduğu görülür (Görsel 
3.159).

Görsel 3.159: End parametresine anahtar kare eklenmesi

9. Adım: Zaman çizelgesinde zaman imlecini 0. saniye konumuna alınız. Animasyonu oynatarak 
inceleyiniz (Görsel 3.160).

Görsel 3.160: Oluşturulan animasyonun oynatılması

Kalem aracıyla yatay düz bir çizgi çiziniz. Çizdiğiniz çizginin Twist değiştiricisi ile 
bükülmesini sağlayınız. Ardından Trim Path komutu ile çizginin bir ucundan başlayarak 
zamanla kaybolmasını sağlayınız.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Yeni proje oluşturdu.

2. Yeni kompozisyon oluşturdu.

3. Yeni şekil katmanı ekledi.

4. Şekil katmanına Twist değiştiricisi ekledi.

5. Şekil katmanına Trim Path komutu uyguladı.

6. Şekil katmanına anahtar kareler ekledi.

7. Projeyi bilgisayara kaydetti.

SIRA SİZDE
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İşlem adımlarına göre çizilen şekil katmanını Text katmanına ait bir yol şeklinde 
atayarak animasyon oluşturunuz.

1. Adım: Yeni bir proje oluşturmak için menü çubuğundan sırasıyla File>New>New Project 
seçeneklerini seçiniz .

2. Adım: Açılan projede yeni bir kompozisyon oluşturmak için menü çubuğundan sırasıyla 
Composition>New Composition seçeneklerini seçiniz.

3. Adım: Ekrana gelen kompozisyon seçenekleri menüsünde kompozisyon ayarlarını yapınız.

4. Adım: Oluşturulan kompozisyona yeni bir Text katmanı eklemek için menü çubuğundan 
sırasıyla Layer>New>Text düğmelerini seçiniz.

5. Adım: Oluşturulan yazı katmanına ait özellikleri belirlemek için ekranın sağında bulunan 
Character panelinde gerekli ayarları Görsel 3.161’de görüldüğü gibi yapınız.

Görsel 3.161: Character panelinden yazı (text) katmanı ayarlarını yapma

6. Adım: Composition panelini seçtikten sonra yazmak istediğiniz yazıyı klavyeden giriniz. 
Daha sonra yazdığınız yazıyı araç çubuğundaki Allign panelini kullanarak ekranın ortasına taşıyınız 
(Görsel 3.162).

Görsel 3.162: Klavyeden yazı girilmesi

7. Adım: Zaman çizelgesinin katmanlar bölümündeki Text katmanı seçiliyken araç çubuğunda 
bulunan Ellipse Tool aracını aktif hâle getiriniz. Klavyeden Shift tuşuna basılı tutarak, Composition 
ekranında farenizi sürükleyerek bir çember şekli çiziniz.

17. UYGULAMA
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Çember şekli çizilirken yazı katmanı seçili olduğu için çizilen şekil, yazı katmanının bir maskesi 
olur (Görsel 3.163).

Görsel 3.163: Yazı katmanında çember şeklinde maske oluşturulması

8. Adım: Yazı katmanının Path Options açılır penceresine ait bir parametre olan Path değer 
kutucuğunda Mask 1 değerini seçiniz (Görsel 3.164).

Görsel 3.164: Path değerine Mask 1 değerinin atanması
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Böylece Mask 1 (çember şekli) maskesi, üzerinde yazının hareket edebileceği bir yol hâline 
gelir (Görsel 3.165).

Görsel 3.165: Çember şeklinin yazı katmanı için Path olarak kullanılması

9. Adım: Yazı katmanının Path Options açılır penceresine ait bir parametre olan Reverse Path 
ayarını On konumuna getiriniz. Böylece oluşturulan yazı, çember şeklinin dış çeperinde hizalanır 
(Görsel 3.166).

Görsel 3.166: Reverse Path ayarının On konumuna getirilmesi

10. Adım: Yazı katmanının Path Options açılır penceresine ait bir parametre olan Force 
Allignment ayarını On konumuna getiriniz. Böylece oluşturulan yazı, çember şeklinin çevresinin 
tamamını kaplayacak şekilde hizalanır (Görsel 3.167).



                                                Hareketli Görüntüler 223

Görsel 3.167: Force Allignment ayarının On konumuna getirilmesi

Yazı katmanının Path Options açılır penceresine ait bir parametre olan First Margin ayarı 0 iken 
çember şeklinin etrafında hizalanan yazının son harfi ile ilk harfi arasında hiç boşluk olmayacaktır 
(Görsel 3.168).

Görsel 3.168: First Margin ayarının 0 olması durumu

11. Adım: First Margin ayarını artırarak çember şeklinin etrafında hizalanan yazının son harfi 
ile ilk harfi arasında bir miktar boşluk olmasını sağlayınız (Görsel 3.169).

Görsel 3.169: First Margin ayarının 100 olması durumu
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12. Adım: Yazının çember etrafında dönmesi animasyonunu oluşturmak için zaman imlecini 
0 konumuna alarak First Margin ve Last Margin ayarlarının solunda bulunan Stop-watch 
düğmelerine basınız. Böylece zaman çizelgesinde bu ayarlara ait anahtar kareler oluşur (Görsel 
3.170).

Görsel 3.170: First Margin ve Last Margin ayarlarına anahtar karelerin eklenmesi

13. Adım: Zaman imlecini 5. saniye konumuna alarak First Margin değerini 2100’e, Last Margin 
değerini 2000’e ayarlayınız. Bu ayarlardan sonra zaman çizelgesinde 5. saniye konumuna anahtar 
kareler otomatik olarak eklenecektir (Görsel 3.171).

Görsel 3.171: First Margin ve Last Margin ayarlarına ikinci anahtar karelerin eklenmesi

14. Adım: Zaman imlecini 0. saniye konumuna aldıktan sonra klavyeden boşluk düğmesine 
basarak oluşturulan animasyonu inceleyiniz.

15. Adım: Proje dosyasını kaydetmek için araç çubuğundan sırasıyla File>Save As>Save As… 
düğmelerini seçiniz (Görsel 3.172).

Görsel 3.172: Projeyi kaydetme
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16. Adım:  Açılan pencereden projeye bir isim veriniz ve dosyanın bilgisayarda kaydedileceği 
konumu belirleyip Kaydet düğmesine basınız (Görsel 3.173).

Görsel 3.173: Projeye isim verme ve projenin kayıt yerini belirleme

3.6.6. Kukla Aracı (Puppet Pin Tool)

Puppet Pin Tool, hareketsiz nesnelere bağlantı noktaları ekleyerek bu noktalarla nesneye 
hareket verilmesini sağlar. Hareket verilecek nesne bir karakter görseli ise bu görselin arka planı 
şeffaf, png uzantılı bir görsel olması tercih edilir.

Puppet Pin Tool, araç çubuğunda bulunur. Varsayılan olarak ayarlanmış Puppet Position Pin 
Tool simgesinin altında farklı hareket ayarları yapılmasını sağlayan Puppet araçları vardır (Görsel 
3.174).

Görsel 3.174: Puppet Pin Tool menüsü

İşlem adımlarına göre karakter ile el sallama animasyonu oluşturunuz.

1. Adım: Oluşturduğunuz proje ve kompozisyonda hareket verilecek görseli katman bölümüne 
taşıyınız. Görsel 3.175’te görülen karakter ile el sallama animasyonu oluşturulacaktır.

Görsel 3.175: Animasyon oluşturulacak karakter

18. UYGULAMA
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2. Adım: Zaman çizelgesinde zaman imlecini 0. saniye konumuna alınız ve araç çubuğundan 
Puppet Position Pin Tool seçiniz (Görsel 3.176).

Görsel 3.176: Puppet Position Pin Tool

Sahnede fare imlecinin şeklinin değiştiği görülecektir. Bu aşamadan sonra karakterin hareket 
ettirilecek ve hareketten etkilenecek bölgelerine farenin sol düğmesi ile pinler eklenir.

3. Adım: Görselde gösterilen noktalara pinler ekleyiniz (Görsel 3.177).

Görsel 3.177: Pin eklenecek noktalar

Hareket ettirilecek görsel üzerinde pinler oluşturulduğu anda zaman çizelgesinin katman 
bölümündeki Effects menüsü altında Puppet özelliği eklenir. Puppet özelliğinin altındaki Deform 
menüsü içinde eklenen pinler görülebilir (Görsel 3.178).

Görsel 3.178: Eklenen pinlerin katman bölümünde gösterilmesi

4. Adım: Eklenen ilk üç pin olan Pin 1, Pin 2 ve Pin 3 düğmelerinin solundaki ok simgelerine 
basarak pinlere ait menülerin açılmasını sağlayınız (Görsel 3.179).
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Görsel 3.179: Pinlere anahtar kare eklenmesi

Her üç pinin de Position değerlerine (önceden belirlenen 0. saniyeye) anahtar karelerin 
otomatik olarak eklendiği görülür.

5. Adım: İkinci anahtar kareleri koyabilmek için zaman imlecini 1. saniye konumuna alınız.

6. Adım: Composition ekranında Pin 1, Pin 2 ve Pin 3 pinlerini karakterin el sallama hareketini 
gerçekleştirebileceği şekilde yukarıya doğru kaldırınız (Görsel 3.180).

Görsel 3.180: Pinleri kullanarak animasyon oluşturma

7. Adım: 1. saniye konumuna eklenen üç anahtar kareyi seçiniz. Ctrl+C düğmeleri ile 
kopyaladıktan sonra zaman imlecini 2. saniye konumuna alınız ve kopyalanan anahtar kareleri 
Ctrl+V düğmeleri ile yapıştırınız. Böylece karakter ilk hareketi yaptıktan sonra bulunduğu 
konumda karakterin bir saniye beklemesi sağlanır.

8. Adım: 0. saniye konumuna eklenen üç anahtar kareyi seçiniz. Ctrl+C düğmeleri ile 
kopyaladıktan sonra zaman imlecini 3. saniye konumuna alınız ve kopyalanan anahtar kareleri 
Ctrl+V düğmeleri ile yapıştırınız. Karakter bir süre bekledikten sonra kol ilk harekete başladığı 
konuma geri döner.
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9. Adım: Oluşturulan animasyonu boşluk tuşu ile oynatınız.

Bir katman için Transform özellikleriyle oluşturulmuş hareket animasyonları, o katmana 
bağlanan başka katmanlara da uygulanabilir. Böylece birden fazla katmanın eş zamanlı olarak 
aynı hareketleri yapması sağlanır.

3.7. HAREKET TAKİBİ
Videonun içinde seçilen bir noktanın X ve Y eksenlerindeki hareketleri tespit edilerek o noktaya 

aslında orada olmayan nesneler eklenebilir. Sonradan eklenen nesneler, daha önce tespit edilen 
hareketleri tekrar ederek nesnenin oraya sonradan eklendiği gizlenir.

3.7.1. Parent (Ebeveyn) Özelliğiyle Hareket Takibi

Parent özelliği ile bir katman diğer bir katmana bağlanır. Böylece bir katmanda oluşturulan 
hareketler başka bir katmana aktarılır (Görsel 3.181).

Görsel 3.181: Parent simgesi

İşlem adımlarına göre parent özelliğini kullanarak katmanları birbirine bağlayınız.

1. Adım: Yeni bir proje ve projede bir kompozisyon oluşturunuz.

2. Adım: Kompozisyona görseldeki gibi içinde 10 yazan Text katmanı ve bir beşgen bulunan 
şekil katmanı ekleyiniz. Katmanları ekranda ortalamak için Allign panelini kullanınız (Görsel 
3.182).

Görsel 3.182: Kompozisyona şekil ve yazı katmanı ekleme

19. UYGULAMA
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3.  Adım: 10 sayısının yazdığı Text katmanı ile ekranın solundan dönerek gelecek şekilde, 5. 
saniyede sonlanacak bir animasyon oluşturunuz (Görsel 3.183).

Görsel 3.183: Yazı katmanıyla animasyon oluşturma

4. Adım: Zaman imlecini 5. saniyeye alınız. Beşgen şekil katmanını yazı katmanına bağlayarak 
aynı animasyona sahip olmasını sağlamak için şekil katmanının Parent düğmesine farenizin sol 
düğmesiyle basılı tutup, fareyi sürükleyerek yazı katmanının üzerine getiriniz ve bırakınız (Görsel 
3.184).

Görsel 3.184: Şekil katmanını yazı katmanına bağlama
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5. Adım: Zaman imlecini 0. saniye konumuna alınız ve animasyonu oynatınız. Şekil katmanının 
Text katmanına bağlanarak aynı animasyona sahip olduğu görülür (Görsel 3.185).

Görsel 3.185: Şekil katmanının yazı katmanıyla eş zamanlı animasyonu

6. Adım: İki katman arasındaki Parent özelliğini kaldırmak için zaman imlecini 5. saniye 
konumuna alınız ve Parent düğmesinin yanındaki kutucuğu seçerek açılan menüde None 
düğmesini seçiniz (Görsel 3.186).

Görsel 3.186: Parent özelliğini kaldırmak

Bir katmanın herhangi bir Transform özelliği, başka bir katmanın Transform özelliğine 
bağlanabilir.

7. Adım: Şekil katmanının Scale özelliğini yazı katmanının Rotation özelliğine bağlayınız (Görsel 
3.187).

Görsel 3.187: Transform özelliklerinin birbirine bağlanması
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8. Adım: Zaman imlecini 0. saniye konumuna alarak oluşan animasyonu gözlemleyiniz. 

Parent özelliği kullanarak oluşturacağınız bir şekil katmanı ile bir Text katmanını 
birbirine bağlayınız. Birbirine bağlanan katmanlarla hareket animasyonu oluşturunuz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. Yeni proje oluşturdu.

2. Yeni kompozisyon oluşturdu.

3. Yeni şekil katmanı ekledi.

4. Yeni Text katmanı ekledi.

5. Katmanları birbirine bağladı.

6. Birbirine bağlanan katmanlarla hareket animasyonu oluşturdu.

7. Projeyi bilgisayara kaydetti.

3.7.2. Null Object Özelliğiyle Katmanları Birbirine Bağlamak

Kendi içinde farklı animasyonlara tabi tutulmuş birden fazla katmanın, aynı zamanda tek bir 
katmanmış gibi davranıp, toplu olarak hareket etmesi istendiğinde Null Object katmanı kullanılır. 
Null Object ekranda yalnızca kılavuz görevindedir. Proje çıktısında görüntüsü gizlenir. 

Kendi içinde farklı animasyonlara tabi tutulmuş katmanlar sahneye eklenen Null Object 
katmanına bağlanır. Toplu olarak verilmek istenen animasyon Null Object katmanına uygulanır. 
Böylece hem katmanlar kendileri için üretilmiş özel animasyonları oynatırken hem de toplu 
olarak Null Object katmanına uygulanmış olan animasyonları oynatır.

SIRA SİZDE
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İşlem adımlarına göre Null Object katmanı kullanarak animasyon oluşturunuz..

1. Adım: Yeni bir proje oluşturunuz. Bu projede 20 saniye uzunluğunda, 1920x1080 piksel 
çözünürlüğünde bir kompozisyon oluşturunuz.

2. Adım: Sahneye yukarıdan aşağıya yazan bir yazı katmanı eklemek için araç çubuğundaki Text 
düğmesine basınız. Açılan menüde dikey yazma düğmesini seçiniz ve yazdığınız yazıyı görseldeki 
gibi sahnenin soluna yerleştiriniz (Görsel 3.188).

Görsel 3.188: Kompozisyona yazı katmanı eklenmesi

3. Adım: Yazı katmanına maske eklemek için katmanı seçiniz. Ardından çember aracını seçerek 
katmanın üzerine yazının tek bir harfini kaplayacak şekilde çember şekli çiziniz (Görsel 3.189).

Görsel 3.189: Yazı katmanının maskelenmesi

20. UYGULAMA
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4. Adım: Katman maskesine animasyon uygulamak için Mask 1 menüsünü açınız.  Katman 
maskesinin altında bulunan Expansion değeri azaltıldığında maskelenen alan küçülür. Bu değer 
artırıldığında maskelenen alan artar.

5. Adım: Expansion değerine anahtar kareler ekleyerek üç saniye uzunluğunda (0-3 saniyeleri 
arasında), katman maskesinin hiç görünmediği görüntüden bütün metni kapsadığı görüntüye 
doğru ilerleyen bir animasyon oluşturunuz (Görsel 3.190).

Görsel 3.190: Maske ile animasyon oluşturma

6. Adım: Sahneye soldan sağa doğru uzanan yeni bir yazı katmanı daha ekleyerek Görsel 
3.191’deki gibi yerleştiriniz.

Görsel 3.191: İkinci yazı katmanının eklenmesi
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5. Adım:  İkinci Text katmanına da katman maskesi uygulayıp, Expansion değerine anahtar 
kareler ekleyerek  üç saniye uzunluğunda (3-6 saniyeleri arasında), katman maskesinin hiç 
görünmediği görüntüden bütün metni kapsadığı görüntüye doğru ilerleyen bir animasyon 
oluşturunuz (Görsel 3.192).

Görsel 3.192: Maske ile animasyon oluşturma

6. Adım: Null Object katmanı eklemek için zaman çizelgesinin katman bölümünde boş bir 
alana farenizin sağ düğmesine tıklayarak açılan pencereden New>Null Object seçeneklerini 
seçiniz (Görsel 3.193).

Görsel 3.193: Kompozisyona Null Object eklenmesi



                                                Hareketli Görüntüler 235

Sahneye Null Object katmanı eklemenin başka bir yolu ise araç çubuğundan sırasıyla  
Layer>New>Null Object düğmelerini seçmektir (Görsel 3.194).

Görsel 3.194: Kompozisyona farklı bir yolla Null Object eklenmesi

Null 1 isimli Null Object katmanı, katman bölümüne gelir ve sahnede kare şeklinde kılavuz 
çizgileri görünür (Görsel 3.195).

Görsel 3.195: Null Object katmanının katman bölümünde ve kompozisyon ekranında görünümü
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7. Adım: Null Object nesnesini sahnede harflerin birleştiği noktaya taşıyınız (Görsel 3.196).

Görsel 3.196: Null Object katmanının sahnede taşınması

8. Adım: Text katmanlarını Null 1 isimli katmana bağlayınız (Görsel 3.197).

Görsel 3.197: Katmanların birbirine bağlanması

9. Adım: Null Object katmanına katmanın Transform özelliklerini kullanıp, sağdan 40 derece 
dönerek gelecek şekilde animasyonu uygulayınız (Görsel 3.198).

Görsel 3.198: Animasyonun oynatılması
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A) Aşağıdaki soruları dikkatlice okuyarak doğru seçeneği işaretleyiniz.

1. Aşağıdakilerden hangisi her katmanda ortak olarak bulunan standart bir menüdür?

    A) Add

    B) Ofset

    C) Path

    D) Start 

    E) Transform 

2. Katmanı sahnede hizalamak için kullanılan panel aşağıdakilerden hangisidir?

    A) Allign		      

    B) Character 	  	  
    C) Libraries 	  

    D) Paragraph	    
    E) Preview

3. Aşağıdakilerden hangisi şekil çizim araçlarıyla çizilebilecek şekillerden değildir?

    A) Sphere Tool   	    				         
    B) Polygon Tool   	         
    C) Ellipse Tool   				    	  

    D) Star Tool        
    E) Rounded Rectangle Tool

4. Aşağıdakilerden hangisi şekil katmanına eklenebilen düzenleyicilerden biridir?

    A) Darken	    	         
    B) Multiply	   	  

    C) Saturation	  

    D) Screen  	

    E) Twist

ÖLÇME VE DEĞERLENDİRME
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5. Hareketsiz nesnelere bağlantı noktaları ekleyerek bu noktalarla nesneye hareket veril- 
mesini sağlayan araç aşağıdakilerden hangisidir?

    A) Clone Stamp Tool  

    B) Brush Tool  

    C) Puppet Pin Tool  

    D) Pan Behind Tool  

    E) Hand Tool

6. Görselde kompozisyon ayarlarından bir tanesi gösterilmektedir. 

    
     Buna göre çalışma alanı ile ilgili aşağıdakilerden hangisi doğrudur?

    A) Çözünürlüğü 800x800 pikseldir.	     

    B) Genişliği 800 pikseldir.	  	  
    C) Yüksekliği 800 pikseldir.

    D) Çözünürlüğü 800x600 pikseldir.	    
    E) Derinliği 800 pikseldir.

7. .  

   Görseldeki transform (dönüşüm) ile nesnenin aşağıdaki hangi özelliği değiştirilir?

    A) Nesnenin konumu  	    				         
    B) Nesnenin büyüklüğü	         
    C) Nesnenin açısı				    	  

    D) Nesnenin çapa noktası     
    E) Nesnenin şeffalığı

8. Aşağıdakilerden hangisi kompozisyonun ön izlemesini başlatmak için kullanılacak kısa- 
yollar arasında yer alır?

    A) Enter tuşu	         
    B) Shift tuşu 	  

    C) Alt tuşu

    D) Boşluk tuşu

    E) Tab tuşu
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9. Anahtar kare seçiliyken aşağıdaki tuşlardan hangisine basılırsa anahtar kare silinir?

    A) Tab tuşuna

    B) Shift tuşuna

    C) Delete tuşuna

    D) Ctrl tuşuna

    E) Caps Lock tuşuna

10. Aşağıdakilerden hangisi nesnenin şeffalığını ayarlamayı sağlar?

    A) Opacity	    

    B) Rotation	  	  
    C) Scale

    D) Position	    
    E) Anchor Point



KONULAR

4.1. MASKELEME (MASK)

4.2. YEŞİL PERDE (GREENBOX) TEKNOLOJİSİ

4.3. ROTO BRUSH ARACI MASKELEME VE ROTOSKOP

ANAHTAR KELİMELER

 VFX, Rotoskop, Greenscreen, grafik, animasyon, maskeleme

 NELER ÖĞRENECEKSİNİZ?

• Görsel efekt programlarında bir görsele veya videoya maske uygulama

• Maske uygulanarak ayrıştırılmış nesnelerle yeni bir kompozisyon oluşturma 

• Chrome Key (Greenbox veya Bluebox) tekniği

• Greenbox tekniğiyle elde edilmiş görüntüleri kullanarak yeni kompozisyon-
lar oluşturma

• Rotoskop tekniği 

• Görsel efekt programlarında Rotoskop tekniğini kullanma



MASKELEME TEKNİKLERİ

4. ÖĞRENME BİRİMİ
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1. Videolarda arka plan değiştirmenin faydası neler olabilir?

2. Bir videoda aslında olmayan bir nesne (bina, kale, dağ, göl vb.) videoya nasıl 
yerleştirilebilir?

4.1. MASKELEME (MASK)
Maskeleme (Mask) işlemi görsel efekt programlarında sıklıkla kullanılan yöntemlerden biridir. 

Maskelemenin temel mantığı, belirlenen içerikte yalnızca istenen yerlerin gösterilmesi, diğer 
alanların gizlenmesi ilkesine dayanır. Böylece kurgusal mekânlar, kişi ve nesne yerleştirmeler, sıra 
dışı efektler videolarda kolayca yapılabilir.

4.1.1. Shape Nesnesi Kullanarak Maskelemek 

Görsel efekt programının Tools paletindeki Shape aracının (Görsel 4.1) alt nesneleri (Görsel 
4.2) kullanılarak basit şekillerde maskeleme yapılabilir.

Tools Paleti 
Shape Aracı

Görsel 4.1: Tools paleti ve Shape aracı 

Shape aracına mouse 
sol tuşu uzun basılarak 
diğer Shape nesneleri 
seçilebilir.

Görsel 4.2: Shape aracının alt nesneleri

Maskeleme işleminde Shape aracına ait alt nesnelerin çizimi, özellikleri ve Layer panelindeki 
özellikleri iyi bilinmelidir. Bir katmanı maskeleme amacıyla Shape nesnelerini kullanmak için 
katman panelinde resim veya video işaretliyken Shape araçlarından istenen araç seçilir ve şekil 
oluşturulur. Böylece çizilen şekilde ilgili katmandaki içerik görüntülenir. 

HAZIRLIK ÇALIŞMALARI
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Görsel 4.3’te Shape araçları ile bir görsel maskelendiğinde oluşabilecek görüntüler bulunur.

Görsel 4.3: Shape araçlarıyla maskelenmiş bir fotoğraf sahnedeki görünümleri

Görsel 4.4: Star Shape aracıyla çizilmiş maske görünümü

Shape araçlarıyla çizilen şekiller, maskeleme için referans şekillerdir. Şekiller üzerindeki 
vertexler (iki çizginin birleştiği noktalar) değiştirilerek farklı şekiller de elde edilebilir.

Görsel 4.4’te Star Shape nesnesi ile çizilmiş bir mask görülür.

Görsel 4.5’te ise Star nesnesinin vertexleri ile oynanarak elde edilmiş yeni maske görünümü 
verilmiştir. Vertexleri konumlandırmak için Selection Tool (V) aracı seçilmiş, mouse işaretçisi ile 
üzerine tıklanarak vertexler hareket ettirilmiştir.

Görsel 4.5: Star Shape aracıyla çizilmiş şeklin vertexleriyle oynanmış hâli
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Bir katmandaki görsel veya videoya maske eklendiğinde katman paneline Mask 1 ile başlayan 
yeni bir özellik alt katmanı ilave edilir (Görsel 4.6). 

Görsel 4.6: Maske çizildiğinde katman paneline eklenen Mask özellikleri alt katmanı

Aynı katman üzerine birden fazla maske eklenmeye devam edilirse Mask 1, Mask 2… şeklinde 
artan alt katmanlar oluşur.

Mask alt katmanındaki özellikler şunlardır:

Mask Path: Eklenen maske şeklinin sınırlarını değiştirip yeniden belirlemeyi sağlar.

Mask Feather: Eklenen maske şeklinin çerçevesinde geçişi yumuşatarak alt katmanlarla 
kaynaşmayı kolaylaştırır.

Mask Opacity: Eklenen maske şeklinin görünürlük oranını ayarlar.

Mask Expansion: Eklenen maske şeklinin sınırlarını artırıp azaltmaya yarar. 

Görsel 4.7’de üstteki görsele maske uygulanmış ancak Mask Opacity değeri “0” olarak 
ayarlanmıştır. Bu durum, maskenin işlevini ortadan kaldırmıştır. Görsel 4.8’de Mask Opacity 
değeri “100”e ayarlanmıştır. Görüldüğü üzere maskenin sınır çizgilerinde keskin bir geçiş söz 
konusudur. Görsel 4.9’da ise Mask Feather değeri “40”a ayarlanarak sınırların alttaki görselle 
biraz daha kaynaşması sağlanmıştır.

Görsel 4.7: Maskesiz görsel 
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Görsel 4.8: Maske eklenip, Feather değeri “100” olarak ayarlanan görsel

Görsel 4.9: Maske eklenip, Mask Feather değeri “40” olarak ayarlanan görsel

İşlem adımlarına göre Shape nesnelerinden biri ile maskeleme yapıp, Position 
animasyonunu kullanarak bir çalışma gerçekleştiriniz.

1. Adım: Çözünürlüğü Full HD (1920x1080), Frame Rate değeri 30 fps olan bir Composition 
oluşturunuz.

2. Adım: Uygulama içinde kullanılabilecek görsel veya videoları uygun web sitelerinden 
indiriniz.

3. Adım: Görseli fare ile sürükleyerek Project bölümünden Timeline panelinin katmanlar 
bölümüne bırakınız.

4. Adım: Görselin boyutunu Scale değeriyle veya sahnede görsele sağ tıklayıp, Transform>Fit 
to Comp Width seçerek görselin sahneyi doldurmasını sağlayınız.

1. UYGULAMA
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Fit to Comp seçildiğinde resim ve videolarda bazen en ve boy sorunları oluşabilir.
Bu nedenle uygun doldurma seçeneği denenmeli, en ve boy oranının bozulmasına izin 
verilmemelidir.

Görsel 4.10: Rectangle Tool ile maske uygulanmış sahne ve Timeline katman bölümü

5. Adım: Resminize ait katman seçiliyken Shape nesnesinden Rectangel Tool seçerek Görsel 
4.10’daki gibi sahnenin alt alanından bir bölümü maskeleyiniz.

6. Adım: Katman panelinde görselin adının üzerine tıklayarak mask özelliklerinin seçimini 
kaldırınız.

7. Adım: Klavyeden Ctrl+D veya Edit>Duplicate yaparak katmanın ikizini oluşturunuz.

8. Adım: Yeni oluşan katman bir önceki katmanın üzerine konumlanmış durumdadır. Yeni 
katman seçiliyken klavyeden M tuşuna basarak Mask özelliklerinin görünmesini sağlayınız (Görsel 
4.11).

Görsel 4.11: Seçili katmanda M tuşu ile Mask özelliklerine erişim

Katman seçiliyken M tuşuna basıldığında 
Mask özellikleri görüntülenir.

Maske

NOT
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9. Adım: Mask 1’i görüntüledikten sonra katman özelliklerindeki Inverted kutusunu 
işaretleyerek maskelenmiş alanı tersine çeviriniz. Böylece katmanlardaki aynı görselin zıt 
bölgelerini maskeleyerek iki katmandan tek bir görüntü elde ediniz (Görsel 4.12). Bu işlemden 
sonra artık iki katmandan oluşan tek bir görsel vardır. Bir sonraki adımda animasyonla alttaki 
görsel sağdan sola, üstteki görsel ise soldan sağa kayarak görsel bütün hâle gelecektir.

Görsel 4.12: Maskelerinden biri Inverted edilmiş iki katmanın tek görseli oluşturması 

10. Adım: Katman panelini düzenlemek ve gerekli  Position özelliğini açmak için katman 
panelindeki ilgili katmanları seçiniz ve P (Position) tuşuna basınız (Görsel 4.13).

Görsel 4.13: Katmanların mouse ile seçilmesi

Katman panelinde ilgili katmanlar seçilir 
ve P tuşuna basılır.

11. Adım: Animasyonun iki (2) saniyede gerçekleşmesini isterseniz Timeline çizgisini 2. 
saniyeye çekiniz ve Position  Keyframe ikonuna basarak 2. saniyeye  bir anahtar kare oluşmasını 
sağlayınız (Görsel 4.14).

Görsel 4.14: Seçili katmanlarda P tuşuna basıldığında Position parametresinin görüntülenmesi
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12. Adım: Timeline çizgisini 0. saniyeye çekip katmanların tek tek Position  x (yatay) değerlerini 
değiştiriniz. Animasyonda alt katmandaki görsel sağdan sola geleceği için 0. saniyede Position  
x değerini artırarak görseli sahnede sağa doğru öteleyiniz. Üst katmandaki görsel için de tersi 
yönde ayarlama yapınız (Görsel 4.15).

Görsel 4.15: Sağa ve sola ötelenerek animasyona hazırlanan görseller

13. Adım: Animasyon hareketinin fizik kurallarına daha uygun oynaması için Easy Ease  
özelliğini aktifleştiriniz. Bunun için Timeline çizgisinde anahtar kareleri mouse ile seçerek 
klavyeden F9 tuşuna basınız (Görsel 4.16).

Görsel 4.16: Easy Ease aktif edildiğinde anahtar karelerin aldığı form

NOT: Easy Ease özelliği kaldırılmak  
isteniyorsa Ctrl tuşuna basılı iken anahtar 
karelere tıklanmalıdır.

Bu çalışmada kullanılan görsel, hareketi belli etmesi açısından sahne ölçülerinde 
seçildi ve kenarlarda boşluk ortaya çıktı. Görsel, sahneden daha büyük ölçülendirildiğinde 
bu kenar boşlukları görünmeyecektir. 

NOT
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14. Adım: Keyframeler seçiliyken üzerine sağ tıklayıp Keyframe Velocity penceresindeki 
değerleri Görsel 4.17’de olduğu gibi ayarlayınız.

Görsel 4.17: Keyframe Velocity penceresindeki değerler

Bu değerlerin animasyon hızına etkisi Görsel 4.18’deki grafikte verilmiştir. Keyframe Velocity 
penceresindeki değerler, durmak üzere olan bir cismin hız eğrisiyle neredeyse eş değerdir ve bu 
değerler animasyonlarda sıklıkla kullanılır.

Görsel 4.18: Graph Editorde Easy Ease ve Velocity in: 100-out: 0.1 değerleri sonucunda oluşan hız eğrisi   

On dördüncü adımdaki işlem, Graph Editor kullanılarak da yapılabilir.

15. Adım: Bu çalışma gerçekleşirken Text aracı ile yazacağınız birkaç kelimelik bir metne 
Opacity ve Position animasyonu ekleyiniz.

NOT
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DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. 1920x1080 çözünürlük ve 30 fps değerlerinde Composition oluşturdu.

2. Belirtilen materyali ilgili klasörden programa aktardı.

3. Görseli Timeline katman paneline taşıdı.

4. Katman paneline taşınan görselin çözünürlüğünü sahneye göre ayarladı.

5. Görseli seçerek görselin üzerine Rectangel Tool ile maske alanı oluşturdu.

6. Katman panelinde dosya ismini seçerek Ctrl+D (Edit>Duplicate) katmanın 
ikizini çıkardı.
7. Çoğaltılan yeni katmanda Mask>Inverted seçeneğini işaretleyerek maske 
alanını ters çevirdi.
8. Katman panelindeki görsel katmanlarında Position özelliğini aktif hâle 
getirdi.
9. Timeline çizgisini 2. saniyeye getirerek her iki görsel için de anahtar kare 
oluşturdu.
10. Timeline çizgisini 0. saniyeye getirerek görsellerin Position  x değerlerini 
doğru ayarladı.
11. Oluşturulan dört anahtar kareyi seçerek F9 ile Easy Ease özelliğini aktif-
leştirdi.

12. Anahtar karelerin Keyframe Velocity değerlerini doğru şekilde ayarladı.

13. Görsel animasyonuna ek olarak metin animasyonu gerçekleştirdi.

Belirleyeceğiniz bir görsel üzerinde birinci uygulamada olduğu gibi Rectangle Tool 
aracı ile maske oluşturup animasyonla görseli hareketlendiriniz.

SIRA SİZDE
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4.1.2. Pen Aracını Kullanarak Maskelemek 

Pen aracı, maskeleme işleminde çok sık kullanılır. Özellikle VFX denilen görsel efekt işlemlerinde 
farklı nesneler kullanılarak bir sahne oluşturulurken Shape araçlarındaki net çizgilerle değil, daha 
girintili maskeleme yapılarak görsel etki artırılmaya çalışılır. Bu nedenle Pen aracını maskeleme 
işleminde tercih etmeden önce yardımcı araçlarıyla birlikte etkin bir şekilde kullanmak önemlidir. 
Pen ve yardımcı araçları Görsel 4.19’da verilmiştir.

Görsel 4.19: Pen ve yardımcı araçları

Pen Tool: Serbest şekil çizim aracıdır. Noktalar (vertex) ekleyerek şekiller oluşturur. Bir vertex 
için tıklandığında sol tuş bırakılmadan mouse hareket ettirilirse keskin bir çizgi yerine yay şeklinde 
bir çizgi elde edilebilir (Görsel 4.20). 

Pen aracıyla çalışmada eklenen bir vertexin yeri, üzerine tıklanıp, bırakılmadan 
sürüklenerek değiştirilebilir. 

Görsel 4.20: Pen aracıyla çizilmiş iki farklı çizgi örneği

Add Vertex Tool:  Çizilen şekilde daha fazla vertexe ihtiyaç varsa bu araç ile vertex eklenebilir. 
Pen Tool seçiliyken vertex dışında çizginin üzerine mouse işaretçisi götürüldüğünde de Add Vertex 
Tool aracı otomatik olarak çağrılır.

Delete Vertex Tool: Eklenen vertexleri silmek için kullanılır. Pen aracı aktifken Ctrl tuşuna 
basılarak vertexin üzerine mouse işaretçisi ile gidildiğinde de çağrılır.

NOT
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Convert Vertex Tool: Vertexleri keskin çizgilerden açılı yaylara (bezier) veya açılı yaylardan 
keskin çizgi formuna dönüştürür.

Mask Feather Tool: Maskeleme işleminde kullanılmış Pen aracının çizgilerini bozmadan Mask 
Feather Tool ile eklenen vertexler, maskenin Feather alanını özelleştirmeye yarar (Görsel 4.21).

Pen aracıyla çizilmiş bir 
maske alanına ait vertex

Mask Feather Tool ile 
eklenmiş bir noktanın 
maske alanına etkisi

Görsel 4.21: Mask Feather Tool aracının kullanımı

İşlem adımlarına göre Pen Tool aracını kullanıp, bir vadi ve kaleden oluşan iki görseli 
maskeleyerek tek bir kompozisyon elde ediniz.

1. Adım: Çözünürlüğü Full HD (1920x1080), Frame Rate değeri 30 fps bir Composition 
oluşturunuz.

2. Adım: Uygulama içinde kullanılabilecek görsel veya videoları uygun web sitelerinden 
indiriniz. Renk uyumu düzenlemesi yapılmayacaktır (Görsel 4.22).

Görsel 4.22: Renk düzenlemesi yapılmamış sadece kompozisyon oluşturulmuş sahne görüntüsü

2. UYGULAMA
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3. Adım: İlgili görselleri Timeline katman alanına sürükleyerek Comp1’e ekleyiniz.

4. Adım: Arka plan vadi görselini uygun olduğunu düşündüğünüz alandan Pen Tool kullanıp 
işaretleyerek maskeleyiniz (Görsel 4.23).

Görsel 4.23: Arka plan görseline Pen Tool ile maske uygulanması

5. Adım: Arka plan görselini Ctrl+D veya Edit>Duplicate yoluyla çoğaltıp, Mask özelliğini Invert 
ederek iki görselden tek görsel meydana getiriniz. Maske kenarlarında belirginlik oluştuysa 
vertexlerin yerini değiştirerek bu sorunu çözebilirsiniz. 

6. Adım: Kale görselini Timeline katmanlar alanına dâhil ediniz ve katmanları sıralayınız. Bu 
kompozisyonda maskeli vadi resmi en üstte, kale resmi ortada ve maskesiz tamamlayıcı resim ise 
en alt sırada olacak şekilde katmanlarda sıralı vaziyettedir (Görsel 4.24).

Görsel 4.24: Katmanların doğru şekilde sıralandığı sahne düzeni

Bu çalışma özelinde üst katmanda kalan görselin maskeye ihtiyacı yoktur. Mask 
özelliği silinerek de çalışmaya devam edilebilir.

NOT
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Görsel 4.25: Pen Tool aracıyla maskelenmiş kale görseli

7. Adım: Kale görselini Pen Tool yardımıyla maskeleyiniz (Görsel 4.25). 

8. Adım: Sahnenin geneline göre büyük olduğunu düşünüyorsanız Scale özelliği ile kale 
görselini küçültünüz.

9. Adım: Pen Tool  ve Mask Feather Tool araçlarını kullanarak kale ile vadi görsellerini 
birbirine karışacak şekilde düzenleyiniz. Bunu yaparken gerekirse Pen Tool ile eklenen vertexleri 
değiştirmekten çekinmeyiniz. Gerekli yerlere Mask Feather vertexi ekleyiniz (Görsel 4.26).

Görsel 4.26: Pen ve Mask Feather Tool ile düzenleme

10. Adım: Kale görseline uygulanan maske işlemi, görselin kenarlarında keskinlik meydana 
getirebilir. Bu keskinliği Mask özelliğindeki Feather değerinden düzenleyiniz. Feather işlemi ile 
kale etrafında resmin diğer alanları belirir ve bir çerçeve meydana getirirse Mask Expansion 
özelliğini negatif yönde ayarlayınız (Görsel 4.27).

Görsel 4.27: Kale görselinde Mask Feather ve Mask Expansion değerlerinin ayarlanması
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11. Adım: Arka plan görselinin derinlik algısı üzerine eklenen kale görseli bu derinliğe uymazsa 
kale görselinin 3D özelliğini aktifleştirerek ve Y ekseninde kale görselini birkaç derece döndürerek 
derinlik algısını daha uygun hâle getiriniz (Görsel 4.28).

3D özelliği aktifleştirildik-
ten sonra katman seçiliy-
ken R tuşuna basılarak 
Oriantation özelliği gö-
rüntülenebilir.

Görsel 4.28: Kale katmanının 3D özelliği aktifleştirilerek elde edilen sahne görüntüsü

Belirleyeceğiniz en az iki görseli Pen Tool aracını kullanarak maskeleyiniz ve 
görsellerden yeni görsel meydana getiriniz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR
1. İstenen çözünürlük ve fps değerlerinde Composition oluşturdu.
2. İlgili klasörden belirtilen materyali programa aktardı.
3. Arka plan görselini Timeline katman paneline taşıdı.
4. Katman paneline taşınan görselin çözünürlüğünü sahneye göre ayarladı.
5. Arka plan görselini seçerek Pen Tool ile maske alanı oluşturdu.
6. Katman panelinde dosya ismini seçerek Ctrl+D (Edit>Duplicate) ikizini çıkar-
dı.
7. Çoğaltılan yeni katmanın Mask>Inverted seçeneğini işaretleyerek maske 
alanını ters çevirdi veya Mask katmanını sildi.

8. Katman panelinde bulunan üç katmanı doğru şekilde sıraladı.

9. Görseli Pen Tool aracıyla maskeledi.

10. Arka plan görselinin Feather değerlerini uygun şekilde ayarladı.

11. Kale görselinin Feather değerlerini uygun şekilde ayarladı.

12. Görseli Scale değeriyle uygun ölçüye getirdi.

SIRA SİZDE
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4.1.3. Track Matte Yöntemiyle Maskelemek

Maskeleme işleminin bir diğer yöntemi “Track Matte” özelliğidir. Track Matte, görsel 
animasyonlarda çok sık kullanılan bir yöntemdir. Timeline katman panelindeki Track Matte 
seçeneği Görsel 4.29 ve Görsel 4.30’daki gibi gösterilip gizlenebilir. Track Matte özelliğinde 
maskeleyici olarak katmanlar kullanılır ancak katmanlardaki nesnelerin renk bilgileri de önemlidir. 
Track Matte yönteminde üst üste konumlanan iki katmandan üst katmanın Alpha veya Luma renk 
bilgileri kullanılarak altta kalan katman, üst katman dolgusunda maskelenebilir (Görsel 4.31).  

Görsel 4.29: Track Matte kapalı Görsel 4.30: Track Matte açık 

Alpha kanalı olarak referans  
alınan katmandaki nesnele-
rin dolgusu saydam bir alan  
meydana getirir. Diğer alanlar opak 
bir hâlde davranır.

Görsel 4.31: Track Matte özelliğinde Alpha Matte seçiliyken gerçekleşen maskeleme
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Alpha Inverted özelliği seçilirse üst katmanın dolgu alanlarının dışı saydam kabul edilir ve 
buna göre maskeleme yapılır (Görsel 4.32).

Görsel 4.32: Alpha Inverted özelliği seçiliyken gerçekleşen maske

İşlem adımlarına göre Track Matte Alpha özelliğini kullanarak bir çalışma 
gerçekleştiriniz. Çalışmanızın sonunda Görsel 4.33’e benzer bir görüntü elde ediniz.

3. UYGULAMA

Görsel 4.33: Uygulama sonunda elde edilecek çalışmanın bir kesiti  
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1. Adım: Çözünürlüğü Full HD (1920x1080), Frame Rate değeri 30 fps bir Composition 
oluşturunuz.

2. Adım: Uygulama içinde kullanılabilecek görsel veya videoları uygun web sitelerinden 
indiriniz.

3. Adım: Arka plan olarak belirlediğiniz görsel veya videoyu Timeline katman paneline 
sürükleyip bırakınız.

4. Adım: Arka plan nesnesinde boyutla ilgili bir düzenleme gerekirse en ve boy oranını 
koruyarak bu düzenlemeyi gerçekleştiriniz.

5. Adım: Metin olarak SU UMUTTUR mesajı tercih edildi. Text katmanı olarak önce SU 
kelimesini yazınız. Ardından ikinci bir Text katmanına UMUTTUR kelimesini Görsel 4.34’e benzer 
şekilde yerleştiriniz.

Görsel 4.34: Çalışmanın ilk yerleştirme ve metinlerin eklendiği hâli

6. Adım: SU kelimesinin olduğu katmanı Ctrl+D kısayolu ile harf sayısınca çoğaltınız (Görsel 
4.35).

Görsel 4.35: Harf sayısı kadar çoğaltılmış kelime katmanı ve katman panelinin son hâli
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Yeni çoğaltılan metin katmanları kullanılırken kolaylık olması açısından metnin rengi 
değiştirilebilir.

7. Adım: Çoğalttığınız metin katmanlarındaki birer harfi silerek S ve U’nun kalmasını sağlayınız,  
alttaki SU kelimesine göre hizalayınız (Görsel 4.36).

Görsel 4.36: S ve U harflerinin rengi değiştirilmiş ve alttaki kelimeye göre hizalanmış hâli

8. Adım: SU kelimesinin yazılı olduğu katmanı gizleyiniz veya siliniz.

9. Adım: Track Matte özelliğinde kullanacağınız görselleri Timeline katman panelinde S ve U 
harflerinin altlarında olacak şekilde konumlandırınız ve Scale değerlerini harf boyutuna uygun 
hâlde ayarlayınız (Görsel 4.37).

Görsel 4.37: Görsellerin harflere göre ayarlanması

NOT
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10. Adım:  S ve U harflerinin altına yerleştirdiğiniz görsellerin katman panelindeki Track Matte 
özelliği aktif değilse bu özelliği aktifleştiriniz ve Alpha Track Matte seçiniz (Görsel 4.38). 

Görsel 4.38: İlgili görsellere Alpha Matte uygulanmış ve bu görsellerin üst katmanında yer alan harfler 
                       tarafından maskelenmiş hâlleri

11. Adım: Ön plana çıkması istenen nesnelerle arka plan arasında bir fark oluşturabilmek için 
arka plan görseli üzerine siyah renkle doldurulmuş Rectangle Tool nesnesini Görsel 4.39’daki gibi 
ekleyip, Opacity değerini düşürerek bir fark katmanı elde ediniz. 

Görsel 4.39: Siyah doldurulmuş Rectangle Tool nesnesi

Görsel 4.40: Çalışmanın mavi Rectangle Tool eklenmiş son hâli

 Mavi renkle doldurulmuş ikinci katman da istenirse kompozisyona eklenebilir 
(Görsel 4.40). İlerleyen süreçte bu işlem efektlerle de yapılabilir. 

NOT
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12. Adım: UMUTTUR kelimesine Animate>Tracking özelliğini ekleyerek bir animasyon 
gerçekleştiriniz.

13. Adım: Bu özelliği eklemek için UMUTTUR katmanındaki aşağı açılır oka tıklayıp yandaki 
Animate bölümünden Tracking seçiniz (Görsel 4.41).

Görsel 4.41: Text katmanına Tracking özelliği ekleme

14. Adım: Tracking eklendikten sonra Timeline çizgisini 2. saniyeye getiriniz ve Tracking 
Amount değerinin yanındaki anahtar kare butonunu aktifleştirerek Timeline paneline bir anahtar 
kare ekleyiniz. Bu işlem, animasyon sona erdiğinde Amount değerini belirtmenin yöntemlerinden 
biridir (Görsel 4.42).

 Görsel 4.42: Timeline paneline anahtar karelerin eklenmesi
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 15. Adım: Anahtar kareyi 2. saniyeye ekledikten sonra Timeline çizgisini 0. saniyeye çekiniz ve 
Tracking Amount değerini bir miktar değiştiriniz (Görsel 4.43).

Görsel 4.43: Animasyon başlamadan önce anahtar karelerin oluşturulması

16. Adım: Tracking Amount anahtar karelerini seçip F9 ile Easy Ease hareketini aktifleştiriniz. 
Easy Ease aktifleştirildikten sonra  Graph Editor yardımıyla veya Keyframe Velocity (anahtar 
kareye sağ tık) penceresinden Incoming Velocity değerini 100, Outgoing Velocity değerini 0,01 
yaparak animasyon hızını belirleyiniz (Görsel 4.44).

Görsel 4.44: Easy Ease değerlerinin ayarlanması
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Belirleyeceğiniz bir konuda görsel veya videolar üzerinde en az iki kelimelik bir 
sloganın tek kelimesini Track Matte kullanarak sloganla uyumlu görsellerle maskeleyiniz. 
Sloganın diğer kelime veya kelimelerine Animate kullanarak animasyon ekleyiniz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. İstenen çözünürlük ve fps değerlerinde Composition oluşturdu.

2. İlgili görseli veya videoyu programa aktardı.

3. Arka plan görselini veya videosunu katmanlar paneline ekledi.

4. Arka plan nesnesinin boyutunu en ve boy oranını koruyarak ölçülendirdi.

5. Text aracını kullanarak ilgili metni oluşturdu.

6. İlgili metnin boyutunu ayarladı.

7. Metni sahneye göre hizaladı.

8. İkinci kelimeyi Text aracını kullanarak ayrı bir katmanda ekledi.

9. İlk kelime katmanını harf sayısınca çoğalttı.

10. Çoğaltılan katmanlardaki harfleri doğru şekilde konumlandırdı.

11. Harflerin alt katmanına ilgili görselleri veya videoları ekledi.

12. Eklenen nesnelerin boyutlarını ayarladı.

13. Track Matte panelini aktif hâle getirdi.

14. İlgili katmanlarda Alpha Matte özelliği ile doğru maskeleme yaptı.

15. Arka planla kontrast için Rectangle Tool nesneleri ile katmanlar oluştur-
du.

16. Katmanların Opacity değerlerini ayarladı.

17. İkinci kelimenin Tracking Amount özelliğiyle animasyon yaptı.

SIRA SİZDE
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İşlem adımlarına göre sahnenin belirlediğiniz bir yerinde maskelenerek ortaya çıkan 
Text animasyonunu gerçekleştiriniz. 

1. Adım: Çözünürlüğü Full HD (1920x1080), Frame Rate değeri 30 fps olan bir Composition 
oluşturunuz.

2. Adım: Uygulama içinde kullanılabilecek görsel veya videoları uygun web sitelerinden 
indiriniz.

3. Adım: Görselinizi katman paneline sürükleyerek sahneye ekleyiniz.

4. Adım: Görselin boyutunu düzenleyiniz (Görsel 4.45).

Görsel 4.45: Sahneyi tam dolduran arka plan görseli

5. Adım: Text aracını kullanarak sahneye TRACK MATTE metnini yazınız (Görsel 4.46).

6. Adım: Arka plan görselinin Ctrl+D ile kopyasını oluşturunuz.

7. Adım: Kopyasını oluşturduğunuz görselin Track Matte özelliğini aktifleştirerek Alpha Matte 
seçeneğini metin katmanı olacak şekilde ayarlayınız.

8. Adım: Kopyasını oluşturduğunuz görseli metne göre hizalayınız.

9. Adım: Kopya görselin boyutunu eklediğiniz metnin boyutuna göre Scale ile ayarlayınız. 

10. Adım: Track Matte uyguladığınız görselin üzerine sağ tıklayıp, Transform>Flip Horizontal 
seçerek görseli yatayda yansıtınız (Görsel 4.46).

Görsel 4.46: Yatay yansıtma uygulanarak elde edilen Track Matte maskelemesi

4. UYGULAMA
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11. Adım: Arka plan ile metin arasında kontrast oluşması için iki katman arasına Pen Tool 
yardımıyla içi dolu bir Shape nesnesi çiziniz (Görsel 4.47). Renk paletini açıp, damlalık aracına 
tıklayarak görsel üzerinden koyu bir ton seçiniz ve katmanın Opacity değerini şeffaf olabilecek 
uygun bir değere ayarlayınız (Görsel 4.48).

Görsel 4.47: Pen Tool aracıyla Shape nesnesinin çizilmesi

Görsel 4.48: Pen Tool yardımıyla Shape nesnesinin çizilmesi, renginin ve Opacity değerinin ayarlanması

12. Adım: Metne animasyon uygulayınız.
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13. Adım: Text katmanının üzerine sağ tıklayıp, Pre-compose… seçerek Text katmanını Pre-
compose hâline getiriniz. Bu uygulamada Pre-compose’u Text olarak adlandırınız (Görsel 4.49 ve 
Görsel 4.50).

Görsel 4.49: Text katmanının Pre-compose’a 
                       dönüştürülmesi

Görsel 4.50: Pre-compose yapıldıktan sonra 
                       katmanın görüntülenmesi

14. Adım: Pre-compose hâline gelen Text katmanına çift tıklayarak Pre-compose’u açınız.

15. Adım: Pre-compose’daki TRACK MATTE Text katmanını Ctrl+D ile iki kez çoğaltınız (Görsel 
4.51).

Görsel 4.51: Track Matte kelime animasyonu için Text katmanlarının çoğaltılması

16. Adım: Kopyalanan diğer iki katmandaki kelimeleri düzenleyiniz (Görsel 4.52). 

Üç katmandan ilki hizalama ve maske çiziminde referans olacağı için üç kopya 
oluşturuldu. 

NOT
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17. Adım: Alpha Inverted Matte olarak her bir katman için Rectangle Tool nesnesi çiziniz 
(Görsel 4.53).

Görsel 4.52: Kelimelerin kılavuz kelimeye göre hizalanması

Görsel 4.53: Çizilecek Shape nesnelerinin konumları

Çizilen Shape nesneleri 
metinleri saklayacak ve  
animasyonla metinler görünür 
yapılacaktır. Bu nedenle Shape 
nesneleri kelimelerin saklanacağı 
yerde olmalıdır.  Matte kelimesini 
maskeleyecek Shape nesnesi, üstte 
görünen kırmızı Shape nesnesidir.

En alttaki TRACK MATTE katmanı referans olduğu için farklı bir renkle gösterildi. 
Diğer Text katmanları Görsel 4.52’de göründüğü gibi düzenlenmelidir.

NOT
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18. Adım: Shape Layerlerini oluşturduktan sonra Track Matte özelliğinden Alpha Inverted 
Matte  seçerek maskeleme yapınız (Görsel 4.54).

Görsel 4.54: Alpha Inverted Matte seçimi

19. Adım: Metinleri anime ediniz. Kelimeler aynı anda ortaya çıkacak, bir süre bekleyip tekrar 
kaybolacaktır.

20. Adım: Track ve Matte Layerlerinin Position özelliğini görüntülemek için katman seçiniz ve 
klavyeden P tuşuna basınız (Görsel 4.55).

Görsel 4.55: Seçili katmanlarda P tuşuna basıldığında Position parametresinin görüntülenmesi

21. Adım: Timeline çizgisini 1. saniyeye getiriniz ve Position yanındaki kronometre ikonuna 
tıklayarak anahtar kareler oluşturunuz (Görsel 4.56).

Görsel 4.56: Animasyona bitiş anahtar karelerinin eklenmesi
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22. Adım: Timeline çizgisini 0. saniyeye çekiniz. Track kelimesini sahneden kayboluncaya 
kadar aşağı, Matte kelimesini ise yukarı doğru hareket ettiriniz (Görsel 4.57).

Görsel 4.57: Animasyona başlangıç anahtar karelerinin eklenmesi

23. Adım: Sadece bitiş anahtar karelerine F9 ile Easy Ease veriniz.

24. Adım: Kelimelerin sahnede 1 saniye durup tekrar gizlenmesi için Timeline çizgisini 2. 
saniyeye getiriniz ve Position özelliğinin en solundaki anahtar kareye tıklayınız (Görsel 4.58).

Görsel 4.58: Easy Ease uygulanmış anahtar karelerin Timeline görüntüsü

25. Adım: Timeline çizgisini 3. saniyeye alınız ve kelimeleri tekrar ortaya çıktıkları maske 
alanına geri döndürünüz (Görsel 4.59).

Görsel 4.59: Animasyona bitiş anahtar karelerinin eklenmesiyle oluşan Timeline görüntüsü

26. Adım: Text Pre-compose’dan Comp1’e tıklayarak geri dönünüz.
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27. Adım: Animasyonu Numpad 0 veya space tuşuna basarak ön izleyiniz. Görsel 4.60’ta  bu 
animasyonun kesitleri verilmiştir.

Görsel 4.60: Animasyonun kesitleri

Seçeceğiniz bir konu hakkında (spor, sanat vb.) görsel belirleyip, konuya uygun bir 
metni dördüncü uygulamada olduğu gibi Track Matte (Alpha Matte ve Alpha Inverted 
Matte) ile maskeleyerek animasyonla hareketlendiriniz. 

DEĞERLENDİRME

Çalışmalarınız diğer sayfada yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

SIRA SİZDE
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DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR
1. İstenen çözünürlük ve fps değerlerinde Composition oluşturdu.
2. İlgili materyali programa aktardı.
3. Arka plan görselini veya videosunu katmanlar paneline ekledi.
4. Arka plan nesnesinin boyutunu en ve boy oranını koruyarak ölçülendirdi.
5. Text aracını kullanarak ilgili metni oluşturdu.
6. İlgili metnin boyutunu ayarladı.
7. Metni sahneye göre hizaladı.

8. Arka plan nesnesini Ctrl+D ile kopyaladı.

9. Kopyaladığı arka plan nesnesinin Track Matte özelliğine metin seçerek mas-
keledi.

10. Maskelediği görseli Transform>Flip Horizontal yaparak yansıttı.

11. Maskelediği görselin Scale değerini metne uygun hâle getirdi.

12. Arka plan ile metin arasına Pen Tool aracıyla Shape nesnesini çizdi.

13. Metin katmanına sağ tıklayarak Pre-compose yaptı.

14. Pre-compose içinde metinleri düzenledi.

15. Maskeleme için Shape Rectangle Tool nesnelerini çizdi.

16. Track Matte özelliğinden Alpha Inverted Matte seçerek metinleri maskele-
di.

17. Position animasyonlarını anahtar kareler ile ilgili saniyelerde gerçekleştirdi.

18. Anahtar karelere F9 ile Easy Ease özelliği verdi.

19. Comp1’e geri dönerek animasyonu ön izledi.

İşlem adımlarına göre Track Matte özelliğinin Luma Inverted Matte maskeleme 
yöntemini kullanarak bir çalışma gerçekleştiriniz.

1. Adım: Çözünürlüğü Full HD (1920x1080), Frame Rate değeri 30 fps bir Composition 
oluşturunuz.

2. Adım: Uygulama içinde kullanılabilecek görsel veya videoları uygun web sitelerinden 
indiriniz.

3. Adım: Görselleri katman paneline sürükleyerek sahneye ekleyiniz.

4. Adım: Görsellerin boyutunu sahneye göre düzenleyiniz.

5. Adım: Görseller arası geçişte kullanılan videoları ink splash (mürekkep damlası) ismiyle 
bulunuz.

5. UYGULAMA

KONTROL LİSTESİ
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6. Adım: Geçiş videosunu da çalışmanıza dâhil ediniz.

7. Adım: Geçişte tek bir video kullanılacağı için projede üç görsel ve bir ink splash videosu 
yer alacaktır. Katman panelindeki sıralama Görsel 4.61’deki gibi olacaktır. Timeline panelinde 
görselin kaçıncı saniyede başlamasını isterseniz Timeline panelinde yer alan katman izini mouse 
ile sürükleyerek ilgili saniyeye yerleştiriniz.

Görsel 4.61: Görseller ve geçiş videosu ile birlikte katman paneli ve Timeline görünümü

8. Adım: Geçiş videosunu Ctrl+D ile görsel sayısınca çoğaltınız. 

9. Adım: Videolar ile görsellerin başlangıcının aynı hizada olmasına dikkat ediniz (Görsel 4.61).

10. Adım: Katman panelinde en alttaki görselin Scale ve Rotation özelliklerini aktifleştiriniz. 
Bu işlem için Shift tuşu basılıyken S (Scale) ve R (Rotation) tuşlarına basıldığında sadece iki özellik 
alt alta görünecektir.

11. Adım: Görselin başlangıcına Scale ve Rotation değerleri için birer anahtar kare ekleyiniz.

12. Adım: Timeline çizgisini videonun bitişine alınız. Scale değerini artırırken Rotation değerini 
birkaç derece değiştiriniz (Görsel 4.62).
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Görsel 4.62: Rotation ve Scale değerlerindeki değişim

13.  Adım: Katman panelinde en alttaki görselin Timeline panelinde bulunan anahtar karelerini 
mouse işaretçisiyle seçili hâle getirip Ctrl+C ile kopyalayınız.

14. Adım: İkinci görselin başlangıç Frame’ine Timeline çizgisini çekip Ctrl+V ile yapıştırınız. 
Böylece bir yerdeki animasyon anahtar karelerini başka katmanlara da aktarabilirsiniz. Aynı işlemi 
üçüncü görsel için de yapınız (Görsel 4.63).

Görsel 4.63: Ctrl+C ve Ctrl+V ile kopyalanıp yapıştırılan anahtar karelerin Timeline panelindeki son hâli

15. Adım: Görsellerin katman panelindeki Track Matte özelliklerini Luma Inverted Matte 
olarak belirleyiniz (Görsel 4.64).

Görsel 4.64: Görsele Luma Inverted Matte uygulanması
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16. Adım: Yaptığınız çalışmayı ön izleyiniz (Görsel 4.65).

Görsel 4.65: Luma Inverted Matte uygulanmış görsellerin sahnedeki görünümü

Belirleyeceğiniz bir konu için birden fazla görsel bulunuz. Görsel geçişleri için ink 
splash tarzı video veya videolar bularak bir akış gerçekleştiriniz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. İstenen çözünürlük ve fps değerlerinde Composition oluşturdu.

2. Görselleri katman paneline yerleştirdi.

3. Ink splash videoyu katman paneline yerleştirdi.

4. Videoyu görsel sayısı kadar çoğalttı.

5. Her bir görselin üst katmanına bir video gelecek şekilde düzenledi.

6. Görseller ve videoları Timeline panelinde istenen saniyelere sürükleyerek 
zaman ayarlaması yaptı.

SIRA SİZDE
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DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

7. Videolar ile görsellerin başlangıç Frame’lerini eşleştirdi.

8. İlk görsele Scale ve Rotation animasyonları için anahtar kareler oluşturdu.

9. İlk görselden Ctrl+C ile kopyaladığı anahtar kareleri diğer görsellere de 
Ctrl+V ile yapıştırdı.
10. Track Matte özelliğinden Luma Inverted Matte seçerek ink splash video 
ile görselleri maskeledi.

4.2. YEŞİL PERDE (GREENBOX) TEKNOLOJİSİ
Chroma Key (Anahtarlama) işlemindeki Greenbox tekniği,  tek renk bir zemin üzerindeki 

görüntünün renk maskelemesiyle zemin renginden ayrıştırılarak başka bir görsel veya video 
üzerine eklenmesi işlemidir. Bu işlem, tek renk zemin olarak yeşil (Greenbox) tercih edildiği için 
Greenbox diye de adlandırılır. Ortam, kostüm vb. durumlara göre zemin renginde mavi (Bluebox) 
de tercih edilebilir.

Chroma Key tekniğinde arka planda çoğunlukla yeşil renk kullanılması, yeşilin insan ten 
renginde en az bulunmasından dolayıdır. Eğer ilgili sahnede yeşil renkli nesnelerin bulunması 
gerekiyorsa bu durumda mavi renkli arka plan kullanılır. Bu arka plan; kumaş, ışık yansıtmayan 
kâğıt ve Chroma Key için özel boyalarla elde edilebilir.

Bu teknik ilk olarak Larry Butler tarafından 1940 yılında çekilen Bağdat Hırsızı (The Thief 
of Bagdad) filminde kullanılmıştır. Reklam, bilim kurgu,  tarihi filmler ve tehlikeli olabilecek 
sahnelerde sıklıkla kullanılan bir teknik olmaya devam etmektedir (Görsel 4.66).

 Görsel 4.66: Greenbox tekniğinin kullanıldığı sahnelerden görüntüler

Chrome Key işleminde tek renk arka plan rengi bilgisayar yazılımlarıyla temizlense de kaliteli 
sonuçlar için dikkat edilmesi gereken bazı hususlar şunlardır:

1. Arka plan rengi ile ön planda kalan nesne veya kişi arasında mesafe olmalıdır. Aksi hâlde 
Keying işleminde arka plan renginin sınır çizgilerine yansıması sonucu kişinin etrafında renk 
atlaması denilen bir yansıma meydana gelebilir. Ayrıca kişinin gölgesi arka plana düşerse veya 
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arka plan zemini (perde, kâğıt vb.) kırışıksa Keying işleminde zorluklarla karşılaşılabilir (Görsel 
4.67).

Kamera

Dolgu Işık (Fill)
60%

Anahtar Işık (Key)
100%

Kişi ya da Nesne

Arka Işık (Back)
40%
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Görsel 4.67: Greenbox stüdyosu planı 

2. Video çekimleri açık alanlarda yapılabildiği gibi Chroma Key için özel olarak hazırlanmış 
stüdyolar da kullanılır. Bu durumda Greenbox yeterli büyüklükte olmalıdır (Görsel 4.68).

Görsel 4.68: Chroma Key için özel olarak hazırlanan stüdyo

Görsel 4.69: Arka planı eşit aydınlatılmamış görsel

3. Chroma Key tekniğinde ışıklandırma çok önemlidir. Arka plan yüzeyi doğru ve eşit bir şekilde 
aydınlatılmalıdır (Görsel 4.69).
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4. Ön plandaki nesne veya kişilerin de eşit ve dengeli bir şekilde aydınlatılması, istenen 
kalitede sonuçlar için gereklidir (Görsel 4.70).

Görsel 4.70: Doğru ışıklandırılmış Greenbox ortamı ve görseli

5. Arka plan rengi ile aynı renkte kıyafet ve aksesuar kullanılmamalıdır. Siyah kıyafet daha iyi 
sonuçlara yardımcı olacaktır.

6. Greenbox ortamında bir video çekimi yapılırsa kamera ayarları hareket bulanıklığını 
giderecek şekilde olmalıdır.

İşlem adımlarına göre Greenbox ile çekilmiş bir görüntüyü görsel efekt programında 
Chroma Key tekniğiyle kullanınız.

1. Adım: Çözünürlüğü Full HD (1920x1080) piksel olan bir Composition oluşturunuz.

ÖNEMLİ: Uygulamada video kullanılacaksa Composition Frame Rate hızı, videonun fps 
değerine göre belirlenmelidir.

2. Adım: Uygulama içinde kullanılabilecek görsel veya videoları uygun web sitelerinden 
indiriniz.

3. Adım: Görseli veya videoyu sahnenin katman paneline ekleyiniz (Görsel 4.71)

Görsel 4.71: Sahnenin katman paneline görsel eklenmesi

6. UYGULAMA
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4. Adım: Keying işlemi için Effect>Keying>Keylight1.2 efektini Greenbox ile çekilmiş görün- 
tünün üzerine ekleyiniz.

Çalışma düzleminde Effect Control paneli kapalıysa Window>Effect Control yolu ile 
açılıp bu panel görüntülenebilir.

5. Adım: Keylight 1.2 efektindeki Screen Colour parametresinin yanındaki damlalık aracına 
tıklayarak sahnedeki nesnenin arka plan renginden seçim yapınız. Yeşil alanlar saydam hâle 
gelmelidir (Görsel 4.72).

Görsel 4.72: Keylight 1.2 efektinde Screen Colour parametresi ekrandaki yeşil renkle ayarlandığında 
                       oluşan görüntü

Arka plan rengini saydamlaştırmada istenen sonuç elde edilmemişse bunun ışık 
ve çekimle ilgili bir eksiklikten kaynaklandığı unutulmamalıdır. Keylight 1.2 yardımcı 
parametre ayarları bu eksiklikleri bir yere kadar tolere edebilir. Görsel 4.73’teki 
parametrelerden bazılarının değerleri değiştirilerek görsele uygulanmıştır (Görsel 4.72).

NOT

NOT
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Görsel 4.73: Keylight efektine ait parametreler

6. Adım: Tek renk arka plan rengini saydamlaştırdığınız görselin alt katmanına konuya uygun 
başka bir görsel veya renk ekleyerek uygulamayı tamamlayınız (Görsel 4.74).

Görsel 4.74: Chrome key tekniği ile değiştirilen arka plan görünümü

Seçeceğiniz Greenbox ile çekilmiş bir görseli veya videoyu uygun başka bir görsel 
veya video üzerine ekleyerek özgün bir çalışma gerçekleştiriniz.

SIRA SİZDE

Ön plandaki görsele Tranform>Flip Horizontal yönlendirmesi uygulanmıştır.

NOT
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DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. İstenen çözünürlükte Composition oluşturdu.

2. İlgili görseli veya videoyu programa aktardı.

3. Chroma Key uygulanacak görseli veya videoyu katman paneline ekledi.

4. Effect>Keying>Keylight1.2 efektini Chroma Key tekniği ile çekilen görsele 
veya videoya ekledi.

5. Screen Colour parametresi ile ekrandan arka plan rengini seçti.

6. Tek renk arka planı saydamlaştırmada sorunlar oluştuysa diğer Keylight 
ayarlarını değiştirerek görüntü sorunlarını giderdi.
7. Arka planı saydamlaştırarak maskelenmiş görseli veya videoyu kompozis-
yona uygun başka bir görselin veya videonun üst katmanına ekledi.

4.3. ROTO BRUSH ARACI MASKELEME VE ROTOSKOP
Görsel efekt programında Roto Brush, hareketli görüntülerdeki kişilerin veya nesnelerin 

seçime bağlı sezgisel olarak sınırlarını belirleyen ve bunları arka plandan ayırarak maskeleyen 
araçtır. 

Shape veya  Pen Tool araçlarıyla videolardaki hareketli bir nesneyi anahtar kareler ekleyerek 
maskelemek iş yükünü oldukça artırır. Roto Brush aracıyla bu iş kolayca yapılabilir. Refine Edge 
Tool ise detayların çok olduğu saç, çimen vb. alanları Roto Brush işleminden sonra maske alanına 
dâhil etmek için kullanılır (Görsel 4.75).

Görsel 4.75: Görsel efekt programında Roto Brush Tool ve Refine Edge Tool aracının yeri

Rotoskop, video kaydı alınan gerçek görüntülerin özel bir yüzeye yansıtılarak videodaki 
hareketlerin kopyalanması tekniğidir. Böylece çizilen karakterlerin animasyonları daha gerçekçi 
hâle gelir. İlk olarak 1917 yılında Max Fleischer isimli yapımcının kullandığı bu teknik gelişerek 
günümüze kadar gelmiştir. Günümüzde video kayıtlarının üzerine çizimler eklenerek videoyu 
yeniden oluşturma şeklinde de kullanılır. A Scanner Darkly, Undone benzeri filmler bu teknikle 
oluşturulmuştur. 
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Motion Capture isimli teknik de Rotoskop tekniğinden ilham alınarak geliştirilen animasyon 
yakalama tekniğidir. 

İşlem adımlarına göre görsel efekt programında Roto Brush aracını kullanarak bir 
çalışma gerçekleştiriniz.

1. Adım: Roto Brush aracını kullanarak işlem yapılacak videonun fps değerlerine sahip bir 
Compotision oluşturunuz. 

2. Adım: Uygulama içinde kullanılabilecek görsel veya videoları uygun web sitelerinden 
indiriniz.

3. Adım: Videoyu katman paneline sürükleyerek ekleyiniz. Ardından katmanın üzerine çift 
tıklayarak sahnede katman detayına erişiniz (Görsel 4.76).

Görsel 4.76: Katman panelinde katmana çift tıklandığında sahnede açılan katman detayı

7. UYGULAMA

Hazır bir çalışmaya video eklenerek Roto Brush işlemi yapılacaksa videonun fps 
değeri Compotision Frame Rate değerine eşitlenmelidir (bk. Interpret Footage) ve 
sahne izleme çözünürlüğü Full olmalıdır.

NOT
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4. Adım: Roto Brush aracını seçiniz (Görsel 4.75). Videoda maskelenecek alanı sınırlarından 
taşmadan boyayınız (Görsel 4.77 ve Görsel 4.78). 

Görsel 4.77: Roto Brush aracı ile maskelenecek 
                       alanın boyanması

Görsel 4.78: Roto Brush sonrası oluşan  
                       maskeleme sınırları

Görsel 4.79: Set IN poin to current time ve Set OUT point to current time noktaları ile ilk Frame vurgusu

5. Adım: Maskeleme alanında taşmalar varsa klavyeden Alt tuşuna basarak taşan alanları 
tekrar boyayınız. Roto Brush fırçasının boyutu Ctrl tuşu ile ayarlanarak daha hassas çalışılabilir 
(Görsel 4.80).

Kullanılan videonun bir kesitine Roto Brush uygulanacaksa set IN poin to current 
time ve set OUT point to current time butonlarıyla videonun tamamından yalnızca bir 
bölümü seçilecek şekilde bir ayarlama yapılır. Videonun ister bir kesitine ister tamamına 
Roto Brush uygulanmasında Timeline çizgisi ilk Frame’de iken işleme başlanmalıdır 
(Görsel 4.79).

NOT
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Görsel 4.80: Alt tuşuyla taşmaların giderildiği maskelenen Roto Brush işlemi 

6. Adım: Space tuşuna basarak ön izleme yapınız. Videonun ister bir kesitine ister tamamına 
Roto Brush uygulandığında kişi veya nesne her Frame’de maskelenir. 

7. Adım: Ön izlemeyi dikkatlice yapınız. Herhangi bir Frame’de maske alanında taşma varsa o 
Frame’de gerekli Roto Brush düzeltme işlemini Alt tuşu ile olabildiğince hatasız yapmaya çalışınız. 

Roto Brush aracının kusursuz çalışabilmesi için  dikkat edilecek hususlar şunlardır:

1. Videonun çekim kalitesi çok iyi olmalıdır.

2. Videodaki nesne arka planla benzer renklerden uzak olmalıdır.

8. Adım: Kullanılacak tüm Frame’ler için seçim ve maskeleme işlemi tamamlandıktan sonra 
pencerenin alt tarafındaki Freeze butonuna tıklayınız (Görsel 4.81).

Görsel 4.81: Roto Brush işleminin tamamlanması için Freeze butonuna tıklanması

NOT
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9. Adım: Freeze işlemini tamamlayıp sahneye döndüğünüzde belirlenen nesne veya kişinin 
maskelenmiş görüntüsünü görünüz (Görsel 4.82).

Görsel 4.82: Roto Brush ile maskelenen kişinin sahnedeki görüntüsü

10. Adım: Maskelenmiş videonun  kopyasını Ctrl+D ile alıp alt katmana sürükleyiniz. Effect 
kontrol panelinden Roto Brush efektini kaldırınız. Böylece sahnede Roto Brush uygulanmış ve 
uygulanmamış aynı videodan iki tane olacaktır.

11. Adım: Bu iki katman arasından temaya uygun bir metin animasyonu gerçekleştirerek 
uygulamayı tamamlayınız (Görsel 4.83).

Görsel 4.83: Roto Brush kullanılarak maskelenmiş görüntü ve metin animasyonu
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Seçeceğiniz videodan bir kişiyi Roto Brush kullanarak maskeleyiniz. Temaya uygun 
bir arka plan ve metin ile destekleyerek bir animasyon gerçekleştiriniz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. İstenen çözünürlükte Composition oluşturdu.

2. İlgili videoyu programa aktardı.

3. Video katman panelini açtı.

4. Roto Brush aracı ile seçim yaptı.

5. Space tuşuna basarak belirlenen aralıkta ön izleme yaptı. 

6. Her Frame’yi kontrol ederek taşma veya eksik alan varsa düzeltti.

7. Ana sahneye geri dönerek temaya uygun arka plan ve metin belirledi.

8. Metin animasyonu gerçekleştirerek çalışmayı tamamladı.

SIRA SİZDE
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A) Aşağıdaki soruları dikkatlice okuyarak doğru seçeneği işaretleyiniz.

1. Aşağıdaki kısayol tuşlarından hangisi görsel efekt programında katman panelindeki 
maske alt katmanlarını gösterir?

    A) M  	     B) P		  C) R		  D) T		  E) U

2. Görsel efekt programında Shape nesnesinin maske olarak çalışması için aşağıdakilerden 
hangisi yapılmalıdır?

    A) Composition Frame Rate değeri görsel veya video ile aynı olmalıdır.

    B) Sahnedeki nesne, katman panelinde seçili vaziyette olmalıdır. 

    C) Sahnede en az iki nesne bulunmalıdır.

    D) Sahnedeki nesnenin 3D özelliği aktifleştirilmelidir.

    E)  Sahnedeki nesneye herhangi bir efekt eklenmemiş olmalıdır.

3. Aşağıdaki özelliklerden hangisi Mask alt katmanına ait değildir?

    A) Expansion 

    B) Feather

    C) Opacity

    D) Orientation

    E) Path

4. Pen Tool aracı ile eklenen bir vertexi kaldırmak için aşağıdaki hangi kısayol tuşu basılı 
tutulmalıdır?

    A) Alt 	     B) Alt Gr	     C) Cmd	  D) Ctrl		  E) Shift

5. Track Matte için aşağıdakilerden hangisi doğrudur?

    A) D tuşu ile kısayoldan erişilir. 

    B) Efekt menüsünden erişilir.

    C) Katman panelinde hep görünür.

    D) Keyframeler ile animasyon yapılır.

    E) Transfer Controls pane ile açılıp gizlenir.

ÖLÇME VE DEĞERLENDİRME
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6. Greenbox tekniğinden yararlanarak video çekimi yapılırken aşağıdaki renklerden hangisi 
video öznesi üzerinde bulunmamalıdır?

    A) Gri

    B) Kırmızı

    C) Mavi

    D) Siyah

    E) Yeşil

7. Hareketli görüntülerdeki bir nesneyi arka plandan ayırmak için aşağıdaki araçlardan 
hangisi kullanılmalıdır?

    A) Clone Stamp Tool		  B) Hand Tool			   C) Puppet Pin Tool

  			     D) Shape Tool			   E) Roto Brush
	
8. Aşağıdaki araçlardan hangisini kullanırken Composition Frame Rate ile video fps değerleri 

aynı olmalıdır?

    A) Clone Stamp Tool		  B) Puppet Pin Tool 		  C) Roto Brush
			       D) Shape Tool			  E) Text Tool

9. 

    Görselde kırmızıyla işaretlenen alan aşağıdaki hangi araç kullanılarak elde edilir?

    A) Mask Expansion 
    B) Mask Feather 
    C) Mask Feather Tool

    D) Mask Opacity

    E) Mask Path



KONULAR

5.1. EFEKTLER

5.2. SAHNEDE KAMERA

5.3. SAHNEDE IŞIK

 NELER ÖĞRENECEKSİNİZ?

• Görsel efekt programlarında bir görsele veya videoya efekt uygulama

• Birden fazla efekti aynı nesneye uygulama 

• Sahnenin tümüne efekt uygulama

• Komut satırı kullanarak animasyonlar yapma

• Kamera özelliklerini kullanarak animasyonlar yapma
• Sahneye ışık ekleme ve ışığa duyarlı nesneler oluşturma

ANAHTAR KELİMELER

Track Motion, Camera Track, Transition, Effect,  CGI



GÖRÜNTÜ EFEKTİ 
OLUŞTURMA

5. ÖĞRENME BİRİMİ
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1. Görsel efekt programlarında efektlerin önemi nedir?

2. CGI teknolojisi sinema dünyasına nasıl bir katkı sunmuştur?

5.1. EFEKTLER 
Efektler, görsel efekt programlarının gerçek gücünü ortaya çıkaran araçlardır. Bazı efektler 

Plugin adı verilen eklentilere dönüştürülerek daha kolay uygulanabilir.

5.1.1. Efektlerin Nesnelere Eklenmesi 

Efektler seçili katmana uygulanır. Seçili bir katmana efekt uygulayabilmenin birden fazla yolu 
bulunur. Örneğin katman seçiliyken üstteki Effect menüsünden ilgili efekt seçilerek katmana 
eklenebilir (Görsel 5.1).

Görsel 5.1: Effect menüsünden efektin seçilmesi

HAZIRLIK ÇALIŞMALARI
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Bir diğer yöntem ise  Effects & Presets componentinin arama kısmına yazılarak efekte 
erişilmesidir. Efektin üzerine tıklanarak veya efekt sürüklenerek seçili katmana eklenebilir (Görsel 
5.2). Effects & Presets componenti Window menüsünden görüntülenip gizlenebilir.

Görsel 5.2: Effects & Presets componentinden efektin bulunması ve seçili katmana eklenmesi

5.1.2. Effect Control Paneli 

Bir katmana efekt eklendiğinde efektin çeşitli özelliklerinin değiştirildiği Effect Controls paneli 
görüntülenir. Panel gizliyse klavyeden F3 tuşuna basılarak veya Window>Effect Controls yolu 
seçilerek panel görüntülenebilir (Görsel 5.3).

Görsel 5.3: Efekt eklendikten sonra Effect Controls panelinin görünümü



                 Görüntü Efekti Oluşturma292

Aynı katmana birden fazla efekt eklendiğinde efektler Effect Controls panelinde alt alta 
sıralanır. Her efektin kendine ait parametreleri vardır (Görsel 5.4). 

Görsel 5.4: Birden fazla efektin bir katmana eklenmesi ve efektlerin Effects Controls panelinde sıralanması

5.1.3. Adjusment Layer ve Efekt Kontrolü

Efektler sahnede seçili nesneye eklenebilir ancak bazı durumlarda bir efektin tüm sahneyi 
etkilemesi gerekebilir. Örneğin renk düzenleme, lens blur vb. efektler için Adjustment Layer 
katmanı eklenerek efekt bu katman üzerine uygulanır. Böylece sahnedeki tüm nesneler efektten 
etkilenir. Adjustment Layer katmanı, Timeline katman paneline sağ tıklayıp New bölümünden 
eklenebilir (Görsel 5.5). Bu katman, Layer menüsünden New yolu takip edilerek de eklenebilir.
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Görsel 5.5: Katman panelinden Adjustment Layer eklenmesi

Adjustment Layer şeffaf bir katmandır ve üzerine eklenen efektleri kendinden aşağıdaki 
katmanlara yansıtmak için kullanılır (Görsel 5.6).

Görsel 5.6: Adjustment Layer katmanına Tint efekti eklenmiş ve maskelenmiş bir çalışma 
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5.1.4. Plugin Eklemek 

Bazı efektler Plugin adı verilen ve özel yüklenen araçlarla  kolay ve hızlı bir şekilde 
gerçekleştirilebilir. Pluginler çoğunlukla ücretli araçlardır ancak bazı üreticiler, bazı Pluginleri 
ücretsiz olarak da sunabilir. Video Copilot’a ait Saber Plugini ücretsiz eklentilere örnek iken aynı 
üreticinin Element 3D eklentisi ücretli bir Plugindir. Saber Plugini ilgili üreticinin sayfasından 
indirilip kurulduğunda Effects menüsüne eklenecektir (Görsel 5.7).

Görsel 5.7: Saber Plugini yüklendikten sonra Effects & Presets panelinde görüntülenmesi

Saber Plugini ile Görsel 5.8’de görülen efektler kolayca yapılabilir.

Görsel 5.8: Ücretsiz Saber Plugini ile videodaki bir nesneye efektlerin uygulanması
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İşlem adımlarına göre Glitch adı verilen etkiyi gerçekleştiriniz.

1. Adım: Çözünürlüğü Full HD (1920x1080) piksel olan bir Composition oluşturunuz.

2. Adım: Sahneye bir portre fotoğraf ekleyiniz.

3. Adım: Fotoğrafın boyutunu uygun olduğunu düşündüğünüz bir ölçüye ayarlayınız.

4. Adım: Timeline katman alanında New>Solid yoluyla siyah renk bir Solid oluşturunuz.

5. Adım: Katmanın adını Fractal Noise olarak değiştiriniz (Görsel 5.9).

Görsel 5.9: Siyah renk Solid katmanın eklenmesi ve adının Fractal Noise olarak değiştirilmesi

6. Adım: Fractal Noise ismini verdiğiniz siyah renkli Solid katmanın üzerine Effects & Presets 
panelinden Fractal Noise efektini sürükleyerek bırakınız (Görsel 5.10).

Görsel 5.10: Fractal Noise efekti eklenmiş siyah renkli Solid katmanın görünümü

1. UYGULAMA
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7. Adım: Effect Controls panelindeki Fractal Noise değerlerini Görsel 5.11’deki değerlere 
benzer şekilde uygulayınız. 

Görsel 5.11: Fractal Noise efektine ait değerler

8. Adım: Timeline katman paneline sağ tıklayıp Adjustment Layer ekleyiniz.

9. Adım: Adjustment Layer katmanına Effects & Presets panelinden Displacement Map 
efektini ekleyiniz.

10. Adım: Adjustmen Layer üzerindeki Displacement Map efektinin değerlerini Görsel 5.12’de 
görüldüğü gibi değiştiriniz.

Görsel 5.12: Displacement Map Layer değerinin Fractal Noise katmanı olarak değiştirilmesi
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11. Adım: Fractal Noise katmanını seçip Timeline çizgisini 1. saniyeye çekiniz.

12. Adım: Effect Controls panelinde Fractal Noise efektinin Random Seed değerini 1. saniyede 
0 olarak değiştirip anahtar kare ekleyiniz.

13. Adım: Timeline çizgisini 2. saniyeye çekip Random Seed değerini artırınız (Görsel 5.13).

Görsel 5.13: Random Seed değerinin anahtar kareyle anime edilmesi

14. Adım: Fractal Noise isimli katman üzerindeki efektin etkili olabilmesi için bu katmanı Pre-
compose hâline getiriniz (Görsel 5.14).

Görsel 5.14: Fractal Noise katmanının Pre-compose hâline getirilmesi
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15. Adım: Görsel 5.15’te olduğu gibi Comp 1’de var olan üç  katmanı seçip, Pre-compose 
hâline getirerek adına Görsel Orijinal ismini veriniz. 

Görsel 5.15: Comp 1’de yer alan üç katmanın seçilerek Görsel Orijinal ismiyle Pre-compose hâline 

                       getirilmesi

16. Adım: Timeline katman panelinde yer alan Görsel Orijinal isimli katman seçiliyken 
klavyeden Ctrl+D kısayolu ile katmanı çoğaltınız ve adını Görsel Kırmızı olarak değiştiriniz.

17. Adım: Görsel Kırmızı isimli katmana Effects & Presets panelinden Shift Channels isimli 
efekti ekleyiniz ve ayarlarını Görsel 5.16’da görüldüğü gibi yapınız.

Görsel 5.16: Görsel Kırmızı katmanına ekli Shift Channels efektinin ayarları

18. Adım: Görsel Kırmızı katmanını Görsel Yeşil ve Görsel Mavi adıyla iki kez daha çoğaltınız ve 
Shift Channels efektindeki Blue ve Green ayarlarını yapınız. 

Yeşil katmanda Take Green From= Green, diğer renkler Full Off şeklinde; Mavi 
katmanda da Take Blue From= Blue, diğer renkler Full Off şeklinde ayarlanmalıdır.

NOT
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wiggle titreşim  scriptinde 10 değeri frekansa, 30 değeri ise genliğe karşılık gelir.

19. Adım: Shift Channels efektine ait ayarlamalar ve katman çoğaltma işlemini bitirdikten 
sonra çoğalttığınız üç renk katmanının karışım modlarını Screen olarak değiştiriniz (Görsel 5.17).

Görsel 5.17: Kopyalanan katmanlar ve karışım modlarının ayarlanması

20. Adım: Renk katmanlarının üçünü de seçip, klavyeden P tuşuna basarak Position özelliğini 
görüntüleyiniz.

21. Adım: Görsel Yeşil katmanından başlayıp, Position özelliği yanındaki anahtar kare ikonuna 
Alt tuşuna basılıyken bir kez tıklayarak Expression: Position özelliğini görüntüleyiniz (Görsel 5.18).

Görsel 5.18: Alt tuşu ile birlikte Position özelliği yanındaki anahtar kare ikonuna tıklandığında açılan 
                        Expression özelliği

22. Adım: transform.position scriptinin yer aldığı script alanına wiggle(10,30) scripti 
ekleyiniz ve fare ile boş bir alana tıklayınız.

NOT
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23. Adım: Diğer iki renk katmanı için de wiggle(10,30) scripti ekleyiniz (Görsel 5.19).

Görsel 5.19: Renk katmanlarının Position özelliklerine wiggle(10,30) scriptinin eklenmesi

24. Adım: Yeşil, Mavi ve Kırmızı renkli katmanların sahnede görünmesini 1. saniyeye kadar 
engellemek için Timeline çizgisini 1. saniyeye çekip renk katmanlarının Opacity özelliğini 0’a 
getiriniz. Timeline çizgisini 10 frame ilerletip renk katmanlarının Opacity değerini 100 yapınız. 
Timeline çizgisini 10 frame ilerletip, renkli katmanların Opacity değerini 100 olarak tekrar 
anahtar kareleyiniz. Timeline çizgisini 10 frame daha ilerletip bu kez renk katmanlarının Opacity 
değerlerini 0 yapınız (Görsel 5.20).

Görsel 5.20: Opacity özelliğiyle anahtar karelenmiş katmanların Timeline görüntüsü

25. Adım: Katman paneline sağ tıklayıp New>Adjustment Layer ekleyiniz.

26. Adım: Adjustment Layer katmanına Effects & Presets panelinden Optic Compensation 
efektini ekleyiniz. 

27. Adım: Effects & Presets panelinden Adjustment Layer katmanına Radial Blur efektini de 
ekleyiniz (Görsel 5.21). 
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Görsel 5.21: Effect Controls panelinde iki efektin alt alta görünümü

Görsel 5.22: Optics Compensation efektinde Field of View değeri, Radial Blur efektinde Amount 
değerinin gösterimi

28. Adım: Timeline çizgisini 1. saniye 20. frameye getiriniz.

29. Adım: Optic Compensation efektinde Reverse Lens Distortion kutusunu işaretleyiniz.

30. Adım: Radial Blur efektinde Type seçeneğini Zoom olarak değiştiriniz.

31. Adım: Timeline çizgisi 1. saniye 20. framedeyken Field Of View ve Amaount değerlerinin 
anahtar kare ikonlarına tıklayıp birer keyframe oluşturunuz.

32. Adım: Timeline çizgisini 2. saniyeye çekiniz. Field of View ve Amount değerlerini Görsel 
5.22’de görüldüğü gibi ayarlayınız. 
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Glitch etkisi bir görsel veya videodan başka bir görsel ya da videoya geçiş için 
kullanılabilir. Dolayısıyla istenirse Optics Compensation ve Radial Blur efekti ile birlikte 
Rotation animasyonu da eklenebilir.

33. Adım: Efektler uygulandıktan sonra elde edilen etkiyi ön izleyiniz (Görsel 5.23).

Görsel 5.23: Efektlerin uygulanması sonucu elde edilen etki

Belirlediğiniz görsel veya videolar arasında Glitch etkisini geçiş olarak kullanacağınız 
bir animasyon gerçekleştiriniz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. İstenen çözünürlükte Composition oluşturdu.

2. İlgili video veya görseli programa aktardı.

3. Görsel veya video üzerine siyah Solid katman oluşturdu.

SIRA SİZDE

NOT
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DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR
4. Siyah Solid katmanda Fractal Noise efekti ile gerekli ayarlamaları yaptı.
5. Siyah Solid katmanı Pre-compose hâline getirdi.

6. Katman paneline Adjustment Layer ekledi.
7. Adjustment Layer katmanına Displacement Maps efekti ekleyerek gerekli 
ayarlamayı yaptı.
8. Tüm katmanları seçerek Pre-compose hâline getirdi.
9. Pre-compose hâline gelen katmanları Ctrl+D ile kopyaladı.
10. Shift Channels efektini kopyalanan katmana ekledi. 
11. Shift Channels ekli katmanı iki kez daha kopyalayarak renk düzenlemelerini 
yaptı.
12. Renk katmanlarının Position özelliklerine wiggle (10,30) Expressionu 
ekledi.
13. Renk katmanlarının Opacity özelliği ile gereken animasyonu anahtar kare- 
lerle gerçekleştirdi.
14. Adjustment Layer ekledi.
15. Adjustmen Layer katmanına Optic Compensation efektini ekledi.
16. Adjustmen Layer katmanına Radial Blur efektini ekledi.
17. İkinci görsel veya videoyu bu etkiden hemen sonra yerleştirerek geçiş 
animasyonunu gerçekleştirdi.

İşlem adımlarına göre 3D Camera Tracker efektinden yararlanarak videolara sabit 
yazı veya logo ekleyiniz.

1. Adım: Çözünürlüğü Full HD (1920x1080) piksel olan bir Composition oluşturunuz.

2. Adım: Sahneye bir video ekleyiniz.

3. Adım: Video Frame Rate özellikleri ile oluşturduğunuz Comp 1 özellikleri benzer değilse 
Project menüsünde videoya sağ tıklayıp New Comp from Selection yoluyla videodan bir 
Composition oluşturunuz.

4. Adım: Effects & Presets panelinden 3D Camera Tracker efektini bulup, video üzerine 
sürükleyerek bırakınız.

Ücretsiz ve telifsiz video desteği sağlayan sitelerden video indirilebilir.

2. UYGULAMA

NOT
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Window menüsünden Tracker seçeneği tıklanıp, Track Camera seçeneği seçilerek de 
aynı efekte erişilebilir (Görsel 5.24).

Görsel 5.24: 3D Camera Tracker ve Tracker bölümünden Track Camera’ya erişim

5. Adım: 3D Camera Tracker efekti ekleyerek görsel efekt programının videoyu analiz etmesini 
sağlayınız (Görsel 5.25). 

Görsel 5.25: 3D Camera Tracker ile videonun işlenmesi

Videonun sadece bir bölümünde bu etkinin çalışması istenirse video, Comp 1 içinde 
sınırlanabilir.

NOT

NOT
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Analiz sona erdiğinde video üzerinde renkli noktalar görülür (Görsel 5.26). Bunlar, 
sabitlenecek yazı, Solid vb. unsurlar için referans noktalarıdır. Noktalardan biri veya 
birkaçı birlikte seçilip, sağ tıklanarak açılan menüden istenen nesne eklenebilir.

Görsel 5.26: Track pointlerin video üzerinde görüntülenmesi

6. Adım: Belirlediğiniz bir noktaya veya seçtiğiniz noktalar grubuna sağ tıklayıp Create Text 
and Camera seçeneğini işaretleyiniz (Görsel 5.27).

Görsel 5.27: Create Text and Camera seçeneğinin işaretlenmesi

NOT
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7. Adım: Sahneye bir Text yazısı eklenecektir. Bu yazıyı videonuza uygun bir kelimeyle 
değiştiriniz. Yazının açısını ve büyüklüğünü Transform özelliklerinden istediğiniz gibi ayarlayınız 
(Görsel 5.28).

Görsel 5.28: Eklenen Text yazısının değiştirilerek ayarlanması

Eklenen yazının video ön izlendiğinde sabit bir nesne gibi davranması beklenir. 
Eklenen yazının sahneye daha fazla dâhil olması istenirse Görsel 5.29’da görüldüğü gibi 
video kopyalanıp, maskeyle sınırlandırılarak daha etkin videolar tasarlanabilir.

Element 3D Plugini sayesinde 3D objeler eklenerek CGI destekli videolar da 
yapılabilir.

Görsel 5.29: Videonun kopyalanması ve maskeyle sınırlandırılması

NOT

NOT
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Belirleyeceğiniz bir videoda 3D Camera Tracker efektini uygulayarak bir metin efekti 
gerçekleştiriniz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. İstenen çözünürlükte Composition oluşturdu.

2. İlgili video veya görseli programa aktardı.

3. Videodan Comp oluşturdu.

4. Video üzerine Track Camera veya 3D Camera Tracker efekti ekledi.

5. Analiz sonrası Track Point noktası belirledi.

6. Belirlenen Track Point noktasına Text and Camera ekledi.

7. Eklenen Text yazısını düzenledi.

8. Videoyu kopyalayarak maskeyle düzenledi.

5.2. SAHNEDE KAMERA
Görsel efekt programları üç boyutlu bir uzay düzlemine sahiptir. Bu çalışma düzleminde 

yapılan animasyonlara derinlik, bir başka deyişle Z eksenine ait boyut işe katıldığında etkisi daha 
güçlü animasyonlar ortaya çıkarılır. Ayrıca CGI (Computer Generated Imagery), VFX vb. sinematik 
kavramlara ait etkileri videolarda gösterebilmek için bu üç boyutlu uzay düzlemi kullanılır. Bu 
uzay düzlemindeki nesneleri gösterebilmek için varsayılan görünüm alanından fazlasına ihtiyaç 
vardır ve bu ihtiyaç, sahneye başka kameralar eklenerek giderilebilir.

SIRA SİZDE
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Görsel efekt programında sahneye kamera eklemek için iki yol vardır. İlki Layer>New>Camera, 
diğeri ise Timeline katman paneline sağ tık New>Camera şeklindedir. Her iki yöntem de Camera 
Settings penceresi açılır, sahnede kullanılacak kameranın ayarları yapılarak kamera sahneye 
eklenir (Görsel 5.30).

Görsel 5.30: Camera Settings penceresi ve kamera seçenekleri

Type: Bu bölümde One Node ve Two Node olmak üzere iki tip kamera seçilebilir. One Node 
kamerada sabitlenmiş bir görüntüleme noktası yoktur. Two-Node Camerada ise sabitlenmiş ikinci 
bir görüntüleme noktası vardır. Kamera hareketleri bu ikinci nokta referansında sabitlenebilir. 
Genellikle Two-Node Cameranın daha çok kullanıldığı görülür.

Name: Kameraya verilecek isimdir. Bir sahnede birden fazla kamera olabilir. Kameralar, 
kullanımına göre isimlendirilebilir.

Preset: Kameranın lens özelliklerinin belirlendiği yerdir. Geniş açıdan dar açıya hazır lens 
ayarları kullanılabileceği gibi Custom bölümünden daha özel lens ayarları da yapılabilir.

Enable Depth of Field: Kameranın derinlik alanın açılıp kapatılabildiği seçenektir. Kameraların 
odaklandığı alan dışındaki nesnelerde oluşan bulanıklığı (Bokeh) ortaya çıkarmak için bu seçenek 
aktifleştirilebilir. 
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Sahneye kamera eklendikten sonra kamera hareketleri için Tools panelindeki 
Görsel 5.31’de görülen araçlar kullanılabilir ancak kamera hareketinde tam kontrol için 
genellikle Null Object oluşturulup, kameranın Parentı yapılarak çalışılır (Görsel 5.32).

Görsel 5.31: Kamera kontrol araçları

Görsel 5.32: Sahnede kamera kontrolü için Null Object eklenerek kameranın Parent objesi yapılmış hâli

Kameraya ait özellikler istenirse Timeline katman panelinde Camera katmanının hemen 
yanındaki oka tıklanarak açılan Camera Options bölümünden de değiştirilebilir (Görsel 5.33).

Görsel 5.33: Kameraya ait özelliklerin katman panelinden görüntülenmesi

İşlem adımlarına göre kamera kullanarak resim galerisi animasyonu gerçekleştiriniz. 

1. Adım: Çözünürlüğü Full HD (1920x1080) piksel olan bir Composition oluşturunuz.

2. Adım: Sahneye stok sitelerinden indirebileceğiniz en az on adet görsel ekleyiniz.

3. Adım: Create a new composition tıklayarak 800x800 ölçülerinde, Görsel 1 adında bir 
Composition oluşturunuz.

3. UYGULAMA

NOT



                 Görüntü Efekti Oluşturma310

4. Adım: Oluşturulan Compositiona Stroke değeri 50 px olan içi boş bir Rectangular nesnesi 
oluşturarak bir çerçeve ekleyiniz (Görsel 5.34).

Görsel 5.34: 50 px Stroke değeriyle oluşturulmuş çerçeve

5. Adım: Görsel 1 Comp’una belirlediğiniz görsellerden ilkini yerleştirip Scale değerini 
ayarlayınız (Görsel 5.35).

Görsel 5.35: Çerçeve altına yerleştirilen ve Scale değeri ayarlanan görsel

6. Adım: Görsel 1 Comp’unu başlangıçta oluşturduğunuz ana Comp’a taşıyınız.

7. Adım: Project bölümünde yer alan Görsel 1 Comp’unu Ctrl+D kısayolu ile görsel sayısınca 
çoğaltınız. Ctrl+D’ye her bastığınızda Görsel 2, Görsel 3… şeklinde artan bir kopyalama göreceksi-
niz.
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8. Adım: Project bölümünde görsel sayısı kadar kopyaladığınız Görsel Comp’larını Timeline 
katman paneline sürükleyip bırakınız (Görsel 5.36).

Görsel 5.36: Timeline paneline kopyalanarak çoğaltılmış Comp’ların taşınması

9. Adım: Her bir Görsel Comp’unun içine erişerek görselini sırayla değiştiriniz.

10. Adım: Görsel Comp’larının içeriği tamamen değiştirildikten sonra Timeline katman pane- 
linde tüm katmanların 3D özelliğini aktif hâle getiriniz (Görsel 5.37).

11. Adım: Sahneye 50 mm özelliklerinde Two Node Camera ekleyiniz.

Görsel Comp’u içinde resim katmanı seçiliyken Alt tuşuna basılıp, Project 
bölümünden başka bir görsel sürüklenerek Timeline katman panelinde seçili görsel 
katmanının üzerine bırakılırsa görsel hızlıca değiştirilebilir.

Görsel 5.37: 3D özelliği aktif hâle getirilen katmanlar

NOT
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12. Adım: Sahneye Null Object ekleyerek 3D özelliğini aktif ediniz ve kamerayı Null Objecte 
Child olarak bağlayınız (Görsel 5.38).

Görsel 5.38: Camera ve Null Objectin eklenerek Parent-Child bağının kurulması

13. Adım: Sahne görünümünü 1 View modundan 2 View moduna alarak görselleri sahnede 
dağıtınız (Görsel 5.39).

14. Adım: Sahnedeki görselleri Görsel 5.40’ta görüldüğü gibi dağıtınız.

Görsel 5.39: Sahne görünümünün 1 View modundan 2 View moduna alınması

Görsel 5.40: Görsellerin sahneye dağıtılması
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15. Adım: Timeline katman alanına bir Null Object daha ekleyip, adını wiggle olarak değiştiriniz.

16. Adım: Katman panelindeki tüm görsel katmanlarını wiggle isimli Null Objecte Child olarak 
bağlayınız.

17. Adım: Wiggle isimli Null Objectin 3D katman özelliğini aktif ediniz.

18. Adım: Wiggle isimli Null Object katmanının Position özelliğini Alt tuşuna basarak Expression 
paneliyle görüntüleyiniz. Script olarak wiggle(.3,50) değerini yazınız (Görsel 5.41).

Görsel 5.41: Wiggle isimli Null Objecti ve Wiggle scriptinin eklenmiş Expression hâli

19. Adım: Görsellerin hafif hafif sallandığı animasyonu ön izleyiniz.

20. Adım: Kameranın Child olarak bağlandığı Null Objecti sahnede bir resmi görecek şekilde 
konumlandırınız.

21. Adım: Timeline çizgisini 1. saniyeye ayarlayıp Null Objectin Position özelliğine anahtar 
kare ekleyiniz. 

22. Adım: Timeline çizgisini 20 frame öteleyerek bir anahtar kare daha ekleyiniz.

23. Adım: Timeline çizgisini 1 saniye öteleyip Camera Null Objectini başka bir görseli görecek 
şekilde konumlandırınız (Görsel 5.42).

Görsel 5.42: Null Objecte bağlı kameraya anahtar kareler eklenerek hareket ettirildiğinde oluşan sahne 

                       görünümü

24. Adım: Bu işlemi tüm görseller için yapınız.

25. Adım: Arka plan için New>Solid yolunu izleyerek bir Solid katmanı ekleyiniz ve katmanı en 
alta sürükleyiniz.
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26. Adım: Solid katmanına Gradient Ramp efekti ekleyerek griden beyaza boyayınız (Görsel 
5.43).

Görsel 5.43: Solid katmanı ve Gradient Ramp efekti eklenmiş katman paneli

Bu noktadan sonra Particular tarzı videolar eklenerek, katman karışımı değiştirilip 
farklı etkiler elde edilebilir (Görsel 5.44).

Görsel 5.44: Particular eklenerek katman karışımı Screen yapılmış bir videonun etkisi

27. Adım: Yaptığınız çalışmayı Numpad 0 tuşuna basarak ön izleyiniz.

NOT
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Belirleyeceğiniz görsellerle bir galeri animasyonu hazırlayınız.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. İstenen çözünürlükte Composition oluşturdu.

2. İlgili görselleri çalışmaya aktardı.
3. Görsel tutucu olarak 800x800 boyutlarında, Görsel 1 adında bir Comp 
oluşturdu.
4. Görsel 1 Comp’unu Project bölümünde görsel sayısı kadar çoğalttı.

5. Çoğaltılan Comp’ları Katman paneline ekledi.

6. Katman panelinde yer alan Görsel katmanlarındaki görselleri değiştirdi.

7. Görsellerin 3D katman özelliğini açtı.

8. Wiggle isminde bir Null Object oluşturdu.

9. Tüm Görsel katmanlarını Wiggle Null Objectine Child olarak bağladı.
10. Wiggle Null Objectinin Position değerinin Expression kısmına wiggle(.3,50) 
değerini yazdı.

11. 50 mm Two Node Camera ekledi.

12. Kamera için Null Object ekledi.

13. Kamerayı Null Objecte Child olarak bağladı.

14. Sahnedeki görselleri sahne uzayında dağıttı.

15. Görsellerden birine göre kamerayı ayarladı.

16. Timeline çizgisinde görselden görsele anahtar karelerle geçiş animasyonu 
yaptı.
17. Çalışmayı ön izledi.

İşlem adımlarına göre 3D harita animasyonunu gerçekleştiriniz. 

1. Adım: Çözünürlüğü Full HD (1920x1080) piksel olan bir Composition oluşturunuz.

SIRA SİZDE

4. UYGULAMA
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2. Adım: Fiziki bir Türkiye haritası görselini stok görsel sitelerinden temin ederek programa 
aktarınız.

3. Adım: Scale değerini sahneyi dolduracak şekilde ayarlayınız.

4. Adım: Türkiye haritası görselinin 3D katman özelliğini aktif ediniz.

5. Adım: 50 mm Two Node Camera ve kameranın Child olarak bağlı olduğu bir Null Object 
ekleyerek Null Objectin 3D katman özelliğini aktif ediniz.

6. Adım: Effects & Presets panelinden Color Emboss efektini harita görselinin üzerine bırakınız.

7. Adım: Relief Contrast değerini Görsel 5.45’te görüldüğü gibi veya sizin görselinizde sahte 
bir kabarma etkisi yapacak düzeyde değiştiriniz.

Görsel 5.45: Color Emboss efekti eklenmiş harita görseli

8. Adım: Harita görselinizin üzerine  Mesh Warp efektini ekleyiniz.

9. Adım: Mesh Warp efektinin parametre ayarlarından Rows ve Columns değerlerini haritada 
oluşturmak istediğiniz kabarma etkisine göre ayarlayınız (Görsel 5.46).

Görsel 5.46: Mesh Warp efektine ait parametrelerin ayarlanmış hâli
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10. Adım: Mesh Warp efekti aktifken çizgilerin kesişim noktalarını tıklayıp, beliren hareket 
tutmacını oynatarak görseli deforme ediniz.

11. Adım: Orbit Around aracıyla görsel görüş açısını değiştiriniz. Harita üzerinde belirtilen 
yükseltileri Mesh Warp efektiyle deforme ediniz (Görsel 5.47).

Görsel 5.47: Mesh Warp efektinin uygulanması

12. Adım: Görsel etkinin daha güçlü olması için gölge etkisinden faydalanabilirsiniz. Bunun 
için siyah Solid bir katmanı görselin üst katmanına ekleyerek 3D özelliğini aktif ediniz.

13. Adım: Siyah Solid katmanının görünürlük göz işaretini kapatınız.

14. Adım: Gölge olması gerektiğini düşündüğünüz yerleri ışık yönüne dikkat edip, Pen aracını 
kullanarak maskeleyiniz.

15. Adım: Gölge alanlarını belirledikten sonra katmanın göz işaretini açarak Opacity değerini 
ayarlayınız.

16. Adım: Solid katmanı seçiliyken F tuşuna basarak Maske Feather özelliğini açınız.

17. Adım: Gerekli Feather değerlerini ayarlayarak gölgeleri yumuşatınız (Görsel 5.48).

Görsel 5.48: Gölge alanları oluşturularak Mask Feather ile yumuşatılmış görsel
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Görsel kontrastına katkı sunmak istenirse Effects & Presets panelinden Curves 
efekti görselin üzerine sürüklenerek eğri ayarları doygunluk ve kontrast yönünde 
değiştirilebilir. Ayrıca görselin etkisini güçlendirmek için istenirse PNG formatında bulut 
görselleri ile harita desteklenebilir (Görsel 5.49).

Görsel 5.49: Curves efekti ve PNG bulut görselleri ile desteklenmiş harita 

18. Adım: Pen aracıyla haritanın bir bölgesinden diğer bölgesine uzanan bir çizgi oluşturunuz 
(Görsel 5.50).

Görsel 5.50: Pen aracıyla çizilmiş bir çizgi

NOT
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19. Adım: Görsel 5.51’de görüldüğü gibi Shape katmanın Contents bölümünde yer alan Add 
sekmesinden Stroke özelliği ekleyiniz.

Görsel 5.51: Stroke özelliğinin eklenmesi

20. Adım: Katmanlara eklenen Stroke özelliğinin Dashes alt özelliğinin + ikonuna tıklayarak 
Dash ve Offset özelliğinin belirmesini sağlayınız (Görsel 5.52).

21. Adım: Çizgi katmanının 3D özelliğini aktif ederek sahnede yeniden konumlandırınız.

Görsel 5.52: Dashes özelliği altına Dash ve Offset alt özelliğinin eklenmesi
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22. Adım: Dashes özelliği açıldığında sahnedeki düz çizgi, kesikli çizgiye dönüşür. Content>Add 
yolunu izleyerek Trim Paths özelliği ekleyiniz (Görsel 5.53).

Görsel 5.53: Trim Paths özelliğinin End değerinin değiştirilmesiyle animasyon elde edilmesi

23. Adım: Trim Paths özelliğinin End değerini 0. saniyede 0, 2. saniyede 100 olarak anahtar 
karelerle anime ediniz.

24. Adım: Çizginizin geçtiği bölgelerdeki bazı illerin isimlerini lokasyon olarak yazınız. 

İllerin isimlerinin yanına Görsel 5.54’te görüldüğü gibi lokasyon ikonu da eklenebilir.

Katmanlar arası Z ekseninde fark çoksa kamera açısı değiştiğinde görüntüler 
bulunduğu yerden kayabilir. Bu nedenle Z ekseni değeri tekrar ayarlanabilir.

NOT

NOT
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Görsel 5.54: Bazı illerin lokasyon ikonlu hâli

25. Adım: İllerin isimlerini ve varsa lokasyon ikonlarını çizgi Trim Path animasyonu tam o 
bölgeye denk geldiğinde ortaya çıkacak şekilde Timeline çizgisinde konumlandırınız (Görsel 5.55).

Görsel 5.55: Çizgi animasyonuna göre beliren şehir adları ve lokasyon ikonları

26. Adım: Timeline çizgisini 0. saniye alıp kameranın Parent nesnesi olan Null Objectin 
Shift tuşuna basılıyken Positon (P) ve Orientation (R) parametrelerini ilgili klavye tuşlarıyla 
görüntüleyiniz.

27. Adım: Position ve Orientation parametreleri için 0. saniyede birer anahtar kare ekleyiniz.

28. Adım: Timeline çizgisini 2. saniyeye alınız.
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29. Adım: Görsel sahnede yatay görünebilecek şekilde Null Objectin değerlerini değiştiriniz 
(Görsel 5.56).

Görsel 5.56: Kamera Null Objectinin değerlerindeki değişime göre sahne görünümünün değişmesi

İstenirse çizgi animasyon süresi uzatılarak farklı kamera animasyonları da yapılabilir.

Belirleyeceğiniz bir haritada benzer kabartma, çizgi ve lokasyon isimli bir animasyon 
gerçekleştiriniz.

DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

SIRA SİZDE

NOT

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. İstenen çözünürlükte Composition oluşturdu.

2. İlgili görseli çalışmaya aktarıp 3D katmanını aktifleştirdi.

3. Görsele Color Emboss efekti uyguladı.

4. Görsele Mesh Warp efekti uygulayarak görsel yükseltilerini deforme etti.

5. Curves efekti ile görsel renk dengesini sağladı.

6. Pen aracı yardımıyla görsel boyunca çizgi çizdi.
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DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR
7. Çizgi katmanına Stroke özelliği ekleyerek Dashes alt özelliğini aktif etti.
8. Çizgi katmanına Trim Paths efekti uyguladı.
9. Trim Paths animasyonu gerçekleştirdi.
10. Harita üzerinde çizginin geçtiği çeşitli lokasyonların isimlerini yazdı.
11. İsmi yazılan lokasyonların çizgi animasyonuna göre sahnede belirmesini 
sağladı.
12. Sahneye 50 mm Two Node Camera ekledi.
13. Kameranın Parenti olacak Null Object ekledi.
14. Null Objectin Position ve Orientation değerleriyle animasyonu gerçekleştir- 
di.

İşlem basamaklarına göre görüntü işleme programında Dekupe edilen görselleri 
kullanarak bir animasyon gerçekleştiriniz. 

1. Adım: Çözünürlüğü Full HD (1920x1080) piksel olan bir Composition oluşturunuz.

2. Adım: Kompozisyon oluşturabilecek en az dört adet görsel belirleyerek görsellerdeki gerekli 
nesneleri maskeleyiniz veya görüntü işleme programında Dekupe işlemi yaparak görsel efekt 
programına aktarınız (Görsel 5.57).

Görsel 5.57: Birbirinden farklı görsellerden uygun alanlar Dekupe edilerek farklı katmanlara yerleştirilen 
                      görseller

5. UYGULAMA

Görüntüler görsel efekt programında maske yöntemi kullanılarak da animasyona 
hazır hâle getirilebilir ancak bazı görsellerde daha çok detay seçilmesi gerektiği için 
görüntü işleme programından yardım alınması gerekir.

Uygulamadaki kompozisyon dağları seyreden bir dağcı fikrine dayanır. Birbirinden 
farklı görsellerden dağlar Dekupe edilmiştir. Dağcı görseli ile mağara görseli birleşti- 
rilerek tek görsel hâline getirilmiştir. Böylece zemin görseli, sahnenin sol tarafına bir 
dağ görseli, sağ tarafına bir dağ ve en geride mağaradan dağları seyreden dağcı görseli 
hazırlanarak bir kompozisyon oluşturulmuştur.

NOT
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3. Adım: En alt zemine yerleştireceğiniz görsel dışında kalan katmanların 3D katman özelliğini 
aktif hâle getiriniz (Görsel 5.58).

Görsel 5.58: Katmanların 3D özelliklerinin aktifleştirilmesi

En alt zemine yerleştirilen görselin 3D özelliği aktif olmadığında çalışma uzayının 
zemini daima bu görsel olur. 

4. Adım: Sahneye 50 mm Two Node Camera ve kameranın Child olarak bağlanacağı 3D katman 
özelliği aktifleştirilmiş Null Object ekleyiniz (Görsel 5.59).

Görsel 5.59: Camera ve Null Objectin eklenmesi

5. Adım: Kamera, zemin görselinden başlayarak geriye doğru hareket edecektir. Hangi görselin 
hangi sırayla gelmesini istiyorsanız sahne uzayında buna göre bir yerleştirme yapınız (Görsel 
5.60).

Görsel 5.60: Görsellerin sahne uzayına yerleştirilmesi

Dağ Sol

Kamera

Dağcı

Dağ Sol

NOT
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Kameranın düz ilerlemesi istenmezse sağa, sola, yukarı, aşağı hareketler eklenerek 
Position anahtar kareleriyle animasyona değişik etkiler katılabilir.

6. Adım: Kamerayı üçer saniyede bir görsele erişecek şekilde Position animasyonu Z ekseninde 
geriye doğru hareket ettiriniz (Görsel 5.61).

Görsel 5.61: Kameranın Position animasyonunun gerçekleştirilmesi

  Kamera animasyonun başlangıç noktası

  Kamera animasyonun bitiş noktası

Kamera geriye doğru hareket ederken uzakta kalan nesneler giderek küçülecektir. 
Bu etkiyi verebilmek için istenirse görsellerin Scale değerleri de anime edilerek daha 
gerçekçi etkiler sağlanabilir.

7. Adım: Çalışmayı ön izleyiniz. Görsellerin Scale ve Position değerlerini gerekirse yeniden 
ayarlayınız.

Bir kompozisyon için belirleyeceğiniz görsellerden gerekli maskeleme veya Dekupe 
işlemi yaparak bir animasyon gerçekleştiriniz.

SIRA SİZDE

NOT

NOT
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DEĞERLENDİRME

Çalışmalarınız aşağıda yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. İstenen çözünürlükte Composition oluşturdu.

2. Kompozisyonu belirledi.

3. Kompozisyon için uygun görselleri belirledi.

4. Görsellere maskeleme veya Dekupe işlemi yaptı.

5. Zemin görseli hariç diğer görsellerin 3D katman özelliğini aktifleştirdi.

6. Görselleri sahne uzayına uygun biçimde yerleştirdi.

7. 50 mm Two Node Camera ekledi.

8. Null Object ekledi.

9. Null Objecti kameranın Parentı olarak ayarladı.

10. Görselleri sırayla görecek şekilde kamerayı anime etti.

11. Çalışmayı ön izledi.

5.3. SAHNEDE IŞIK
Görsel bir tasarımın önemli unsurlarından biri de ışıktır. Işık, görsel efekt programlarında 

sadece sahne dolgu unsuru olarak değil, animasyonun kendisi olarak da kurgulanabilir. Görsel 
efekt programında yardımcı Pluginler sayesinde sahneye eklenebilen 3D nesnelerin sahneyle 
uyumu için de  ışık nesnelerinden yardım alındığı unutulmamalıdır.

Sahneye ışık ekleyebilmek için iki yöntem vardır. İlki, Layer>New>Light… yolunu kullanmaktır. 
İkinci yol ise Timeline katman paneline sağ tık>New>Light… yoludur. Her iki yöntem de Görsel 
5.62’deki Light Setting penceresini görüntüleyecektir.
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Görsel 5.62: Light Settings penceresinin görüntülenmesi

Light Settings penceresindeki parametreler şunlardır:

Name: Işığın isminin belirlendiği alandır.

Light Type: Işık tipinin belirlendiği alandır. Paralel, Spot, Point ve Ambient olmak üzere dört 
farklı ışık türü seçilebilir.

Color: Sahnenin dokusuna ve ışığın kullanılacağı nesnenin rengine göre ışık rengi belirlenebilir.

Intensity: Işık yoğunluğunun belirlendiği parametredir.

Cone Angle: Spot ışık türü dışında pasif olan değerdir. Işık türü Spot seçildiğinde düzenlenebilir.

Cone Feather: Spot ışık türünün yayılmasının keskinliğinin ayarlandığı parametredir.

Falloff: Işık kaynağının aydınlatma şiddetinin Intensity değerine bağlı olarak aydınlatma 
çapının, aydınlatma çapı içinde aydınlatılan bölgenin genişliğinin ayarlandığı, Radius ve Falloff 
Distance değerlerinin yer aldığı parametredir.

Casts Shadows: Seçilen ışık türünün nesnelere çarptığında gölge üretip üretmeyeceğinin 
belirlendiği seçenektir. 

Shadow Darkness: Üretilen gölgenin koyuluğunun ayarlandığı parametredir.

Shadow Diffusion: Gölgenin ne kadar dağılacağını veya bulanıklaşacağını belirleyen 
parametredir.
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Casts Shadows: On Casts Shadows: Only Casts Shadows: Off

Bir ışık türü eklendikten sonra katman panelinden Light Settingse erişilerek ışık türü 
ve diğer özellikleri değiştirilebilir. Sahneye ışık eklendikten sonra sahnedeki nesnelerin 
ışık karşısındaki davranışları katman panelindeki Material Options bölümünden 
belirlenebilir. Görsel 5.63’te bu özelliklerin detayları verilmiştir.

Material Options bölümünde Casts Shadows, Light Transmission, Accept Shadows, 
Accept Lights başlangıçta en çok kullanılan parametrelerdir. Diğer parametreler ise ışık 
detayı ve hassasiyeti gerektiğinde kullanılır.

Görsel 5.63: Material Options bölümünden nesnelerin ışığa karşı davranışlarının ayarlanması

Casts Shadows: Nesnenin gölge oluşturması, sadece gölgenin kalıp nesnenin kaybolması ve 
gölgenin olmaması durumudur. On, Only ve Off şeklinde üç değer alabilir (Görsel 5.64).

Görsel 5.64: Casts Shadows değerleri değiştiğinde oluşan etki

NOT

NOT
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Light Transmission: Nesnenin ışık geçirgenliğini ayarlar. Light Transmission değeri arttıkça 
nesne kendi rengini gölgeye yansıtır (Görsel 5.65).

Görsel 5.65: Light Transmission değeri arttıkça nesne renginin gölgeye yansıması

Accept Shadows: Casts Shadows ile benzer görevdedir. Cast Shadows parametresine 
bağımlıdır.

Accept Light: Nesnenin renk ve görünürlük durumlarının sahne ışıklarından etkilenip 
etkilenmemesini ayarlayan değerdir.

Diğer parametreler nesneye düşen ışığa daha hassas davranışlar sergilemek için kullanılır. 

İşlem adımlarına göre eklenen ışığın Position animasyonunu gerçekleştiriniz.

1. Adım: Çözünürlüğü Full HD (1920x1080) piksel olan bir Composition oluşturunuz.

2. Adım: Sahneyi tümüyle kaplayacak açık gri renkli bir Shape oluşturunuz.

3. Adım: Shape layerin 3D katman özelliğini aktifleştiriniz.

4. Adım: Sahneye “Görsel Efekt” veya uygun olabilecek başka bir kelime yazınız.

5. Adım: Shape katmanını X ekseninde 90 derece döndürerek yatay bir zemin olması için 
sahnenin en altına hizalayınız.

6. Adım: Yazdığınız kelimeyi de zemine göre konumlandırınız (Görsel 5. 66).

Görsel 5.66: Zemin ve kelimelerin konumlandırılması

6. UYGULAMA
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7. Adım: Sahneye Point türünde bir ışık ekleyiniz.

8. Adım: Işığı Görsel 5.67’de görüldüğü gibi metnin arkasına konumlandırınız.

9. Adım: Material Options özelliklerinden Casts Shadows özelliğini açarak metnin gölgesinin 
oluşmasını sağlayınız.

Görsel 5.67: Işığın konumlandırılması ve gölgenin aktifleştirilmesi

10. Adım: Işığı sahnenin en solunda olacak şekilde konumlandırınız.

11. Adım: Position özelliği için 0. saniyeye bir anahtar kare ekleyiniz.

12. Adım: Timeline çizgisini 2. saniyeye alınız. Işık nesnesini sahnenin en sağına doğru X 
ekseninde hareket ettiriniz. Görsel 5.68’de olduğu gibi bir etki göreceksiniz.

Görsel 5.68: Işık nesnesinin Position animasyonuyla oluşan etki

İşlem adımlarına göre pencere, ışıyan nesneler vb. sahnelerde kullanılabilecek 
çalışmayı gerçekleştiriniz.

1. Adım: Çözünürlüğü Full HD (1920x1080) piksel olan bir Composition oluşturunuz.

2. Adım: Sahneyi tümüyle kaplayacak açık gri renkli bir Shape oluşturunuz.

3. Adım: Shape nesnesinin 3D katman özelliğini aktifleştiriniz.

4. Adım: Shape nesnesini X ekseninde 90 derece döndürerek zemin hâline getiriniz.

7. UYGULAMA
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5. Adım: Zemin üzerine Text aracını kullanarak EFEKT yazınız. 3D katman özelliğini aktifleştiriniz 
ve Görsel 5.69’da olduğu gibi sahnede konumlandırınız.

Görsel 5.69: Zemin ve yazının konumlandırılması

6. Adım: 28 mm Two Node Camera özelliklerinde bir kamera ekleyiniz.

7. Adım: Cast Shadows özelliği aktif olan Point türünde bir ışık ekleyiniz.

8. Adım: Eklenen ışığı sahnede yazının gerisine konumlandırınız.

9. Adım: Text katmanının Casts Shadows özelliğini açınız (Görsel 5.70).

Görsel 5.70: Işığın konumlandırılması ve Text katmanının gölge özelliğinin açılması

Görsel 5.71: Beyaz Solid katmanının konumlandırılması

10. Adım: Beyaz renkte bir Solid nesnesi ekleyerek 3D katman özelliğini aktifleştiriniz.

11. Adım: Elips Tool kullanarak Solid nesnesinin merkezinde daire şeklinde maskeleme yapınız.

12. Adım: Material Options seçeneklerinden Accept Light seçeneğini Off yapınız. 

13. Adım: Maskelenen beyaz renkli Solid katmanı yazı nesnesinin arkasına, ışığa yakın bir 
konuma sürükleyiniz (Görsel 5.71 ).
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14. Adım: Katman paneline Adjustment Layer ekleyiniz.

15. Adım: Adjustment Layer katmanına CC Radial Fast Blur efekti ekleyerek parametreleri 
Görsel 5.72’de görüldüğü gibi ayarlayınız. 

Görsel 5.72: CC Radial Fast Blur efektinin Adjustment Layer katmanına eklenmesi ve ayarlanması

16. Adım: Adjustment Layer katmanının karışım modunu Screen olarak değiştiriniz.

17. Adım: Katman paneline bir Null Object ekleyiniz ve 3D katman özelliğini aktifleştiriniz.

18. Adım: Null Objectin konumunu ışık nesnesinin arkasına gelecek şekilde ayarlayınız.

Adjustment Layer katmanında yer alan Center parametresi Child olarak Null Objecte 
bağlanmalıdır. Aksi hâlde kamera yönü değiştiğinde Adjustment Layerda etki gösteren  
CC Radial Fast Blur efekti doğru yönde durmaz.

Null 2, Null 1 veya başka isimle olabilir. Katman panelinde yazan isim önemlidir.

19. Adım: Görsel 5.73’te gösterilen CC Radial Fast Blur efektine ait Center değerinin anahtar 
karesine Alt tuşu ile birlikte basarak Expression aktif hâle getiriniz. 

20. Adım: Pick Whip Tool aracı ile Null Object katmanını Parent olarak bağlayınız.

21. Adım: Expression kısmındaki scripti “thisComp.layer("Null 2").toComp([0,0,0]);” şek- 
linde düzenleyiniz.

Pick Whip Tool aracı

Script bu şekilde tamamlanmalıdır.

Görsel 5.73: Expression aktifleştirilmesi ve yazılan script

NOT

NOT
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23. Adım: Adjustment Layer katmanına Curves efekti ekleyerek kontrastını artırınız (Görsel 
5.74).

24. Adım: Adjustment Layer katmanına ikinci Curves efektini CC Radial Fast Blur efektinin 
altına ekleyiniz. Red, Green ve Blue parametrelerini Görsel 5.75’te görüldüğü gibi ayarlayınız.

Görsel 5.74: Curves efektinin eklenmesi ve ayarlanması

Görsel 5.75: Eklenen ikinci Curves efektinin eğri ayarları
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25. Adım: Adjustment Layer katmanına son olarak Tint efekti ekleyerek Map White To rengini 
mavi yapınız (Görsel 5.76).

Görsel 5.76: Tint efektinin eklenmesi 

26. Adım: Tint efektinin rengini değiştirerek farklı renklerde ışımalar elde ediniz (Görsel 5.77).

Görsel 5.77: Tint efektinin renginin değişmesiyle farklı ışımaların elde edilmesi

Belirleyeceğiniz bir kelime üzerinde ışıma efekti gerçekleştiriniz.

DEĞERLENDİRME

Çalışmalarınız diğer sayfada yer alan kontrol listesi kullanılarak değerlendirilecektir. Çalışmanızı 
yaparken değerlendirme ölçütlerini dikkate alınız.

SIRA SİZDE
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KONTROL LİSTESİ

DEĞERLENDİRME ÖLÇÜTLERİ EVET HAYIR

1. İstenen çözünürlükte Composition oluşturdu.

2. Zemin katmanı oluşturdu.

3. Zemini 3D hâle getirdi.

4. Zemini sahneye konumladı.

5. Metni yazdı.

6. Metni 3D hâle getirdi.

7. Metni sahneye konumladı.

8. Kamera ekledi.

9. Point türünde Light nesnesi ekledi.

10. Beyaz Solid nesnesi ekleyerek Elips Tool ile maskeledi.

11. Adjustment Layer ekledi.

12. Adjustment Layer katmanına CC Radial Fast Blur efekti ekledi.

13. Adjustment Layer katmanına Curves efekti ile kontrast ayarı yaptı.

14. Adjustment Layer katmanının karışım modunu Screen olarak belirledi.

15. Katman paneline Null Object ekledi.

16. Null Objectin 3D katman özelliğini aktifleştirdi.

17. CC Radial Fast Blur efektinin Center değerini Null Objecte Pick Whip Tool 
aracıyla bağladı.

18. Null Objecte Pick Whip Tool aracıyla bağlanan Center değerinin Expression 
scriptini tamamladı.

19. Adjustment Layer katmanına ikinci Curves ekleyerek Red, Blue ve Green 
değerlerini ayarladı.

20. Adjustment Layer katmanına Tint efekti ekleyerek ışıma rengini değiştirdi.

İşlem adımlarına göre belirlediğiniz alanda ışıma efektini gerçekleştiriniz.

1. Adım: Çözünürlüğü Full HD (1920x1080) piksel olan bir Composition oluşturunuz.

8. UYGULAMA
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2. Adım: Görsel 5.78’de görüldüğü gibi bir video bularak veya çekerek sahneye ekleyiniz.

Görsel 5.78: Işımada kullanılabilecek videonun bir kesiti

3. Adım: Sahneye eklediğiniz videoya 3D Camera Tracker efektini uygulayınız.

4. Adım: Görsel 5.79’da görüldüğü gibi sahne üzerinde Tracker yapılabilecek noktalardan 
ışıma alanına en yakın olanları seçiniz.

Görsel 5.79: Tracker alanlarından ışıma bölgesine en yakın olanların seçilmesi

5. Adım: Seçim yapılan Tracker bölgesinde sağ tıklayıp Create Null and Camera seçeneğini 
işaretleyiniz.

6. Adım: Sahneye Adjustment Layer ekleyiniz.

7. Adım: Adjustment Layer katmanına Curves efekti ekleyip değerleri Görsel 5.80’de olduğu 
gibi ayarlayınız.

Bu çalışmada mavi ışıma renkleri kullanılacağı için tonlama Görsel 5.80’de görüldüğü 
gibi ayarlandı. Farklı renkler istenirse Curves eğrileri ona göre ayarlanabilir.

NOT
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Görsel 5.80: Curves eğrilerinin son durumu

8. Adım: Adjustment Layer katmanına CC Radial Fast Blur efekti ekleyiniz. Zoom parametresini 
Brightest olarak değiştiriniz. Amount değerini uygun gördüğünüz bir değere doğru yükseltiniz.

9. Adım: Adjustment Layer katmanın karışım modunu Screen yapınız (Görsel 5.81).

Görsel 5.81: Sahnenin son durumu

Görsel 5.82: Null Objectin ışıma alanının merkezinde konumlandırılması

10. Adım: Adjustment Layer katmanında yer alan CC Radial Fast Blur efektine ait Center 
parametresini eklediğiniz Null Objecte Child olarak bağlayınız ve Expression kısmına “thisComp.
layer("Track Null 1").toComp([0,0,0]); ” scriptini yazınız.

11. Adım: Null Objectini ışıma alanının merkezinde konumlandırınız (Görsel 5.82).
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12. Adım: Adjustment Layer katmanına Tint efektini ekleyiniz. Map White To rengini mavi 
veya çalışmanıza uygun bir renk olarak belirleyiniz.

13. Adım: Adjustment Layer katmanının Effect Controls panelinde Curves efektinden hemen 
sonra araya Fractal Noise efektini ekleyiniz. CC Radial Fast Blur ve Tint efektleri, Fractal Noise 
efektinden sonra gelmelidir.

14. Adım: Fractal Noise efektinde Fractal Type: Dynamic, Blending Mode: Darken olarak 
belirleyiniz.

15. Adım: Evolution parametresinin anahtar kare ikonuna Alt tuşu ile basarak Expression 
kısmına time*25  scriptini yazınız (Görsel 5.83).

Görsel 5.83: Efektler ve gerekli Expression scriptler yazıldıktan sonra sahnenin son hâli

16. Adım: Çalışmanızı Numpad 0’a basarak ön izleyiniz.
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A) Aşağıdaki soruları dikkatlice okuyarak doğru seçeneği işaretleyiniz.

1. Aşağıdaki kısayol tuşlarından hangisi görsel efekt programında Expression bölümünü  
          aktifleştirir?

    A) Alt   	       B) Ctrl	      C) Shift	     D) Shift+Ctrl	            E) Z

2. Aşağıdakilerden hangisi görsel efekt programında ışık nesnesinin gölge oluşturması için 
          seçilmelidir?

    A) Depth of Field		      B) Accept Light		      C) Metalic		
		  D) Casts Shadows		  E) Falloff Distance

3. Aşağıdaki tuşlardan hangisi Effect Control panelini açıp kapatır?

    A) F4  	     B) Alt		     C) F3		      D) F12	            E) Alt Gr

4. Pluginler için aşağıdakilerden hangisi yanlıştır?

A) Pluginler Efektlerin kolayca uygulanmasını sağlar.

B) Pluginler Ücretli ve ücretsiz olabilir.

C) Görsel efekt programına üç boyutlu nesne ekleyebilmek için Plugine ihtiyaç vardır.

D) Görsel efekt programının standart sunmadığı bazı özellikleri içerir.

E) Pluginler sahne ölçülerinin ayarlanmasına yardımcı olur.

5. Görsel efekt programında kamera tipi sayısı aşağıdakilerden hangisinde doğru verilmiştir?

    A) 1   	                 B) 2		    C) 3	 	      D) 4		            E) 5
  
6. Aşağıdakilerden hangisi bir katmana efekt ekleme yoludur?

    A) Effects & Presets 	     B) Layer>New>Effects	 	    C) Window>View>Effect	
		  D) Compotision>Preview	 E) Views>Effects

7. Sallanma Expression scripti aşağıdakilerden hangisidir?

    A) anchorPoint	  B) Bounce	   C) random	       D) time	           E) wiggle

8. Aşağıdaki efektlerden hangisi eklendiği görselde deformasyon meydana getirir?

    A) Tint	 	  B) Curves	   C) Mesh Warp       D) Fractal Noise     E) Color Emboss

9. Aşağıdakilerden hangisi bir katmana efekt ekleme yoludur?

    A) Tint			       B) Optics Compensations 	     C) Fractal Noise	
		  D) Displacement Map		  E) Gradient Ramp

ÖLÇME VE DEĞERLENDİRME
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CEVAP ANAHTARLARI

1. ÖĞRENME BİRİMİNİN CEVAP ANAHTARI

1. C, 2. C, 3. B, 4. E, 5. B, 6. E, 7. D, 8. C, 9. C, 10. B

2. ÖĞRENME BİRİMİNİN CEVAP ANAHTARI

1. C, 2. B, 3. B , 4. B, 5. C, 6. E, 7. B, 8. E, 9. D, 10. B, 11. D

3. ÖĞRENME BİRİMİNİN CEVAP ANAHTARI

1. E, 2. A, 3. A, 4. E, 5. C, 6. B, 7. A, 8. D, 9. C, 10. A

4. ÖĞRENME BİRİMİNİN CEVAP ANAHTARI

1. A, 2. B, 3. D, 4. D, 5. E, 6. C, 7. E, 8. C, 9. C

5. ÖĞRENME BİRİMİNİN CEVAP ANAHTARI

1. A, 2. D, 3. C, 4. E, 5. B, 6. A, 7. E, 8. C, 9. E


	1
	2
	3
	4
	5
	6
	7
	8

